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Welcome!

 

This is the Operation Manual for Steinberg’s Nuendo 3. Here you will 
find detailed information about virtually all features and functions in the 
program. 

 

How to use the manuals and the Help

 

When it comes to manuals, different users look for information in dif-
ferent ways, depending on their previous knowledge and personal 
preferences. You may be looking for a complete description of a pro-
cedure, you may just be trying to find a certain function in the program, 
you may have found a function in the program and want it explained – 
or you may simply want to learn it all!

Therefore, there are several ways to enter the documentation and get 
help:

 

•

 

Use the Table of Contents to browse the manual or the Help and find 
the section you need to know more about.

 

In the pdf version of the Operation Manual (and in the help) you can click directly on a 
chapter or section to go there.

 

•

 

Use the Index to look up specific features and functions.

 

Again, in the pdf (and the help) you can click directly on the page number for an index 
entry or on the help list index entry to go to there. The help also allows you to perform 
a free search of any term.

 

•

 

In the program you will find Help buttons in most dialogs – click to get 
information about that specific dialog.

 

Similarly, you can press [F1] to get information about the current window.

 

•

 

If you want information about a specific menu item, use the Menu 
Reference section in the Help.

 

All main menu items in Nuendo are listed and explained there.

 

•

 

Finally, you could read the manuals from start to end if you like.

 

See below for a description of all parts of the Nuendo documentation package.
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Other documents

 

Apart from the Operation Manual and the help, the following docu-
ments are included with Nuendo:

 

Getting Started

 

In this book (also available in Adobe Acrobat pdf format) you will find:

 

• Requirements, installation and setting up your system.
• Basic concepts and terminology.
• Basic methods – e.g. how to set values, use tools and menus.
• A list of all default key commands.
• A number of tutorials, helping you get started with working in Nuendo.

 

Audio Effects and VST Instruments

 

In this pdf document you will find:

 

• Descriptions of the included VST audio effect plug-ins.
• Descriptions of the included VST Instruments.

 

These descriptions can also be found in the help.

 

Working with MIDI

 

In this pdf document you will find:

 

• Descriptions of the MIDI processing functions
• Descriptions of the MIDI editors
• Information on effect handling and descriptions of the included MIDI effect 

plug-ins
• Information on how to set up and manage MIDI devices and device panels in 

Nuendo.
• Information on how to edit MIDI System Exclusive messages.
• Information on how to use the Logical Editor and Input Transformer.

 

Networking

 

This pdf document describes how you can use Nuendo’s project shar-
ing and networking features to collaborate with other users of Nuendo 
in a TCP/IP based peer-to-peer network.
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Remote Control Devices

 

This pdf document lists the supported MIDI remote control devices 
and describes how to set up and use them with Nuendo.

 

Score Layout and Printing

 

This pdf document describes the score editing features in Nuendo.

 

Using Nuendo with DSP Factory (Windows only)

 

In this pdf document you will find detailed information about Nuendo’s 
implementation for the Yamaha DSP Factory audio card.

 

All pdf documents can be opened from the Help menu in the program. 
Under Windows, you can also open them from the Nuendo Documenta-
tion subfolder on the Windows Start menu. Under Mac OS X, the pdf 
documents are located in the folder /Contents/Documentation/ within 

 

the program folder or the folder /Library/Documentation/Nuendo 3.
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input and output busses
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Introduction

 

As described in the Getting Started book, Nuendo uses a system of 
input and output busses to transfer audio between the program and 
the audio hardware.

 

• Input busses let you route audio from the inputs on your audio hardware into 
the program. This means that when you record audio, you will always do this 
through one or several input busses.

• Output busses let you route audio from the program to the outputs on your 
audio hardware. When you play back audio, you will always do this through 
one or several output busses.

• The audition bus creates a special audio path for monitoring your mix, pre-
viewing audio while importing, editing in the Sample editor, and for the special 
Listen Mode in the mixer which provides AFL/PFL solo. There is only one au-
dition bus but it can have any channel configuration from mono all the way up 
to 10.2 surround.

 

The audition bus is new to Nuendo 3 and users who have upgraded 
from earlier versions should pay special attention to its function since it 
affects the way you monitor audio in Nuendo. The audition bus should 

 

be connected to your monitoring system.

 

As you can see, the input and output busses are vital when you work 
with Nuendo. That’s the reason why you find this chapter at the begin-
ning of the Operation Manual – once you understand the bus system 
and set up the busses properly, it will be easy to go on with recording, 
playing back, mixing and doing surround work.
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Setting up busses

 

Strategies

 

You can create any number of busses in Nuendo, in virtually any chan-
nel configuration – mono, stereo or a number of surround formats. 

 

• The bus configuration is saved with the projects – therefore it’s a good 
idea to add and set up the busses you need and save these in a tem-
plate project (see page 641).

 

When you start working on new projects, you start from this template. That way you 
get your standard bus configuration without having to make new bus settings for each 
new project. If you need to work with different bus configurations in different projects, 
you could either create several different templates or store your configurations as pre-
sets (see page 23). The templates can of course also contain other settings that you 
regularly use – sample rate, record format, a basic track layout, etc.

 

So, which type of busses do you need? This depends on your audio 
hardware, your general audio setup (e.g. surround speaker setup) and 
what kind of projects you work with. Here’s an example:

Let’s say you are using audio hardware with eight analog inputs and 
outputs and digital stereo connections (10 inputs and outputs all in 
all). Furthermore, you work with a surround setup in 5.1 format. Here’s 
a list of busses you may wish to add:

 

Input busses

 

• Most likely you need at least one stereo input bus assigned to an analog input 
pair. This would let you record stereo material. If you want to be able to record 
in stereo from other analog input pairs as well, you could add stereo input 
busses for these too.

• Although you can record mono tracks from one side of a stereo input, it may 
be a good idea to add a dedicated mono input bus. This could be assigned to 
an analog input to which you have connected a dedicated microphone pre-
amp for example. Again, you could have several different mono busses.

• You probably want a dedicated stereo input bus assigned to the digital stereo 
input, for digital transfers.

• If you want to transfer surround material directly to a surround track, e.g. from 
surround-configured location recording equipment, you need an input bus in 
that surround format (here, this would be a 5.1 input bus).
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Output busses

 

• You will need one or several stereo output busses for routing stereo mixes to 
master recorders or other destinations. 

• For digital transfers, you need a stereo bus assigned to a digital stereo output 
as well.

• You might also need a surround bus in the format of your speaker configura-
tion (here, 5.1) assigned to the correct outputs (which in turn are connected 
to the correct speakers). 

• You may want additional surround busses if you tend to work in different sur-
round formats.

• The audition bus is a special output bus used to monitor your mix, preview ma-
terial for importing, listening to realtime audio exports and for Listen mode which 
provides standard AFL/PFL solos for channels in the mixer. Every project con-
tains an audition bus. It is configured under the Studio tab in the VST Connec-
tions window. This should be connected to your monitoring system.

 

Different busses can use the same inputs/outputs on the audio hard-
ware! Be aware that assigning the audition bus to the same set of outputs 
as your default bus can sometimes cause clipping due to the special re-
lationship of these two busses. By default, audio passing through the de-
fault output bus will also be heard through the audition bus. If they share 
the same ASIO output, the signals will combine in the audio card causing 
the levels to rise by 6dB and possibly clipping the D/A converter’s out-

 

puts. See page 21.
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Preparations

 

Before you set up busses, you should name the inputs and outputs on 
your audio hardware. For example, if you are using a 5.1 surround 
speaker setup, you should name the outputs according to which 
speaker they are connected to (Left, Right, Center and so on). 

The reason for this is compatibility – it makes it easier to transfer 
projects between different computers and setups. For example, if you 
move your project to another studio, the audio hardware may be of a 
different model. But if both you and the other studio owner have given 
your inputs and outputs names according to the surround setup (rather 
than names based on the audio hardware model), Nuendo will auto-
matically find the correct inputs and outputs for your busses and you 
will be able to play and record without changing the settings.

You name your inputs and outputs in the Device Setup dialog:

 

1.

 

Open the Device Setup dialog from the Devices menu.

 

2.

 

Select the VST Outputs device in the list to the left.

 

The available output ports on your audio hardware are listed.

 

3.

 

To rename a port, click its name in the list and type a new name.

 

•

 

If needed, you can also disable ports by clicking in the “Visible” col-
umn (so that it says “No”).

 

Disabled ports won’t show up in the VST Connections window when you are making 
bus settings. If you attempt to disable a port that is already used by a bus, you will be 
asked whether that is really what you want – note that this will remove the port from the 
bus!

 

4.

 

Select the VST Inputs and name them in the same way.

 

5.

 

Click OK to close the Device Setup dialog.

 

• If you open a project created on another computer and the port names 
don’t match (or the port configuration isn’t the same – e.g. the project is 
created on a system with multi-channel i/o and you open it on a stereo 
in/out system), a Pending Connections dialog will appear.

 

This allows you to manually re-route ports used in the project to ports available in your 
system.
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The VST Connections window

 

You add and set up busses in the VST Connections window, opened 
from the Devices menu.

There are five tabs in the window:

 

• The Input and Output tabs are for viewing input busses or output busses, re-
spectively. 

• The Group/FX tab allows you to create Group and FX channels/tracks and to 
make output assignments for these. See page 28. 

• The External FX tab allows you to create effect send/return busses for con-
necting external effects which can then be selected via the effect pop-up 
menus from inside the program. See page 284 for a description of how to use 
external effects.

• The Studio tab is for the audition bus, which is a dedicated output bus for 
monitoring your mix, auditioning material for import, editing in the Sample ed-
itor, realtime exports, listen mode etc. See page 29.

 

For the time being we shall focus on how to set up input and output 
busses.
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Depending on which tab you have selected, Input or Output, the win-
dow lists the current input or output busses, with the following columns:

 

Adding a bus

 

1.

 

Click the Inputs or Outputs tab depending on which you want to add.

 

2.

 

Click the Add Bus button.

 

A dialog appears.

 

3.

 

Select the desired (channel) configuration.

 

The pop-up menu contains Mono and Stereo options as well as the most common sur-
round formats. To select another surround format, use the “More...” submenu.

 

•

 

Alternatively you can right-click (Win) or [Ctrl]-click (Mac) in the VST 
Connections window and add a bus in the desired format directly 
from the context menu that appears.

 

The new bus appears with the ports visible.

 

4.

 

Click in the Device Port column to select an input/output port for a 
channel in the bus.

 

The pop-up menu that appears lists the ports with the names you have given them in 
the Device Setup dialog. Repeat this for all channels in the bus.

 

Column Description

 

Bus Name Lists the busses. You can select busses and rename them by clicking 
on them in this column.

Speakers Indicates the speaker configuration (mono, stereo, surround formats) 
of each bus.

Audio Device This shows the currently selected Master ASIO driver.

Device Port When you have “opened” a bus (by clicking its + button in the Bus 
Name column) this column shows which physical input/output on your 
audio hardware is used by the bus.
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Adding a child bus 

 

A surround bus is essentially a set of mono channels – 6 channels in 
the case of 5.1 format. If you have a mono track in the project, you can 
route it to a separate speaker channel in the bus (or route it to the 
whole surround bus and use the surround panner to position it in the 
surround image). But what if you have a stereo track that you simply 
want to route to a stereo channel pair within the bus (Left and Right or 
Left Surround and Right Surround for example)? For this you need to 
create a child bus:

 

1.

 

Select the surround bus in the list and right-click (Win) or [Ctrl]-click 
(Mac) it.
A pop-up menu appears.

2. Select a channel configuration from the “Add Child Bus” submenu.
As you can see, you can create stereo child busses (routed to various speaker channel 
pairs in the surround bus) or other surround bus formats (with fewer channels than the 
“parent bus”).

The child bus you created will be available for direct routing in the 
mixer. It’s a part of the parent surround bus, which means there will be 
no separate channel strip for it.

Although child busses are probably most useful in output busses, you 
could also create child busses within a surround input bus – for exam-
ple if you want to record a stereo channel pair (e.g. front left-right) in 
the surround bus to a separate stereo track.
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Setting the Default Output Bus

The Default Bus is the output bus that each new channel in the mixer 
will be assigned to when it is created. This bus will typically be your 
main mix bus, where all your signals will be combined.

Any one of the output busses in the VST Connections window can be 
the default output bus. By [right]-clicking (PC)/[Control]-clicking (Mac) 
on an output bus’s name, you can select the “Default Bus” option which 
will define that bus as the default bus. The default bus is identified by 
the orange speaker icon found to the left of its name.

Setting the default output bus in the VST Connections window.

The Default Bus and the Audition Bus are related. The default bus has 
its aux send #1 automatically routed to the audition bus. This aux send 
is enabled but set to -∞ dB. Depending on your setup, you will have to 
make the following changes to make the full use of the audition bus and 
the AFL/PFL functionality:

1. Set the level of aux send #1 (destination audition bus) on your default 
output bus to 0.00 dB. This will pass the complete mix signal of the 
default output bus to the audition bus. If you are using more than one 
output bus, you may need to create additional aux sends #1s to the 
audition bus, also set to 0.00 dB.



NUENDO
2 – 22 VST Connections: Setting up input and output busses

2. Be aware that the default output bus AND the audition bus are con-
nected to ASIO output port 1/2. This means that once you have set 
the send levels to 0.00 dB, as described above, the levels present on 
the default output bus and the audition bus are summed, resulting in a 
6 dB level boost at the output. Normally you would disconnect the de-
fault output bus from the ASIO output or route the audition bus to 
separate ASIO outputs which are used exclusively for monitoring.

To monitor your mix, the signal from aux send #1 of the default bus is 
sent to the audition bus, which in turn should be connected to your 
monitoring system.

The reason for this unusual connection is the Listen Mode in the mixer. 
This provides a pre-fader listen (PFL) and after-fader listen (AFL) solo 
bus to your monitoring system. When you enable a Listen button on 
any channel in the mixer, that signal (taken pre fader or post fader de-
pending on the global setting) will be routed directly to the audition 
bus (the connection between your mix signal (default output bus) and 
the audition bus is temporarily interrupted). This allows you to hear the 
listen-enabled channel by itself without interrupting the signal to the 
default bus. When you defeat listen mode for all channels, the aux 
send #1 pathway from the default bus to the audition bus will be en-
abled, returning the whole mix to your monitoring system.

If you assign the default bus and the audition bus to the same set of 
ASIO outputs on your audio card, and with the aux send #1 level (default 
output bus to audition bus) set to 0.00 dB, this could cause clipping in 
the DA converters on your audio card, because of the increased level of 
the summed signals.

When creating new audio, group or FX channels in the mixer, they will 
automatically be routed to the default bus unless the channel configu-
ration exactly matches that of another output bus. For example, if the 
default output bus is stereo and you have created a second 5.1 out-
put bus, when you create a 5.1 audio track, it will be routed to the 5.1 
output bus initially.

The default bus is indicated by an orange colored speaker icon next to 
its name in the VST Connections window.
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Other bus operations

• To change the port assignment for a bus you proceed as when you 
added it – make sure the channels are visible (by clicking the + button 
next to the bus, or by clicking the “+ All” button at the top of the win-
dow) and click in the Device Port column to select ports.

• To remove a bus you don’t need, select it in the list, right-click (Win) 
or [Ctrl]-click (Mac) and select “Remove Bus” from the pop-up menu 
or press the [Backspace] key.

• You can store and recall bus presets with the pop-up menu at the top 
of the window.
To store the current configuration as a preset, click the store (+) button and enter a 
name for the preset. You can then select the stored configuration directly from the Pre-
sets pop-up menu at any time. To remove a stored preset, select it and click the (-) 
button.
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Using the busses

This section describes briefly how to use the input and output busses 
you have created. This is described in more detail in the chapters Re-
cording and The mixer.

Routing

When you play back an audio track (or any other audio channel in the 
mixer – VST Instrument channels, ReWire channels, etc.), you route it 
to an output bus. In the same way, when you record on an audio track 
you select from which input bus the audio should be sent.

• You can select input and output busses in the Inspector, using the 
“In” and “Out” pop-up menus.

For channel types other than audio tracks (VST Instrument channels, 
FX channels, etc.), only the “Out” pop-up menu is available. To access 
the “Out” pop-up menu for such a channel in the Inspector, select one 
of its automation subtracks in the Track list.
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• You can also select busses in the Input and Output Settings panel at 
the top of each channel strip in the mixer.
Again, for VST Instrument channels, ReWire channels, Group channels and FX chan-
nels you will only be able to select output busses.

• If you press [Alt]/[Option] and select an input or output bus, it will be 
chosen for all selected channels.
This makes it easy to quickly set several channels to use the same input or output. 
Similarly, if you press [Shift] and select a bus, the following selected channels will be 
set to use incrementing busses - the second selected channel will use the second 
bus, the third will use the third bus and so on.

• If the Input and Output Settings panel isn’t shown, click the Show Input 
and Output Settings field in the common panel to the left in the mixer.

When selecting an input bus for a track you can only select busses that 
correspond to the track’s channel configuration. Here are the details:

• Mono tracks can be routed to mono busses or individual channels within a 
stereo or surround bus (input or output). You can also route a mono track to 
the “whole” stereo or surround output bus, in which case a pan control (ste-
reo pan or surround panner) will be used to position the sound.

• Stereo tracks can be routed to stereo busses or stereo child busses within a 
surround bus, to surround busses using a stereo surround panner and to 
mono busses using what looks like a normal pan control but is actually a bal-
ance control between the left and right channels.

• Surround tracks can be routed to busses with the same number of speaker 
channels as the track (or to corresponding child busses within a “larger” sur-
round bus). If a surround track is routed to a bus with a different number of 
channels, the pan controls will be replaced by the Mixconvert plugin. See the 
Audio Effects and VST Instruments document for more information.
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Viewing the busses in the mixer

In the mixer, busses are represented by input and output channels 
(shown in separate panes to the left and right in the window). You can 
show or hide these independently by clicking the buttons Hide Input 
Channels and Hide Output Channels in the mixer’s common panel to 
the left:

Input channels

The input channels are shown to the left in the mixer. As you can see, 
each input channel resembles a regular mixer channel strip. Here you 
can do the following:

Hide Input Channels

Hide Output Channels
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• Check and adjust the recording level using the Input Gain knobs and/or the 
level fader.
See page 59.

• Change the phase of the input signal.
This is done by clicking the Input Phase button next to the Input Gain control.

• Add effects or EQ to the input bus.
See page 72 for an example of how to add effects to your recording at the input bus 
stage.

The settings you make in the input channel strip will be a permanent 
part of the recorded audio file!

Output channels

The output channels are shown to the right in the mixer. Here you can 
do the following:

• Adjust the total output level for the busses with the faders.
• Add effects or EQ.

These will affect the whole bus. Examples of effects you may want to add here include 
compressors, limiters and dithering. See page 269.

• Using Sends, send varying amounts of one Output bus to any other Output 
bus that is to the right of the selected Output bus in the mixer.
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Setting up Groups and FX channels

The Group/FX tab in the VST Connections window shows all Group 
channels and FX channels in your project. You can create new Group 
or FX channels by clicking the corresponding Add button. This is the 
same as creating Group channel tracks or FX channel tracks in the 
Project window (see page 249 and page 274 for details). 

However, the VST Connections window also allows you to create 
child busses for Groups and FX Channels. This is useful e.g. if you 
have Groups or FX Channels in surround format and want to route 
stereo channels to specific channel pairs in these.

To create a child bus for a Group channel or FX channel, proceed as 
follows:

1. Open the VST Connection window and select the Groups/FX tab.

2. Select the Group or FX channel in the list and right-click (Win) or 
[Ctrl]-click (Mac) it.

3. Select a channel configuration from the “Add Child Bus” submenu.

The child bus you created will be available for direct routing in the 
mixer. It’s a part of the parent Group or FX channel, which means 
there will be no separate channel strip for it.
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About the Audition bus
The Audition bus provides a “direct” and dedicated output for moni-
toring. It should use the same configuration as your monitor system, 
e.g. stereo or 5.1 surround.

Operations such as importing audio files, working in the Sample editor, 
exporting realtime mixdowns and others will occur using the audition 
bus for monitoring. Of course the main mix will also be heard through 
the audition bus.

You set up the audition bus output from the “Studio” tab in the VST 
Connections window, using the same methods as for other output 
busses. It can use any available Device Port outputs. Be careful not to 
assign the audition bus to the same Device Ports as the default bus, 
for the reasons mentioned on page 21.

The audition bus cannot be removed. However, you can change its 
channel configuration by right-clicking (Win) or [Ctrl]-clicking (Mac) 
the bus and selecting the desired configuration from the “Change 
Bus” submenu.
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Setting the audition bus level

In the Mixer, the audition bus is represented by a channel strip in the 
output section, to the right of the regular output channels. The audition 
bus channel strip only has a pre/post fader status button, a mute but-
ton and a level fader.

When auditioning or scrubbing in the Sample editor, you can also set 
the output level of the audition bus using the small fader on the Sample 
editor toolbar. This can function as a monitor level control if needed.

Setting the Pre or Post Fader Status

The Audition channel has a button next to the fader to control the pre/
post fader status of the solo bus used in Listen Mode. When a chan-
nel in the mixer is Listen enabled, its signal is routed directly to the au-
dition bus. When the audition bus is set to pre-fader, the signal will 
come from just before the fader (and pan) controls on that channel. If 
the audition bus is set to post-fader, the signal will come after the 
fader (and pan) controls, providing a AFL solo with pan. Its normal sta-
tus is pre-fader.
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About the signal flow

The audition bus makes the Listen functionality available by doubling 
the signals of the default output bus. This is achieved by the fact that 
output busses in Nuendo can have other output busses as send des-
tination. This new concept differentiates between what is mixed and 
what is auditioned (see the illustration below).
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Background

This chapter describes the various methods available for controlling 
Playback and Transport functions in Nuendo.

The Transport panel

Below you can find a brief description of each Transport panel item.

• You can customize the look of the Transport panel, hiding unneeded 
controls and moving controls as desired – see page 676.
The pictures below show the Transport panel with all controls visible and in their de-
fault position. The Transport panel is divided into sections, from left to right.

Activates Auto Quantize

Record mode pop-up

Cycle Record 
mode pop-up

CPU load and Disk Cache meters

Right locator: punch out point 
and end of Cycle

Activates punch out

Activates punch in

Left locator: record start point, punch in point 
and beginning of Cycle

Preroll setting and on/off switch

Postroll setting and on/off switch

Shuttle speed

Jog Wheel (project 
scrubbing)

Nudge +/- 1 Frame

Primary Time Display and format pop-up

Position slider Record

Play

Fast forward
Rewind Stop

Go to next marker or project end

Nudge position 
right/left

Go to previous 
marker or project 
start

Secondary Time Display 
and format pop-up

Exchange time formats

Cycle on/off
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• The main Transport functions (Cycle/Stop/Play/Record) can also be 
shown on the toolbar.

In addition, various play options are available on the Transport menu.

Hiding and showing

The Transport panel is shown by default when you launch a new 
project. To hide or show it, select the “Transport Panel” item from the 
Transport menu (or use a key command – by default [F2]).

About Preroll and Postroll

These items are described in the chapter “Recording” – see page 88.

Tempo track on/off 

Synchronization on/off The tempo and time signature display

Metronome click on/off Show Markers (opens Marker window)

Jump to Marker

Precount on/off

Play Order controls

MIDI In (left meter)/
MIDI Out activity

Level Control (Output bus 1)

Audio activity (Output bus 1)Audio input activity (Input bus 1)
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Customizing the Transport panel

You can customize the appearance of the Transport panel by right-
clicking (Win) or [Ctrl]-clicking (Mac) anywhere on the panel and 
making selections on the pop-up menu that appears.

• On the upper half of the pop-up menu you can hide or show elements on the 
panel by activating or deactivating the corresponding menu items.

• Selecting the Show All item displays all sections of the Transport panel.
• Selecting Default shows all sections in their default positions on the panel.
• The items in the lower half of the pop-up menu are preset configurations for 

the Transport panel. You will also find your own stored presets here, for quick 
selection.

• Selecting Setup brings up a dialog where you can set show/hide status for 
the separate sections, configure where the sections should be placed on the 
panel and store different Transport panel layouts as presets for instant recall.

For more about customizing the Transport panel, see page 676.
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The numeric keypad

In the default Key Command settings, the numeric keypad on the 
computer keyboard is assigned various Transport panel operations:

Numeric Key Function

[Enter] Play

[+] Fast Forward

[–] Rewind

[*] Record

[÷] (Win)
[/] (Mac)

Cycle On/Off

[,] Return to Zero

[0] Stop

[1] Go to Left Locator

[2] Go to Right Locator

[3 - 9] Go to marker 3 to 9
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Operations

Setting the project cursor position

There are several ways to move the project cursor position:

• By using Fast Forward and Rewind.
• By using the Jog/Shuttle/Nudge control on the Transport panel – see page 41.
• By dragging the project cursor in the lower part of the ruler. 
• By clicking in the ruler.

Double clicking in the ruler moves the cursor and starts/stops playback. 

• If the option “Locate when Clicked in Empty Space” is activated in the Prefer-
ences dialog (Transport page) you can click anywhere in an empty section of 
the Project window to move the cursor position.

• By changing the value in any of the position displays.
• By using the position slider above the transport buttons.

The range of the slider relates to the Length setting in the Project Setup dialog. Hence, 
moving the slider all the way to the right will take you to the end of the project. 

• By using markers (see page 174).
• By using playback options (see page 44).
• By using the play order function (see page 158).
• By using functions on the Transport menu.

The following functions are available:

• If Snap is activated when dragging the project cursor, the Snap value is 
taken into account. This is helpful for finding exact positions quickly.

Function Description

Locate Selection / 
Locate Selection End

Moves the project cursor to the beginning or end of the cur-
rent selection. For this to be available, you must have selected 
one or more events or parts, or made a selection range.

Locate Next/Previous 
Marker

This moves the project cursor to the closest marker to the 
right or left (see page 174).

Locate Next/Previous 
Event

This moves the project cursor forwards or backwards respec-
tively, to the closest beginning or end of any event on the se-
lected track(s).
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• There are also numerous key commands available for moving the 
project cursor (in the Transport category in the Key Commands dialog). 
For example, you can assign key commands to the “Step Bar” and “Step Back Bar” 
functions, allowing you to move the project cursor in steps of one bar, backwards and 
forwards.

About the Transport panel display formats

Primary time display (left) and secondary time display (right).

The time unit shown in the ruler can be independent from the time unit 
shown in the main time display on the Transport panel. This means that 
you can display timecode in the transport position display and bars 
and beats in the ruler, for example. In addition, there is a secondary 
time display to the right of the primary time display which is also inde-
pendent, giving you three different time units shown at the same time 
(in the Project window, you can also create additional ruler tracks – 
see page 109). 

The following rules apply:

• If you change the time format from the primary time display on the 
Transport panel, this will apply to the ruler as well.
This is the same as changing the display format in the Project Setup. Therefore, to 
have different display formats in the ruler and the main time display you should change 
the format in the ruler.

• The primary time display format is set on the pop-up menu to the right 
in the main position display.

• The setting here also determines the time format displayed for the left 
and right locators.
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• The secondary time display is completely independent, and the dis-
play format is set on the pop-up menu to the right in the secondary 
time display.

• You can swap time formats between the primary and secondary time 
displays by clicking the double arrow symbol between them.

The left and right locators

The left and right locators are a pair of position markers used for 
specifying punch-in and punch-out positions during recording, and as 
boundaries for cycle playback and recording. 

• When cycle mode is activated on the Transport panel, the area between 
the left and right locator will be repeated (cycled) on playback. 
However, if the right locator is positioned before the left, this will work as a “jump” or 
“skip mode” – when the project cursor reaches the right locator it will immediately 
jump to the left locator position and continue playback from there.

There are several ways to set locator positions:

• To set the left locator, press [Ctrl]/[Command] and click at the desired 
position in the ruler.
Similarly, pressing [Alt]/[Option] and clicking in the ruler sets the right locator. You can 
also drag the locator “handles” directly in the ruler.

The locators are indicated by the “flags” in the ruler. The area between the locators 
is highlighted in the ruler and in the Project window (see page 690). Note that if the 
right locator is before the left locator the area will be red in the ruler to indicate this.

• Click and drag in the upper half of the ruler to “draw” a locator range.
If you click on an existing locator range, you can drag to move it.

• Pressing [Ctrl]/[Command] and pressing [1] or [2] on the numeric 
keypad sets the left or right locator to the project cursor position.
Similarly, you can press [1] or [2] on the numeric keypad (without [Ctrl]/[Command]) to 
set the project cursor position to the left or right locator position. Note that these are 
default key commands – you can change these if you like.
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• By creating cycle markers you can store any number of left and right 
locator positions, which can be recalled by simply double clicking on 
the corresponding marker (see page 178).

• The “Locators to Selection” item on the Transport menu (default key 
command [P]) sets the locators to encompass the current selection.
This is available if you have selected one or several events or made a selection range.

• You can also adjust the locators numerically in the Transport panel.
Clicking the L/R buttons in the locator section on the Transport panel will move the 
project cursor to the respective locator. If you press [Alt]/[Option] and click the L or R 
button, the corresponding locator will be set to the current project cursor position.

The Shuttle Speed control

The shuttle speed control (the outer wheel on the Transport panel) al-
lows you to play the project at any playback speed, forwards or back-
wards. This provides a quick way to locate or “cue” to any position in 
the project.

• Turn the shuttle speed wheel to the right to start playback.
The further to the right you move the wheel, the faster the playback speed.

• If you turn the wheel to the left instead, the project will play back-
wards.
Similarly, the playback speed depends on how far to the left you turn the wheel.
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Project scrubbing – the Jog Wheel

The middle wheel on the Transport panel serves as a jog wheel. By 
clicking and dragging it to the right or left you will move the playback 
position manually forwards or backwards – much like scrubbing on a 
tape deck. This helps you pinpoint exact locations in the project.

• Note that the jog wheel is an “endless dial” – you can turn it as many 
times as needed to move to the desired location.
The faster you turn the wheel, the faster the playback speed.

• If you click the jog wheel during playback, playback will automatically 
stop.

The nudge position buttons

The + and – buttons in the middle of the Shuttle/Jog Wheel allows 
you to nudge the project cursor position to the right or left, respec-
tively. Each time you click a nudge button, the project cursor is moved 
by one frame.



NUENDO
Playback and the Transport panel 3 – 43

Options and Settings

The “Return to Start Position on Stop” preference

This setting is found on the Transport page in the Preferences dialog 
(found on the File menu under Windows, on the Nuendo menu under 
Mac OS X).

• If “Return to Start Position on Stop” is activated when you stop play-
back, the project cursor will automatically return to the position where 
recording or playback last started.

• If “Return to Start Position on Stop” is deactivated, the project cursor 
will remain at the position where you stop playback.
Pressing Stop again will return the project cursor to the position where recording or 
playback last started.

About track disable/enable

For audio tracks, the track context menu contains an item named “Dis-
able Track”. This shuts down all disk activity for the track, as opposed 
to using Mute, which merely turns down the output volume for a track. 
For example, if you often record “alternative takes” you can easily build 
up a large number of takes on different tracks. Even though these 
tracks are muted, they are actually still “playing back” from the hard 
disk during playback. This puts an unnecessary load on your disk sys-
tem, so using “Disable Track” is recommended for such situations.

• Select “Disable Track” for tracks that you want to keep in the project 
for later use (but don’t want to play back now).
Select “Enable Track” from the track context menu to re-enable disabled tracks.
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Playback functions

Apart from the standard transport controls on the Transport panel, you 
can also find a number of functions that can be used to control play-
back on the Transport menu. The items have the following functionality:

The functions listed above (except “Play until Next Marker”) are only avail-
able if you have selected one or more events or made a selection range.

Option Description

Postroll from Selection 
Start/End

Starts playback from the beginning or end of the currently 
selected range and stops after the time set in the Postroll 
field on the Transport panel.

Preroll to Selection Start/ 
End

Starts playback from a position before the start or end of the 
currently selected range and stops at the selection start or 
end, respectively. The playback start position is set in the 
Preroll field on the Transport panel.

Play from Selection Start/
End

Activates playback from the beginning or end of the current 
selection.

Play until Selection Start/ 
End

Activates playback two seconds before the start or end of 
the current selection and stops at the selection start or end, 
respectively.

Play until Next Marker This activates playback from the project cursor and stops at 
the next marker.

Play Selection Range This activates playback from the start of the current selec-
tion and stops at the selection end.

Loop Selection This activates playback from the start of the current selection 
and keeps starting over again when reaching the selection 
end.
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About Chase

Chase is basically a function that makes sure your MIDI instruments 
sound as they should when you locate to a new position and start 
playback. This is accomplished by having the program transmitting a 
number of MIDI messages to your instruments each time you move to 
a new position in the project, making sure all MIDI devices are set up 
correctly with regard to program change, controller messages (such 
as MIDI Volume) etc.

For example, let’s say you have a MIDI track with a program change 
event inserted at the beginning. This event makes a synth switch to a 
piano sound.

In the beginning of the first chorus you have another program change 
event which makes the same synth switch to a string sound.

You now play back the song. It begins with the piano sound and then 
switches to the string sound. In the middle of the chorus you stop and 
rewind to some point between the beginning and the second program 
change. The synth will now still play the string sound although in this 
section it really should be a piano!

The Chase function takes care of that. If program change events are 
set to be chased, Nuendo will track the music back to the beginning, 
find the first program change and send this out, so that the synth is set 
to the right sound.

The same thing can apply to other event types as well. The Chase 
Events settings in the Preferences dialog–MIDI page determine which 
event types will be chased when you locate to a new position and 
start playback.

• Event types for which the checkbox is activated here will be chased.
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Background

This chapter describes the various recording methods that you can 
use in Nuendo. As it is possible to record both audio and MIDI tracks 
in Nuendo, both these recording methods are covered in this chapter.

Before you start 

This chapter assumes that you are reasonably familiar with certain ba-
sic recording concepts, and that the following initial preparations have 
been made:

• You have properly set up, connected and calibrated your audio hard-
ware. 
This is described in the Getting Started book.

• You have opened a project and set the project setup parameters to 
your specifications.
Project setup parameters determine the record format, sample rate, project length etc. 
that affect the audio recordings you make during the course of the project. See page 
111.

• If you plan to record MIDI, your MIDI equipment should be set up and 
connected correctly.
See the Getting Started book.
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Basic recording methods

This section describes the general methods used for recording. How-
ever, there are additional preparations and procedures that are specific 
to audio and MIDI recording respectively. Make sure to read these sec-
tions before you start recording (see page 54 and page 75).

Record enabling a track

Nuendo can record on a single track or on several tracks (audio and/
or MIDI) simultaneously. To make a track ready for recording, click the 
Record Enable button for the track in the Track list, in the Inspector or 
in the mixer. When activated, the button(s) turn red, indicating record 
ready mode.

Record Enable in the Inspector, Track list and mixer.

• If the option “Enable Record on Selected Track” is activated in the Pref-
erences dialog (Editing page), tracks are automatically record enabled 
when you select them in the Track list.

• The exact number of audio tracks you can record simultaneously de-
pends on your computer CPU and hard disk performance.
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Manually activating recording

You activate recording by clicking the Record button on the Transport 
panel or toolbar, or by using the corresponding key command (by de-
fault [*] on the numeric keypad).

Recording can be activated from Stop mode (from the current cursor 
position or from the left locator) or during playback:

• If you activate recording from Stop mode, and the option “Start Record at Left 
Locator” is activated on the Transport menu, recording will start from the left 
locator.
The preroll setting or the metronome count-in will be applied (see page 88).

• If you activate recording from Stop mode, and “Start Record at Left Locator” 
is deactivated, recording will start from the current project cursor position.

• If you activate recording during playback, Nuendo will immediately enter 
Record mode and start recording at the current project cursor position.
This is known as “manual punch in”.

Activating recording in Sync mode

If you are synchronizing the Nuendo transport to external equipment 
(Sync is activated on the Transport panel) and you activate recording, 
the program will go into “record ready” mode (the record button on 
the Transport panel will light up). Recording then starts when a valid 
timecode signal is received (or when you manually click the Play but-
ton). See page 570 for more information about synchronization.
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Automatically activating recording

Nuendo can automatically switch from playback to recording at a 
given position. This is known as “automatic punch in”. A typical use for 
this would be if you need to replace a section of a recording, and want 
to listen to what is already recorded, up to the recording start position.

1. Set the left locator to the position where you want recording to start.

2. Activate the Punch In button on the Transport panel.

Punch In activated.

3. Activate playback from some position before the left locator.
When the project cursor reaches the left locator, recording is automatically activated.

Stopping recording

Again, this can be done automatically or manually:

• If you click the Stop button on the Transport panel (or use the corre-
sponding key command, by default [0] on the numeric keypad), record-
ing is deactivated and Nuendo goes to Stop mode.

• If you click the Record button or use the key command for recording, 
by default [*], recording is deactivated but playback continues.
This is known as “manual punch out”.

• If the Punch Out button is activated on the Transport panel, recording 
will be deactivated when the project cursor reaches the right locator.
This is known as “automatic punch out”. By combining this with automatic punch in, 
you can set up a specific section to record – again very useful if you want to replace a 
certain part of a recording. See also page 88.

Punch In and Out activated.



NUENDO
4 – 52 Recording

Cycle recording

Nuendo can record and play back in a cycle – a loop. You specify 
where the cycle starts and ends by setting the left and right locators. 
When the cycle is active, the selected section is seamlessly repeated 
until you hit Stop or deactivate cycle mode.

• To activate cycle mode, click the cycle button on the Transport panel.
If you now start playback, the section between the left and right locator is repeated in-
definitely until you stop.

Cycle activated

• To record in cycle mode, you can start recording from the left locator, 
from before the locators or from within the cycle, from Stop mode or 
during playback.
As soon as the project cursor reaches the right locator, it will jump back to the left lo-
cator and continue recording a new lap.

• The results of cycle recording depend on the selected cycle record 
mode and are different for audio (see page 66) and MIDI (see page 81).

Audio pre-record

This feature allows you to capture up to 10 minutes of any incoming 
audio you play in Stop mode or during playback, “after the fact”. This 
is possible because Nuendo can capture audio input in buffer mem-
ory, even when not recording. 

Proceed as follows:

1. Pull down the File menu and open the Preferences dialog.

2. In the list to the left, select “Record” to open the Record page.

3. Specify a time (up to 600 seconds) in the Audio Pre-Record Seconds 
field.
This activates the buffering of audio input, making Pre-Record possible.
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4. Make sure an audio track is record enabled and receives audio from 
the signal source.

5. When you have played some audio material you want to capture (either 
in Stop mode or during playback), click the Record button.

6. After a few seconds stop the recording (unless you wish to continue 
recording).
An audio event is created, starting at where the cursor position was when you acti-
vated recording. This means that if you were in stop mode, and the cursor was at the 
beginning of the project, you may have to move the event to the right in the next step. 
If you were playing along to a project you should leave the event where it is.

7. Select the Arrow tool and place the cursor on the bottom left edge of 
the event so that a double arrow appears, then click and drag to the left. 
Now the event is extended and the audio you played before activating record is inserted 
– this means that if you played along during playback, the captured notes will end up ex-
actly where you played them in relation to the project.

The recording was activated at the start of bar 9. This is indicated by a blue line in 
the audio event.
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Audio recording specifics

Selecting a recording file format

The format of recorded files is set in the Project Setup dialog on the 
Project menu. There are three settings: sample rate, record format (bit 
depth) and record file type. While the sample rate is set once and for 
all when you start working on a new project, the bit depth and file type 
can be changed at any time.

Record file type

The Record File Type setting determines which type of files will be 
created when you record:

• If you select Broadcast Wave File or AIFF format, you can specify 
Author, Description and Reference text strings that will be embedded 
in the recorded file.
This is done on the Record–Broadcast Wave page in the Preferences dialog.

File type Description

Wave File Wave files have the extension “.wav” and are the most common file for-
mat on the PC platform.

Wave 64 File Wave64 is a proprietary format developed by Sonic Foundry Inc. Audio-
wise it is identical to the Wave format, but the internal file structure makes 
much larger file sizes possible. This is useful e.g. for long live recordings 
in surround format, where the audio files could become huge.

Broadcast 
Wave File

In terms of audio content, the same as regular Wave files, but with em-
bedded text strings for supplying additional information about the file (see 
below).

AIFF File Audio Interchange File Format, a standard defined by Apple Computer 
Inc. AIFF files have the extension “.aif” and are used on most computer 
platforms. Like Broadcast Wave files, AIFF files can contain embedded 
text strings (see below).
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Record format (bit depth)

The available options are 16 bit, 24 bit and 32 bit float. Use the fol-
lowing guidelines:

• Normally, select the record format according to the bit depth delivered by 
your audio hardware.
For example, if your audio hardware has 20 bit A/D converters (inputs), you may want 
to record at 24 bit resolution, to capture the full bit depth. On the other hand, if your 
hardware has 16 bit inputs, it’s pointless to record with a higher bit depth – this will 
only make the audio files larger, with no difference in audio quality. The exception is if 
you record with effects – see page 72 for an example of this.

• The higher the bit depth, the larger the files and the more strain is put on the 
disk system.
If this is an issue, you may want to lower the record format setting.

Setting up the track

Creating a track and selecting the channel configuration

Audio tracks can be configured as mono, stereo or surround tracks, 
with almost any combination of channels (LCRS, 5.1, 7.1, 10.2 etc.). 
This allows you to record or import a file containing multiple channels 
and treat it as one entity, with no need to split it up into several mono 
files etc. The signal path for an audio track maintains its channel con-
figuration all the way from the input bus, via EQ, level and other mixer 
settings to the output bus.

You specify the channel configuration for a track when you create it:

1. Select Add Audio Track from the Track list context menu or the 
Project menu (or double click in an empty area of the Track list when 
an audio track is selected – when a MIDI track is selected, double 
clicking in the Track list creates a new MIDI track).
A dialog appears with a channel configuration pop-up menu.

2. Select the desired format from the pop-up menu.
The most common formats are listed directly on the pop-up menu; the remaining sur-
round formats are listed on the “More...” submenu. For a list of the available surround 
formats, see page 303.

3. Click OK.
A track appears, set to the specified channel configuration. In the mixer, a correspond-
ing channel strip appears. You cannot change the channel configuration for a track.
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Selecting an input bus for a track

Here we assume that you have added and set up the required input 
busses (see page 15). Before you record you need to specify from 
which input bus the track should record. You can do this in the In-
spector or in the mixer:

• In the Inspector you select an input bus on the “in” pop-up menu in 
the top section.
As described on page 98, the Inspector shows the settings for the selected track. You 
show or hide the Inspector using the Inspector icon on the Project window toolbar.

Click here to select an input 
bus for the track.

Click here to show/hide the Inspector.
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• In the mixer you select an input bus on the Input Routing pop-up menu 
at the top of the track’s channel strip.
If this pop-up menu isn’t shown, you need to click the Show Input and Output Settings 
field in the common panel to the left. See page 209 for more about the mixer.

Click here to 
select an input 
bus for the 
track.

Click here to show 
or hide the input 
and output set-
tings.
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Selecting a folder for the recorded audio files

As described in the Getting Started book, each Nuendo project has a 
project folder containing (among other things) an “Audio” folder. By 
default, this is where recorded audio files are stored. However, you 
can select record folders independently for each audio track if needed:

1. To select the same record folder for several audio tracks, you need to 
select them by [Shift] or [Ctrl]/[Command]-clicking in the Track list.

2. Right-click (Win) or [Ctrl]-click (Mac) in the Track list for one of the 
tracks to bring up the track context menu.

3. Select “Set Record Folder”.

4. Use the file dialog that appears to navigate to the desired folder (or 
create a new folder with the Create button).
Tip: if you want to have separate folders for different types of material (speech, ambi-
ent sounds, music, etc.) you can create subfolders within the Project’s “Audio” folder 
and assign different tracks to different subfolders. This way, all audio files will still re-
side within the project folder which will make managing the Project easier.

• It’s fully possible to have different tracks record to totally different lo-
cations, on different disks if you like. However, if you need to move or 
archive the Project, there is a risk of missing some files. The solution is 
to use the Prepare Archive function in the Pool to gather all external 
files into the project folder first – see page 497.
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Setting input levels

When recording digital sound, it’s important to set the input levels 
correctly – loud enough to ensure low noise and high audio quality, 
but not so loud that clipping (digital distortion) occurs.

Clipping typically occurs in the audio hardware, when a too loud ana-
log signal is converted to digital in the hardware’s A/D converters. 

• It is also possible to get clipping when the signal from the input bus is 
written to a file on your hard disk.
This is because in Nuendo, you can make settings for the input bus, adding EQ, ef-
fects, etc. to the signal as its being recorded. This may raise the level of the signal, 
causing clipping in the recorded audio file.

To check the level of the “unprocessed” signal coming into the audio 
hardware you need to switch the level meters to “Meter Input”. In this 
mode the input channel level meters will show the level of the signal at 
the input of the bus, before any adjustments such as input gain, EQ, 
effects, level or pan:

1. Right-click (Win) or [Ctrl]-click (Mac) in the Mixer window.
The Mixer context menu appears.

2. Select the Global Meter Settings submenu and make sure “Meter In-
put” is activated.

3. Play back the audio and check the level meter for the input channel.
The signal should be as loud as possible without exceeding 0 dB (the Clipping indica-
tor for the input bus should not light up).

The Clipping indicator.

4. If necessary, adjust the input level in one of the following ways:

• Adjust the output level of the sound source or external mixer.
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• Use the audio hardware’s own application program to set the input 
levels, if this possibility is provided.
See the documentation for the audio hardware.

• If your audio hardware supports the ASIO Control Panel function, it 
may be possible to make input level settings.
To open the ASIO control panel, open the Device Setup dialog on the Devices menu 
and click the Control Panel button on the VST Audiobay subpage with the name of 
your hardware device.

The next step is to check the level of the audio being written to a file 
on your hard disk. This is only necessary if you have made any adjust-
ments to the input channel (level settings, EQ, insert effects, etc.). 
Note also:

• If you record in 32 bit float format the bit depth will not be reduced – 
which means there’s no risk of clipping at this stage.
Also, this preserves the signal quality perfectly. Therefore, you should consider using 
32 bit float format when you are recording with effects (see page 72).

• If you record in 16 or 24 bit format the available headroom is lower 
which means clipping can occur if the signal is too loud.
To avoid this, set the signal level in the following way:

1. Bring up the mixer context menu and select “Meter Post-Fader” from 
the Global Meter Settings submenu.

2. Set up the input channel, adding EQ and/or effects as desired.
With some effects you may want to adjust the level of the signal going into the effect – 
use the Input Gain knob for this. Note that you need to press [Shift] or [Alt]/[Option] to 
adjust the Input Gain.

3. Play back the audio and check the level meter of the input channel.
The signal should be reasonably loud but should not reach 0 dB (the Clipping indica-
tor for the input bus should not light up).

4. If necessary, use the input channel fader to adjust the signal level.
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Monitoring

In this context, “monitoring” means listening to the input signal during 
recording. There are three fundamentally different ways to do this: via 
Nuendo, externally (by listening to the signal before it reaches Nuendo) 
or by using ASIO Direct Monitoring (which is a combination of both of 
the other methods – see below).

Monitoring via Nuendo

If you monitor via Nuendo, the input signal is mixed in with the audio 
playback. The advantage of this is that you can adjust the monitoring 
level and panning in the mixer, and add effects and EQ to the monitor 
signal just as during playback (using the track’s channel strip – not 
the input bus!). 

The disadvantage of monitoring via Nuendo is that the monitored sig-
nal will be delayed according to the latency value (which depends on 
your audio hardware and drivers). Therefore, monitoring via Nuendo re-
quires an audio hardware configuration with a low latency value (see 
the Getting Started book). You can check the latency of your hardware 
in the Device Setup dialog (VST Audiobay page).

• If you are using plug-in effects with large inherent delays, the automatic 
delay compensation function in Nuendo will increase the latency.
If this is a problem you can use the Constrain Delay Compensation function while re-
cording - see the chapter “VST instruments” in the separate PDF document “Working 
with MIDI”.

When monitoring via Nuendo, you can select one of four modes in the 
Preferences dialog (VST page):



NUENDO
4 – 62 Recording

• Manual.
This option allows you to turn input monitoring on or off by clicking the Monitor button 
in the Inspector, the Track list or in the mixer.

• While Record Enabled.
With this option you will hear the audio source connected to the channel input when-
ever the track is record enabled.

• While Record Running.
This option switches to input monitoring only during recording.

• Tapemachine Style.
This option emulates standard tapemachine behavior: input monitoring in Stop mode 
and during recording, but not during playback.

External monitoring

External monitoring (listening to the input signal before it goes into 
Nuendo) requires some sort of external mixer for mixing the audio 
playback with the input signal. This can be a stand-alone physical 
mixer or a mixer application for your audio hardware, if this has a mode 
in which the input audio is sent back out again (usually called “Thru”, 
“Direct Thru” or similar).

When using external monitoring, you cannot control the level of the 
monitor signal from within Nuendo, or add VST effects or EQ to the 
monitor signal. The latency value of the audio hardware configuration 
does not affect the monitor signal in this mode.

• If you want to use external monitoring, you need to make sure that mon-
itoring via Nuendo isn’t activated as well.
Select the “Manual” monitoring mode in the Preferences dialog (VST page) and simply 
don’t activate the Monitor buttons.
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ASIO Direct Monitoring

If your audio hardware is ASIO 2.0 compatible, it may support ASIO 
Direct Monitoring. In this mode, the actual monitoring is done in the 
audio hardware, by sending the input signal back out again. However, 
monitoring is controlled from Nuendo. This means that the audio hard-
ware’s direct monitoring feature can be turned on or off automatically 
by Nuendo, just as when using internal monitoring.

• To activate ASIO Direct Monitoring, open the Device Setup dialog on 
the Devices menu and check the Direct Monitoring checkbox on the 
VST Audiobay page.
If the checkbox is greyed out, your audio hardware (or its driver) doesn’t support ASIO 
Direct Monitoring. Consult the audio hardware manufacturer for details.

• When ASIO Direct Monitoring is activated, you can select a monitor-
ing mode in the Preferences dialog (VST page), as when monitoring 
via Nuendo (see page 61).

• Depending on the audio hardware, it may also be possible to adjust 
monitoring level and panning from the mixer.
Consult the documentation of the audio hardware if in doubt.

• VST effects and EQ cannot be applied to the monitor signal in this 
mode, since the monitor signal doesn’t pass through Nuendo.

• Depending on the audio hardware, there may be special restrictions 
as to which audio outputs can be used for direct monitoring.
For details on the routing of the audio hardware, see its documentation.

• The latency value of the audio hardware configuration does not affect 
the monitor signal when using ASIO Direct Monitoring.
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Recording

Recording is done using any of the general recording methods (see 
page 49). After you finish recording, an audio file has been created in 
the Audio folder within the project folder. In the Pool, an audio clip is 
created for the audio file, and an audio event that plays the whole clip 
appears on the recording track. Finally, a waveform image is calcu-
lated for the audio event. If the recording was very long, this may take 
a while.

• If the option “Create Audio Images During Record” is activated in the 
Preferences dialog (Record page), the waveform image will be calcu-
lated and displayed during the actual recording process.
This real-time calculation uses some processing power – if your processor is slow or 
you are working on a CPU-intensive project you should consider turning this option off.

Undoing recording

If you decide that you don’t like what you just recorded, you can delete 
it by selecting Undo from the Edit menu. The following will happen:

• The event(s) you just created will be removed from the Project window.
• The audio clip(s) in the Pool will be moved to the Trash folder.
• The recorded audio file(s) will not be removed from the hard disk.

However, since their corresponding clips are moved to the Trash folder, you can delete 
the files by opening the Pool and selecting “Empty Trash” from the Pool menu.
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Recording overlapping events

The basic rule for audio tracks is that each track can play back a sin-
gle audio event at a time. This means that if two or more events are 
overlapping, only one of them will be heard at any given time.

What happens when you record overlapping events (record in an area 
where there’s already events on the track) depends on the Linear 
Record Mode setting on the Transport panel:

• In “Normal” or “Merge” mode, recording where something has already 
been recorded creates a new audio event that overlaps the previous 
one(s).
When you record audio there is no difference between “Normal” and “Merge” mode – 
the difference only applies to MIDI recording (see page 80).

• In “Replace” mode, existing events (or portions of events) that are 
overlapped by the new recording will be removed.
This means that if you record a section in the middle of a longer existing recording, that 
original event will be cut into two events with a gap for the new event.

Which event will be heard?

If two or more events are overlapping, you will only hear the events (or 
portions of events) that are actually visible. Overlapped (hidden) 
events or sections are not played back.

• The functions “Move to Front” and “Move to Back” on the Edit menu 
(see page 132) are useful for managing overlapping events, as is the 
“To Front” function (see below).
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Recording audio in cycle mode

If you are recording audio in cycle mode, the result depends on two 
factors:

• The Cycle Record Mode setting on the Transport panel.

• The “Audio Cycle Record Mode” setting in the Preferences dialog 
(Record page).

Cycle Record Modes on the Transport panel

There are five different modes on the Transport panel, but the differ-
ences between two of the modes only apply to MIDI recording. For 
audio cycle recording, the following applies:

• If “Keep Last” is selected, the last complete “take” (the last completely 
recorded lap) is kept as an audio event.
In reality, all laps you recorded are saved in one audio file divided into regions – one re-
gion for each take. You can easily select a previous take for playback – this is done as 
when recording in “Create Regions” mode (see page 68).

• If “Stacked” is selected, each take will appear as an event on a sepa-
rate “lane” on the track.
This is useful when you want to view and edit the different takes and eventually com-
bine them to one recording. In this mode, the Audio Cycle Record Mode preference 
doesn’t matter. Stacked 2 (No Mute) is the same as Stacked, except that all the takes 
will be audible. See page 70. 

• If any of the other cycle recording modes is selected, the result de-
pends entirely on the Audio Cycle Record Mode setting in the Prefer-
ences.
These options are described below.
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Create Events mode (Preferences)

When Audio Cycle Record Mode (Preferences–Record page) is set 
to “Create Events”, the following will happen when you record audio 
in cycle mode:

• One continuous audio file is created during the entire recording process. 
• For each recorded lap of the cycle, one audio event is created.

The events will have the name of the audio file plus the text “Take *”, where “*” indi-
cates the number of the take.

• The last take (the last recorded lap) will be on top (and will thus be the one 
you hear when you activate playback).

To select another take for playback, proceed a follows:

1. Right-click (Win) or [Ctrl]-click (Mac) the event and select “To Front” 
from the pop-up menu that appears.
A submenu appears, listing all the other (obscured) events.

2. Select the desired take.
The corresponding event is brought to front.
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This method allows you to quickly combine the best parts of each 
take, in the following way:

1. Use the Scissors tool to split the events in several sections, one for 
each part of the take.
For example, if you recorded four lines of vocals (in each take), you can split the events 
so that each line gets a separate event.

The events after splitting. Note that since the original take events overlap each 
other, clicking with the Scissors tool will split all takes at the same position.

2. For each section of the take, use the “To Front” function to bring the 
best take to the front.
This way, you can quickly combine the best sections of each take, using the first vocal 
line from one take, the second line from another take and so on.

You can also compile a “perfect” take in the Audio Part Editor, as de-
scribed on page 430.

Create Regions mode (Preferences)

When Audio Cycle Record Mode (Preferences–Record page) is set 
to “Create Regions”, the following will happen when you record audio 
in cycle mode:

• One continuous audio file is created during the entire recording process. 
• The audio event in the Project window shows the name of the audio file plus 

the text “Take *” (with “*” being the number of the last completed cycle lap).
• If you play back the recorded event, you will only hear what was recorded dur-

ing the last lap of the cycle recording. 
The previous “takes” recorded in the cycle are still available, however. 
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• The audio clip is divided into regions (called takes), one for each lap of the cy-
cle that was recorded.
If you locate the audio file you just recorded in the Pool, and click on the plus sign be-
side it, you can see the regions that have been created, one for each lap of the cycle 
that was completed during recording.

“Take” regions in the Pool window.

To play back the different “takes”, proceed as follows:

1. In the Project window, right-click (Win) or [Ctrl]-click (Mac) the event 
that was created during cycle recording.
The Quick menu appears.

2. Select the “Set To Region” menu item.
A submenu appears with the takes you recorded during cycle record.

3. Now you can freely select any of the takes from the submenu and it 
will replace the previous take event in the Project window.

Use this method to listen through the various takes. Select the best 
single take, or compile a “perfect” take by cutting out the best bits 
from each take and putting them together (see page 430).
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Create Events + Regions mode (Preferences)

In this mode, both events and regions are created. If you work with the 
takes as events in this mode, you can edit the events freely (e.g. split-
ting them as described on page 67). However, in case you want to go 
back to the original takes, they are still available as regions (on the 
“Set To Region” submenu, in the Pool or in the Sample Editor).

Recording audio in Stacked mode

When you record audio in cycle mode and the “Stacked” Cycle Record 
Mode is selected on the Transport panel, the following happens: 

• Each complete recorded cycle lap is turned into a separate audio event.
• The track is divided into “lanes”, one for each cycle lap.
• The events are stacked above each other, each on a different lane.

This makes it easy to create a “perfect take” by combining the best 
parts from the different cycle laps:

1. Zoom in so you can work comfortably with the stacked events.

If you play back the recorded section, only the lowest (last) take will 
be heard. 

2. To audition another take, either mute the lower take(s) with the Mute 
tool or move the takes between the lanes.
This can be done by dragging or by using the functions Move to Next Lane/Previous 
Lane on the Quick menu or Edit menu.
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3. Edit the takes so that only the parts you want to keep can be heard.
You can cut events with the Scissors tool, resize them, mute them or delete them.

The sections that will be heard are indicated in green.

4. When you are satisfied with the result, select all events on all lanes 
and select “Delete Overlaps” from the Advanced submenu on the 
Audio menu.
This puts all events back on a single lane and resizes events so that overlapped sec-
tions are removed.

5. To turn off the lane display mode for the track, click the Lane Display 
Type button in the track list and select “Lanes Off”.
If the button is hidden, you can bring it to view in the Track Controls Settings dialog – 
see page 680.

The Lane Display Type button.
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Recording with effects

Normally you record the audio signals “dry” and add effects non-de-
structively during playback as described in the chapter “Audio effects”. 
However, Nuendo also allows you to add effects (and/or EQ) directly 
while you are recording. This is done by adding insert effects and/or 
making EQ settings for the input channel in the mixer. Note:

• This will make the effects become part of the audio file itself – you can-
not change the effect settings after recording.

About the record format

When you record with effects you should consider setting the record 
format (bit depth) to 32 Bit Float. This is done in the Project Setup di-
alog on the Project menu. Note that this isn’t required in any way – 
you can record with effects in 24 or 16 Bit format should you so like. 
However, there are two advantages to 32 Bit Float format:

• With 32 Bit Float recording you don’t risk clipping (digital distortion) 
in the recorded files.
This can of course be avoided with 24 or 16 Bit recording as well, but requires more 
care with the levels.

• Nuendo processes audio internally in 32 Bit Float format – recording 
in the same format means the audio quality will be kept absolutely 
pristine.
The reason is that the effect processing in the input channel (as well as any level or EQ 
settings you make there) is done in 32 Bit Float format. If you record at 16 or 24 Bit, 
the audio will be converted to this lower resolution when it’s written to file – with pos-
sible signal degradation as a result.

Note also that it doesn’t matter at which actual resolution your audio 
hardware works. Even if the signal from the audio hardware is in 16 
Bit resolution, the signal will be 32 Bit Float after the effects are 
added in the input channel.
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An example

This example shows how to apply the “Datube” effect while recording. 
Datube emulates the soft clipping distortion produced by valve ampli-
fiers, and adds “warmth” to the recording. Note that this is only an ex-
ample, you could use any effect (or any combination of effects), the 
principle is the same.

1. Set up an audio track for recording and select the desired input bus.
Also, for best results you should activate monitoring as this allows you to hear and try 
out your settings before actually recording. See page 61 for a description of monitor-
ing via Nuendo.

2. Open the Mixer and make sure the full extended view is shown.

3. Locate the input channel (bus) from which you record.
If the input channels are hidden, click on the Show/Hide Input Channels button to the 
left.

4. Check the input level (of the signal coming into the audio hardware) 
as described on page 59 and adjust the level of the source audio if 
necessary.

Click here to show the 
extended panel.
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5. Pull down the View Options pop-up menu for the input channel and 
select “Inserts”.

The View Options pop-up menu is opened by clicking the arrow button between the 
fader panel and the extended panel.

Now the extended panel for the input channel shows the insert slots.

6. Click on an insert slot and select an effect from the pop-up menu that 
appears.
As you see, the included effects are sorted into submenus – you will find the Datube 
effect on the “Distortion” submenu.

The effect is loaded and activated and its control panel is automati-
cally opened.

7. Adjust the Drive (the pre-gain of the “amplifier” – higher settings will 
produce more distortion) and Balance (controls the balance between 
the unprocessed (dry) signal and the effect output) parameters to 
your liking.

8. When the effect is set up as desired, you can check the level of the in-
put channel by setting the Meters to post-fader (see page 59). 
Use the input channel fader to adjust the level if needed.

9. Activate recording.

10.When you’re finished you can play back the recorded audio track. 
As you can hear, the effect you applied is now a part of the actual audio file.

11. If you don’t want to record more with the same plug-in, you should de-
activate it by clicking in the insert slot and selecting “No Effect”.
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MIDI recording specifics

Activating MIDI Thru

As described in the Getting Started book, the normal way to work with 
MIDI is to have MIDI Thru activated in Nuendo, and Local Off selected 
in your MIDI Instrument(s). In this mode, everything you play during re-
cording will be “echoed” back out again on the MIDI output and chan-
nel selected for the recording track.

1. Make sure the option “MIDI Thru Active” is activated in the Preferences 
dialog (MIDI page).

2. Record enable the track(s) on which you want to record.
Now, incoming MIDI is “echoed” back out again, for all record enabled MIDI tracks. 

• If you just want to use the Thru function for a MIDI track without record-
ing, activate the monitor button for the track instead.
This is useful e.g. if you want to try out different sounds or play a VST instrument in real 
time without recording your playing.

Setting MIDI channel, input and output

Setting the MIDI channel in the instrument

Most MIDI synthesizers can play several sounds at the same time, each 
on a different MIDI channel. This is the key to playing back several 
sounds (bass, piano etc.) from the same instrument. Some devices 
(such as General MIDI compatible sound modules) always receive on 
all 16 MIDI channels. If you have such an instrument, there’s no specific 
setting you need to make in the instrument. On other instruments you 
will have to use the front panel controls to set up a number of “Parts”, 
“Timbres” or similar so that they receive on one MIDI channel each. See 
the manual that came with your instrument for more information.

Record Enable button. Monitor button.
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Naming MIDI ports in Nuendo

MIDI inputs and outputs can often be shown with unnecessarily long 
and complicated names. If you wish, you can rename your MIDI ports 
to more descriptive names:

1. Open the Device Setup dialog from the Devices menu.

2. Select the Windows MIDI or DirectMusic (Win) or MIDI System (Mac) 
device in the Device list.
The available MIDI inputs and outputs are listed. Under Windows, which device to 
choose depends on your system.

3. To change the name of a MIDI port, click in the Device column and 
type in a new name.
After closing the dialog, the new names will appear on the MIDI “in:” and “out:” pop-ups.

Setting the MIDI input in the Inspector

You select MIDI inputs for tracks in the Inspector – the area to the left 
of the Track list in the Project window:

1. If the Inspector is hidden, click the Show Inspector button on the tool-
bar.

2. Select the track(s) by clicking in the Track list.
To select multiple tracks, press [Shift] or [Ctrl]/[Command] and click. The Inspector 
shows the settings for the first selected track (for details, see page 98).

3. Click the track headline in the Inspector to make sure the topmost 
section is shown.
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4. Pull down the “in” pop-up menu and select an input.
The available MIDI inputs are shown. The items on the menu depend on the type of 
MIDI interface you are using etc. 

• If you select the “All MIDI Inputs” option, the track will receive MIDI 
data from all available MIDI inputs.

• If you hold down [Alt]/[Option] and select a MIDI input, this is selected 
for all MIDI tracks.

• If you hold down [Shift] and select a MIDI input, this is selected for all 
selected MIDI tracks.

• If you hold down [Ctrl]/[Command] and select a MIDI input, this is se-
lected for all MIDI tracks within the same folder track (see page 103).
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Setting the MIDI channel and output

The MIDI channel and output settings determine where the recorded 
MIDI is routed during playback, but are also relevant for MIDI Thru in 
Nuendo. Channel and output can be selected in the Track list or in the 
Inspector. The procedure below describes how to make the settings 
in the Inspector, but it can be done in largely the same manner in the 
Track list as well.

1. To select the track(s) and show the settings in the Inspector, proceed 
as when selecting a MIDI input (see above).

2. Pull down the “out:” pop-up menu and select an output.
The available MIDI outputs are shown. The items on the menu depend on what type of 
MIDI interface you are using etc.

• If you hold down [Alt]/[Option] and select a MIDI output, this is selected for all 
MIDI tracks.

• If you hold down [Shift] and select a MIDI output, this is selected for all se-
lected MIDI tracks.

• If you hold down [Ctrl]/[Command] and select a MIDI output, this is selected 
for all MIDI tracks within the same folder track (see page 103).

3. Use the “chn” pop-up menu to select a MIDI channel for the track.

• If you set the track to MIDI channel “Any”, each MIDI event on the 
track will be sent out on the channel stored in the event itself.
In other words, the MIDI material will be played back on the channel(s) used by the 
MIDI input device (the MIDI instrument you play during recording).
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Selecting a sound

You can select sounds from within Nuendo, by instructing the program 
to send Program Change and Bank Select messages to your MIDI de-
vice. This is done using the “prg” and “bnk” value fields in the Inspector 
or Track list.

Program Change messages give access to 128 different program lo-
cations. If your MIDI instruments have more than 128 programs, Bank 
Select messages (set in the “bnk” value field) allow you to select dif-
ferent banks, each containing 128 programs.

• Bank Select messages are recognized differently by different MIDI instru-
ments. Also, the structure and numbering of banks and programs may 
vary. Consult the documentation of your MIDI instruments for details.

• Note that it is also possible to select sounds by name. For descriptions 
of how to set this up, see the “MIDI Devices” chapter in the separate 
PDF document “Working with MIDI”.
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Recording

Recording MIDI is done according to the basic recording methods 
(see page 49). When you finish recording, a part containing MIDI 
events is created in the Project window.

About overlap and the Rec Mode setting

MIDI tracks are different from audio tracks when it comes to overlap-
ping parts:

• All events in overlapping parts are always played back.
If you record several parts at the same locations (or move parts so that they overlap), 
you will hear the events in all parts on playback, even though some of the parts are ob-
scured in the Project window.

When recording overlapping parts, the result depends on the Rec 
Mode setting on the Transport panel:

• If Rec Mode is set to “Normal”, overdub recording works as with audio tracks, 
i.e. if you record again where something has already been recorded, you get a 
new part that overlaps the previous one(s).

• If Rec Mode is set to “Merge”, the overdubbed events are added to the exist-
ing part.

• If Rec Mode is set to “Replace”, the new recording replaces any existing 
events in the area on that track.

About punch in and out on MIDI tracks

Performing and setting up manual and automatic punch in/out record-
ing for MIDI tracks is done in exactly the same way as for audio tracks. 
There is one thing to note, however: 

• Punching in and out on recordings with Pitch Bend or controller data 
(modulation wheel, sustain pedal, volume etc.) may lead to strange ef-
fects (apparently hanging notes, constant vibrato etc.).
If this happens, you may need to use the Reset item on the MIDI menu (see page 84).
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About the Auto Quantize function

If Auto Quantize is activated on the Transport panel (the “Auto Q” but-
ton), the notes you record are automatically quantized according to 
the current Quantize settings. For more information about quantizing, 
see the chapter “MIDI Processing” in the separate PDF document 
“Working with MIDI”.

Recording MIDI in cycle mode

When you record MIDI in cycle mode, the result depends on which 
Cycle Record mode is selected on the Transport panel:

Cycle Rec mode: Mix (MIDI)

For each completed lap, everything you record is added to what was 
previously recorded, in the same part. This is useful for building up 
rhythm patterns, for example. Record a hi-hat part on the first lap, the 
bass drum part on the second lap etc. 

Cycle Rec mode: Overwrite (MIDI)

As soon as you play a MIDI note (or send any MIDI message) all MIDI 
you have recorded on previous laps is overwritten – from that point on 
in the part. An example:

1. You start recording in an eight bar cycle.

2. The first take wasn’t good enough – you start directly with a new take 
on the next cycle lap and overwrite the first take.

3. After recording the second take you let the recording roll on and listen, 
without playing anything. 
You find that the take was good up until bar seven, for example.

4. On the next lap, you wait until bar seven and start playing.
This way you will overwrite the last two bars only.

5. Make sure you stop playing before the next lap begins – otherwise 
you will overwrite the entire take.
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Cycle Rec mode: Keep Last

Each completed lap replaces the previously recorded lap. Note:

• The cycle lap must be completed – if you deactivate recording or 
press Stop before the cursor reaches the right locator, the previous 
take will be kept.

• If you don’t play or input any MIDI during a lap, nothing happens (the 
previous take will be kept).

Cycle Rec mode: Stacked/Stacked 2 (No Mute)

In this mode, the following happens: 

• Each recorded cycle lap is turned into a separate MIDI part.
• The track is divided into “lanes”, one for each cycle lap.
• The parts are stacked above each other, each on a different lane.
• All takes but the last one are muted (Stacked). 
• If Stacked 2 is selected, no muting takes place.

This makes it easy to create a “perfect take” by combining the best 
parts from the different cycle laps. You can edit the parts in the 
Project window (by cutting, resizing and deleting) or you can use a 
MIDI editor as in the following example:

1. Unmute the muted takes by clicking the parts with the Mute tool.

2. Select all takes (parts) and open them in the Key Editor for example.

3. Use the part list pop-up menu on the toolbar to select which part to 
edit.
See the chapter “MIDI Editing” in the separate PDF document “Working with MIDI”.

4. Remove or edit notes as desired.

5. When you are happy with the result, close the editor.
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6. To turn it all into a single MIDI part (containing your “perfect take”), se-
lect all parts and select Merge MIDI in Loop from the MIDI menu.

7. In the dialog that appears, activate the Erase Destination option and 
click OK.
The remaining events in the parts are merged together into a single part.

Recording different types of MIDI messages

You can decide exactly which event types should be recorded by using 
the MIDI filters – see page 87.

Notes

With MIDI, when you press and release a key on your synth or other 
MIDI keyboard, a Note On (key down) and a Note Off (key up) message 
are sent out. The MIDI note message also contains the information 
which MIDI channel was used. Normally, this information is overridden 
by the MIDI channel setting for the track, but if you set the track to MIDI 
channel “Any”, the notes will be played back on their original channels.

Continuous messages

Pitch bend, aftertouch and controllers (like modulation wheel, sustain 
pedal, volume etc.) are considered as MIDI continuous events (as op-
posed to the momentary key down and key up messages). If you move 
the Pitch bend wheel on your synthesizer while recording, this move-
ment is recorded together with the key (Note On and Note Off mes-
sages), just as you’d expect. But the continuous messages can also be 
recorded after the notes have been recorded (or even before). They can 
also be recorded on their own tracks, separately from the notes to 
which they belong. 

Say for instance that you record one or several bass parts on track 2. 
If you now set another track, like track 55, to the same output and 
MIDI channel as track 2 you can make a separate recording of just 
pitch bends for the bass parts. This means that you activate recording 
as usual and only move the pitch bend wheel during the take. As long 
as the two tracks are set to the same output and MIDI channel it will 
appear to the MIDI instrument as if the two recordings were made at 
the same time.
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Program Change messages

Normally, when you switch from one program to another on your key-
board (or whatever you use to record), a number corresponding to 
that program is sent out via MIDI as a Program Change message. 
These can be recorded on the fly with the music, recorded afterwards 
on a separate track, or manually entered in the Key or List Editors. 

System Exclusive messages

System Exclusive (SysEx) is a special type of MIDI message used to 
send data that only makes sense to a unit of a certain make and type. 
Every major MIDI manufacturer has its own SysEx identity code and 
these are part of practically all SysEx messages. SysEx can be used to 
transmit a list of the numbers that make up the settings of one or more 
sounds in a synth. For more about viewing and editing SysEx mes-
sages, see the chapter “Working with System Exclusive messages” in 
the separate PDF document “Working with MIDI ”.

The Reset function

The Reset function on the MIDI menu sends out note-off messages 
and resets controllers on all MIDI channels. This is sometimes neces-
sary if you experience hanging notes, constant vibrato, etc.

• Nuendo can also automatically perform a MIDI reset during playback 
(after each part) and/or on stop.
You turn these functions on or off in the Preferences dialog (MIDI page).
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Retrospective Record

This feature allows you to capture any MIDI notes you play in Stop 
mode or during playback and turn them into a MIDI part “after the 
fact”. This is possible due to the fact that Nuendo can capture MIDI 
input in buffer memory, even when not recording.

Proceed as follows:

1. Enable the Retrospective Record function in the Preferences dialog 
(Record page).
This activates the buffering of MIDI input, making Retrospective Record possible.

2. Make sure a MIDI track is record enabled.

3. When you have played some MIDI material you want to capture (either 
in Stop mode or during playback), select Retrospective Record from 
the Transport menu (or use the key command, by default [Shift]-[Pad*]).

The contents of the MIDI buffer (i.e. what you just played) is turned 
into a MIDI part on the record enabled track. The part will appear 
where the project cursor was when you started playing – this means 
that if you played along during playback, the captured notes will end 
up exactly where you played them in relation to the project.

• The Retrospective Record Buffer Size setting in the Preferences dia-
log (Record page) determines how much data can be captured.
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MIDI Preferences

The following options and settings in the Preferences dialog affect 
MIDI recording and playback:

MIDI page

• Length Adjustment
Adjusts the length of notes so that there always is a short time between the end of one 
note and the start of another (of the same pitch and on the same MIDI channel). You 
set the time in ticks. By default there are 120 ticks per 1/16 note, but you can adjust 
this with the MIDI Display Resolution setting on the same page.

Record page

• Snap MIDI Parts to Bars
When this is activated, recorded MIDI parts will automatically be lengthened to start 
and end at whole bar positions. If you are working in a Bars+Beats-based context, this 
can make editing (moving, duplicating, repeating, etc.) easier.

• Solo Record in MIDI Editors
If this is activated and you open a part for editing in a MIDI editor, its track is automat-
ically record enabled. Furthermore, Record Enable is deactivated for all other MIDI 
tracks until you close the editor again.
This makes it easier to record MIDI data when you’re editing a part – you will always be 
sure the recorded data ends up in the edited part and not on any other track.

• MIDI Record Catch Range in ms
When you record starting at the left locator, this setting helps you make sure the very 
start of the recording is included. A very annoying scenario is when you have recorded a 
perfect MIDI take, only to find out that the very first note wasn’t included – because you 
started playing a little bit too early! If you raise the Record Catch Range, Nuendo will 
catch the events played just before the recording start point, eliminating this problem. 
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Filtering MIDI

The MIDI–MIDI Filter page in the Preferences dialog allows you to 
prevent certain MIDI messages from being recorded and/or “thruput” 
(echoed by the MIDI Thru function).

The dialog is divided into four sections:

Section Description

Record Activating any of these options prevents that type of MIDI message from 
being recorded. It will, however, be thruput, and if already recorded, it 
will play back normally.

Thru Activating any of these options prevents that type of MIDI message from 
being thruput. It will, however, be recorded and played back normally.

Channels If you activate a channel button, no MIDI messages on that MIDI channel 
will be recorded or thruput. Already recorded messages will, however, 
be played back normally.

Controller Allows you to prevent certain MIDI controller types from being recorded 
or thruput.
To filter out a controller type, select it from the list at the top of the 
Controller section and click “Add”. It will appear on the list below.
To remove a controller type from the list (allow it to be recorded and 
thruput), select it in the lower list and click “Remove”.
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Options and Settings

Recording-related Preferences

A couple of settings in the Preferences dialog (Transport page) are 
relevant for recording. Set these according to your preferred method 
of work:

Deactivate Punch In on Stop

If this is activated, punch in on the Transport panel is automatically de-
activated whenever you enter Stop mode.

Stop after Automatic Punch Out

If this is activated, playback will automatically stop after automatic 
punch out (when the project cursor reaches the right locator and 
punch out is activated on the Transport panel). If the postroll value on 
the Transport panel is set to a value other than zero, playback will con-
tinue for the set time before stopping (see below).

About Preroll and Postroll

The preroll and postroll value fields (below the left/right locator fields) 
on the Transport panel have the following functionality:

• By setting a preroll value, you instruct Nuendo to “roll back” a short section 
whenever playback is activated.
This applies whenever you start playback, but is perhaps most relevant when recording 
from the left locator (punch in activated on the Transport panel) as described below.

• By setting a postroll value, you instruct Nuendo to play back a short section 
after automatic punch out, before stopping.
This is only relevant when punch out is activated on the Transport panel and “Stop 
after Automatic Punchout” is activated in the Preferences dialog (Transport page).

Preroll value field and on/off switch.

Postroll value field and on/off switch.
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• To turn pre- or postroll on or off, click the corresponding button on the Trans-
port panel (next to the pre/postroll value) or use the “Use Preroll” and “Use 
Postroll” options on the Transport menu.

An example:

1. Set the locators to where you want to start and end recording.

2. Activate punch in and punch out on the Transport panel.

3. Activate the option “Stop after Automatic Punchout” in the Preferences 
dialog (Transport page).

4. Set suitable preroll and postroll times by clicking in the corresponding 
fields on the Transport panel and typing in time values.

5. Activate pre- and postroll by clicking the buttons next to the preroll 
and postroll times so that they light up.

6. Activate recording.
The project cursor “rolls back” by the time specified in the preroll field and playback 
starts. When the cursor reaches the left locator, recording is automatically activated. 
When the cursor reaches the right locator, recording is deactivated, but playback con-
tinues for the time set in the postroll field before stopping.
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Using the metronome

The metronome will output a click that can be used as a timing refer-
ence. The two parameters that govern the timing of the metronome 
are tempo and time signature, and these are edited in the Tempo 
Track window (see page 506).

You can use the metronome for a click during recording and/or play-
back or for a precount (count-in) that will be heard when you start re-
cording from Stop mode. Click and precount are activated separately:

• To activate the metronome, click the Click button on the Transport panel.
You can also select “Metronome On” from the Transport menu or use the correspond-
ing key command (by default [C]).

• To activate the precount, click the Precount button on the Transport panel.
You can also select “Precount On” from the Transport menu or set up a key command 
for this.

Click on/off Precount on/off
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Metronome settings

You make settings for the metronome in the Metronome Setup dialog, 
opened from the Transport menu.

The metronome can use either an audio click played back via the audio 
hardware, send MIDI data to a connected device which will play back 
the click or do both. 

The following metronome settings can be made in the dialog:

Metronome Options Description

Metronome in 
Record / Play

Allows you to specify whether the metronome should be heard 
during playback, recording or both (when Click is activated on 
the Transport panel).

Use Count Base If this option is activated, a field appears to the right where you 
specify the “rhythm” of the metronome. Normally, the metro-
nome plays one click per beat, but setting this to e.g. “1/8” 
gives you eighth notes – two clicks per beat. It’s also possible 
to create unusual metronome rhythms such as triplets etc.
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Precount Options Description

Precount Bars Sets the number of bars the metronome will count in before it 
starts recording if precount is activated on the Transport panel.

Use Time Signature at 
Project Time

When this is activated, the precount will be in the time signa-
ture set in the Tempo track. Furthermore, any tempo changes 
in the Tempo track during the precount will be applied.

Use Time Signature... Lets you set a time signature for the precount. In this mode, 
tempo changes in the Tempo track won’t affect the precount.

MIDI Click Description

Activate MIDI Click Selects whether or not the metronome will sound via MIDI.

MIDI Port/Channel This is where you select a MIDI output and channel for the met-
ronome click.

Hi Note/Velocity Sets the MIDI note number and velocity value for the “high 
note” (the first beat in a bar). 

Lo Note/Velocity Sets the MIDI note number and velocity for the “low notes” (the 
other beats). 

Audio Click Description

Activate Audio Click Selects whether or not the metronome will sound via the audio 
hardware.

Beeps When this is selected, the audio click will be beeps generated 
by the program. Adjust the pitch and level of the beeps for the 
“Hi” (first) beat and “Lo” (other) beats using the sliders below.

Sounds When this is selected, you can click in the “Sound” fields below 
to load any audio files for use as the “Hi” and “Lo” metronome 
sounds. The sliders set the level of the click.



5
The Project window
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Background

The Project window is the main window in Nuendo. This provides you 
with an overview of the project, allowing you to navigate and perform 
large scale editing. Each project has one Project window.

About tracks

The Project window is divided vertically into tracks, with a timeline 
running horizontally from left to right. The following track types are 
available:

Track type Description

Audio For recording and playing back audio events and audio parts. Each au-
dio track has a corresponding audio channel in the mixer.
An audio track can have any number of automation “subtracks” for auto-
mating mixer channel parameters, insert effect settings etc.

Folder Folder tracks function as containers for other tracks, making it easier to 
organize and manage the track structure. They also allow you to edit sev-
eral tracks at the same time. See page 165.

FX Channel FX channel tracks are used for adding send effects. Each FX channel 
can contain up to eight effect processors – by routing effect sends from 
an audio channel to an FX channel, you send audio from the audio chan-
nel to the effect(s) on the FX channel. Each FX channel has a corre-
sponding channel strip in the mixer – in essence an effect return 
channel. See page 273 for more about FX Channel tracks and send ef-
fects.
An FX channel can also have any number of automation subtracks for 
automating mixer channel parameters, effect settings etc. All FX channel 
tracks are automatically placed in a special FX channel folder in the 
Track list, for easy management.

Group 
Channel

By routing several audio channels to a Group channel, you can submix 
them, apply the same effects to them, etc. (see page 249).
A Group channel track contains no events as such, but displays settings 
and automation curves for the corresponding Group channel. Each 
Group channel track has a corresponding channel strip in the mixer. In 
the Project window, Group channels are organized as subtracks in a 
special Group Tracks folder. 
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About parts and events

Events are the basic building blocks in Nuendo. Different event types 
are handled differently in the Project window:

• Video events and automation events (curve points) are always viewed and re-
arranged directly in the Project window.

• MIDI events are always gathered in MIDI parts, containers for one or more 
MIDI events. MIDI parts are rearranged and manipulated in the Project win-
dow. To edit the individual MIDI events in a part, you have to open the part in 
a MIDI editor, see the separate PDF document “Working with MIDI”. 

• Audio events can be displayed and edited directly in the Project window, but 
you can also work with audio parts containing several events. This is useful if 
you have a number of events which you want to treat as one unit in the 
project.

An audio event and an audio part.

MIDI For recording and playing back MIDI parts. Each MIDI track has a corre-
sponding MIDI channel strip in the mixer. It’s also possible to edit MIDI 
tracks directly in the Project window, using the Edit In-Place function, 
see the separate PDF document “Working with MIDI”.
A MIDI track can have any number of automation “subtracks” for auto-
mating mixer channel parameters, insert and send effect settings etc. 

Marker The Marker track displays markers, and allows you to move and rename 
them directly in the Project window (see page 178). There can only be 
one Marker track in the project.

Play Order Allows you to mark out sections in the project and set in which order 
they should be played back. See the chapter “The play order track”.

Ruler Ruler tracks contain additional rulers, displaying the timeline from left to 
right. You can use any number of ruler tracks, each with a different dis-
play format if you wish. See page 108 for more information about the 
ruler and the display formats.

Video For playing back video events. A project can only have one Video track.

Track type Description



NUENDO
5 – 96 The Project window

Window Overview

The toolbar.The info line.

 Track list with various 
track types.

The event display, showing 
audio parts and events, MIDI 
parts, automation, markers, etc.

Project overview

The Inspector.

The ruler.
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The Track list

The Track list is the area to the left in the Project window. It contains 
name fields and various settings for the tracks. Different track types 
have different controls in the Track list. To see all the controls you may 
have to resize the track in the Track list (see page 115):

• The Track list area for an audio track:

• The Track list area for an automation subtrack (revealed by clicking 
the + button on a track):

• The Track list area for a MIDI track:

Mute & Solo Record Enable
Track name

Output activity 
indicator

Show/hide 
automation

Indicates whether effect sends, EQ or insert 
effects are activated for the track. Click to bypass.

Monitoring on/off

Musical/Linear time base (see page 124)

Lane Display Type

Automation Read/
Write buttons

Edit channel settings
Lock track button

Automation Read/Write buttons

Automation parameter 
(click to select parameter)

Expand automation track 
(show more parameters)

Mute Lock track button

Record Enable

Track name

MIDI Output Bank Program 

MIDI channel

Drum map assign Lock trackMonitoring on/off

Read/Write buttons

Edit channel settings

Mute & Solo

Indicates whether effect sends or insert effects 
are activated for the track. Click to bypass.

Edit In-Place button Lane display type
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The Inspector

The area to the left of the Track list is called the Inspector. This shows 
additional controls and parameters for the track you have selected in 
the Track list. If several tracks are selected (see page 121), the In-
spector shows the setting for the first (topmost) selected track.

To hide or show the Inspector, click the Inspector icon in the toolbar.

The Inspector icon.

• For most track classes, the Inspector is divided into a number of sec-
tions, each containing different controls for the track. You can hide or 
show sections by clicking on their respective headlines.
Clicking the headline for a hidden section brings it to view and hides the other sections. 
[Ctrl]/[Command]-clicking the headline allows you to hide or show a section without af-
fecting other sections. Finally, [Alt]/[Option]-clicking a headline shows or hides all sec-
tions in the Inspector.

• You can also use key commands to show different Inspector settings.
These are set up under the Inspector heading in the Key Commands dialog.

• Folding a section does not affect the functionality but merely hides the 
section from view.
In other words, if you have set up a track parameter or activated an effect for example, 
your settings will still be active even if you fold the Inspector section.

Which sections are available in the Inspector depends on the se-
lected track’s class.
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Sections

In general, the Inspector contains the same controls as the Track list, 
but there are also some additional buttons and parameters. Below is a 
list of all common, possible settings and sections, their controls and 
usage, followed by descriptions of which sections are actually avail-
able for each type of track:

Parameter Description

Auto Fades 
Settings button

Opens a dialog in which you can make separate Auto Fade settings 
for the track. See page 205.

Edit button Opens the Channel Settings window for the track, allowing you to 
view and adjust effect and EQ settings, etc. See page 237.

Volume Use this to adjust the level for the track. Changing this setting will 
move the track’s fader in the mixer window, and vice versa. See page 
225 to learn more about setting levels.

Pan Use this to adjust the panning of the track. As with the Volume set-
ting, this corresponds to the Pan setting in the mixer.
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Delay This adjusts the playback timing of the audio track. Positive values 
delay the playback while negative values cause the track to play ear-
lier. The values are set in milliseconds.

In This lets you specify which Input bus or MIDI input the track should 
use (see page 15 for information about Input busses).

Out Here you decide to which output the track should be routed. For au-
dio tracks you select an output bus (see page 15) or Group channel, 
for MIDI tracks you select a MIDI output.

Inserts section Allows you to add insert effects to the track, see page 262. The Edit 
button at the top of the section opens the control panels for the 
added insert effects.

Equalizers 
section

Lets you adjust the EQs for the track. You can have up to four bands 
of EQ for each track, see page 240. The Edit button at the top of the 
section opens the Channel Settings window for the track. 

Equalizer Curve 
section

Lets you adjust the EQs for the track graphically, by clicking and 
dragging points in a curve display.

Sends section Allows you to route an audio track to one or several FX channels (up 
to eight), see page 273. For MIDI tracks, this is where you assign 
MIDI send effects. The Edit button at the top of the section opens the 
control panel for the first effect in each FX channel.

Channel section Shows a duplicate of the corresponding mixer channel strip. The 
channel overview strip to the left lets you activate and deactivate 
insert effects, EQs and sends.

Notepad section This is a standard text notepad, allowing you to jot down notes about 
the track. 
If you have entered any notes about a track, the icon next to the 
“Notepad” heading will light up to indicate this. Moving the pointer 
over the icon will display the Notepad text in a tool tip.

Network section This contains controls related to the Network functions of the program. 
For further information, see the separate Networking document.

User Panel Here you can display MIDI device panels, audio track panels or VST 
insert effect panels. For information on how to create or import MIDI 
device setups, see the separate PDF document “Working with MIDI”.

Parameter Description
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Audio tracks

For audio tracks, all settings and sections listed above are available.

• User Panels for audio tracks can display panels for channel controls 
(such as input phase or the linked panner option) or for VST effects 
currently inserted in the channel.

• User Panels for audio tracks are accessed by [Ctrl]/[Command]-click-
ing on the Edit Channel button in the Inspector. This opens up a menu 
listing all the device panels available for the audio track. If panels have 
not yet been created, you will see “Setup” panels in the menu. Double-
clicking on one of these will open the Device window for that audio 
track. Here you will be able to create User panels for any parameter of 
the audio track, including VST effects that have been inserted. For 
more information on how to create Device and User panels, see the 
separate PDF document “Working with MIDI”.

The Device Panel Browser.
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Once panels have been created, they are available from the User Panel 
section of the Inspector. Click on the small arrow at the top right of the 
User Panels section to view the choices.

The User Panel menu in the Inspector

In order to have User Panels available in the Inspector, you must create 
Inspector-sized panels. Panels of bigger sizes (e.g. General) will not be 
available in the Inspector.

MIDI tracks

When a MIDI track is selected, the Inspector contains a number of ad-
ditional sections and parameters, affecting the MIDI events in real time 
(e.g. on playback). Which sections are available for MIDI tracks is de-
scribed in the PDF document “Working with MIDI”.

Marker tracks

When the marker track is selected, the Inspector shows the marker 
list. See page 174.
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Video tracks

When a Video track is selected, the Inspector contains a lock button 
for locking the track (see page 140) and two settings for how the 
video thumbnails are shown: Show Frame Numbers and Snap 
Thumbnails (see page 619).

Folder tracks

When a folder track is selected, the Inspector shows the folder and its 
underlying tracks, much like a folder structure in the Windows Ex-
plorer or Mac OS X Finder.

• You can click one of the tracks shown under the folder in the Inspector 
to have the Inspector show the settings for that track.
This way, you don’t have to “open” a folder track to make settings for tracks within it.

Here, an audio track within the folder is selected.

FX channel tracks

When an FX channel track is selected, the following controls and sec-
tions are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Channel section.
• Notepad section.
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FX channel folder tracks

FX channel tracks are automatically placed in a special folder, for eas-
ier management. When this folder track is selected, the Inspector 
shows the folder and the FX channels it contains. You can click one of 
the FX channels shown in the folder to have the Inspector show the 
settings for that FX channel – this way you don’t have to “open” a 
folder track to access the settings for the FX channels in it.

Group channel tracks

When a Group channel track is selected, the following controls and 
sections are available:

• Edit button.
• Volume control.
• Pan control.
• Output routing pop-up menu.
• Inserts section.
• Equalizers section.
• Sends section.
• Channel section.
• Notepad section.

Group channel folder tracks

Just like FX channel tracks, all Group channel tracks are placed in a 
separate folder – when this is selected, the Inspector shows the 
folder and the Group channels it contains. You can click one of the 
Group channels shown in the folder to have the Inspector show the 
settings for that Group channel – this way, you don’t have to “open” a 
folder track to access the settings for the Group channels in it.

Ruler tracks

For ruler tracks, the Inspector isn’t used.
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The toolbar

The toolbar contains tools and shortcuts for opening other windows 
and various project settings and functions:

• In addition, the toolbar can contain a number of other tools and short-
cuts, not visible by default. How to set up the toolbar and specify which 
tools should be displayed or hidden is described on page 678.

Active project 
indicator

Show/hide 
Inspector

Show/hide info line

Show/hide Overview

Open Pool

Open Mixer

Automation mode

Project window tools

Transport controls 
(Previous/Next Marker, Cycle, Stop, Play, and Record)

Snap on/off

Snap mode

Grid pop-up menu

Quantize value

Color pop-up menu

Autoscroll on/off
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The info line

The info line shows information about the currently selected event or 
part in the Project window. You can edit almost all values in the info 
line using regular value editing. Length and position values are dis-
played in the format currently selected for the ruler (see page 108).

• To hide or show the info line, click this icon on the toolbar:

The following elements can be selected for display and editing on the 
info line:

• Audio events.
• Audio parts.
• MIDI parts.
• Video events.
• Markers.
• Automation curve points.

When several elements are selected

• If you have several elements selected, the info line will show information about 
the first item in the selection. The values will be shown in yellow to indicate 
that several elements are selected.

• If you edit a value on the info line, the value change is applied to all selected 
elements, relatively to the current values. 

An example: You have two audio events selected. The first is one bar 
long and the other two bars long. The info line shows the length of the 
first event (one bar). If you now edit this value to 3 bars in the info line, 
the other event will be resized by the same amount – and will thus be 
4 bars long.

• If you press [Ctrl]/[Command] and edit on the info line, the values will be ab-
solute instead. In our example above, both events would be resized to 3 bars. 
Note that [Ctrl]/[Command] is the default modifier key for this – you can 
change this in the Preferences dialog (Editing-Tool Modifiers page, under the 
Info Line category).
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Editing Transpose and Velocity for MIDI parts

When one or several MIDI parts are selected, the info line contains 
Transpose and Velocity fields.

• Adjusting the Transpose field transposes the selected parts in semi-
tone steps.
Note that this transposition doesn’t change the actual notes in the part – it’s just a 
“play parameter”, affecting the notes on playback. The transposition you specify for a 
part on the info line is added to the transposition set for the whole track with the Trans-
pose track parameter in the Inspector.

• Adjusting the Velocity field shifts the velocity for the selected parts – 
the value you specify is added to the velocities of the notes in the 
parts.
Again, this velocity shift only affects the notes on playback, and again, the value you 
specify is added to the Vel.Shift. value set for the whole MIDI track in the Inspector.

Audio events can also be transposed – see page 451.

Getting on-the-fly info with the Arrow tool

If the option “Select Tool: Show Extra Info” is activated in the Prefer-
ences dialog (Editing page), a tool tip will be shown for the Arrow tool, 
displaying various info depending on where you point it. For example, 
in the Project window’s event display, the tool will show the current 
pointer position and the name of the track and event you’re pointing at.
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The ruler

The ruler at the top of the event display shows the timeline. Initially, the 
Project window ruler uses the display format specified in the Project 
Setup dialog (see page 111), as do all other rulers and position dis-
plays in the project. However, you can select an independent display 
format for the ruler by clicking the arrow button to the right of it and 
selecting an option from the pop-up menu that appears (you can also 
bring up this pop-up menu by right-clicking (Win) or [Ctrl]-clicking 
(Mac) anywhere in the ruler).

Option Positions and lengths displayed as

Bars+Beats Bars, beats, sixteenth notes and ticks. By default there are 120 
ticks per sixteenth note but you can adjust this with the “MIDI 
Display Resolution” setting in the Preferences dialog (MIDI 
page).

Seconds Hours, minutes, seconds and milliseconds.

Timecode This format displays hours, minutes, seconds and frames. The 
number of frames per second (fps) is set in the Project Setup di-
alog (see page 111). You can choose from 24, 25, 29.97 and 
30 fps or 29.97 and 30 dfps (“drop frame”).

Feet+Frames 16mm Feet and frames, with 40 frames per foot.

Feet+Frames 35mm Feet, frames and 1/4 frames, with 16 frames per foot.

Samples Samples.

User Hours, minutes, seconds and frames, with a user definable num-
ber of frames per second. You set the desired number of fps in 
the Preferences dialog (Transport page).

Time Linear When this is selected, the ruler will be linear relative to time. This 
means that if there are tempo changes on the Tempo track, the 
distance between the bars will vary in Bars+Beats mode.

Bars+Beats Linear When this is selected, the ruler will be linear relative to meter po-
sition – bars and beats. This means that if there are tempo 
changes on the Tempo track, there will still be the same distance 
between bars in Bars+Beats mode. If the ruler is set to a time-
based mode, the distance between seconds will vary depending 
on the tempo changes.
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• The selection you make here affects the ruler, the info line and tool tip 
position values (appear when you drag an event in the Project win-
dow).
You can also select independent formats for other rulers and position displays. 

• To set the display format globally (for all windows), use the primary 
display format pop-up on the Transport panel, or hold down [Ctrl]/
[Command] and select a display format in any ruler.

• If you use the “Timecode” or “User” options and the option “Show 
Timecode Subframes” is activated in the Preferences dialog (Trans-
port page), the frames will also display subframes.
There are 80 subframes per frame.

• For the “Feet+Frames” settings, there is an option in the Preferences 
(Transport page) called “Feet’n’Frames Count from Project Start”.
When this is activated, time displays and rulers in Feet+Frames format will always start 
with 0’00 at the beginning of the project - regardless of any Start offset settings in the 
Project Setup dialog.

Using multiple rulers – ruler tracks

As described above, the Nuendo Project window contains a main ruler 
at the top of the event display, displaying the timeline from left to right.

If needed, you can have several rulers in the Project window, by adding 
ruler tracks to the project. Each ruler track contains an additional ruler.

• To add a ruler track, select “Add Track” from the Project menu and 
from the submenu that appears, select “Ruler”.
A ruler track showing an additional ruler is added to the Track list.

A ruler track set to the display format “Seconds”.

You can add any number of ruler tracks to a project, and position them 
as needed by dragging them up or down in the list. Each one can 
show a separate display format:
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• To select a display format for a ruler track, click the leftmost part of it 
in the track list and select an option from the pop-up menu.
The different display formats are described above.

Note that ruler tracks are completely independent from the main event 
display ruler, as well as rulers and position displays in other windows. 
This means that:

• Ruler tracks can all have independent display formats.
• Ruler tracks are not affected by the display format setting in the Project Setup 

dialog (see page 111).
• Ruler tracks are not affected if you set the display format globally with the pri-

mary time display in the Transport panel.

• Ruler tracks are however affected by the option “Show Timecode Sub-
frames” (described above) in the Preferences dialog.
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Operations

Creating a new project

You create a new project in the following way:

1. Select “New Project” from the File menu.
A dialog appears, listing a number of project templates, including any custom tem-
plates you may have created (see page 641). 

2. Select a template and click OK.
A file dialog appears, allowing you to specify a location for the project folder. This will 
contain all files related to the project. 

3. Select an existing folder or type the name of a new one. Click OK.
A Project window appears. The new project will be based on the selected template, 
and include tracks, events and settings from the template.

The Project Setup dialog

General settings for the project are made in the Project Setup dialog. 
This is opened by selecting “Project Setup...” from the Project menu.
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The following settings are available in the Project Setup dialog:

Setting Description

Start The start time of the project. Allows you to have the project start at 
another time than zero. Also used for setting the sync start position 
when synchronizing Nuendo to external devices (see page 580). 
The format of this value is always in timecode. When you change 
this setting you will be asked whether you want to keep the project 
content at its timecode positions. “Yes” means that all events will 
stay at their original timecode positions - i.e they will be moved in re-
lation to the start of the project. “No” means that all events keep their 
position relative to the project start.
See also the note about Feet’n’Frames Count from Project Start” on 
page 109.

Length The length of the project. Nuendo is capable of having longer lengths 
than 24 hours since the timecode includes a “day” field. This can be 
handy when creating projects that use “time of day” timecode and 
cross over the 24 hour mark. The maximum project length is 10 days. 

Frame Rate Used when synchronizing Nuendo with external equipment. If Nu-
endo is slave, this value is automatically set to the frame rate of the 
incoming sync signal. If Nuendo is the master, this determines the 
frame rate of the sent sync signal. See page 594.

Display Format This is the global display format used for all rulers and position dis-
plays in the program, except ruler tracks (see page 104). However, 
you can make independent display format selections for the individ-
ual rulers and displays if you like.
For descriptions of the different display format options, see page 108.

Display Offset Offsets the time positions displayed in the ruler etc., allowing you to 
compensate for the Start position setting. Typically, if you synchro-
nize Nuendo to an external source starting at a frame other than 
zero, you set the Start position to this value. However, if you still 
want the display in Nuendo to start at zero, set the Display Offset to 
the same value too.

Bar Offset This works just like “Display Offset” described above, in that it off-
sets the time positions in the ruler by a number of bars, allowing you 
to compensate for the Start position setting. The difference is that 
Bar Offset is only used when the “Bars+Beats” display format is se-
lected (see page 108).

Sample Rate The sample rate at which Nuendo records and plays audio.

Record Format / 
File Type

When you record audio in Nuendo, the files that are created will be 
of this resolution and file type. See page 54.
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While most Project Setup settings can be changed at any time, you 
should select a sample rate once and for all when starting with a new 
project! All audio files must be of this sample rate to play back correctly.

Zoom and view options

Zooming in the Project window is done according to the standard 
zoom procedures (see the Getting Started book), with the following 
special notes:

• When you are using the Zoom tool (magnifying glass), the result de-
pends on the option “Zoom Tool Standard Mode: Horizontal Zooming 
Only” in the Preferences – Editing dialog.
If this is activated and you drag a selection rectangle with the Zoom tool, the window 
will only be zoomed horizontally (track height will not change). If the option is off, the 
window will be zoomed both horizontally and vertically.

• When using the vertical zoom sliders, the tracks are scaled relatively. 
In other words, if you have made any individual track height adjustments (see below), 
the relative height differences are maintained.

You find the following options are available on the Zoom submenu on 
the Edit menu:

Stereo Pan Law Decides whether panning should use power compensation or not. 
This is explained on page 234.

Option Description

Zoom In Zooms in one step, centering on the project cursor.

Zoom Out Zooms out one step, centering on the project cursor.

Zoom Full Zooms out so that the whole project is visible. “The whole 
project” means the timeline from the project start to the length set 
in the Project Setup dialog (see above).

Zoom to Selection Zooms in horizontally and vertically so that the current selection 
fills the screen.

Zoom to Selection 
(Horiz)

Zooms in horizontally so that the current selection fills the screen.

Setting Description
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• If the option “Zoom while Locating in Time Scale” is activated in the 
Preferences (Transport page), you can also zoom by clicking in the 
main ruler and dragging up or down with the mouse button pressed.
Drag up to zoom out; drag down to zoom in.

• You can zoom the contents of parts and events vertically, using the 
Waveform Zoom slider in the top right corner of the event display.
This can be useful to better view quiet audio passages.

To get an approximate reading on the level of the audio events by view-
ing the waveforms, make sure the slider is all the way down. Otherwise, 
zoomed waveforms may be mistaken for clipped audio.

• If you activate the option Quick Zoom in the Preferences (Editing 
page), the contents of parts and events will not be continuously re-
drawn when you zoom manually.
Instead, the contents are redrawn once you have stopped changing the zoom – acti-
vate this if screen redraws are slow on your system.

Zoom to Event This option is available only in the Sample Editor (see page 406).

Zoom In Vertical Zooms in one step vertically.

Zoom Out Vertical Zooms out one step vertically.

Zoom In Tracks Zooms in selected track(s) one step vertically.

Zoom Out Tracks Zooms out selected track(s) one step vertically.

Zoom Selected 
Tracks 

This zooms in vertically on the selected track(s) and minimizes the 
height of all other tracks.

Option Description
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Resizing tracks in the Track list

• You can change the height of an individual track by clicking on its lower bor-
der in the Track list and dragging up or down.
To change the height of all tracks simultaneously, hold down [Ctrl]/[Command] and re-
size one of the tracks in this way. If “Snap Track Heights” is activated on the Track 
scale pop-up (see below), the track height will change in fixed increments when you 
resize it.

• You can also change the width of the Track list area, by dragging the 
border between the Track list and the event display.

• The controls shown for tracks in the Track list will by default adapt to 
the track size. This means that when resizing a track’s height or width 
some of the controls will be dynamically placed where they best “fit 
in”.
If you instead always want to have the controls in fixed positions, you can deactivate 
the option “Wrap Controls” in the Track Controls settings dialog (see page 680).

• You can decide for each track type what controls should be shown in the 
Track list – see page 680.

• You can use the Track scale pop-up (opened by clicking the arrow button 
above the vertical zoom control) to set the number of tracks to view in the cur-
rent Project window.
The track height will be adjusted to show only the number of tracks specified on the 
pop-up menu. By selecting “Zoom N Tracks” from the pop-up you can manually set the 
number of tracks to fit in the current Project window.

• Tracks can also be divided vertically in lanes – see page 144.
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Zoom presets and Cycle markers

The pop-up menu to the left of the horizontal zoom control allows you 
to select, create and organize zoom presets. These are useful if you 
want to toggle between different zoom settings (e.g. one where the 
whole project is displayed in the project window and another with a 
high zoom factor for detailed editing). With this pop-up menu, you can 
also zoom in on the area between cycle markers in the project.

The upper part of the menu lists the zoom presets:

• To store the current zoom setting as a preset, select Add from the 
pop-up menu.
A dialog appears, allowing you to type in a name for the preset.

• To select and apply a preset, select it from the pop-up menu.

• The “Zoom Full” preset is always available. Selecting this option 
Zooms out so that the whole project is visible. “The whole project” 
means the timeline from the project start to the length set in the 
Project Setup dialog (see page 111).

• If you want to delete a preset, select “Organize…” from the pop-up 
menu.
In the dialog that appears, select the preset in the list and click the Delete button. The 
preset is removed from the list.
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• If you want to rename a preset, select “Organize…” from the pop-up 
menu.
In the dialog that appears, select the desired preset in the list and click the Rename 
button. A second dialog opens, allowing you to type in a new name for the preset. 
Click OK to close the dialogs.

Zoom presets are global for all projects, i.e. they are available in all 
projects you open or create.

The middle part of the pop-up lists any cycle markers you have added 
in the project:

• If you select a cycle marker from this menu, the event display is 
zoomed in to encompass the marker area (see page 180).

• You cannot edit the cycle markers in this pop-up menu. For informa-
tion on editing markers, see page 174.

Only the cycle markers you create in the current project are available on 
the menu.

The Zoom history

Nuendo maintains a history of recent zoom stages, allowing you to 
undo and redo zoom operations. This way you can zoom in several 
steps and then easily go back to the zoom stage at which you started.

There are two ways to invoke Undo Zoom and Redo Zoom:

• Use the items on the Zoom submenu on the Edit menu.
You can also assign key commands for these.

• Double click with the Zoom tool (magnifying glass) to Undo Zoom.
Press [Alt]/[Option] and double click to Redo Zoom.

Adjusting how parts and events are shown

The Preferences dialog on the File menu (the Nuendo menu, under 
Mac OS X) contains several settings for customizing the display in the 
Project window.
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The Event Display page contains common settings for all track types:

The Event Display–Video page contains settings for video events:

The Event Display–Audio page contains settings for audio events:

Option Description

Colorize Event 
Background

Determines whether the backgrounds or “contents” (waveforms, 
etc.) of parts and events will be colorized. See page 121.

Transparent Events When this is activated, events and parts will be transparent, 
showing the waveforms and MIDI events only.

Show Data on Small 
Track Heights

If this is activated, the contents of events and parts will be 
shown, even if the height of a track is very small.

Show Event Names Determines whether the names of parts and events should be 
shown in the Project window.

Option Description

Show Video 
Thumbnails

When this is activated, thumbnail frames of the video contents 
are shown on the Video track.

Video Cache Size This determines how much memory is available for video thumb-
nails. If you have long video clips and/or work with a large zoom 
factor (so that a lot of frames are shown in the thumbnails), you 
may have to raise this value.

Option Description

Interpolate Audio 
Images

If the option is deactivated, single sample values are drawn as 
“steps”. If the option is activated they are interpolated to form 
“curves”.

Wave Image Style Determines whether audio waveforms should be displayed as 
solid images, frames or “inverted” images (solid+frame). This 
selection affects all waveform images in the Project window, 
Sample Editor and Audio Part Editor.
Note that the “Framed” and “Solid and Framed” styles are more 
demanding for the computer. If the system feels slower in these 
modes, please switch back to “Solid” wave image style.

Show Event Volume 
Curves Always

If this is activated the “volume curves” created with the volume 
and fade handles are always shown – if not, the curves are only 
shown for selected events.
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The Event Display–MIDI page contains settings for MIDI parts:

Show Waveforms Determines whether audio waveforms should be shown at all.

Background Color 
Modulation

When this is activated, the backgrounds of audio waveforms 
are displayed in a different way, reflecting the waveform dynam-
ics. This is especially useful to get an overview when working 
with small track heights.

Option Description

Default Edit Action Determines which editor should be opened when you double 
click a MIDI part or select it and press [Ctrl]/[Command]-[E]: the 
Key, Drum, List or Score editor. Note that this setting is overrid-
den for tracks with drum maps if the option “Edit as Drums when 
Drummap is assigned” (see below) is activated.

Part Data Mode Determines if and how events in MIDI parts should be shown in 
the Project window: as lines, as score notes or as drum notes. If 
“No Data” is selected, events will not be shown at all. Note that 
this setting is overridden for tracks with drum maps if the option 
“Edit as Drums when Drum Map is assigned” (see below) is ac-
tivated.

Show Controllers Governs whether non-note events (controllers, etc.) should be 
shown in MIDI parts in the Project window.

Edit as Drums 
when Drum Map is 
assigned

If this is activated, parts on MIDI tracks with drum maps assigned 
will be shown with drum note symbols in the Project window. 
Also, the parts will automatically open in the Drum editor when 
double clicked (overriding the Default Edit Action setting above).

Note Name Style Determines how MIDI note names (pitches) should be displayed 
in editors, etc.

Option Description
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Zooming and navigating in the overview line

By clicking the Show Overview button on the toolbar, an extra pane 
appears under the toolbar; the project overview line. 

Show Overview button

In the overview line, events and parts on all tracks are displayed as 
boxes. You can use the overview line to zoom in or out, and for navi-
gating to other sections of the project. This is done by moving and re-
sizing the track view rectangle in the overview line:

• The track view rectangle indicates the section of the project currently 
displayed in the event display.

• You can zoom in or out horizontally by resizing the rectangle.
Resizing is done by dragging the edges of the rectangle.

• You can drag the track view rectangle to view other sections of the 
project.
This can also be done by clicking anywhere in the upper part of the overview – the 
track view rectangle will be moved to where you clicked. The number of tracks shown 
will not change.

The track view rectangle
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Handling tracks

To add a track to the project, select “Add Track” from the Project 
menu and select a track type from the submenu that appears. The 
new track is added below the currently selected track in the Track list.

• The items on the “Add Track” submenu are also available on the 
Quick menu.
This is accessed by right-clicking (Win)/[Ctrl]-clicking (Mac) in the Track list.

• There is an additional option at the bottom of the Add Track submenu, 
called “Multiple...”. Selecting this brings up a dialog allowing you to 
add more than one track in one operation.
The number of tracks to add is entered in the “Count” value field. You can set whether 
audio, MIDI or group tracks should be created by selecting from the Track pop-up in 
the dialog. For audio and group tracks, the channel configuration – mono, stereo or a 
surround configuration – can be set in the Configuration pop-up.

Once you have created tracks, you can manipulate and rearrange 
them in various ways:

• To rename a track, double click the name field and type in a new name.
If you hold down any modifier key when pressing [Return] to close the name field, all 
events on the track will get the name you entered.
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• To select a track, click on it in the Track list.
A selected track is indicated by a light grey color in the Track list. 

It is possible to select several tracks, by pressing [Ctrl]/[Command] and clicking them. 
To select a continuous range of tracks, use [Shift]-clicking.

• To move a track, click and drag it up or down in the list.

• To duplicate a track, complete with all contents and channel settings, 
right-click (Win)/[Ctrl]-click (Mac) in the Track list and select “Dupli-
cate track” from the context menu.
The duplicated track will appear above the original track.

• You can select a default color for a track by activating “Show Track 
Colors” above the track list and selecting a color at the top of the In-
spector. This color will be used for all events on the track and will also 
be shown in the Mixer. If you like, you can override the default track 
color for individual events and parts by using the Color tool or the 
Color Selector pop-up menu. This is described in detail in the Getting 
Started manual. 
The option “Colorize Event Background” in the Preferences dialog (Event Display 
page) determines whether the backgrounds or waveforms of events will be colorized.

• To remove a track, right-click (Win)/[Ctrl]-click (Mac) on it in the Track 
list and select “Remove Track” from the context menu that appears.
You can also remove multiple selected tracks, by selecting “Remove Selected Tracks” 
either from the Project menu or from the context menu. Furthermore, you can remove 
all tracks not containing any events by selecting “Remove Empty Tracks” from the 
Project menu.

Disabling tracks

Tracks can be disabled by selecting “Disable Track” from the Track 
list context menu. Disabling a track in a way is the same as Muting it 
(see page 142), since a disabled track will not be played back. How-
ever, disabling a track not only “zeroes” the output volume from the 
track, but actually shuts down all disk activity for it. See page 43 for 
more information.

This track is selected.
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Dividing the Track list

It is possible to divide the Track list into two parts. Both sections will 
have independent zoom and scroll controls (if needed), but resizing 
the window vertically will affect the lower section only (if possible). 
This could be convenient for example if you’re working with a video 
track along with multi-track audio. This way, you can place the video 
track in the upper Track list, letting you scroll the audio tracks sepa-
rately in the lower Track list, referencing them against the video track.

• To divide the Track list, click the “Divide Track List” button in the top 
right corner of the Track list.

The “Divide Track List” button.

• To revert to a single Track list, click the button again.

When the Track list is divided into two parts, the following applies:

• If you add tracks from the Project–Add Track submenu, Video tracks, 
Marker tracks and ruler tracks will automatically be placed in the up-
per part of the Track list.
All other types of tracks will be placed in the lower part.

• If you add tracks from the context menu invoked by right-clicking (Win)/
[Ctrl]-clicking (Mac) in the Track list, tracks will be added to the part of 
the Track list in which you click.

• You can move any type of track from the lower Track list to the upper 
and vice versa by right-clicking or [Ctrl]-clicking it in the Track list and 
selecting “Toggle Track List” from the context menu.

• If the Track list already contains tracks of the type Video or Marker, 
these will automatically be moved to the upper part when you divide 
the Track list.
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• You can resize the upper part by clicking and dragging the divider be-
tween the Track lists.

Switching between musical or linear time base

Tracks can be either “musical” (tempo) or “linear” (time) based.

• On a track using linear time base, the events will be positioned on specific 
time positions – changing the playback tempo will not affect the time position 
of events.

• On a track using musical time base, the positions of events are represented 
as meter values (bars, beats, 1/16th notes and ticks, with 120 ticks per 1/
16th note). If you change the playback tempo, the events will play back at an 
earlier or later time.

Whether to use musical or linear time base depends on the type of 
project and recording situation. By default, all track types featuring a 
time base setting use linear time base. However, you can change this 
setting individually for each track. This is done by clicking the musical/
linear time base button in the Inspector or Track list. Musical time 
base is indicated by a note symbol, while linear time base is indicated 
by a clock symbol.

The musical/linear time base button.

Linear time base selected. Musical time base selected.
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Note that internally, events on musical time based tracks use the same 
high precision for positioning (64 bit floating point values) as linear time 
based events.
However, switching between linear and musical time base results in a 
very small loss of precision (introduced by the mathematical operations 
used for scaling values in the two different formats). Therefore you 
should avoid switching repeatedly between the two modes.

For more information about tempo changes, see page 502.

Adding events to a track

There are a number of ways to add events to a track:

• By recording (see page 49).
This is possible for audio and MIDI tracks.

• By selecting “Audio File...” or “Video File...” from the Import submenu on the 
File menu.
This opens a file dialog, allowing you to locate the file you wish to import. When you 
import a file this way, a clip is created for the file and an event that plays the whole clip 
is added to the selected track, at the position of the project cursor.
You can also import MIDI files by using the Import submenu, but this works in a slightly 
different way (see page 655).

• By grabbing audio CD tracks and converting them to audio files (see page 
662).

• By importing only the audio portion of a video file and converting it to an audio 
file (see page 623).

• By using Copy and Paste on the Edit menu.
This allows you to copy all kinds of events between projects. You can also copy events 
within the project, from the Audio Part Editor or Sample Editor.

• By drawing.
Some types of events (markers and automation events) can be drawn directly into the 
Project window. For audio and MIDI tracks, you can draw parts (see page 127).

• By dragging files and dropping them on the track at the desired position.
You can create events by dragging and dropping from the following locations:

• The Desktop.
• The Pool.
• A Library (A Pool file that is not attached to a project).
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• The Project window of another open project.
• The Audio Part Editor of any open project.
• The Sample Editor of any open project – press [Ctrl]/[Command] and drag to 

create an event of the current selection, or click in the left column of the re-
gion list and drag to create an event from a region.

• The “Find media” dialog.

While you drag the clip in the Project window, its position will be indicated by a 
marker line and a numerical position box. See also page 484.

Audio file import options

When you are importing audio files there are a number of options con-
cerning how the files should be treated by Nuendo: 

• You can choose to copy the file into the project’s audio folder and have the 
project make reference to the copied file rather than the original file. This 
helps you keep your project “self-contained”.

• You can choose to split stereo- and multi-channel files into a number of mono 
files.

• Furthermore, you may want all files in the project to have the same sample rate 
and sample size (resolution).

The Preferences dialog (Editing – Audio page) contains a setting that 
lets you decide which options, if any, to use. Select the desired option 
on the “On Import Audio Files” pop-up:
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• Open Options Dialog.
An Options dialog appears when you import, allowing you to select whether you want 
to copy the files to the Audio folder and/or convert them to the project settings. Note:
- When importing a single file of a format other than the project settings, you can spec-
ify which properties (sample rate and/or resolution) should be changed.
- When importing multiple files at the same time, you can select to have the imported 
files automatically converted if necessary, i.e. if the sample rate is different than the 
project’s or the resolution is lower than the project setting.

• Use Settings.
No Options dialog will appear when you import. Instead, you can choose to make any 
of the options below the pop-up the standard action(s). Activate any number of the fol-
lowing options to have them performed automatically each time you import audio files:

Creating parts

Parts are containers for MIDI or audio events. If you record MIDI, a 
MIDI part is automatically created, containing the recorded events. 
You can also create empty audio or MIDI parts and later add events to 
them. There are two ways to do this:

• Draw a part on a MIDI or audio track with the Pencil tool.
You can also draw parts by pressing [Alt]/[Option] and using the Arrow tool.

Option Description

Copy Files to Working 
Directory

If files are not already in the project’s audio folder they are 
copied there before being imported.

Convert and Copy to 
Project If Needed

If files are not already in the project’s audio folder they are 
copied there before being imported. Furthermore, if the 
files have a different sample rate or a lower resolution than 
the project settings, they are automatically converted.

Split multi channel files If you import a multi-channel audio file (including two-
channel stereo files), it will be split into a number of mono 
files – one for each channel – which are placed on sepa-
rate, automatically created mono tracks.
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• Double click with the Arrow tool on a MIDI or audio track, between the 
left and right locator.

To add events to a MIDI part, you use the tools and functions in a MIDI 
editor, see the separate PDF document “Working with MIDI”. Adding 
events to audio parts is done in the Audio Part Editor (see page 423) 
by pasting or by using drag and drop.

• You can also gather existing audio events into a part, by using the 
“Events to Part” function on the Audio menu.
This creates an audio part containing all selected audio events on the same track. To 
remove the part and make the events appear as independent objects on the track 
again, select the part and use the “Dissolve Part” function on the Audio menu.

Auditioning audio parts and events

Audio parts and events can be auditioned in the Project window with 
the Speaker tool:

When auditioning, audio will be routed directly to the Audition bus, by-
passing the audio channel’s settings, effects and EQs.

1. Select the Play tool.
Note that the Play tool and the Scrub tool share the same tool button. If the rightmost 
tool icon on the toolbar isn’t a Speaker symbol, first click on the icon to select it, then 
click again and select “Play” from the pop-up menu that appears.

2. Click where you want playback to start, and keep the mouse button 
pressed.
Only the track on which you click is played back, starting at the click position. 

3. Release the mouse button to stop playback.
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Scrubbing

The Scrub tool allows you to locate positions in the audio by playing 
back, forwards or backwards, at any speed:

1. Select the Scrub tool.
Note that the Play tool and the Scrub tool share the same tool button. If the rightmost 
tool icon on the toolbar isn’t a “Scrub symbol”, first click on the icon to select it, then 
click again and select “Scrub” from the pop-up menu that appears.

2. Click at the desired position and keep the mouse button pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played back. The speed 
and pitch of the playback depends on how fast you move the pointer.

You can adjust the responsiveness of the Scrub function in the Pref-
erences dialog (VST page).

• It is also possible to “scrub” the whole project with the Jog wheel on the 
Transport panel.
See page 42.

Editing parts and events

This section describes techniques for editing in the Project window. If 
not explicitly stated, all descriptions apply to both events and parts, 
even though we use the term “event” for convenience.

• When you are using the tools for editing, you can in many cases get ad-
ditional functions by pressing modifier keys (e.g. pressing [Alt]/[Option] 
and dragging with the Arrow tool creates a copy of the dragged event). 
On the following pages, the default modifier keys are described – you can customize 
these in the Preferences dialog on the Editing –Tool Modifiers page (see page 712).



NUENDO
5 – 130 The Project window

Selecting events

Selecting events is done using any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

Note that these functions work differently when the Range Selection 
tool is selected (see page 146).

• Select all events on a track by right-clicking in its Track list and select-
ing “Select All Events” from the pop-up menu that appears.

• You can also use the arrow keys on the computer keyboard, to select 
the closest event to the left, right, above or below.
If you press [Shift] and use the arrow keys, the current selection will be kept, allowing 
you to select several events.

Option Description

All Selects all events in the Project window.

None Deselects all events.

Invert Inverts the selection – all selected events are deselected and 
all events that were not selected are selected instead.

In Loop Selects all events that are partly or wholly between the left 
and right locator.

From Start to Cursor Selects all events that begin to the left of the project cursor.

From Cursor to End Selects all events that end to the right of the project cursor.

Equal Pitch These are available in the MIDI Editors, see the separate PDF 
document “Working with MIDI”.

All on Selected Tracks Selects all events on the selected track.

Select Event This is available in the Sample Editor (see page 401).

Left/Right Selection 
Side to Cursor

These two functions are only used for range selection editing 
(see page 146).
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• If the option “Auto Select Events under Cursor” is activated in the 
Preferences dialog (Editing page), all events on the selected track(s) 
that are “touched” by the project cursor are automatically selected.
This can be helpful when rearranging your project, since it allows you to select whole 
sections (on all tracks) by selecting all tracks and moving the project cursor.

• It is also possible to select ranges, regardless of the event and track 
boundaries.
This is done using the Range Selection tool (see page 146).

Moving events

To move events in the Project window, use the following methods:

• Click and drag to a new position.
All selected events will be moved, maintaining their relative positions. You can only 
drag events to tracks of the same type. If Snap is activated, this determines to which 
positions you can move the events (see page 152).
Note also, that you can restrict movement to be either horizontal or vertical only, by 
holding down [Ctrl]/[Command] while dragging.

You will note that there is a slightly delayed response when you move 
an event by dragging. This helps you avoid accidentally moving events 
when you click on them in the Project window. You can adjust this delay 
with the Drag Delay setting in the Preferences dialog (Editing page).

• Select the event and edit the Start position in the info line.

• Use the “Move to” functions on the Edit menu.
The following functions are available:

Function Description

Move to Cursor Moves the selected event to the project cursor position. If there are 
several selected events on the same track, the first event will start at 
the cursor, and the following will be lined up end-to-start after the 
first one.

Move to Origin Moves the selected events to their original positions, i.e. the posi-
tions at which they were originally recorded.
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• Use the Nudge buttons in the toolbar.
These move the selected events to the left or right. The amount of movement depends 
on the selected display format (see page 111) and the value set on the Grid pop-up 
menu.

Here, clicking this button will move the Event 2 frames to the right.

When the Range Selection tool is used, the Nudge buttons move the se-
lection range (see page 149).

• The Nudge buttons are not visible in the toolbar by default. 
You can decide which items should be visible by right-clicking (Win)/[Ctrl]-clicking 
(Mac) in the toolbar and checking them in the pop-up menu that appears. See page 
678 for more information.

Move to Front,
Move to Back

This function doesn’t actually change the position of the events, but 
moves the selected events to the front or back, respectively. This is 
useful if you have overlapping events, and want to see one that is 
partially obscured.
For audio events, this is an extra important feature, since only the 
visible sections of events will be played back. Moving an obscured 
audio event to front (or moving the obscuring event to back) will al-
low you to hear the whole event on playback.
Note that it is also possible to use the “To Front” function on the 
event context menu for this (although this works in a different way, 
see page 67).

Function Description
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Duplicating events

Events can be duplicated in the following ways:

• Hold down [Alt]/[Option] and drag the event to a new position.
If Snap is activated, this determines to which positions you can copy the events (see 
page 152). 

If you hold down [Ctrl]/[Command] as well, movement direction is re-
stricted to either horizontal or vertical. That means if you drag an event 
vertically it can not be moved horizontally at the same time.

• Audio and MIDI parts can also be duplicated by pressing [Alt]/[Op-
tion] + [Shift] and dragging.
This creates a shared copy of the part. If you edit the contents of a shared copy, all 
other shared copies of the same part are automatically edited in the same way.

Shared copies are indicated by an icon in the right corner of the part.

Note:

• When you duplicate audio events, the copies are always shared. This means 
that shared copies of audio events always refer to the same audio clip (see 
page 361).

• You can convert a shared copy to a real copy by selecting “Convert to Real 
Copy” from the Edit menu. This creates a new version of the clip (that can be 
edited independently) and adds this to the Pool. Note that no new files are 
created by this operation – for that you need to use the “Bounce Selection” 
function from the Audio menu (see page 494).

• Selecting “Duplicate” from the Edit menu creates a copy of the se-
lected event and places it directly after the original.
If several events are selected, all of these are copied “as one unit”, maintaining the rel-
ative distance between the events.

• Selecting “Repeat...” from the Edit menu opens a dialog, allowing you to 
create a number of copies (regular or shared) of the selected event(s).
This works just like the Duplicate function, but you can specify the number of copies.
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• You can also perform the Repeat function by dragging: Select the 
event(s) to repeat, press [Alt]/[Option], click the handle in the lower 
right corner of the last selected event and drag to the right.
The longer to the right you drag, the more copies are created (as shown by the tooltip).

• Selecting “Fill Loop” from the Edit menu creates a number of copies 
starting at the left locator and ending at the right locator.
The last copy is automatically shortened to end at the right locator position.

Using Cut, Copy and Paste

You can cut or copy selected events, and paste them in again, using 
the functions on the Edit menu.

• When you paste an event it is inserted on the selected track, posi-
tioned so that its snap point is aligned with the cursor position.
If the selected track is of the wrong type, the event will be inserted on its original track. 
See page 152 for information about the snap point.

• If you use the “Paste at Origin” function, the event is pasted at its orig-
inal position (the position from which you cut or copied it).

Renaming events

By default, audio events show the name of their clip, but you can enter 
a separate descriptive name for separate events if you like. This is done 
by selecting the event and typing in a new name in the “Description” 
field in the info line or by using the Rename Object command from the 
Edit menu.
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• You can also give all events on a track the same name as the track by 
changing the track name, holding down a modifier key and pressing 
[Return].
See page 121

• The Rename Objects command is useful when renaming multiple 
events at the same time. Select one or more events. Then choose 
“Rename...” from the Edit menu. You have several options for renam-
ing events automatically using sequential numbers, timestamps and 
more (see page 481).

Splitting events

You can split events in the Project window in the following ways:

• Click with the Scissors tool on the event you want to split.
If Snap is activated, this determines the exact split position (see page 152). You can 
also split events by pressing [Alt]/[Option] and clicking with the Arrow tool.

• Select “Split at Cursor” from the Edit menu.
This splits the selected events at the position of the project cursor. If no events are se-
lected, all events (on all tracks) that are intersected by the project cursor will be split.

• Select “Split Loop” from the Edit menu.
This splits events on all tracks at the left and right locator positions.

• If you split a MIDI part so that the split position intersects one or several 
MIDI notes, the result depends on the option “Split MIDI Events” in the 
Preferences dialog (Editing page). 
If the option is activated, the intersected notes will be split (creating new notes at the 
beginning of the second part). If it is deactivated, the notes will remain in the first part, 
but “stick out” after the end of the part.

Gluing events together

Clicking on an event with the Glue Tube tool glues it together with the 
next event on the track. The result is a part containing the two events, 
with one exception:

• If you first split an event and then glue the two sections together again 
(without moving or editing them first), they become a single event again.
In other words, gluing can create a single event if the two events are lined up end to 
start and play a continuous section of the same clip.
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Resizing events

Resizing events means to move their start or end positions individu-
ally. In Nuendo, there are three types of resizing:

To select one of the resizing modes, select the Arrow tool and then 
click again on the Arrow tool icon on the toolbar. This opens a pop-up 
menu from which you can select one of the resizing mode options.

The icon on the toolbar will change, indicating the selected resizing mode.

Resizing type Description

Normal Sizing The contents of the event stay fixed, and the start or 
end point of the event is moved to “reveal” more or 
less of the contents.

Sizing Moves Contents The contents follow the moved start or end of the 
event (see the figure below).

Sizing Applies Time Stretch The contents will be time stretched to fit the new event 
length (see the separate description on page 138).
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The actual resizing is done by clicking and dragging the lower left or 
right corner of the event. If Snap is activated, the Snap value deter-
mines the resulting length (see page 152).

Normal sizing.

Sizing moves contents.

• If several events are selected, all will be resized in the same way.

• You can also resize events with the Scrub tool.
This works just the same as when resizing with the Arrow tool, but the audio under the 
pointer is played back (scrubbed) while you drag.



NUENDO
5 – 138 The Project window

• It is also possible to resize events by using the Trim buttons (located 
in the Nudge palette) on the toolbar.
This will move the start or end position of the selected Event(s) by the amount set on 
the Grid pop-up menu. The sizing type currently selected applies to this method too, 
with the exception of “Sizing Applies Time Stretch” which is not possible with this 
method. You can also use key commands for this (by default, press [Ctrl]/[Command] 
and use the left and right arrow key).

• Note that the Nudge palette is not visible in the toolbar by default. See 
page 678 for instructions on how to show and hide items in the toolbar.

Resizing events using time stretch

If you want to resize a part and make its contents “fit” the new size, 
you should use this option. Proceed as follows:

1. Click the Arrow icon on the toolbar and select the “Sizing Applies 
Time Stretch” option from the pop-up menu.

2. Point close to the end point of the part you want to stretch.
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3. Click and drag left or right.
When you move the mouse, a tooltip information shows the current mouse position 
and length of the part. Note that the snap value applies, as with any part operation.

4. Release the mouse button.
The part is “stretched” or “compressed” to fit the new length.

• For MIDI parts, this means that the note events are stretched (moved 
and resized).
Controller data will be moved.

• For audio parts, this means that the events are moved, and that the 
referenced audio files are time stretched to fit the new length.
A dialog box shows the progress of the time stretch operation.

• You can adjust which algorithm should be used for the time stretch algo-
rithm on the Preferences page (Editing–Audio–Time Stretch Tool page).
For more information about time stretch, see page 381.

Sliding the contents of an event or part

You can move the contents of an event or part without changing its 
position in the Project window. By default, this is done by pressing 
[Ctrl]/[Command]+[Alt]/[Option], clicking in the event or part and 
dragging to the left or right.

When sliding the contents of an audio event, you cannot slide past the 
start or end of the actual audio clip. If the event plays the whole clip, you 
cannot slide the audio at all.
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Grouping Events

Sometimes it is useful to treat several events as one unit. This can be 
done by grouping them: Select the events (on the same or different 
Tracks) and select “Group” from the Edit menu.

Grouped events are indicated by a group icon in the right corner.

If you edit one of the grouped events in the Project window, all other 
events in the same group are affected too (if applicable). Group edit-
ing operations include:

• Selecting events.
• Moving and duplicating events.
• Resizing events.
• Adjusting fade-in and fade-out (audio events only, see page 186).
• Splitting events (splitting one event will automatically split any other grouped 

events that are intersected by the split position).
• Locking events.
• Muting events (see below).
• Deleting events.

Locking events

If you want to make sure you don’t edit or move an event by accident, 
you can lock it. Locking can affect one (or any combination) of the fol-
lowing properties:

Lock Options Description

Position If this is locked, the event cannot be moved.

Size If this is locked, the event cannot be resized.

Other If this is locked, all other editing of the event is disabled. This in-
cludes adjusting the fades and event volume, processing, etc.



NUENDO
The Project window 5 – 141

• To specify which of these properties should be affected by the Lock 
function, use the “Lock Event Attributes” pop-up menu in the Prefer-
ences dialog (Editing page).

• To lock events, select them and select “Lock...” from the Edit menu.
The events will be locked according to the options specified in the Preferences dialog.

• You can adjust the lock options for a locked event by selecting it and 
selecting “Lock...” from the Edit menu again.
This opens a dialog in which you can activate or deactivate the desired lock options.

• To unlock an event (turn off all lock options), select it and select “Un-
lock” from the Edit menu.

• It is also possible to lock a whole track, by clicking the padlock symbol 
in the Track list or in the Inspector.
This disables all editing of all events on the track.

The padlock symbol indicates that 
one or more of the lock options are 
activated for the event.
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Muting events

To mute individual events in the Project window, proceed as follows:

• To mute or unmute a single event, click on it with the Mute tool.

• To mute or unmute several events, select them – either by using the 
standard selection techniques, or by using one of the options on the 
Edit–Select submenu – and click on one of the selected events with 
the Mute tool.
All selected events will be muted.

• You can also click in an empty area with the Mute tool and drag a se-
lection rectangle around several events you want to mute or unmute, 
and then click on one of them with the Mute tool.

• You can mute events by selecting them and selecting “Mute” from the 
Edit menu.
Similarly, you can unmute the selected events by selecting “Unmute” from the Edit 
menu.

• You can also change the mute status of selected events on the info line.

Muted events can be edited as usual (with the exception of adjusting 
fades), but are not played back.

Muted events are “greyed out”.

• You can also mute whole tracks by clicking the Mute (“M”) button in 
the Track list, the Inspector or the mixer.
Clicking the Solo (“S”) button for a track mutes all other tracks. Note that there are two 
modes for the track solo function: 
If the option “Enable Solo on Selected Track” is activated in the Preferences dialog 
(Editing page) and you have soloed a track, selecting another track in the track list will 
automatically solo that track instead – the solo state “moves” with the track selection.
If the option isn’t activated, the track you solo stays soloed, regardless of the selection.
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Removing events

To remove an event from the Project window, use any of the following 
methods:

• Click on the event with the Eraser tool.
Note that if you press [Alt]/[Option] while you click, all following events on the same 
track will be deleted, but not the event you clicked and all events before it.

• Select the event(s) and press [Backspace], or select “Delete” from 
the Edit menu.

Creating new files from events

As described in the Getting Started book, an audio event plays a sec-
tion of an audio clip, which in turn refers to one or more audio files on 
the hard disk. However, in some situations you may want to create a 
new file that consists only of the section played by the event. This is 
done with the function “Bounce Selection” on the Audio menu:

1. Select one or several audio events.

2. Set up fade in, fade out and event volume (on the info line or using the 
volume handle) as desired.
These settings will be applied to the new file. For details on fades and event volume, 
see page 186.

3. Select “Bounce Selection” from the Audio menu.
You are asked whether you want to replace the selected event or not.

• If you click “Replace”, a new file is created, containing only the audio 
in the original event. A clip for the new file is added to the Pool, and 
the original event is replaced by a new event playing the new clip.

• If you click “No” a new file is created and a clip for the new file is 
added to the Pool.
The original event is not replaced.

You can also apply the Bounce Selection function to an audio part. In 
that case, the audio from all events in the part will be combined into a 
single audio file. If you choose “Replace” when asked, the part will be 
replaced with a single audio event playing a clip of the new file.
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Editing in Lane Display mode

When you are recording in Stacked cycle recording mode, each take 
ends up on a separate lane on the track as described on page 70 and 
page 82. However, you can also select this lane mode manually for in-
dividual tracks, and use it when editing in the Project window. This 
makes it easier to view and handle overlapping events and parts.

Audio tracks

1. Make sure the Lane Display Type button is visible in the track list.
If it is hidden, you need to select Track Controls Settings from the context menu for the 
track and add the Lane Display Type item in the dialog that appears.

2. Click the Lane Display Type button and select “Lanes Fixed” from the 
pop-up menu that appears.
The audio track is divided vertically into two lanes. By default, all audio events end up 
in the first (top) lane.

3. Now you can move events or parts between lanes, either by dragging 
or by using the “Move to Next Lane/Previous Lane” commands on the 
Edit menu or Quick menu.
Note that if there are overlapping audio events, the audio on the lowest lane has play-
back priority – moving events between lanes affects what will be heard!

If the vertical zoom factor is sufficiently high, the sections that will be heard on 
playback are indicated in green.
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• Note that there will always be an extra, empty lane at the bottom of the 
track – if you move an event there, another lane will always be added.
Depending on the number of lanes used, you may want to adjust the vertical zoom for 
the track – simply drag the track edges in the track list.

4. After rearranging the overlapping events so that you hear what you 
want, you can select all events and select “Delete Overlaps” from the 
Advanced submenu on the Audio menu.
This puts all events in the top lane and resizes events so that overlapping sections are 
removed.

5. To turn off Lanes mode, select “Lanes Off” from the Lane Display 
Type pop-up menu.
If you do this without using the “Delete Overlaps” function, all overlapping sections will 
be kept. However, the sections that were green will now be the sections visible (“on 
top”) and thus the sections that will be heard.

MIDI tracks

1. Make sure the Lane Display Type button is visible in the track list.
If it is hidden, you need to select Track Controls Settings from the context menu for the 
track and add the Lane Display Type item in the dialog that appears.

2. Click the Lane Display Type button and select “Lanes Auto” or “Lanes 
Fixed”.

• In Lanes Auto mode, extra lanes will automatically be added where 
necessary – if two MIDI parts overlap, they will automatically be put on 
separate lanes.

• In Lanes Fixed mode, you have to move MIDI parts between lanes 
manually (by dragging them or by using the “Move to Next Lane/Previ-
ous Lane” commands on the Edit menu or Quick menu).
In this mode, there will always be an extra, empty lane at the bottom of the track – if you 
move a part there, another lane will be added and so on.
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3. You can edit the overlapping parts as usual – by cutting, deleting or 
muting sections in the Project window or by opening them in a MIDI 
editor.
In an editor, parts on different lanes will be treated just like parts on different tracks – 
you can use the part list pop-up menu to select an active part for editing, etc. 
Note that there is no playback priority between lanes on a MIDI track – all unmuted 
parts will be heard during playback.

4. To merge all overlapping parts into one, make sure the MIDI track is 
selected, position the left and right locator around the parts and select 
“Merge MIDI in Loop” from the MIDI menu.
In the dialog that appears, activate the Erase Destination option and click OK. This 
merges all unmuted MIDI between the locators to a single part.

5. To turn off Lanes mode, select “Lanes Off” from the Lane Display 
Type pop-up menu.

Range editing

Editing in the Project window isn’t necessarily restricted to handling 
whole events and parts. You can also work with selection ranges, 
which are independent from the event/part and track boundaries.

Creating a selection range

To make a selection range, drag with the Range Selection tool.

When the Range Selection tool is selected, the Select submenu on 
the Edit menu has the following items for making selection ranges:

Option Description

All Makes a selection that covers all tracks, from the start of the 
project to the end (as defined by the Length setting in the 
Project Setup dialog).

None Removes the current selection range.

Invert Only used for event selection (see page 130).

In Loop Makes a selection between the left and right locator, on all 
tracks.
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• Double clicking on an event with the Range Selection tool creates a 
selection range encompassing the event.
If you hold down [Shift] you can double click several events in a row, and the selection 
range will expand to encompass them all. Double clicking a second time on an event 
opens it for editing in the Sample Editor.

Adjusting the size of the selection range

You can adjust the size of a selection range in the following ways:

• By dragging its edges.
The pointer takes the shape of a double arrow when you move it over an edge of the 
selection range.

• By holding down [Shift] and clicking.
The closest selection range edge will be moved to the position at which you clicked.

• By adjusting the selection range start or end position on the info line.

From Start to Cursor Makes a selection on all tracks, from the start of the project to 
the project cursor.

From Cursor to End Makes a selection on all tracks, from the project cursor to the 
end of the project.

All on Selected Tracks Only used for event selection (see page 130).

Select Event This is available in the Sample Editor (see page 410).

Left Selection Side 
to Cursor

Moves the left side of the current selection range to the project 
cursor position.

Right Selection Side 
to Cursor

Moves the right side of the current selection range to the 
project cursor position.

Option Description
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• By using the Trim buttons on the toolbar.
The left Trim buttons will move the start of the selection range and the right buttons will 
move the end. The edges will be moved by the amount specified on the Grid pop-up.

This Trim button will move the end of the selection range to the right by 1 beat.

• By using the Nudge buttons on the toolbar.
These will move the whole selection range to the left or the right. The amount of move-
ment depends on the selected display format (see page 111) and the value specified 
on the Grid pop-up menu.

Note that the contents of the selection are not moved – using the Nudge 
buttons is the same as adjusting the start and end of the selection range 
at the same time, by the same amount.

• The Trim buttons and the Nudge buttons are located in the Nudge pal-
ette, which is not visible in the toolbar by default. 
See page 678 for instructions on how to show and hide items in the toolbar.
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Making selection ranges for several non-contiguous tracks

As described above, selection ranges can cover several tracks. How-
ever, it is also possible to exclude tracks from a selection range:

1. Create a selection range from the first to the last desired track.

2. Press [Ctrl]/[Command] and click in the selection range on the tracks 
you want to exclude from the selection.

3. In the same manner, you can add a track to the selection range by 
[Ctrl]/[Command]-clicking in the selection range area on the track.

Moving and duplicating

• To move a selection range, click and drag it to a new position.
This will move the contents of the selection range to the new position. If the range in-
tersected events or parts, these will be split before moving, so that only the sections 
within the selection range are affected.

• To duplicate a selection range, hold down [Alt]/[Option] and drag.
You can also use the Duplicate, Repeat and Fill Loop functions, just as when duplicat-
ing events (see page 133).
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Using Cut, Copy and Paste

When working with selection ranges, you can either use Cut, Copy 
and Paste on the Edit menu, or use the functions “Cut Time” and 
“Paste Time” on the Range submenu on the Edit menu. These work 
differently to their related functions on the Edit menu:

Deleting selection ranges

Again, you can either use “regular” Delete or “Delete Time”:

• If you use the Delete function on the Edit menu (or press [Backspace]), 
the data within the selection range is replaced by empty track space.
Events to the right of the range keep their position.

• If you use “Delete Time” on the Edit menu’s Range submenu, the se-
lection range is removed and events to the right are moved to the left 
to close up the gap.

Function Description

Cut Cuts out the data in the selection range and moves it to the 
Clipboard. The selection range is replaced by empty track 
space in the Project window, meaning that events to the right 
of the range keep their positions.

Copy Copies the data in the selection range to the clipboard.

Paste Pastes the clipboard data at the start position and track of the 
current selection. Existing events are not moved to make room 
for the pasted data.

Paste at Origin Pastes the clipboard data back at its original position. Existing 
events are not moved to make room for the pasted data.

Cut Time Cuts out the selection range and moves it to the Clipboard. 
Events to the right of the removed range are moved to the left 
to fill out the gap.

Paste Time Pastes the clipboard data at the start position and track of the 
current selection. Existing events are moved to make room for 
the pasted data.

Paste Time at Origin Pastes the clipboard data back at its original position. Existing 
events are moved to make room for the pasted data.



NUENDO
The Project window 5 – 151

Other functions

On the Range submenu on the Edit menu, you will find three more 
range editing functions:

Region operations

Regions are sections within a clip, with various uses. While regions 
are perhaps best created and edited in the Sample Editor (see page 
414), the following region functions are available on the Audio menu 
in the Project window: 

Function Description

Split Splits any events or parts that are intersected by the selection 
range, at the positions of the selection range edges.

Crop All events or parts that are partially within the selection range are 
cropped, that is, sections outside the selection range are re-
moved. Events that are fully inside or outside the selection range 
are not affected.

Insert Silence Inserts empty track space from the start of the selection range. 
The length of the silence equals the length of the selection range. 
Events to the right of the selection range start are moved to the 
right to “make room”. Events that are intersected by the selection 
range start are split, and the right section is moved to the right.

Function Description

Event or Range as 
Region

This function is available when one or several audio events 
or selection ranges are selected. It creates a region in the 
corresponding clip, with the start and end position of the re-
gion determined by the start and end position of the event 
or selection range within the clip.

Events from Regions This function is available if you have selected an audio event 
whose clip contains regions within the boundaries of the 
event. The function will remove the original event and re-
place it with event(s) positioned and sized according to the 
Region(s).
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Options

Snap

The Snap function helps you to find exact positions when editing in 
the Project window. It does this by restricting horizontal movement 
and positioning to certain positions. Operations affected by Snap in-
clude moving, copying, drawing, sizing, splitting, range selection, etc.

• You turn Snap on or off by clicking the Snap icon in the toolbar.

Snap activated.

• When you are moving audio events with Snap activated, it isn’t neces-
sarily the beginning of the event that is used as Snap position reference. 
Instead, each audio event has a snap point, which you can set to a rele-
vant position in the audio (such as a downbeat, etc.).
The snap point is preferably set in the Sample Editor since it will allow for a higher de-
gree of precision (see page 408). You can however also set the snap point directly in 
the Project window, in the following way: 

1. Select an event.

2. Place the project cursor at the desired position within the selected 
audio event.

3. Pull down the Audio menu and select “Snap Point To Cursor”.
The snap point is set at the cursor position.

The snap point for an event is displayed as a blue line in the Project window.
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Exactly how Snap works depends on which mode is selected on the 
Snap mode pop-up menu.

The following sections describe the different Snap modes:

Grid

In this mode, the Snap positions are set with the Grid pop-up menu to 
the right. The options depend on the display format selected for the 
ruler. For example, if the ruler is set to show bars and beats, the grid 
can be set to bars, beats or the quantize value set with the next pop-up 
menu to the right. If a time- or frame-based ruler format is selected, the 
grid pop-up menu will contain time- or frame-based grid options, etc.

When seconds is selected as ruler format, the grid pop-up menu contains time-
based grid options.

Grid Relative

When you move events and parts in this mode they will not be “mag-
netic” to the grid. Rather, the grid determines the step size for moving 
the events. This means that a moved event will keep its original posi-
tion relative to the grid.

For example, if an event starts at the position 3.04.01 (one beat be-
fore bar 4), Snap is set to Grid Relative and the Grid pop-up is set to 
“Bar”, you can move the event in steps of one bar – to the positions 
4.04.01, 5.04.01 and so on. The event will keep its relative position to 
the grid, i.e. stay one beat before the bar lines.
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• This only applies when dragging existing events or parts – when you 
create new events or parts this mode works like the Grid mode.

Events

In this mode, the start and end positions of other events and parts be-
come “magnetic”. This means that if you drag an event to a position 
near the start or end of another event, it is automatically aligned with 
the start or end of the other event. For audio events, the position of the 
snap point is also magnetic (see page 408).

• Note that this includes marker events on the marker track.
This allows you to snap events to marker positions, and vice versa.

Shuffle

Shuffle mode is useful when you want to change the order of adjacent 
events. If you have two adjacent events and drag the first one to the 
right, past the second event, the two events will change places.

The same principle works when changing the order of more than two 
events:

Magnetic Cursor

When this mode is selected, the project cursor becomes “magnetic”. 
Dragging an event near the cursor causes the event to be aligned with 
the cursor position.

1 2 3 4 5

52431

Dragging event 2 past event 4...

...changes the order of events 2, 3 and 4.
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Grid + Cursor

This is a combination of the “Grid” and “Magnetic Cursor” modes.

Events + Cursor

This is a combination of the “Events” and “Magnetic Cursor” modes.

Events + Grid + Cursor

This is a combination of the “Events”, “Grid” and “Magnetic Cursor” 
modes.

Snap to Zero Crossing

When this option is activated in the Preferences dialog (Editing–Au-
dio page), splitting and sizing of audio events is done at zero cross-
ings (positions in the audio where the amplitude is zero). This helps 
you avoid pops and clicks which might otherwise be caused by sud-
den amplitude changes.

This setting affects all windows in all open projects – with the exception 
of the Sample Editor (which has its own Snap to Zero Crossing button).

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will scroll during 
playback, keeping the project cursor visible in the window.

• If the option “Stationary Cursor” is activated in the Preferences dialog 
(Transport page), the project cursor will be positioned in the middle of 
the screen (if possible).
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Introduction

The play order track allows you to work with sections of your project in 
a non-linear fashion. By marking sections of the project as play order 
parts and then ordering these parts in a list, adding repeats as desired, 
you can specify exactly how the project should be played back.

This offers a different and more pattern-oriented way of working which 
complements the usual linear editing methods in the Project window. 
When you have created a play order list that you like, you have the op-
tion of “flattening” the list, which creates a normal linear project accord-
ing to the play order list and removes the play order track.
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Setting up the play order track

You create a play order track by using the Add Track function on the 
Project menu or Quick menu, as usual. There can only be one play or-
der track in each project.

On the play order track, you define specific sections of the project by 
creating play order parts. These can be of any length, may overlap and 
are not bound to the start or end of existing events and parts.

• Use the Pencil tool to draw play order parts.
Snap applies as usual.

• Double click between the locators to create a part between the left 
and right locator.

The play order track with two parts.

The parts will initially be named “A”, “B”, “C”, and so on. You can re-
name a part by selecting it and changing its name in the Project win-
dow infoline or by holding [Alt]/[Option], double clicking on the name 
in the play order list and entering a new one.

Parts can be moved, resized and deleted using the standard tech-
niques. Please note:

• If you copy a play order part (by [Alt]/[Option]-dragging or by using 
copy/paste), a new part will be created, with the same name as the 
original.
It is however totally independent from the original part.

• Double clicking on a play order part adds it to the current play order 
list.
This is described on the following pages.
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Creating a play order

• You can set up a play order in the Play Order Editor or in the Inspector 
for the play order track.
The text below describes the Play Order Editor – the settings in the Inspector are sim-
ilar, but functions that are available with toolbar buttons in the editor are accessed from 
the Play Order menu in the Inspector.

To open the Play Order Editor, click the “e” button in the track list or 
Inspector for the play order track.
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Adding parts to the play order

The editor contains two lists: the available play order parts are listed 
to the right and the actual play order list is shown to the left. The play 
order list shows in which order the parts should be played back, from 
top to bottom. Initially the play order list will be empty – you set up the 
play order by adding parts from the right list to the play order list:

• Drag and drop play order parts from the right list to the left list.
A blue insertion line shows you where the dragged part will end up in the list.

• Drag and drop play order parts from the Project window to the play 
order list shown in the Inspector.

• Double clicking on a part in the right list adds it to the left list, above 
the currently selected part.

• Double clicking on a play order part in the Project window adds it to 
the play order list shown in the Inspector.

• If no part is selected in the play order list, double-clicking on a part 
adds it to the end of the play order list.

• If a part is selected in the play order list, double-clicking on a part in-
serts it above the selected part.

• If a part is selected in the right list, right-clicking (Windows) or [Ctrl]-
clicking (Mac) on it and selecting “Append Selected In Play Order” 
adds it to the play order list.

Editing the play order

In the play order list to the left you can do the following:

• Select parts by clicking or [Shift]-clicking in the usual way.
The selected parts do not have to be a continuous selection.

• Drag parts to move them in the list.
• Drag parts while holding [Alt]/[Option] to create copies of the selected items.

The insert location for both move and copy operations is shown with a blue or red line 
in the list. A blue line indicates that the move or copy is possible; a red line indicates 
that if the current position was to be used, a move or copy is not allowed.

• Use the Repeats column to specify how many times each part should be re-
peated.
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• Click the arrow to the left of a part to move the playback position to the start 
of that part.

• To remove a part from the list, right-click (Windows) or [Ctrl]-click (Mac) on it 
and select “Remove Touched” from the pop-up menu that appears. To remove 
several parts, select them, right-click (Windows) or [Ctrl]-click (Mac) and se-
lect “Remove Selected”.

Managing play orders

You can create several play order lists. Typically, you would use this 
feature to create alternative versions for playback. The buttons on the 
right part of the editor toolbar are used for this:

The play orders you create will be listed on the pop-up menu to the 
left of the buttons. However, to select another play order from the 
pop-up menu, you need to activate play order mode – see below.

Button Description

Click this to rename the current play order.

Creates a new, empty play order.

Creates a duplicate of the current play order, containing the same parts.

Removes the currently selected play order. Only available if you have created 
more than one play order.



NUENDO
The play order track 6 – 163

Playing back the play order

To play back, you must first activate Play Order mode. This is done by 
clicking the Activate Play Order Mode button in the editor or in the 
track list.

• You can also have the play order controls shown in the Transport 
panel.
For details on how to show or hide Transport panel controls, see page 676.

Now you can click the Start button in the Play Order Editor or the 
Transport panel to start playback.

Navigating

To navigate between play order parts, you use the play order transport 
buttons:

In the Play Order Editor the part that is currently played back is indi-
cated by the arrow in the leftmost column, and the indicators in the 
Counter column. You can switch between play orders during play-
back using the pop-up menu in the editor, Inspector or track list.

First repeat of current Play Order ItemPrevious Play Order Item

Next Play order Item Last repeat of current Play Order Item
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Flattening the play order

When you have found a play order that suits your purposes, you can 
“flatten” it. Clicking the Flatten Play Order button (or selecting Flatten 
Play Order from the pop-up menu in the Inspector for the play order 
track) does the following:

• The events and parts in the project are reordered, repeated, resized, moved 
and/or deleted, so that they correspond exactly to the play order.

• Play Order mode is deactivated.
• The play order track is removed.

The project will now play back exactly as in Play Order mode, but you 
can view it and work with it as usual.

• Flattening the play order may remove events and parts from the project 
(if these are not within the boundaries of any used play order part).

• Only use the Flatten function when you know you don’t want to edit the 
play order any more.
When in doubt, save a copy of the project before flattening the play order.
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About folder tracks

Just as the name implies, a folder track is a folder that contains other 
tracks. Moving tracks into a folder is a way to structure and organize 
tracks in the Project window. For example, grouping several tracks in a 
folder track makes it possible for you to “hide” tracks (thus giving you 
more working space on the screen). You can solo and mute several 
tracks in a quicker and easier way, and perform editing on several tracks 
as one entity. Folder tracks can contain any type of track including other 
folder tracks. 

A folder track

Tracks in the 
folder
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Handling folder tracks

Creating a folder track

Folder tracks are created just like any other track: Select “Add Track” 
from the Project menu and select “Folder” from the submenu that ap-
pears.

Moving tracks into a folder

You can move any type of track into a folder by using drag and drop:

1. In the Track list, click on a track that you want to move into a folder, 
and drag it onto a folder track.
A green arrow pointing to a folder appears when you drag the track onto the folder 
track in the list.

2. Release the mouse button.
The track is now placed in the folder track, and all parts and events on the track will be 
represented by a corresponding folder part (see page 169), that is a graphical repre-
sentation of all parts and events in the folder.

Since you can move any type of track into a folder track, it is possible 
to create sub-folders by moving one folder track into another. This is 
called “nesting”. For example, you could have a folder containing all 
the vocals in a project, and each vocal part could have a nested folder 
containing all the takes, in a subfolder for easier handling etc.



NUENDO
7 – 168 Folder tracks

Removing tracks from a folder

To remove a track from a folder, simply drag it out of the folder and re-
lease it in the Track list.

Hiding/showing tracks in a folder

You can hide or show the tracks located in a folder by clicking on the 
“Show/Hide” button (the plus sign) in the Track list for the folder track. 
Hidden tracks are still played back as usual.

When a folder is “closed” this way, the folder part(s) still give you a 
graphic representation of the parts and events within the folder.

Muting and soloing folder tracks

One of the main advantages of using folder tracks is that they provide 
you with a way to mute and solo several tracks as one unit. Muting and 
soloing a folder track affects all tracks in the folder. You can also solo 
or mute individual tracks in the folder. 

Muting a folder track

You can mute a folder track (and thereby mute all tracks within it) the 
same way you mute other tracks by clicking in the Mute (“M”) button 
in the Track list.

Soloing a folder track

You can solo a folder track (and thereby mute all tracks outside the 
folder) the same way you solo other tracks, by selecting it and clicking 
the Solo button.

Soloing or muting tracks within a folder

This can be done by showing the tracks in the folder and using the 
Mute and Solo buttons in the Track list as usual for any tracks inside 
the folder.
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Working with folder parts

A folder part is a graphic representation of events and parts on the 
tracks in the folder. Folder parts indicate the position and length of the 
events and parts, as well as on which track they are (their vertical po-
sition). If part colors are used, these are also shown in the folder part.

Folder parts are created automatically when there are parts or events 
on the tracks within the folder. The following rules apply:

• If there is a gap between parts/events on the tracks, there will be two 
separate folder parts.

• Parts or events that overlap within the folder may be represented by 
the same folder part or by two different folder parts – depending on 
how much they overlap.
If a part/event overlaps by half its length or less it will be placed in a new folder part.

The MIDI part overlaps the audio events by more than half its length, which means 
it is included in the same folder part.
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If you move the MIDI part slightly to the right, the overlap is less than half its length. 
This means a new folder part is created.

Handling and editing folder parts

Any Project window editing you perform to a folder part affects all its 
contained events and parts (those elements on the track within the 
folder that are represented by the folder part). You can select several 
folder parts if you like – this allows you to handle and edit them to-
gether. The editing you can perform includes:

• Moving a folder part. This will move its contained events and parts (possibly 
resulting in other folder parts, depending on how the parts overlap).

• Using cut, copy and paste.
• Deleting a folder part. This will delete its contained events and parts.
• Splitting a folder part with the Scissors tool (see the example below).
• Gluing folder parts together with the Glue tube tool. This will only work if the 

adjacent folder parts contain events or parts on the same track.
• Resizing a folder part resizes the contained events and parts according to the 

selected resizing method. This is set by clicking the Arrow tool icon on the 
toolbar and selecting either “Normal Sizing” or “Sizing Moves Contents” from 
the pop-up menu – see page 136. The third option on the pop-up, “Sizing 
Applies Time Stretch” cannot be used to resize folder parts.

• Muting a folder part. This will mute its contained events and parts.

In short, most of the editing you can do in the Project window applies 
to folder parts as well.
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An example

Editing tracks within folder parts

Tracks inside a folder can be edited as one entity, by performing the 
editing directly on the folder part containing the tracks as explained 
above. You can also edit individual tracks within the folder, by show-
ing the contained tracks, selecting parts and opening editors as usual.

Double clicking a folder part opens the editors for the corresponding 
track classes present in the folder. The following applies:

• All MIDI parts located on the tracks within the folder are displayed as 
if they were on the same track, just like when opening the Key Editor 
with several MIDI parts selected.
To be able to easily discern the different tracks in the editor, give each track a different 
color in the Project window and use the “Part Colors” option in the editor (see the 
chapter “MIDI Editing” in the separate PDF document “Working with MIDI”).

• If the folder contains tracks with audio events and/or audio parts, the 
Sample and/or Audio Part Editors are opened, with each audio event 
and audio part in a separate window.

Splitting the folder part with the Scissors tool...

...will split all contained parts or events 
present at that position.
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About markers

Markers are used to quickly locate any position. If you often find your-
self jumping to a specific position, you can set up that position as a 
marker. There are two types of markers: 

• Cycle markers, which allow you to store the start and end positions of a 
range. 

• Standard markers which store a specific position. 

Markers can be created and edited in several ways: 

• By using the Marker window (see below).
• By using the Marker track (see page 178).
• By using key commands (see page 182).
• By using the Project Browser (see page 183).

• The left and right locators are handled separately – see page 40.

The Marker window

In the Marker window you can perform most editing operations con-
cerning markers. Markers are displayed sequentially starting from the 
top of the window in the order that they occur in the project. Most 
functions in the Marker window are also available in the Inspector 
when the Marker track is selected.

To open the Marker window, select “Markers” from the Project menu, 
click the “Show” button in the Marker section on the Transport panel 
or use the key command (by default [Ctrl]/[Command]-[M]).
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The Marker window columns

The Marker window is divided into six columns which are used for per-
forming the following operations:

• The leftmost column is the Locate column. 
Clicking in this column will move the project cursor to the corresponding Marker posi-
tion. A blue arrow indicates the Marker at the project cursor position (or the closest 
marker before the project cursor).

• The ID column is used to edit marker ID-numbers. 
See page 176.

• The Position column displays the markers’ time positions (or start positions 
for cycle markers).
The marker positions can be edited directly in this column.

• The End and Length columns display the end positions and length of cycle 
markers – see page 178.
These values can also be edited directly in the respective column.

• The Description column lets you enter names or descriptions for markers.

Click on a column heading to sort the marker list by that column. The 
Marker columns can also be reordered.

Adding and removing markers in the Marker window

You add position markers (in Stop mode, during playback or during 
recording) by clicking the Add button or by pressing [Insert] on the 
computer keyboard. Markers are always added at the current project 
cursor position. 

• To add a cycle marker, select “Cycle Markers” from the Show pop-up 
menu and click the Add button.
This adds a cycle marker between the left and right locator. You can also draw cycle 
markers on the Marker track (see page 179).

• To remove a marker, select it and click the Remove button.
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Moving marker positions in the Marker window

The Move button in the Marker window can be used to “reprogram” 
marker positions. Proceed as follows:

1. Set the project cursor to the position to which you want to move (or 
re-program) a marker.

2. Select the marker which you want to change in the Marker window.
Do not select the marker by clicking in the leftmost column, as this will move the 
project cursor you set up in the previous step.

• If a cycle marker is selected, the Move operation affects the cycle 
marker start position.
The length of the range is not affected.

3. Click the Move button.

You can also move markers by editing their position numerically in the 
Position column.

About marker ID-numbers

Each time you add a marker it is automatically and sequentially as-
signed an ID-number, starting from ID 1 and onwards. ID numbers 
can be changed at any time if needed – this allows you to assign 
specific markers to key commands (see below). 

IDs for cycle markers are shown in brackets and start from [1]. These 
may also be changed, for the same reason.

Assigning markers to key commands

As explained earlier, marker ID-numbers are assigned automatically 
and sequentially each time you add a marker. The nine first markers 
(1-9) can be recalled by using key commands – by default these are 
[Shift]-[1] to [9] on the typewriter part of the keyboard. This means 
that even if you have more than nine markers, you cannot use key 
commands to navigate to markers numbered 10 or higher.

If you want to keep all current markers, but want to specify which 
markers should be accessed with key commands, the solution is to 
reassign the marker ID-numbers. Proceed as follows:
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1. First decide which of the current markers with an ID between 1 and 9 
you want to reassign to a new ID-number, and thus remove its key 
command assignment.
Memorize the ID-number.

2. Type in this ID-number in the ID column of the marker you want to ac-
cess with a key command and press enter.
The two marker ID-numbers are switched, and the key commands now locates to the 
marker selected in this step.

3. Repeat as necessary for other markers.

• You can also simply remove a marker with an ID-number between 1 to 
9 to free up a key – see page 175.

• For more about marker key commands, see page 182.
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Using the Marker track

The Marker track is used for viewing and editing markers. Markers 
shown on the Marker track are exactly the same as shown in the Marker 
window, and any changes made on the Marker track are reflected in the 
Marker window and vice versa. Standard position markers in the Marker 
track are shown as marker events, vertical lines with the marker name (if 
assigned) and number beside it. If you select the Marker track, all mark-
ers are shown in the Inspector, much like in the Marker window.

About cycle markers

Cycle markers are shown on the Marker track as two markers bridged 
by a horizontal line. Cycle markers are ideal for storing sections of a 
project. By setting cycle markers for sections of a song, for example 
“Intro”, “Verse”, “Chorus” etc., this enables you to quickly navigate to 
the song sections, and also to optionally repeat the section (by acti-
vating Cycle on the Transport panel). 

In addition, Cycle markers appear on the horizontal Zoom pop-up menu 
in the Project window. If you select a Cycle marker from the pop-up 
menu, the screen is automatically zoomed to encompass the Cycle 
marker range.

Opening the Marker track

To open the Marker track, select “Marker” from the Project menu – 
Add Track submenu. You can only have one Marker track in a project.

MarkersMarkers Cycle marker Locators
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Editing markers on the Marker track

The following basic editing functions can be performed directly on the 
Marker track:

• Adding position markers “on the fly”.
Use the [Insert] key or the “Add Marker” button in the Track list for the Marker track to 
add position markers at the current cursor position during playback. 

• Adding a cycle marker at the left and right locator positions.
Clicking the “Add Cycle Marker” button in the Track list for the Marker track adds a cycle 
marker spanning the area between the left and right locator.

• Selecting markers.
You can use standard selection techniques like dragging to make a selection rectangle 
or using [Shift] to select separate markers.

• Drawing position markers.
By clicking with the Pencil tool (or pressing [Alt]/[Option] and clicking with the Arrow 
tool), you can create or “draw” position marker events at any position on the track. If 
snap is activated on the toolbar, this determines at which positions you can draw 
markers.

• Drawing cycle markers.
To draw a cycle marker range, you press [Ctrl]/[Command] and use the Pencil tool or 
the Arrow tool. Snap settings are applied if activated. 

Cycle markers can freely overlap. 

Add Marker/Add Cycle Marker buttons



NUENDO
8 – 180 Using markers

• Resizing a cycle marker.
Select a cycle marker by clicking on it. As you can see, two handles appear at the bot-
tom of the start and end events. If you click and hold one of the handles you can drag 
the event left or right to resize the cycle marker. This can also be done numerically on 
the info line.

• Moving markers.
Click and drag to move the selected markers, or edit marker positions on the info line. 
As usual, snap is taken into account if activated.

• Removing markers.
This is done exactly the same way as for other events, i.e. by selecting and pressing 
[Delete], using the Erase tool etc.

• Naming markers.
A selected marker’s name can be edited by clicking the name on the info line.

Navigating using cycle markers

Cycle markers represent ranges rather than single positions. There-
fore you don’t use them for moving the project cursor, but for moving 
the left and right locators:

• If you double click on a cycle marker, or select it from the Cycle pop-
up menu in the Track list, the left and right locators are moved to en-
compass the cycle marker.
To move the project cursor position to the start or the end of the cycle marker, move it 
to the corresponding locator (e.g. by using the numeric pad keys [1] and [2]).

• You can also use key commands for this – see page 182.

Zooming to cycle markers

• By selecting a cycle marker on the Zoom pop-up menu, the event dis-
play is zoomed in to encompass the selected range only.
You can also do this by pressing [Alt]/[Option] and double clicking on the cycle marker 
in the event display.
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Editing cycle markers using tools

Cycle markers can be edited on the Marker track using the following 
tools. Note that the snap value applies as with regular events:

The other tools cannot be used with cycle markers.

Using markers to make range selections in the Project window

Besides enabling you to quickly move the project cursor and locators, 
markers can be used in conjunction with the Range Selection tool to 
make range selections in the Project window. This is useful if you 
quickly want to make a selection that spans all tracks in the project. 

• Double click with the Range Selection tool between any two markers 
– this creates a selection range between the markers, spanning all 
tracks in the project (just as if you had used the Range Selection tool 
to draw a rectangle).
Any functions or processing you perform will now affect the selection only.

Moving and Copying sections

This is a quick way to move or copy complete sections of the project 
(on all tracks):

1. Set markers at the start and end of the section you want to move or 
copy.

2. Select the Range Selection tool and double click on the Marker track 
between the markers.
Everything in the project within the cycle marker boundaries is selected.

Tool Use

Pencil Press [Ctrl]/[Command] and use the Pencil tool to create new 
ranges (as described above).

Eraser Click with the Eraser tool to delete a cycle marker. If you hold down 
[Alt]/[Option] when you click, all consecutive markers will also be 
deleted.

Selection Range This is described on page 181.



NUENDO
8 – 182 Using markers

3. Click on the Marker track in the selected range and drag the range to 
a new position.
The selection in the Project window is moved to the same position.

• If you hold down [Alt]/[Option] while you drag the range, the selection 
in the Project window is copied instead.

Marker key commands

You can use key commands for the following marker operations:

If you need to change the key command assignments, the marker com-
mands can be found in the Transport category in the Key Commands 
dialog.

• For the [Shift]-[Pad1] to [Pad9] commands to work, Num Lock must be 
deactivated on the computer keyboard!

Operation Description Default key

Insert Marker Creates a new marker at the current project 
cursor position.

[Insert]/[Help]

Locate Next Marker Moves the project cursor to the right to the 
next marker position (if any).

[Shift]-[N]

Locate Previous Marker Moves the project cursor to the left to the 
previous marker position (if any).

[Shift]-[B]

To Marker 1-9 Moves the project cursor to the specified 
marker (number 1 to 9).

[Shift]-[1] to [9]

Set Marker 1-9 Moves the specified marker (number 1 to 9) 
to the current project cursor position.

[Ctrl]-[1] to [9]

Recall Cycle Marker 1-9 Moves the left and right locators to encom-
pass the specified cycle marker (1 to 9).

[Shift]-[Pad1] to 
[Pad9]
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Editing markers in the Project Browser

To view and edit markers in the Project Browser, the Marker track must 
be added to the Project window.

If you have a Marker track in the Project window, you can create and 
edit all marker parameters, including marker ID’s, in the Project 
Browser. Proceed as follows:

1. Open the Project Browser by selecting it on the Project menu.

2. Select “Marker” in the Project Structure window.
A list of the markers is shown in the main Browser window.

3. Now you can edit marker names, positions and ID numbers, by select-
ing an item and typing in values as usual in the main editor window.
For details about editing in the Project Browser see page 531.

• You can use the Add pop-up menu and Add button to insert new 
markers or cycle markers when the Marker track is selected in the 
Project Browser.
This works just like the Add button in the Marker window (see page 175).
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Creating fades

There are two main types of fade-ins and fade-outs in audio events in 
Nuendo: fades created by using the fade handles (see below) and 
fades created by processing (see page 189).

Fades created by using the fade handles

Selected audio events have blue handles in the upper left and right 
corners. These can be dragged to create a fade-in or fade-out re-
spectively.

Creating a fade-in. The fade is automatically reflected in the shape of the event’s 
waveform, giving you a visual feedback of the result when you drag the fade handle. 

Fades created with the handles are not applied to the audio clip as 
such but calculated in real time during playback. This means that sev-
eral events referring to the same audio clip can have different fade 
curves. It also means that having a huge number of fades may demand 
a lot of processor power.

• If you select multiple events and drag the fade handles on one of them, the 
same fade will be applied to all selected events.

• A fade can be edited in the Fade dialog, as described on the following pages. 
You open the dialog by double clicking in the area above the fade curve, or by select-
ing the event and selecting “Open Fade Editor(s)” from the Audio menu (note that this 
will open two dialogs if the event has both fade-in and fade-out curves).
If you adjust the shape of the fade curve in the Fade dialog, this shape will be main-
tained when you later adjust the length of a fade.

• You can make the fade longer or shorter at any time, by dragging the handle.
You can actually do this even without selecting the event first, i.e. without visible han-
dles. Just move the mouse pointer along the fade curve until the cursor turns into a bi-
directional arrow, then click and drag.

• If the option “Show Event Volume Curves Always” is activated in the Prefer-
ences dialog (Event Display–Audio page), the fade curves will be shown in all 
events, regardless of whether they are selected or not.
If the option is deactivated, the fade curves are shown in selected events only.
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• As an alternative to dragging the fade handles, you can use the items 
“Fade In to Cursor” and “Fade Out to Cursor” on the Audio menu to cre-
ate fades.
Position the project cursor on an audio event where you want a fade in to end or a fade 
out to begin, and select the appropriate option from the Audio menu. A fade will then 
be created, ranging from the event’s start or end to the position of the cursor.

Creating and adjusting fades with the Range Selection tool

“Handle-type” fades can also be created and adjusted with the Range 
Selection tool, in the following way:

1. Select a section of the audio event with the Range Selection tool.
The result depends on your selection, in the following way:

• If you select a range from the beginning of the event, a fade-in will be created 
within the range. 

• If you select a range that reaches the end of an event, a fade-out will be cre-
ated in the range. 

• If you select a range encompassing a middle section of the event, but not 
reaching neither the start nor the end, both a fade-in and a fade-out will be 
created outside of the selected range. In other words, the fade-in will cover 
the area from the beginning of the event to the beginning of the selected 
range, and the fade-out will cover the area from the end of the selected range 
to the end of the event.

2. Pull down the Audio menu and select “Adjust Fades to Range”.
The fade areas are adjusted according to the selection range.

You can select multiple audio events on separate tracks with the Range 
Selection tool, and apply the fade to all of them simultaneously.
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Applying Default Fades

You can also create fades by using the commands “Apply Standard 
Fade In” and “Apply Standard Fade Out” from the Audio menu.

1. Select one or more audio events in the project window.

2. From the Audio menu, choose either “Apply Standard Fade In” or 
“Apply Standard Fade Out”.
A fade will be created that is the same length and shape as the Default fade (see page 
191 for more information on how to define Default fades).

About the volume handle

A selected audio event also has a blue handle in the top middle. This 
is the volume handle, and it provides a quick way of changing the vol-
ume of an event, directly in the Project window. It stands in direct cor-
relation with the volume setting in the info line, that is, dragging the 
volume handle also changes the value in the info line.

Removing fades

To remove a fade, select the event and select “Remove Fades” from 
the Audio menu.

You can also use the Range Selection tool to remove fades and 
crossfades:

1. Drag the Range Selection tool in the Project window, so that the se-
lection encloses all of the fades and crossfades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

Drag the Volume handle up or down 
to change the volume of the event.

The volume change is displayed 
numerically in the info line.

The event waveform re-
flects the volume change.
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Fades created by processing

If you have selected an audio event or a section of an audio event (us-
ing the Range Selection tool), you can apply a fade-in or fade-out to 
the selection by using the “Fade In” or “Fade Out” functions on the 
Process submenu on the Audio menu. These functions open the cor-
responding Fade dialog, allowing you to specify a fade curve.

Note that the length of the fade area is determined by your selection. In 
other words, you specify the length of the fade before you enter the 
Fade dialog. 

Also note that you can select multiple events and apply the same pro-
cessing to all of them simultaneously.

Fades created this way are applied to the audio clip rather than to the 
event. This has the following consequences:

• If you later create new events that refer to the same clip, these will have the 
same fades.

• At any time you can remove or modify the fades using the Offline Process His-
tory (see page 386).

If other events refer to the same audio clip, you will be asked whether 
you want the processing to be applied to these events or not.

• Continue will apply the processing to all events that refer to the audio clip.
• New Version will create a separate, new version of the audio clip for the se-

lected event.
• You can also choose to put a checkmark in the “Do not ask this message again” 

box. Regardless of whether you then choose “Continue” or “New Version”, any 
and all further processing you do will conform to the option you select.

You can change this setting at any time in the Preferences dialog (Edit-
ing–Audio page), under “On Processing Shared Clips”.
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The Fade dialogs

The Fade dialogs appear when you edit an existing fade or use the 
“Fade In”/”Fade Out” functions on the Audio menu’s Process submenu. 
The picture below shows the Fade In dialog; the Fade Out dialog has 
identical settings and features.

• If you open the Fade dialog(s) with several events selected, you can 
adjust the fade curves for all these events at the same time.
This is useful if you want to apply the same type of fade-in to more than one event, etc.

Curve Kind

These determine whether the fade curve should consist of spline curve 
segments (left button), damped spline segments (middle button) or lin-
ear segments (right button).

Fade display

Shows the shape of the fade curve. The resulting waveform shape is 
shown in dark grey, with the current waveform shape in light grey.

You can click on the curve to add points, and click and drag existing 
points to change the shape. To remove a point from the curve, drag it 
outside the display.

Restore button

The Restore button (to the right above the fade display) is only avail-
able when editing fades made by dragging the fade handles. Click 
this to cancel any changes you have made since opening the dialog.
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Curve shape buttons

These buttons give you quick access to some common curve shapes.

Fade Length Value

The Fade Length Value is only available when editing fades made by 
dragging the fade handlws. It can be used to enter fade lengths nu-
merically. The format of values displayed here are determined by the 
Primary Time Display in the Transport window (see page 39).

When you activate the “Apply Length” option, the value entered in the 
Fade Length will be used when clicking “Apply” or “OK.” This setting 
is deactivated by default each time you open the Fade dialog.

When you set the current Fade as the Default fade, the length value is 
included as part of the default settings.

Default button

The Default button is only available when editing fades made by drag-
ging the fade handles. Clicking the “As Default” button stores the cur-
rent settings as default fade. This shape will be used whenever you 
create new fades by dragging event handles. Both the shape and 
length will be used whenever you create fades using the “Apply Stan-
dard Fade...” commands from the Audio menu.

Presets

If you have set up a fade-in or fade-out curve that you may want to ap-
ply to other events or clips, you can store it as a preset by clicking the 
Store button.

• To apply a stored preset, select it from the pop-up menu. 

• To rename the selected preset, double click on the name and type a 
new one. 

• To remove a stored preset, select it from the pop-up menu and click 
Remove.
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Stored fade-in presets will only appear in the Fade In dialog, and fade-
out presets will only appear in the Fade Out dialog.

Preview, Apply and Process

The buttons in the bottom row are different depending on whether you 
are editing a fade made with the fade handles or applying a fade using 
processing:

The Edit Fade dialogs have the following buttons:

The Process Fade dialogs have the following buttons:

Button Function

OK Applies the set fade curve to the event, and closes the dialog.

Cancel Closes the dialog.

Apply Applies the set fade curve to the event, without closing the dialog.

Button Function

Preview Plays back the fade area. Playback will repeat until you click the button 
again (the button is labeled “Stop” during playback).

Process Applies the set fade curve to the clip, and closes the dialog.

Cancel Closes the dialog without applying any fade.

The Edit Fade dialog. The Process Fade dialog.
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Creating crossfades

Overlapping audio material on the same track can be crossfaded, for 
smooth transitions or special effects. You create a crossfade by se-
lecting two consecutive audio events and selecting the Crossfade 
command on the Audio menu (or using the corresponding key com-
mand, by default [X]). The result depends on whether the two events 
overlap or not:

• If the events overlap, a crossfade is created in the overlapping area.
The crossfade will be of the default shape – initially a linear, symmetric crossfade, but 
you can change this as described below.

• If the events don’t overlap but are directly consecutive (lined up end-
to-start, with no gap) it’s still possible to crossfade them – provided 
that their respective audio clips overlap! In this case, the two events 
are resized so that they overlap, and a crossfade of the default length 
and shape is applied.
The default crossfade length and shape are set in the Crossfade dialog (see page 191).

Overlapping section.
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An example:

The events in themselves do not overlap, but their clips do. Therefore, the events 
can be resized so that they overlap, which is required for a crossfade to be created.

When you select the Crossfade function, the two events are resized so that they 
overlap, and a default crossfade is created in the overlapping section.

• If the events don’t overlap, and cannot be resized enough to overlap, a 
crossfade cannot be created.

• You can specify the length of the crossfade using the Range Selection 
tool: make a selection range covering the desired crossfade area and 
use the Crossfade command.
The crossfade is applied in the selected range (provided that the events or their clips 
overlap, as above). You can also make a selection range after creating the crossfade 
and use the function Adjust fades to Range on the Audio menu.

• Once you have created a crossfade, you can edit it by selecting one 
or both crossfaded events, and selecting “Crossfade” from the Audio 
menu again (or by double clicking in the crossfade zone). 
This opens the Crossfade dialog, as described below.

Audio clips.

Audio events.
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Removing crossfades

To remove a crossfade, select the events and select “Remove Fades” 
from the Audio menu, or use the Range Selection tool:

1. Drag the Range Selection tool in the Project window, so that the se-
lection encloses all of the fades and crossfades you wish to remove.

2. Select “Remove Fades” from the Audio menu.

• You can also remove a crossfade by clicking and dragging it outside 
the track.

The Crossfade dialog

• The following section describes the default Crossfade dialog.
However, if you activate the option Simple Crossfade Editor in the Preferences (Editing-
Audio page), a simplified dialog will be used instead (similar to the regular fade dialogs).

The Crossfade dialog is divided into two parts:

The upper part contains a display that shows the crossfade curve and 
the waveforms.
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The lower part contains a number of common settings and controls, 
as well as separate settings for the fade-in and fade-out curves in the 
crossfade. In the center of the lower part there are two sets with iden-
tical controls: The upper set controls the fade out curve, and the lower 
set controls the fade-in curve.

Play buttons

• The “Play Fade Out” and “Play Fade In” buttons allow you to audition 
the fade-out or fade-in part only, without the crossfade.

• The “Play Crossfade” button plays back the whole crossfade.

You can also use the Transport play controls to play back the cross-
faded audio events. However, that method will play back all unmuted 
audio events on other tracks as well.

Pre-roll and Post-roll

When auditioning with the Play buttons, you can choose to activate 
pre-roll and/or post-roll. Pre-roll lets you start playback before the fade 
area, and post-roll lets you stop playback after the fade area. This can 
be useful for auditioning the fade in a context.

• To specify how long the pre- and post-rolls should be, click in the time 
fields and enter the desired time (in seconds and milliseconds).

• To activate pre- and post-roll, click the respective button.
To deactivate, click the button again.

1 second pre-roll activated.
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Curve buttons

• The curve kind buttons determine whether the corresponding fade 
curve should consist of spline curve segments (left button), damped 
spline segments (middle button) or linear segments (right button).

• The curve shape buttons give you quick access to some common 
curve shapes.

Symmetric Fades

As previously mentioned, there are separate, identical controls for the 
fade out curve and the fade in curve. However, by activating “Symmet-
ric Fades”, the controls are “linked” so that both fade curves are af-
fected by the same amount regardless of whether you use the fade-out 
or fade-in controls. The actual result however, depends on which con-
trol is used. The following descriptions of the controls detail what hap-
pens when you use a certain control with “Symmetric Fades” activated.

Fade Displays

Shows the shape of the fade-out and fade-in curve, respectively. You 
can click on the curve to add points, and click and drag existing points 
to change the shape. To remove a point from the curve, drag it outside 
the display.
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Crossfade display

The top display shows the shape of the whole crossfade curve and 
the resulting waveform. You can perform a number of click and drag 
operations in this display.

Depending on whether “Symmetric Fades” is activated or not (see 
above), the following will happen when you click and drag the differ-
ent points in the display:

1. Click and drag these points to change the length of the fade-out 
curve (upper) or the fade-in curve (lower), respectively.
If “Symmetric Fades” is activated, these instead change the length of both the fade out 
curve and the fade in curve. The length change will be applied equally to both sides, 
without moving the “Offset Point” (see page 202).

2. Click and drag these points to move the fade-out curve (upper) or the 
fade-in curve (lower), respectively.
If “Symmetric Fades” is activated, these instead change the length of both the fade out 
curve and the fade in curve – by moving only the end or the start of the curves as well 
as the “Offset Point”.

3. Click and drag these points to move the Offset Point (the dotted line) 
for the fade-out curve (upper) or the fade-in curve (lower), respectively.
Moving the Offset Point will also move the fade curve. If “Symmetric Fades” is activated, 
the Offset Point for both curves will be moved.

1

1

2

2

3

3
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• You can also click and drag to move audio clips (along with the fade 
curve) in the display. The pointer takes on the shape of a hand to indi-
cate that it’s possible to move a clip.

• You can right-click (Win) or [Ctrl]-click (Mac) in the ruler and use the 
pop-up menu to select a time format (see page 108).

• You can scroll and zoom the display with the horizontal and vertical 
scroll bars and zoom controls. The standard zoom procedures apply 
(see the Getting Started book).

Equal Gain and Power

• If you activate the “Equal Gain” checkbox, the fade curves are adjusted 
so that the summed fade-in and fade-out amplitudes will be the same 
all along the crossfade region. 
This is often suitable for short crossfades.

• If you activate the “Equal Power” checkbox, the fade curves are ad-
justed, so that the energy (power) of the crossfade will be constant all 
along the crossfade region.

Equal Power curves have only one editable curve point. You cannot use 
the Curve kind buttons or the presets when this mode is selected.

Resizing the crossfade area

You can adjust the length of the crossfade area either in the crossfade 
display (as described on page 198), by using the Length sliders or by 
clicking in the “Length” fields, changing the value numerically and 
pressing [Return].
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• If “Symmetric Fades” is activated, both the fade out and the fade in 
length will be changed by the same amount. Otherwise, the upper 
Length controls change the length of the fade-out curve, and the 
lower controls change the length of the fade-in curve.

• If possible, the length change will be applied equally to “both sides” of 
the crossfade (i.e. Nuendo tries to “center” the crossfade).

To be able to resize a crossfade this way, it must be possible to resize 
the corresponding event. For example, if the left crossfaded event al-
ready plays its audio clip to the end, its endpoint cannot be moved any 
further to the right.
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Moving the crossfade area

You can move the crossfade area in various ways: In the crossfade 
display (as described on page 198), with the Nudge buttons, with the 
Overlap controls (either the slider or numerically) or by changing the 
Offset Point.

Using the Nudge controls

• When you use the Nudge controls, you can decide whether they should 
move the fade area or the audio clip, by clicking the corresponding ra-
dio button under “Nudge Mode”. 

• Each time you click a Nudge button, the fade area or the audio event 
will be moved in the corresponding direction by the amount specified 
on the “Nudge Range” pop-up menu.
The Nudge buttons in the upper region affect the fade-out curve, and the Nudge but-
tons in the lower region affect the fade-in curve. Note that it is only possible to move 
the audio of the second event – i.e. the event that is faded in.

• You can also click in the Nudge value field, enter a numerical value 
and press [Return] to move a fade area or an audio event.

• If “Symmetric Fades” is activated, and the Nudge Mode is set to 
“Move Fade”, both the fade-out area and the fade-in area will be 
moved by the same amount.

• If “Symmetric Fades” is activated, and the Nudge Mode is set to 
“Move Audio”, the Nudge buttons in the lower region will move the 
audio event with the fade in.
In this mode, the Nudge buttons in the upper region will move both the entire fade area 
and the audio event with the fade in.

Using the Overlap controls

The Overlap controls let you move the fade area without moving the 
Offset Point – the “center” of the fade area (see below). This means 
that the “center” of the fade will be offset in relation to the fade area.

• You can either use the Overlap sliders or you can click in the Overlap 
fields, change the values numerically and press [Return].

• If “Symmetric Fades” is activated, both the upper and the lower Over-
lap controls will move both the fade-out and the fade-in area.
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Changing the Offset Point

You can also move a fade area by changing its Offset Point. The Off-
set Point is the “center” of the fade area, i.e. the point where the vol-
ume of the event is precisely halfway between full level and zero level.

• Click in the value field, enter the desired value, in accordance with the 
selected display format (see page 198) and press [Return].
This will move the Offset Point along with the fade area by the specified amount. Note 
however that this only applies to the fade-in area!

• The Offset Point is indicated by a dotted vertical line in the crossfade 
display.

Changing the volume

You can use the Volume controls to change the volume of the cross-
faded events. Either use the Volume sliders or click in the Volume 
fields, change the values numerically and press [Return].

This is the same thing as using the volume handles in the Event display, 
as described on page 188.

Default buttons

Clicking the “As Default” button stores all of the current settings as 
the default crossfade. These settings will then be used whenever you 
create new crossfades.

Clicking the “Recall Default” button copies the curves and settings in 
the Default crossfade to the Crossfade dialog.

Presets

If you have set up a crossfade that you may want to apply to other 
events, you can store it as a preset by clicking the store button (the 
disk icon).

• To apply a stored preset, select it from the pop-up menu. 

• To rename the selected preset, double click on the name and type in 
a new one. 

• To remove a stored preset, select it from the pop-up menu and click 
the remove button (the trash icon).
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Autoscroll

If this option is activated, the crossfade display will be scrolled during 
playback, so that the play position cursor is always visible. This works 
just like Autoscroll in the Project window (see page 155).

• Note that this only applies if you use the Transport play controls – not if 
you use the Play controls in the Crossfade dialog.

Zoom and Auto Zoom

If you have scrolled or zoomed the crossfade display horizontally (see 
page 198), you can click the “Zoom to Fade” button (the magnifying 
glass icon) to quickly revert to the standard zoom factor and center 
the display on the currently selected crossfade area.

If Auto Zoom is activated (checked), the crossfade display will auto-
matically be zoomed and centered on the current crossfade if you re-
size it (see page 199).

Select Crossfade buttons

These allow you to select the previous/next crossfade area on the cur-
rent track, if it contains more than one crossfade.

• If “Project selection follows” is activated, selecting another crossfade 
will automatically change the event selection in the Project window.
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Auto Fades and Crossfades

Nuendo features an Auto Fade function that can be set both globally, 
i.e. for the entire project, and separately for each audio track. The idea 
behind the Auto Fade function is to create smoother transitions be-
tween events by applying short (1 - 500 ms) fade-ins and fade-outs.

As mentioned earlier, fades are calculated in real time during playback. 
This means that the larger the number of audio tracks with Auto Fades 
activated in a project, the higher the demands on the processor.

Making global Auto Fade settings

1. To make Auto Fades settings globally for the project, select “Auto 
Fades Settings...” from the Project menu.
This opens the Auto Fades dialog for the project.

2. Use the checkboxes in the upper right corner to activate or deactivate 
Auto Fade In, Auto Fade Out and Auto Crossfades, respectively.

3. Use the Length value field to specify the length of the Auto Fade or 
Crossfade (1-500 ms).
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4. To adjust the shapes of Auto Fade In and Auto Fade Out, select the 
“Fades” tab and make settings as in the regular Fade dialogs.

5. To adjust the shape of the Auto Crossfade, select the “Crossfades” 
tab and make settings as in the regular Crossfade dialog.

6. If you want to use the settings you have made in forthcoming new 
projects, click the “As Default” button.
The next time you create a new project, it will use these settings by default.

7. Click OK to close the dialog.

Making Auto Fade settings for a separate track

By default, all audio tracks will use the settings you have made in the 
project’s Auto Fades dialog. However, since Auto Fades use comput-
ing power, a better approach may be to turn Auto Fades off globally, 
and activate them for individual tracks, as needed:

1. Right-click (Win) or [Ctrl]-click (Mac) the track in the Track list and 
select “Auto Fades Settings...” from the context menu (or select the 
track and click the “Auto Fades Settings” button in the Inspector).
The Auto Fades dialog for the track appears. This is identical to the project’s Auto 
Fades dialog, with the addition of a “Use Project Settings” option.

2. Deactivate the “Use Project Settings” option.
Now, any settings you make will be applied to the track only.

3. Set up the Auto Fades as desired and close the dialog.

Reverting to project settings

If you want a track to use the global Auto Fade settings, open the Auto 
Fades dialog for the track and activate the “Use Project Settings” 
checkbox. This makes the track use the Auto Fade settings you have 
made for the project.
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Event Envelopes

An envelope is a volume curve for an audio event. It is similar to the 
real-time fades, but allows you to create volume changes within the 
event, not only at the start or end. To create an envelope for an audio 
event, proceed as follows:

1. Zoom in on the event so that you can view its waveform properly.

2. Select the Pencil tool.
When you move the Pencil tool over an audio event, a small volume curve symbol is 
shown next to the tool.

3. To add an envelope point, click in the event with the Pencil tool.
A blue envelope curve and a curve point appear.

4. Drag the curve point to adjust the envelope shape.
The waveform image reflects the volume curve.

• You can add as many curve points as you like.

• To remove a curve point from the envelope, click on it and drag it out-
side the event.

• The envelope curve is a part of the audio event - it will follow when you 
move or copy the event.
After copying an event with an envelope, you can make independent adjustments to 
the envelopes in the original event and the copy.

• It is also possible to apply an envelope to the audio clip using the Enve-
lope function on the Audio - Process menu.
See page 367.



10
The mixer
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About this chapter

This chapter contains detailed information about the elements used 
when mixing audio and MIDI, and the various ways you can configure 
the mixer. 

Some mixer related features are not described in this chapter. These 
are the following:

• Setting up and using audio effects.
See page 260.

• Setting up and using MIDI effects.
See the separate PDF document “Working with MIDI”.

• Surround Sound.
See page 298.

• Automation of all mixer parameters.
See page 322.

• How to mix down several audio tracks (complete with automation and 
effects if you wish) to a single audio file.
See page 551.
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Overview

The picture above shows an extended mixer (see page 235).

The mixer offers a common environment for controlling levels, pan, 
solo/mute status etc. for both audio and MIDI channels. 
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Opening the mixer

The mixer can be opened in several ways:

• By selecting Mixer from the Devices menu.

• By clicking the Mixer icon on the toolbar
This always opens the first Mixer window (see below).

• By using a key command (by default [F3]).

• By clicking the Mixer button in the Devices panel.
You open the Devices panel by selecting Show Panel from the Devices menu.

About the multiple mixer windows

You may have noticed that there are in fact several separate mixer 
items selectable from the Devices menu. These are not separate mix-
ers, but rather separate windows of the same mixer. 

• Each of the mixer windows can be configured to show any combina-
tion of channels, channel types, narrow and wide channel strips etc. 
(how to do this is described later in this chapter).
You can for example configure one mixer window to show MIDI channel strips, another 
to show input and output channels, another to show all audio channels and so on.

• You can also save channel configurations as View sets (see page 219) 
which are then accessible from all mixer windows.
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These features are very convenient when working with large projects. 
Considering the number of different channel types that can be shown 
in the mixer, they could even be described as necessary!

With the several mixer windows combined with the ability to recall dif-
ferent mixer configurations, you are always able to focus on the task at 
hand and keep window scrolling down to a minimum.

• All the various options for configuring the mixer described in this chap-
ter are identical for all mixer windows. 

What channel types can be shown in the mixer?

The following track based channel types are shown in the mixer:

• Audio
• MIDI
• Effect return channels (FX channel tracks are referred to as effect return 

channels in the mixer). 
• Group channels. 

The order of audio, group, effect return and MIDI channel strips (from 
left to right) in the mixer corresponds to the Project window Track list 
(from the top down). If you reorder tracks of these types in the Track 
list, this will in turn be mirrored in the mixer.

In addition to the above, the following channel types are also shown in 
the mixer:

• Activated ReWire channels (see page 630).
• VST Instrument channels (see the separate PDF document “Working with 

MIDI”).

ReWire channels cannot be reordered and always appear to the right 
of other channels in the main mixer pane (see below). VST instrument 
(VSTi) channels can be reordered in the Track list which will in turn be 
mirrored in the mixer.

Folder, Marker, Video and Automation tracks are not shown in the mixer.
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Input and output busses in the mixer

Input and output busses are represented by input and output channels 
in the mixer. They appear in separate “panes” separated by movable 
dividers and with their own horizontal scrollbars. See page 224.

About multichannel audio

Nuendo has full support for surround sound. Each audio channel and 
bus in the mixer can carry up to 12 speaker channels. This means that 
if you have an audio track configured for 5.1 surround sound for exam-
ple, this will have a single channel strip in the mixer, just like mono or 
stereo tracks (although its level meter will have six meter bars, one for 
each speaker channel).

Another thing to note is that the look of a channel strip differs slightly 
depending on how it is routed – mono or stereo tracks routed to a 
surround output bus will have a surround panner control instead of a 
regular pan control, for example.
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Configuring the mixer

As mentioned earlier, the mixer windows can be configured in various 
ways to suit your needs and to save screen space. Here follows a run 
through of the various view options (the following descriptions as-
sume that you have an active project containing some tracks):

Normal vs. Extended channel strips

You have the option of selecting normal or extended channel strips 
and whether to show the input and output settings at the top of the 
channel strips. Proceed as follows:

1. Open any of the mixer windows.
The leftmost strip is called the common panel and is always shown in the mixer. This 
contains various global settings and options relating to the mixer. For further info see 
page 223.

In the lower left corner of the common panel you can see a graphic 
representation of a row of three “channel strips”, divided into three 
vertical sections. The three vertical sections indicate what channel 
strip sections are currently visible in the mixer – if a section is lit the 
corresponding panel will be visible in the mixer. 

Here the middle section is dark, but the lower and upper sections are lit. This 
indicates that the mixer will show channel strips with the fader panel (lower section) 
plus the Input/Output settings panel (top section).

2. Click on the middle section so it lights up.
Now the mixer will show the extended panel for all channel strips.

3. You can show or hide the extended and top panels of the channel 
strips by clicking on the corresponding section in the figure.
The fader panel is always shown.

• You can also show or hide the extended and top panels by clicking 
the + and – buttons to the left of each section in the common panel. 

Input/Output settings.

Extended channel strips.

Fader section (cannot be hidden).
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The fader panel shows the basic controls – faders, pan controls and 
an associated vertical row of buttons. The extended panel can be set 
to show EQ, effect sends, insert effects, etc. The input/output set-
tings panel contains input and output routing pop-up menus (where 
applicable), along with input phase switches and input gain controls.

A basic channel strip with 
no extended options.

A fully extended channel strip 
with the input/output settings 
panel at the top.
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Selecting what to display in the extended channel strips

You can select what to display in the extended channel strip either glo-
bally from the common panel, or individually from each channel strip. 

The available options vary depending on the type of channel.

• See page 235 for a description of the various options for audio channels. 
• See page 252 for a description of the various options for MIDI channels.

Selecting globally from the common panel

1. Open any of the mixer windows.
The leftmost strip is called the common panel and is always shown in the mixer. This 
contains various global settings and options relating to the mixer. For further info see 
page 223.

2. Make sure that the extended panel of the mixer is visible.

In the extended area of the common panel you can see a vertical row 
of icons. These act as buttons, and determine globally what is dis-
played in the extended panel for all channel strips in the mixer.

If you place the pointer on an icon a tooltip appears, describing the item.

Clear all views (blank panels)

Show all Inserts

Show all Equalizers

Show all Equalizers as dials

Show all Equalizers as curves

Show all Sends

Show Sends 1-4

Show Sends 5-8

Show Surround Panners (where applicable)

Show all Meters

Show Channel Overview
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3. Click on the “Show all Inserts” button (second icon from the top).
Now all channel strips in the mixer will show Insert effect slots in the extended panel.

• As mentioned above, what can be set globally depends on the type of 
channel. 
Channel types that do not support a selected global option will be unaffected.

• If you press [Alt]/[Option] and click one of the global view buttons, in-
put and output channels will be affected as well.

Selecting for individual channels

Each channel strip in the mixer features a View options pop-up, which 
is used for two things:

• To determine what is shown in the extended panel for individual chan-
nels in the mixer.

• To set the “Can Hide” status for individual channels in the mixer.
This is described on page 218.

The View options pop-up is opened by clicking the down arrow lo-
cated just above the fader panel of the channel strip.

• To select what to display in the extended panel from the View options 
pop-up you must first open the extended mixer.
You can then use the pop-up to select what parameters to show in the extended panel 
for each individual channel in the mixer.
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Setting the width of channel strips

Each channel strip’s width can be sized to either “Wide” or “Narrow” 
mode by using the Narrow/Wide button. This is the two left/right arrows 
just above the fader strip (to the left of the View options pop-up).

The Narrow/Wide button

• Narrow channel strips contain a narrow fader, miniature buttons, plus 
the View options pop-up.
If you have selected to show parameters in the extended section, only the channel 
overview is shown in narrow mode. (The parameters will be shown again when you 
return to wide mode.)

Wide and narrow channel strips

• When selecting wide or narrow channel strips from the common 
panel View options pop-up, all channel strips are affected.
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Selecting what channel types to show/hide

You can specify what channel types to show or hide in the mixer. In 
the lower part of the common panel you find a vertical strip with differ-
ent indicator buttons. Each indicator represents a channel type to 
show or hide in the mixer:

• To hide or show a channel type, click the corresponding indicator.
If an indicator is dark, the corresponding channel type will be shown in the mixer. If it is 
orange, the corresponding channel type will be hidden.

Selecting individual channels to show/hide

You can also show/hide individual channels of any type in the mixer. 
This is done by first assigning channels a “Can Hide” status. After 
having done so you can hide all channels assigned this status at any 
time. Proceed as follows:

1. Pull down the View options pop-up menu for the channel you want to 
hide and activate the “Can Hide” option.

Input Channels

Audio Channels

Group Channels

ReWire Channels

MIDI Channels

VST Instrument Channels

Effect Return Channels

Output Channels

For hiding individual channels – see below.
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2. Repeat this for all channels you want to hide.

3. Click the bottom “hide button” in the common panel.
This hides all channels set to “Can Hide”. To show them, click the button again.

Channel view sets

Channel view sets are saved configurations of the mixer windows, al-
lowing you to quickly switch between different layouts for the mixer. 
Proceed as follows:

1. Set up the mixer the way you wish to store it as a view set.
The following settings will be stored:

• Settings for individual channel strips (e.g. narrow or wide mode and whether 
the channel strip is (or can be) hidden or not).

• The hide/show status for channel types.
• The mixer’s display status (fader panel, extended panel, input/output panel
• Settings for what is shown in the extended view of the mixer.

2. Click the “Store View Set” button (the plus sign) at the top of the 
(non-extended) common panel.

3. A dialog appears, allowing you to type in a name for the view set.
Do so and click OK to store the current mixer view set.

• You can now return to this stored configuration at any time, by clicking 
the “Select Channel View Set” button (the down arrow at the top of 
the common panel) and selecting it from the pop-up menu.

• To remove a stored channel view set, select it and click the “Remove 
View Set” button (the minus sign).

Some remote control devices (such as Steinberg’s Houston) feature 
this function, which means that you can use the remote device to switch 
between the channel view sets.
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The audio channel strips

The mixer in normal mode (faders and input/output settings panel visible), showing 
(from left to right): the common panel, a VST Instrument channel, a stereo audio 
channel, an effect return channel and a group channel strip.

All audio related channel types (audio, input/output channels, group, 
effect return, VST Instrument or ReWire) basically have the same 
channel strip layout, with the following differences:

• Only audio track channels have an Input Routing pop-up, a Record Enable 
and Monitor button.

• Input channels do not have sends.
• VST Instrument channels have an additional button for opening the instrument’s 

control panel.

The common panel 
(see page 223).

Level meter

Level fader

Channel automation controls

Pan control

Edit button 
(opens the Channel 
Settings window).

Insert/EQ/Send indicators and 
bypass buttons (see below).Record Enable and Monitor buttons

Channel input/output routing

Channel name field

Opens the control panel 
for the VST Instrument.

Channel View 
options pop-up

Input Gain control

The speaker configu-
ration for the channel.

Input Phase switch
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• Input channels and output channels have clip indicators.

About the Insert/EQ/Send indicators and bypass buttons

The three indicator buttons in each audio channel strip have the follow-
ing functionality:

• If an Insert or Send effect or EQ module is activated for a channel, the 
corresponding button is lit. 
The effect indicators will be blue, the EQ indicator will be green.

• By clicking these buttons when lit, the corresponding EQ or effects 
section will be bypassed.
Bypass is indicated by yellow buttons. Clicking the button again deactivates bypass.
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The MIDI channel strips

The MIDI channel strips allow you to control volume and pan in your 
MIDI instrument (provided that they are set up to receive the corre-
sponding MIDI messages). The settings here are also available in the 
Inspector for MIDI tracks.

Level fader 
(MIDI volume)

Level (velocity) meter
Channel automation 
controls

Pan control

Monitor and 
Record Enable 
buttons

MIDI output routing pop-up

MIDI input pop-up

Edit button

Mute and Solo

Bypass Inserts

Disable Sends

Input Transformer 
button

MIDI channel pop-up

This opens the control 
panel for a connected 
VST Instrument.
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The common panel

The common panel appears to the left in the mixer windows and con-
tains settings for changing the look and behavior of the mixer, as well 
as global settings for all channels.

Global automation Read/Write buttons, 
see the “Automation” chapter.

Channel settings copy/paste, see page 245.

Global Listen/Solo/Mute 
Off, see page 229.

These indicator buttons select what channel 
types are shown/hidden in the mixer.

Channel select pop-up

The View options buttons determine what to 
display in the extended panels of channel strips 
([Alt]/[Option]-click to affect busses as well). 
Only visible in extended mixer mode.

Store/Remove View set buttons (+/-) and 
Select View set pop-up, see page 219.

Show/hide buttons for the 
extended and input/output 
settings panels.

Toggles “All Wide” (left arrows) or “All Narrow” 
channel strips in the mixer.

Opens the VST Connections 
window, see page 18.

Shows/hides the input/
output settings panel

Shows/hides the 
extended panel.

Resets the settings to default 
(for all or selected channels).
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The input & output channels

The busses you have set up in the VST Connections window are rep-
resented by input and output channels in the mixer. These are shown 
in separate “panes” (to the left and right of the regular channel strips, 
respectively), with their own dividers and horizontal scrollbars. The i/o 
channel strips are very similar to other audio channels and are identi-
cal for input and output channels (except that input channels don’t 
have Solo buttons).

• How to set up input and output busses is described in the chapter 
“VST Connections: Setting up input and output busses”.

• How to route audio channels to busses is described on page 251.

• The output channel section also contains the channel strip for the 
Audition bus. This is the output bus used for auditioning, scrubbing, 
etc. The only settings here are the pre or post fader status for the Lis-
ten Mode, a level fader and a mute button. For more about the Audition 
bus, see page 29 and page 230.

Input gain

Bus volume fader

Bus level meter

Read/Write 
Automation

Clip indicator

The Speaker configuration for 
the bus.

Edit button
Inserts/Sends/
EQ indicator 
and Bypass 
buttons

Pan control (no Panner 
used for surround busses)

Input Phase switch

Mute and Solo 
buttons
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Basic mixing procedures

Setting volume in the mixer

In the mixer, each channel strip has a fader for volume control. 

• For audio channels, the faders control the volume of the channels be-
fore they are routed directly or via a group channel to an output bus.
Each channel can in turn handle up to 12 speaker channels – see page 298.

• An output channel fader determines the master output level of all au-
dio channels routed to that output bus.

• MIDI channels handle fader volume changes in the mixer by sending 
out MIDI volume messages to the connected instrument(s).
Connected instruments must be set to respond to MIDI messages (such as MIDI vol-
ume in this case) for this to function properly.

• The fader settings are displayed numerically below the faders, in dB 
for audio channels and in the MIDI volume 0 to 127 value range for 
MIDI channels.
You can click in the fader value fields and enter a volume setting by typing.

• To make fine volume adjustments, hold down [Shift] when you move 
the faders.

• If you hold down [Ctrl]/[Command] and click on a fader, it will auto-
matically be set to position 0.0 dB for audio channels, or MIDI volume 
100 for MIDI channels.
Most mixer parameters can be reset to default values by [Ctrl]/[Command]-clicking 
this way.

You can use the faders to set up a volume balance between the audio 
and MIDI channels and perform a manual mix, by moving the faders 
and other controls while playing back. By using the Write function 
(see page 333), you can automate the levels and most mixer actions.

It is also possible to create volume envelopes for separate events in the 
Project window or Audio Part Editor (see page 206) as well as to make 
static volume settings for an event on the info line or with the volume 
handle (see page 188).
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About the level meters for audio channels

When playing back audio in Nuendo, the level meters in the mixer 
show the level of each audio channel.

• Directly below the level meter is a small level readout – this shows the 
highest registered peak level in the signal.
Click this to reset the peak levels.

• Peak levels can also be shown as static horizontal lines in the meter 
(there are options for how this is displayed – see page 247).

If the peak level of the audio goes above 0dB, the numerical level indi-
cator will show a positive value (i.e. a value above 0dB).

Nuendo uses 32 bit floating point processing internally, so there is vir-
tually limitless headroom – signals can go way beyond 0dB without 
clipping. Therefore:

• Having higher levels than 0 dB for individual audio channels is not a 
problem in itself. The audio quality will not be degraded by this. 
However, when many high level signals are mixed in an output bus this may require that 
you lower the output channel level a lot (see below). Therefore it’s good practice to 
keep the max levels for individual audio channels roughly around 0 dB.

About the level meters for input and output channels

For the input and output channels things are different. I/O channels 
have clip indicators.

• When you are recording, clipping can occur when the analog signal is 
converted to digital in the audio hardware. 
It’s also possible to get clipping in the signal being recorded to disk (when 16 or 24 bit 
record format is used and you have adjusted the mixer settings for the input channel). 
Read more about checking and setting input levels on page 59.

• In the output busses, the floating point audio is converted to the reso-
lution of the audio hardware. In the integer audio domain, the maximum 
level is 0dB – higher levels will cause the clip indicator for each bus to 
light up.
If the clip indicators light up for a bus, this indicates actual clipping – digital distortion 
which should always be avoided.

If the clip indicator lights up for an output channel, reset the clip indicator 
by clicking on it, and lower the level until the indicator doesn’t light up.
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Adjusting Input Gain

Each audio channel and input/output channel features an Input Gain 
control. This controls the gain for the incoming signal, before EQ and 
effects.

The Input Gain is not meant to be used as a volume control in the 
mixer. It can, however, be used to cut or boost the gain in various cir-
cumstances:

• To change the level of a signal before the effects section.
The level going into certain effects can change the way the signal is affected. A com-
pressor, for example, can be “driven” harder by raising the Input Gain.

• To boost the level of poorly recorded signals.

To change the Input Gain, you need to press [Shift] and adjust the 
control (to avoid accidental gain changes). You can also press [Alt]/
[Option] – this lets you adjust the Input Gain with a fader.

• You should set the Input Gain once and for all for a channel – it is not 
suited for continuous level adjustments during playback.
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Input Phase switch

Each audio channel and input/output channel has an Input Phase 
switch, to the left of the Input Gain control dial. When activated, the 
phase polarity is inverted for the signal. Use this to correct for bal-
anced lines and mics that are wired backwards, or mics that are “out 
of phase” due to their positioning.

• Phase polarity is important when mixing together two similar signals. 
If the signals are “out of phase” with respect to one another, there will be some cancel-
lation in the resulting audio, producing a hollow sound with less low frequency content.

About level meters for MIDI channels

The level meters for MIDI channels do not show actual volume levels. 
Instead, they indicate the velocity values of the notes played back on 
MIDI tracks.

About MIDI tracks set to the same MIDI channel and output

If you have several MIDI tracks set to the same MIDI channel (and 
routed to the same MIDI output), making volume settings for one of 
these MIDI tracks/mixer channels will also affect all other mixer chan-
nels set to the same MIDI channel/output combination. 
This also applies to pan settings.
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Using Solo and Mute

The Mute (top) and Solo buttons.

You can use the Mute and Solo buttons to silence one or several 
channels. The following applies:

• The Mute button silences the selected channel.
Clicking the Mute button again un-mutes the channel. Several channels can be muted 
simultaneously. Muting Group channels can have two different results depending on 
how the Preferences are set (see page 249). A muted channel is indicated by a lit 
Mute button, and also by the lit Global Mute indicator on the common panel. 

• Clicking the Solo button for a channel mutes all other channels.
A soloed channel is indicated by a lit Solo button, and also by the lit Global Solo indi-
cator on the common panel. Click the Solo button again to turn off Solo.

• Several channels can be soloed at the same time.
However, if you press [Ctrl]/[Command] and click the Solo button for a channel, any 
other soloed channels will automatically be un-soloed (i.e. this Solo mode is exclusive).

• [Alt]/[Option]-clicking a Solo button activates “Solo Defeat” for that channel.
In this mode (indicated by a red solo button without any other channels being muted) 
the channel will not be muted if you solo another channel (see page 283 for a practical 
use of this). To turn off Solo Defeat, [Alt]/[Option]-click the Solo button again. 

• You can un-mute or un-solo all channels by clicking the Mute or Solo indica-
tor on the common panel.

A muted channel in 
the mixer.

A lit Global Mute indicator on the 
common panel shows that one or 
more channels are muted.
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Listen Mode

Be aware of the following when you want to use the Listen mode:

The Default Bus and the Audition Bus are related. The default bus has 
its aux send #1 automatically routed to the audition bus. This aux send 
is enabled but set to -∞ dB. Depending on your setup, you will have to 
make the following changes to make the full use of the audition bus and 
the AFL/PFL functionality:

1. Set the level of aux send #1 (destination audition bus) on your default 
output bus to 0.00 dB. This will pass the complete mix signal of the 
default output bus to the audition bus. If you are using more than one 
output bus, you may need to create additional aux sends #1s to the 
audition bus, also set to 0.00 dB.

2. Be aware that the default output bus AND the audition bus are con-
nected to ASIO output port 1/2. This means that once you have set 
the send levels to 0.00 dB, as described above, the levels present on 
the default output bus and the audition bus are summed, resulting in a 
6 dB level boost at the output. Normally you would disconnect the de-
fault output bus from the ASIO output or route the audition bus to 
separate ASIO outputs which are used exclusively for monitoring.

To monitor your mix, the signal from aux send #1 of the default bus is 
sent to the audition bus, which in turn should be connected to your 
monitoring system.

The reason for this unusual connection is the Listen Mode in the mixer. 
This provides a pre-fader listen (PFL) and after-fader listen (AFL) solo 
bus to your monitoring system. When you enable a Listen button on 
any channel in the mixer, that signal (taken pre fader or post fader de-
pending on the global setting) will be routed directly to the audition bus 
(the connection between your mix signal (default output bus) and the 
audition bus is temporarily interrupted). This allows you to hear the lis-
ten-enabled channel by itself without interrupting the signal to the de-
fault bus. When you defeat listen mode for all channels, the aux send 
#1 pathway from the default bus to the audition bus will be enabled, 
returning the whole mix to your monitoring system (see page 21).
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Using Listen mode

The Listen button

Clicking the Listen button for a channel routes that channel to the au-
dition bus without interrupting the normal signal flow. The following 
applies:

• When the Audition channel is set to after-fader (also referred to as post-
fader), the signal being routed to the Audition channel will come after the 
fader and pan controls of the Listen enabled channel.

• When the Audition channel is set to pre-fader, the signal will be routed from 
just before the fader.

A Listen-enabled channel is indicated by a lit Listen button, and also by 
the lit Global Listen button on the common panel. Click the Listen but-
ton again to turn off Listen mode. You may also turn off Listen mode for 
every listen-enabled track at once by clicking the Listen button on the 
common panel.

…and to pre-fader.Audition channel set to after-fader…
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Setting pan in the mixer

The pan control.

The pan controls in the mixer are used to position a channel between 
the left and right side of the stereo spectrum. For stereo audio chan-
nels, pan (by default) controls the balance between the left and right 
channels. By selecting one of the other pan modes (see below) you 
can set pan independently for the left and right channel.

• To make fine pan adjustments, hold down [Shift] when you move the 
pan control.

• To select center pan position, hold down [Ctrl]/[Command] and click 
on the pan control.

• For MIDI channels, the pan control sends out MIDI pan messages.
The result depends on how your MIDI instrument is set to respond to pan – check your 
documentation for details.

• The Surround Panner is described on page 311.
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About the three pan modes

If you right-click (Win) or [Ctrl]-click (Mac) in the pan control field for 
a (stereo) audio channel you can select one of three pan modes:

• Stereo Balance Panner controls the balance between the left and 
right channels.
This is the default mode.

• If Stereo Dual Panner is selected, there will be two pan controls with 
the upper controlling pan for the left channel, and the lower controlling 
pan for the right channel.
This allows you set pan independently for the left and right channels. Note that it is 
possible to reverse the left and right channels, i.e. the left channel can be panned to 
the right and vice versa. You can also “sum” two channels by setting them to the same 
pan position (i.e. mono) – note that this will increase the volume of the signal.
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• If Stereo Combined Panner is selected, the left and right pan posi-
tions are shown as two lines with a blue/gray area between them.
If you reverse the left and right channels, the area between the pan controls will be red 
instead of blue/gray.

Stereo Combined mode also allows you set pan independently for the 
left and right channels. This is done by holding down [Alt]/[Option] 
and dragging the corresponding pan control. When you release the 
[Alt]/[Option] key, the left and right pan controls are linked, and can be 
moved left and right like a single pan control (with their relative posi-
tions intact). 

When moving combined pan controls so that the left or right pan con-
trol reaches its maximum pan value, it naturally cannot go any further. 
If you do continue to move further in the same direction, only the other 
pan control will move, thus altering the set relative pan range until 
both channels are panned fully to one side. If you move the pan con-
trols in the opposite direction without releasing the mouse, the previ-
ously set pan range will be restored.

• The pan settings made with the Dual Panner are reflected in the Com-
bined Panner and vice versa.

About the “Stereo Pan Law” Preference (audio channels only)

In the Project Setup dialog there is a pop-up menu named “Stereo 
Pan Law”, on which you can select one of three pan modes. This is all 
related to the fact that without power compensation, the power of the 
sum of the left and right side will be higher (louder) if a channel is 
panned center than if it’s panned left or right. 

To remedy this, the Stereo Pan Law setting allows you to attenuate 
signals panned center, by -6, -4.5 or -3dB (default). Selecting the 
0dB option effectively turns off “constant-power panning”. Experiment 
with the modes to see which fits best in a given situation.
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Audio specific procedures

This section describes the options and basic procedures regarding 
audio channels in the mixer.

Options for the extended audio channel strip

When using the extended channel strip view options, the upper panel 
can be set to show different views for each audio channel strip. You 
can select what to display in the extended panel individually for each 
channel or globally for all channels (see page 215).

The following views are possible:

• The 8 insert effect slots.
The inserts can also be found in the Inspector and the Channel Settings window, see 
page 237.

• The 8 effect sends, with pop-ups and send level value sliders.
The sends can also be found in the Inspector and the Channel Settings window, see 
page 237.

• You also have the option of displaying four sends at a time (the Sends 1-4 
and 5-8 menu items). 
These modes offer the additional benefit of displaying send levels as dB values.

• There are no sends for Input channels.
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• The EQ section, either with parameter dials (“EQ +” menu item), value sliders 
(“EQs” item) or as numerical settings with a curve display (“EQs curve” item).
These three views have exactly the same controls but different graphic layouts. The EQ 
section is also available in the Channel Settings window. For EQ parameter descrip-
tions, see page 240.

• The Surround Panner section (where applicable).
If the channel is routed to a surround bus you can view a compact version of the Sur-
round Panner in the extended panel – double click to open the full Surround Panner 
panel. Also in this section, three parameters of the Mixconvert plug-in will be shown 
(provided that this plug-in is inserted and active). They are  SRD (surround), CTR (cen-
ter) and LFE levels. You can edit these values by clicking on them and typing in new 
values.

• The “Meter” option shows large level meters in the extended panel. 
These operate exactly like the regular meters.

• The User Panel option displays Device panels for the audio track, including 
panels for inserted VST effects, see page 101. You can access User panels 
by clicking on the tab at the top of the User Panel display in the extended 
mixer.
Refer to the separate PDF document “Working with MIDI” for information on how to 
import or create Device Setups and Panels.

The User Panel pop-up in the VST Mixer

• Selecting the “Empty” option will display a blank panel in the extended strip.
• You can also select the “Overview” option – this shows a graphic overview of 

which insert effect slots, EQ modules and effects sends are activated for the 
channel.
You can click the indicators to turn the corresponding slot/EQ module/send on or off.



NUENDO
The mixer 10 – 237

• If you have selected a parameter for the extended channel strip and 
then switch to “narrow” mode, only the channel overview is shown in the 
extended channel strip. When you switch back to “wide” mode, the para-
meter settings are displayed again.

Using Channel Settings 

For each audio channel strip in the mixer (and in the Inspector and 
Track list for each audio track) there is an Edit button (“e”).

Clicking this opens the VST Audio Channel Settings window. This 
window contains a simplified common panel, a duplicate of the mixer 
channel strip (without the extended panel but with the input and output 
settings panel), a section with eight insert effect slots (see page 262), 
four EQ modules and an associated EQ curve display (see page 240) 
and a section with eight effect sends (see page 276). Every channel 
has its own channel settings (although you can view each in the same 
window if you like – see below).

Click the Edit button to open 
the Channel Settings window:
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The Channel Settings window is used for the following operations:

• Apply equalization, see page 240.
• Apply send effects, see page 273.
• Apply insert effects, see page 262.
• Copy channel settings and apply them to another channel, see page 245.

All channel settings are applied to both sides of a stereo channel.

Changing channels in the Channel Settings window

You can view any channel’s settings from a single window. 

If the option “Mixer Selection Follows Project” is activated in the Pref-
erences (Editing page), this can be done “automatically”:

• Open the Channel Settings window for a track and position it so that 
you can see both the Project window and the Channel Settings 
window.

Selecting a track in the Project window automatically selects the cor-
responding channel in the mixer (and vice versa). If a Channel Settings 
window is open, this will immediately switch to show the settings for 
the selected channel. This allows you to have a single Channel Set-
tings window open in a convenient position on the screen, and use this 
for all your EQ and channel effect settings.
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You can also select a channel manually (thereby changing what is 
shown in the open Channel Settings window). Proceed as follows:

1. Open the Channel Settings window for any channel.

2. Open the Channel Select pop-up on the common panel.

3. Select a channel from the pop-up to show the settings for that chan-
nel in the open Channel Settings window.

• Alternatively, you can select a channel in the mixer by clicking the strip 
at the bottom of the channel strip (above the channel name).
This selects the channel, and the Channel Settings window will be updated.

• To open several Channel Settings windows at the same time, press 
[Alt]/[Option] and click the Edit buttons for the respective channels.
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Making EQ settings

Each audio channel in Nuendo has a built-in parametric equalizer with 
up to four bands. There are several ways to view and adjust the EQs:

• By selecting one of the three EQ display modes (“EQs”, “EQs +” or “EQs 
Curve”) for the extended channel strip in the mixer.
These three modes contain the same settings but present them in different ways:

From left to right, “EQs” mode (sliders), “EQs +” mode (dials) and “EQs Curve” 
mode (numeric values with a curve display).

• By selecting the “Equalizers” or “Equalizer Curve” tab in the Inspector.
The “Equalizers” section is similar to the “EQs” mode in the extended mixer, while the 
“Equalizer Curve” section shows a display in which you can “draw” an EQ curve. Set-
ting EQ in the Inspector is only possible for track-based audio channels (not for Re-
Wire channels).

• By using the Channel Settings window.
This offers both parameter dials and a clickable curve display and also lets you store 
and recall EQ presets.

Below we describe how to set up EQ in the Channel Settings window, 
but the parameters are the same in the mixer and Inspector (apart from 
the presets and reset function).

The outer ring of the 
dial controls the fre-
quency, while the in-
ner controls gain.
The small dial sets 
the Q parameter.

The top value slider 
controls the gain, the 
middle controls fre-
quency and the lower 
sets the Q parameter 
for each EQ band.

In this mode, EQ 
settings are shown 
as a curve. Param-
eters are set by 
clicking on the 
value and adjust-
ing with the fader 
that appears.
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In the Channel Settings window you find the EQ section in the middle 
(or to the right, if you are making settings for an FX channel track). The 
section consists of four EQ modules with parameter dials, an EQ 
curve display and some additional functions at the top.

Using the parameter dials

1. Activate an EQ module by clicking its power button.
Although the modules are labeled “lo”, “lo mid” and so on, they all have the same fre-
quency range (20Hz to 20kHz). The only difference between the modules is that the 
“lo” and “hi” bands can act as shelving or high/low-pass filters (described below).

2. Set the desired frequency with the outer ring of the parameter dial.
This is the center frequency of the frequency range to be cut or boosted.

3. Set the amount of cut or boost with the gain control – the inner pa-
rameter dial.
The range is ± 24 dB.

4. Set the Q value with the lower dial.
This determines the width of the affected frequency range. Higher values give nar-
rower frequency ranges.

• If you set the Q value for the “lo” EQ module to minimum, it will act as 
a low shelving filter.
If you set it to its maximum value, it will act as a high-pass filter.
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• If you set the Q value for the “hi” EQ module to minimum, it will act as 
a high shelving filter.
If you set it to its maximum value, it will act as a low-pass filter.

5. If needed, you can activate and make settings for up to four modules.
Note that you can edit the values numerically as well, by clicking in a value field and en-
tering the desired gain, frequency or Q value.

Using the curve display

When you activate EQ modules and make settings with the parameter 
dials you will see that your settings are automatically reflected in the 
curve display above. You can also make settings directly in the curve 
(or combine the two methods any way you like):

1. To activate an EQ module, click in the curve display.
This adds a curve point and one of the modules below are activated.

2. Make EQ settings by dragging the curve point in the display.
This allows you to adjust gain (drag up or down) and frequency (drag left or right).

3. To set the Q parameter, press [Shift] and drag the curve point up or 
down.
You will see the EQ curve become wider or narrower as you drag.

• You can also restrict the editing by pressing [Ctrl]/[Command] (sets 
gain only) or [Alt]/[Option] (sets frequency only) while you drag the 
curve point.

4. To activate another EQ module, click somewhere else in the display 
and proceed as above.

5. To turn off an EQ module, double click its curve point or drag it outside 
the display.

EQ reset (Channel Settings window only)

To the right above the EQ curve display in the Channel Settings win-
dow you will find a reset button. Clicking this will turn off all EQ mod-
ules and reset all EQ parameters to their default values.
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EQ bypass

Whenever one or several EQ modules are activated for a channel, the 
EQ button will light up in green in the mixer channel strip, Inspector 
(Equalizer and Channel sections), Track list and Channel Settings 
window (top right corner of the EQ section).

Clicking the EQ button will bypass all EQ modules for the channel, al-
lowing you to compare the sound with and without EQ. When the EQ 
is in Bypass mode, the EQ button is yellow.

Using EQ presets (Channel Settings window only)

Some useful basic presets are included with the program. You can 
use them as they are, or as a starting point for further “tweaking”. 

• To call up a preset, pull down the presets pop-up menu above the EQ 
curve display and select one of the available presets.
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• To store the current EQ settings as a preset, click the store button 
(plus sign) to the left of the presets field.
The settings are stored with the default name “Preset” and a number. To rename a pre-
set, double click in the preset pop-up field and enter a new name.

• To remove a preset, select it and click the remove (minus sign) button.

EQ in the channel overview

If the “Channel” section is selected in the Inspector or the “Channel 
Overview” view mode is selected in the extended mixer, you will get 
an overview of which EQ modules, insert effects and effect sends are 
activated for the channel.

By clicking the “hi”, “hi mid”, “lo mid” or “lo” indicator, you can turn the 
corresponding EQ module on or off.

The channel overview in the Inspector.
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Copying settings between audio channels

It is possible to copy all channel settings for an audio channel and 
paste them onto another channel. This applies to all audio channel 
types. For example, you can copy EQ settings from an audio track and 
apply these to a group or VST Instrument channel, if you want them to 
have the same sound. Proceed as follows:

1. Select the channel you want to copy settings from by clicking the nar-
row horizontal strip just above the channel name field (or just above 
the pan control). A selected channel is indicated by these two fields 
being highlighted.
You can also select channels with the Channel Select pop-up menu – see page 238.

Selecting a channel in the channel strip (left), and in the common panel (right).

2. Click the “Copy” button in the common panel.
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3. Select the channel you want to copy the settings to and click the 
Paste button.
The settings are applied to the selected channel.

4. To copy the same settings to several channels, repeat step 3.
The copied settings are retained in memory until you copy new channel settings, or 
close the project.

Channel settings can be copied from stereo channels and pasted to 
mono channels and vice versa.

Copying channel settings from a channel using a surround format to a 
mono or stereo channel can lead to conflicts. For example, any Insert ef-
fects routed to surround speaker channels will be muted. Or, in other 
words: you can copy channel settings to any type of channel, but of 
course only those settings are used for which corresponding speakers 
are available in the target channel.

Input channels do not have sends, but channel settings can still be cop-
ied to/from other audio channel types. When copying from a i/o or effect 
channel, any send settings in the channel you paste into are unaffected.
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Initialize Channel and Reset Mixer

The Initialize Channel button can be found at the bottom of the Chan-
nel Settings common panel. It resets the selected channel to the de-
fault settings. Similarly, the mixer common panel holds a Reset Mixer 
button – when you click this you will be asked whether to reset all 
channels or just the selected channel.

Default settings are:

• All EQ, Insert and Send effect settings are deactivated and reset.
• Solo/Mute is deactivated.
• The fader is set to 0dB.
• Pan is set to center position.

Changing the meter characteristics 

On the Mixer context menu, opened by right-clicking (Win) or [Ctrl]-
clicking (Mac) anywhere on the mixer panel, there is a submenu named 
“Global Meter Settings”. Here you can make settings for the preferred 
meter characteristics, with the following options:
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• If “Hold Peaks” is activated, the highest registered peak levels are 
“held” and are shown as static horizontal lines in the meter.
Note that you can turn this on or off by clicking in any audio level meter in the mixer.

Hold activated

• If “Hold Forever” is activated, the peak levels will remain until meters 
are reset (by clicking the numerical peak display below the meter).
If “Hold Forever” is off, you can specify for how long the peak levels will be held with 
the parameter “Meters’ Peak Hold Time” in the Preferences dialog (VST page). The 
peak hold time can be between 500 and 30000ms.

• If “Meter Input” is activated, meters will show input levels for all audio 
channels and input/output channels. 
Note that the input meters are post input gain.

• If “Meter Post-Fader” is activated, meters will show post-fader levels.
This is the default setting for channels in the mixer.

• There is also a “Meter Post-Panner” mode.
This is similar to “Meter Post-Fader”, but the meters will reflect pan settings as well.

• If “Fast Release” is activated, the meters respond very quickly to level 
peaks.
If “Fast Release” is deactivated, the meters respond more like standard meters.
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Using group channels

You can route the outputs from multiple audio channels to a group. 
This enables you to control the channel levels using one fader, apply 
the same effects and equalization to all of them etc. To create a group 
channel, proceed as follows:

1. Select Add Track from the Project menu and select “Group Channel” 
from the submenu that appears.

2. Select the desired channel configuration and click OK.
A group channel track is added to the Track list and a corresponding group channel 
strip is added to the mixer. By default the first group channel strip is labeled “Group 1”, 
but you can rename it just like any channel in the mixer.

3. Pull down the Output routing pop-up for a channel you want to route 
to the group channel, and select the group channel.
The output of the audio channel is now redirected to the selected group.

4. Do the same for the other channels you wish to route to the group.

Settings for group channels

The group channel strips are (almost) identical to audio channel strips 
in the mixer. The descriptions of the mixer features earlier in this chap-
ter apply to group channels as well. Some things to note:

• You can route the output of a group to an output bus or to another 
group with a higher number.
You cannot route a group to itself. Routing is done with the Output Routing pop-up 
menu in the Inspector (select an automation track for the Group in the Track list) or in 
the input/output settings area at the top of each channel strip.

• There are no input routing pop-ups, monitor buttons or record enable 
buttons for group channels.
This is because inputs are never connected directly to a group.

• Solo functionality is automatically linked for a channel routed to a 
group and the group channel itself.
This means that if you solo a group channel, all channels routed to the group are auto-
matically soloed as well. Similarly, soloing a channel routed to a group will automati-
cally solo the group channel.
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• Mute functionality depends on the setting “Group Channels: Mute Sources 
as well” in the Preferences dialog.
By default, when you mute a group channel no audio will pass through the group. How-
ever, other channels that are routed directly to that group channel will remain unmuted. 
If any of those channels have aux sends routed to other group channels, FX channels or 
output busses, those will still be heard.

If the option “Group Channels: Mute Sources as well” is activated in the Preferences 
(VST page) muting a group channel will cause all other channels directly routed to it to 
be muted as well. Pressing mute again will unmute the group channel and all other 
channels directly routed to it. Channels that were muted prior to the group channel be-
ing muted will not remember their mute status and will be unmuted when the group 
channel is unmuted.

The option “Group Channels: Mute Sources as well” does not affect how 
mute automation is written. Writing mute automation on a group channel 
only affects the group channel and not channels routed to it. When writ-
ing the automation you will see the other channels being muted when 
this option is checked. However, upon playback, only the group channel 
will respond to the automation.

One application of group channels is to use them as “effect racks” – 
see page 271.

About output busses

As described in the Getting Started book Nuendo uses a system of 
input and output busses which are set up using the VST Connections 
dialog. This is described in the chapter “VST Connections: Setting up 
input and output busses”.

Output busses let you route audio from the program to the outputs on 
your audio hardware. 
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Routing audio channels to busses

To route the output of an audio channel to one of the active busses, 
proceed as follows:

1. Open the Mixer.

2. Make sure the input/output settings panel is visible – see page 213.

3. Pull down the output routing pop-up menu at the top of the channel 
strip and select one of the busses.
This pop-up menu contains the output busses configured in the VST Connections 
window, as well as available group channels (provided that the busses and groups are 
compatible with the speaker configuration for the channel – see page 24).

You can also make routing settings in the Inspector.

For details on routing surround channels, see page 302.

Viewing the output busses in the mixer

Output busses are shown as output channels in a separate pane to 
the right in the mixer. You show or hide this pane by clicking the Hide 
Output Channels button in the mixer’s common panel to the left:

Each output channel resembles a regular audio channel strip. Here 
you can do the following:

• Adjust master levels for all configured output busses using the level faders.
• Adjust input gain and input phase of the output busses.
• Add effects or EQ to the output channels (see page 269).
• Create Sends that can be routed to other Output channels as long as they are 

to the right of the selected Output channel in the mixer. 
This can be useful when creating quick headphone mixes from the current monitor mix. 
This is done by creating a send from the current monitor Output bus to another Output 
bus that is routed to a headphone amplifier.
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MIDI specific procedures

This section describes basic procedures for MIDI channels in the mixer.

Selecting what to show in the extended MIDI channel strip

When using the extended channel strip view options (see page 213), 
the upper panel can be set to show different views for each MIDI 
channel strip. You select what to display for each channel by using 
the View options pop-up menu at the top of each channel strip. The 
following views are possible:

• The MIDI insert effects.
The MIDI inserts can also be found in the Inspector and the Channel Settings window for 
MIDI channels. How to use MIDI insert effects is described in the chapter “MIDI realtime 
parameters and effects” - see the separate PDF document “Working with MIDI”.

• The MIDI send effects.
The sends can also be found in the Inspector and the Channel Settings window for 
MIDI channels. How to use MIDI send effects is described in the chapter “MIDI real-
time parameters and effects” - see the separate PDF document “Working with MIDI”.

• The “Meter” option shows large level (velocity) meters in the extended 
panel.

• The “User Panel” option allows you to import MIDI device panels – 
this is described in the chapter “MIDI Devices” in the separate pdf 
document “Working with MIDI”.

• Selecting “Empty” will display a blank panel in the extended strip.

• You can also select the “Overview” option – this shows a graphic 
overview of which insert effect slots and effect sends are activated for 
the channel.
You can click the indicators to turn the corresponding slot/send on or off.

• By selecting from the View options pop-up in the common panel, you 
can set the view for all channels in the mixer.
Selecting EQ or Surround Panners (which apply to audio channels only) will not 
change the view for MIDI channels. Selecting inserts or send effects from the common 
panel will change the view for all channel types.
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Using Channel Settings

For each MIDI channel strip in the mixer (and MIDI track in the Track 
list or the Inspector) there is an Edit (“E”) button. 

Clicking this opens the MIDI Channel Settings window. This window 
contains a duplicate of the mixer channel strip, a section with four 
MIDI inserts and a section with four MIDI send effects. Every MIDI 
channel has its own channel settings.

The MIDI Channel Settings window.
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Utilities

Link/Unlink channels

This function is used to “link” selected channels in the mixer so that 
any change applied to one channel will be mirrored by all channels in 
that group. You can link as many channels as you like, and you can 
also create as many groups of linked channels as you like. To link 
channels in the mixer, proceed as follows:

1. Press [Ctrl]/[Command] and click on the strip just above the name 
field for all the channels that you want to link.
There is an identical select channel field just above the pan control. Selected channels 
are indicated by highlighted select fields. [Shift]-clicking allows you to select a 
continuous range of channels.

2. Right-click (Win) or [Ctrl]-click (Mac) somewhere on the grey mixer 
panel.
The Mixer context menu appears.

3. Select “Link Channels” from the context menu.

• To unlink channels, select one of the linked channels and select “Un-
link Channels” from the Mixer context menu.
The channels are unlinked. Note that you do not need to select all the channels that are 
linked, only one of them.

• It is not possible to remove individual channels from Link status. 
To make individual settings to a linked channel, press [Alt]/[Option] when changing the 
setting.
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What will be linked?

The following rules apply for linked channels:

• Fader levels will be “ganged”.
The relative level offset between channels will be kept if you move a linked channel 
fader.

The three channels shown are linked. Pulling down one fader changes the levels for 
all three channels, but keeps the relative level mix.

• Any individual channel settings you have made before linking will re-
main until you alter the same setting for any of the linked channels.
For example, if you link three channels, and one of them was muted at the time you ap-
plied the Link Channel function, this channel will remain muted after linking. However, 
if you mute another channel then all linked channels will be muted. Thus, the individual 
setting for one channel is lost as soon as you change the same parameter setting for 
any of the linked channels.

• Only level, mute, solo, select, monitor and record enable will be linked 
between channels.
Effect/EQ/pan/input and output routing settings are not linked.

• By pressing [Alt]/[Option], you can make individual settings and 
changes for channels that are linked.

Linked channels can also have individual automation subtracks. These 
are completely independent, and are not affected by the Link function.
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Saving mixer settings

Saving/Loading mixer settings does not apply to MIDI channels in the 
mixer – only audio related channels (group, audio, effect return, VSTi 
and ReWire) are saved with this function!

It is possible to save complete mixer settings for selected or all audio 
channels in the mixer. These can later be loaded into any project. 
Channel settings are saved as mixer settings files. These have the 
Windows file extension “.vmx”. 

Right-clicking (Win) or [Ctrl]-clicking (Mac) somewhere on the mixer 
panel or in the Channel Settings window brings up the Mixer context 
menu where four Save/Load items can be found. The following op-
tions are available:

• “Save Selected Channels” will save all channel settings for the se-
lected channels.
Input/output routings are not saved.

• “Save All Mixer Settings” saves all channel settings for all channels.

When you select any of the above options, a standard file dialog 
opens where you can select a name and storage location on your disk 
for the file.
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Loading mixer settings 

Load Selected Channels

To load mixer settings saved for selected channels, proceed as follows:

1. Select the same number of channels in the new project to match the 
number of channels you saved settings for in the previous project.
For example, if you saved settings for six channels, then select six channels in the mixer.

• Mixer settings will be applied in the same order as they appear in the 
mixer, when saved. 
Thus, if you save settings from channels 4, 6 and 8 and apply these settings to chan-
nels 1, 2 and 3, the settings saved for channel 4 would be applied to channel 1, the 
settings saved for channel 6 to channel 2 and so on.

2. Right-click (Win) or [Ctrl]-click (Mac) the mixer panel to open the 
context menu, and select “Load Selected Channels”.
A standard file dialog appears, where you can locate the saved file.

3. Select the file and click “Open”.
The channel settings are applied to the selected channels.

If you choose to apply mixer settings to fewer channels than you saved, 
the order of the saved channels in the mixer applies – i.e. the saved 
channels that are “left over” and not applied will be the channels with 
the highest channel numbers (or furthest to the right in the mixer).

Load All Mixer Settings

Selecting “Load All Mixer Settings” from the context menu allows you 
to open a saved mixer settings file, and have the stored settings ap-
plied to all channels for which there is information included in the file. 
All channels, master settings, VST Instruments, sends and master ef-
fects will be affected.

• Please note that if the saved mixer settings were 24 channels, and the 
mixer you apply it to currently contains 16 channels, only the settings for 
channels 1 to 16 will be applied – this function will not automatically add 
channels.
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About the VST Performance window

The VST Performance window is opened by selecting it from the De-
vices menu. It indicates the current load on the CPU and the hard disk 
transfer rate. It is recommended that you check this from time to time, 
or keep it open always. Even though you have been able to activate a 
number of audio channels in the project without getting any warning, 
you may possibly run into performance problems when adding EQ or 
effects.

• The upper bar graph shows the CPU (processor) load.
If the red Overload indicator lights up, you need to decrease the number of EQ mod-
ules, active effects and/or audio channels playing back simultaneously.

• The lower bar graph shows the hard disk transfer load.
If the red overload indicator lights up, the hard disk is not supplying data fast enough to 
the computer. You may need to reduce the number of tracks playing back by using the 
Disable Track function (see page 43). If this doesn’t help, you need a faster hard disk. 
Note that the overload indicator may occasionally blink, typically when you locate dur-
ing playback. This does not indicate a problem, but happens because the program 
need an instant for all channels to load data for the new playback position.

• The CPU and Disk load meters can also be shown on the Transport 
panel and on the Project window toolbar.
There they are shown as two miniature vertical meters (by default at the left side of the 
panel/toolbar).
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About this chapter

Nuendo comes with a number of effect plug-ins included. This chap-
ter contains general details about how to assign, use and organize ef-
fect plug-ins. The effects and their parameters are described in the 
separate pdf document “Audio Effects and VST Instruments”.

This chapter describes audio effects, i.e. effects that are used to process 
audio, group, VST Instrument and ReWire channels. For info on how to 
use MIDI effects, see the separate PDF document “Working with MIDI”.

Overview

There are three ways to use audio effects in Nuendo:

• As insert effects.
An insert effect is inserted into the signal chain of an audio channel, which means that 
the whole channel signal passes through the effect. This makes inserts suitable for ef-
fects for which you don’t need to mix dry and wet sound, e.g. distortion, filters or other 
effects that change the tonal or dynamic characteristics of the sound. You can have up 
to eight different insert effects per channel (and the same is true for input and output 
busses – for recording with effects and “master effects”, respectively).

• As send effects.
Each audio channel has eight effect sends, each of which can be freely routed to an 
effect (or to a chain of effects). Send effects are practical for two reasons: you can 
control the balance between the dry (direct) and wet (processed) sound individually 
for each channel using the sends, and several different audio channels can use the 
same send effect. In Nuendo, send effects are handled by means of FX channel tracks.

• By using offline processing.
You can apply effects directly to individual audio events, see page 384.
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About VST plug-ins and tempo sync

Version 2.0 of the VST plug-in standard (and later) allows plug-ins to 
receive MIDI from the host application (in this case, Nuendo). A typical 
use for this feature is tempo-based effects (such as delays, auto-pan-
ning, etc.), but it is also used in other ways for certain plug-ins.

• MIDI timing information is automatically provided to any VST 2.0 plug-
in that “requests it”.
You don’t need to make any special settings for this.

• In many cases you set up tempo sync by specifying a base note value 
and a multiplier. The resulting timing interval is the base note value 
multiplied with the multiplier value.
For example, if you set the base note value to 1/16 (a sixteenth note) and the multiplier 
to 3, the resulting timing is 3/16. In the case of a delay effect, this means the interval 
between each delay repeat will be three sixteenth notes.

• When MIDI receive is available (or necessary) for other purposes than 
timing, the setting up and operation is described in the documentation 
for the corresponding effect.
Please refer to the pdf document “Audio Effects and VST Instruments” for details 
about the included effects.

About plug-in delay compensation

A plug-in effect may have some inherent delay or latency. This means 
that it takes a brief time for the plug-in to process the audio fed into it – 
as a result, the output audio will be slightly delayed. This may happen 
with dynamics processors featuring “look-ahead” functions, etc.

However, Nuendo provides full plug-in delay compensation through-
out the entire audio path. All plug-in delays are compensated for, main-
taining the sync and timing of all audio channels.

Normally, you don’t have to make any settings for this. However, in the 
“Plug-In Information” dialog, you can switch off plug-in delay compen-
sation for individual plug-ins by unchecking the corresponding option 
in the “Use Delay Compensation” column (see page 292). Note that 
you have to re-load the plug-in for the change to take effect.

You can also constrain the delay compensation, which is useful to 
avoid latency when recording audio or playing a VST Instrument in 
real time. See the VST instruments chapter in the separate PDF doc-
ument “Working with MIDI”.
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Insert effects

Background

As the name implies, insert effects are inserted into the audio signal 
path – this means that the audio will be routed through the effect. You 
can add up to eight different insert effects independently for each au-
dio channel (audio track, group channel track, FX channel track, VST 
Instrument channel or ReWire channel) or bus. The signal passes 
through the effects in series from the top downwards, with the follow-
ing signal path

As you can see, the last two insert slots (for any channel) are post-EQ 
and post-fader. Post-fader slots are best suited for insert effects 
where you don’t want the level to be changed after the effect, such as 
dithering (see page 269) and maximizers – both typically used as in-
sert effects for output busses.

• Applying insert effects on many channels uses up a lot of CPU power!
It might often be more efficient to use send effects, especially if you want to use the 
same type of effect on several channels. Remember that you can use the VST Perfor-
mance window to keep an eye on the CPU load.

Input gain

Insert effect 1

Insert effect 2

Insert effect 3

Insert effect 6

EQ

Volume (fader)

Insert effect 7

Insert effect 8

Insert effect 4

Insert effect 5

Insert effect 6
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Which effect plug-ins can I use as insert effects?

Most effect plug-ins will work fine as insert effects. In general, the only 
restrictions are with the number of inputs and outputs in the effects:

• For a plug-in to be usable as an insert effect, it has to have at least 1 
or 2 inputs and 1 or 2 outputs.
Different effects feature different amounts of inputs and outputs, but the number of in-
puts and outputs actually used is determined by whether you use the insert effects on 
a single (mono) audio channel, a stereo channel pair or a surround audio channel (mul-
tiple channels).

• For stereo audio channels, you need to use an effect with at least two 
inputs (stereo).
It is possible to use a mono-input effect with a stereo channel pair, but then only the 
one channel in the pair will be processed, which is probably not what you want. It is 
also possible to use an effect with more than two inputs of course, since both chan-
nels in the stereo pair will be processed even though the effect actually accommo-
dates more.

• For mono audio channels, you can use mono- or stereo-input effects.
However, since the audio channel is in mono, the output of the effect will also be in 
mono. For stereo output effects, the left channel will then be used.

• For multi-channel audio tracks, you can use effects with any number 
of inputs.
If you use an effect with only one or two inputs however, this will have the effect that 
only one or two channels (most often L and/or R) in a surround configuration will be af-
fected, leaving the other channels unprocessed by the effect. See page 266.
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Routing an audio channel or bus through insert effects

Insert effect settings are available in the mixer (in extended mode), the 
Channel Settings window and the Inspector (audio tracks, group tracks 
and FX tracks only). The examples below show the Channel Settings 
window, but the procedures are similar for all three send sections:

1. Bring up the Channel Settings window, the Inserts pane in the ex-
tended mixer or the Inserts section in the Inspector.
In the Channel Settings window, the inserts are located immediately to the right of the 
channel strip.

2. Pull down the effect type pop-up for one of the insert slots, and select 
an effect.

The effect is loaded and automatically activated and its control panel 
appears. You can hide or show the control panel for the effect by 
clicking the “e” button for the insert slot.

• If the effect has a Dry/Wet Mix parameter you can use this to adjust 
the balance between the dry signal and the effect signal.
See page 287 for details about editing effects.

• When one or several insert effects are activated for a channel, the in-
sert effects buttons light up in blue in the mixer and Track list. Click 
the button for a channel to bypass (disable) all its inserts.
When the inserts are bypassed, the buttons are yellow. Click the button again to en-
able the inserts. Note that the bypass button is also available in the Inspector and the 
Channel settings window for the audio track.
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• To remove an effect, pull down the effect type pop-up menu and se-
lect “No Effect”.
You should do this for all effects that you don’t intend to use, to minimize unnecessary 
CPU load.

• When you have several insert effects for a channel, you can bypass 
separate effects by clicking the bypass button of the respective slot.
When an effect is bypassed, the button is yellow.

The “Reverb A” insert effect slot is bypassed.

Insert effects in the channel overview

If the “Channel” section is selected in the Inspector or the “Channel 
Overview” view mode is selected in the extended mixer, you will get 
an overview of which EQ modules, insert effects and effect sends are 
activated for the channel.

You can activate or deactivate individual insert effect slots by clicking 
the corresponding number (in the upper half of the overview).

The channel overview in the Inspector.
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Using mono or stereo effects with a surround channel

Normally, when you apply a mono or stereo insert effect to a surround 
(multi channel) track, the first speaker channel(s) of the track (often L 
and/or R) are routed through the effect’s available channels, and the 
other channels of the track are left unprocessed.

However, you may want to apply the effect to other speaker channels. 
This is done in the Channel Settings window:

1. Click in the small window to the left above the inserts section to open 
up the Display Modes pop-up menu.

2. Select “Routing” from the menu.
The inserts section changes appearance, to display a row of small signal diagrams.



NUENDO
Audio effects 11 – 267

3. Double click on the small signal diagram for the effect to open up an 
editor window.

The columns in the diagram represent the channels in the current sur-
round configuration, with signals passing from top to bottom. The grey 
field in the middle represents the actual effect plug-in.

• The squares above the effect represent inputs to the effect plug-in.
• The squares below the effect represent outputs from the effect plug-in.
• A line that passes through the effect (with no square input/output indicators) 

represent a bypass connection – the audio on that speaker channel passes 
the effect without being processed.

• A “broken” line indicates a broken connection – the audio on that speaker 
channel will not pass on to the output at all.

Here, the effect will process the L and R channels. The Ls, Rs and C channels will 
pass through unaffected, while the Lfe connection is broken.
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Operations

You can move connections to the effect inputs and outputs sideways 
to route the audio to/from other inputs/outputs than the standard con-
figuration. To do this, you click the arrow buttons to the right.

• The upper two arrows move the input connections, and the lower two 
arrows move the output connections.
If the “Link” checkbox is activated the input and output connections will be moved at 
the same time. This is the mode to use when you simply want to process other chan-
nels than the default, without any cross-connections.

• If you move inputs or outputs independently of each other, this means 
you create a “cross-connection”.

The audio on the Ls-Rs channels is processed in the plug-in and output on the L-R 
channels. Since the L-R channels are bypassed, this means the final L-R output will 
contain both the original L-R signals and the processed Ls-Rs signals.

• If a channel is bypassed (a straight line is shown through the plug-in) 
you can click the line to break the connection.
Click again to replace the broken connection with a bypass.

• Clicking Reset gets you back to the original standard connection.

• Changes you make in this window are audible immediately.
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About adding insert effects to busses

As already stated, all input and output busses have eight insert slots, 
just like regular audio channels. The procedures for adding insert ef-
fects are the same (except you cannot use the Inspector here).

• Adding insert effects to an input bus allows you to record with effects.
The effects will become a permanent part of the recorded audio file (see page 72).

• Insert effects added to an output bus will affect all audio routed to that 
bus, like a “master insert effect”.
Typically you would add compressors, limiters, EQ or other plug-ins to tailor the dy-
namics and sound of the final mix. A special case is dithering, as described below.

Dithering

Dithering is a method for controlling the noise produced by quantiza-
tion errors in digital recordings. The theory behind this is that during 
low level passages, only a few bits are used to represent the signal, 
which leads to quantization errors and hence distortion. 

For example, when “truncating bits”, as a result of moving from 24- to 
16-bit resolution, quantization errors are added to an otherwise im-
maculate recording. By adding a special kind of noise at an extremely 
low level, the effect of these errors is minimized. The added noise 
could be perceived as a very low-level hiss under exacting listening 
conditions. However, this is hardly noticeable and much preferred to 
the distortion that otherwise occurs.

When should I use dithering?

• Consider dithering when you mix down to a lower resolution, either in 
real-time (playback) or with the Export Audio Mixdown function. 
A typical example is when you mix down a project to a 16-bit stereo audio file for audio 
CD burning.

What is a “lower resolution” then? Well, Nuendo uses 32-bit float res-
olution internally, which means that all integer resolutions (16-bit, 24-
bit, etc.) are lower. The negative effects of truncation (no dithering) are 
probably most noticeable in 8-bit, 16-bit and 20-bit format; whether 
to dither when mixing down to 24 bits is perhaps a matter of taste.



NUENDO
11 – 270 Audio effects

Applying dithering

1. Click the “e” button to bring up the Output Settings window for the 
output bus, or display its Inserts section in the extended mixer pane, 
as described above.

2. Pull down the Inserts pop-up menu in slot 7 or 8.
The two last Insert effect slots (for all channels) are post-fader, which is crucial for a 
dithering plug-in. The reason is that any master gain change applied after dithering 
would bring the signal back to the internal 32 bit float domain, rendering the dithering 
settings useless.

3. Select a dithering plug-in from the pop-up menu.
Dithering plug-ins included with Nuendo are: 

For a description of the included dithering plug-ins and their parame-
ters, please see the separate PDF document “Audio Effects and VST 
Instruments”. If you have installed another dithering plug-in that you 
prefer, you can of course select this instead.

4. Make sure the dithering plug-in is set to dither to the correct resolu-
tion.
This would be the resolution of your audio hardware (on playback) or the desired res-
olution for the mixdown file you want to create (as set in the Export Audio Mixdown di-
alog, see page 551).

5. Use the other parameters in the control panel to set up the dithering 
to your liking.

Plug-in Description

UV22HR UV22HR offers very high-quality dithering with support for multiple 
resolutions (8, 16, 20 or 24 bits).

SurroundDither SurroundDither is a surround-compatible plug-in capable of dither-
ing six channels at the same time. If you are applying dithering to a 
surround bus, this is the recommended dithering plug-in to use.
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Using group channels for insert effects

Like all other channels, group channels can have up to eight insert ef-
fects. This is useful if you have several audio tracks that you want to 
process through the same effect (e.g. different vocal tracks that all 
should be processed by the same compressor). Another special use 
for group channels and effects is the following:

If you have a mono audio track and want to process this through a ste-
reo insert effect (e.g. a stereo chorus or an auto panner device), you 
cannot just insert the effect as usual. This is because the audio track 
is in mono – the output of the insert effect will then be in mono as well, 
and the stereo information from the effect will be lost.

One solution would be to route a send from the mono track to a stereo 
fx channel track, set the send to pre fader mode and lower the fader 
completely for the mono audio track. However, this makes mixing the 
track cumbersome, since you cannot use the fader. Here’s another 
solution:

1. Create a group channel track in stereo and route it to the desired out-
put bus.

2. Add the desired effect to the group channel as an insert effect.

3. Route the mono audio track to the group channel.

Now the signal from the mono audio track is sent directly to the group, 
where it passes through the insert effect, in stereo.
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Freezing insert effects for a track

Effect plug-ins can sometimes require a lot of processor power. If you 
are using a large number of insert effects for a track, you may eventu-
ally reach a point where the computer cannot play back the track 
properly (the CPU overload indicator in the VST Performance window 
lights up, you get crackling sounds, etc.).

To remedy this, you can freeze the track, by clicking on the Freeze 
button in the Inspector.

• When you freeze an audio track, the program renders the output of the track, 
including all pre-fader insert effects, to an audio file. This file is placed in the 
“Freeze” folder within the Project folder.

• The frozen audio track is locked for editing in the Project window. The frozen 
insert effects cannot be edited or removed and you cannot add new insert ef-
fects for the track (except post-fader effects).

• On playback, the rendered audio file is played back. You can still adjust the 
level and panning in the Mixer, make EQ settings and adjust the effect sends. 
In the Mixer, the channel strip for a frozen track is indicated by a “snow flake” 
symbol on the volume fader handle.

The result is that you hear the track play back as before but the insert 
effects don’t have to be calculated in real time, easing the load on the 
computer processor. Typically, you would freeze a track when it’s 
more or less finished and you don’t need to edit it at the moment. 

Unfreezing

If you need to edit the events on the track or make settings for the in-
sert effects, you need to unfreeze the track:

1. Click the Freeze button in the Inspector for the track.
You will be asked whether you really want to unfreeze the instrument and if you wish to 
keep or delete the freeze files.

2. Click “Unfreeze” or “Keep Freeze files”.
This reactivates the frozen insert effects. Clicking “Keep Freeze Files” will unfreeze the 
channel but not delete the freeze files. After editing you can freeze the track again.
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Notes

• You can only freeze audio tracks this way, not group channel tracks or FX 
channel tracks.

• The last two insert effects will not be frozen. This is because these are post-
fader insert slots.

• You can also freeze VST instruments and their insert effects – see the VST In-
struments chapter in the separate PDF document “Working with MIDI”.

Send effects

Background

Send effects are handled through FX channel tracks. These are spe-
cial tracks that each can contain up to eight insert effects. The signal 
path is as follows:

• By routing an effect send from an audio track to an FX channel track, 
the audio is sent to the FX channel and through its insert effect(s).
Each audio channel has eight sends, which can be routed to different FX channels. 
You control the amount of signal sent to the FX channel by adjusting the effect send 
level.

• If you have added several effects to the FX channel, the signal passes 
through the effects in series, from the top (the first slot) downward.
This allows for “custom” send effect configurations – you could e.g. have a chorus fol-
lowed by a reverb followed by an EQ and so on.

• The FX channel track has its own channel strip in the mixer, the effect 
return channel.
Here you can adjust the effect return level and balance, add EQ and route the effect 
return to any output bus.

• Each FX channel track has an automation subtrack, for automating 
various effect parameters. 
See page 337 for information.
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Setting up send effects

Adding an FX channel track

1. Pull down the Project menu and select “FX Channel” from the “Add 
Track” submenu.
A dialog appears.

2. Select a channel configuration for the FX channel track.
Normally, stereo is a good choice since most effect plug-ins have stereo outputs.

3. Select an effect for the FX channel track.
This is not strictly necessary at this point – you can leave the Plug-in pop-up menu set 
to “No Effect” and add effects to the FX channel later if you like.

4. Click OK.
An FX channel track is added to the Track list, and the selected effect, if any, is loaded 
into the first insert effect slot for the FX channel (in that case, the lit Inserts tab for the 
FX channel track in the Inspector indicates that an effect has been assigned and auto-
matically activated).

• All FX channel tracks you create will appear in a kind of “folder” in the 
Track list.
This makes it easy to manage and keep track of all your FX channel tracks, and also al-
lows you to save screen space by folding the FX Channel folder.

FX channel tracks are automatically named “FX 1”, “FX 2” etc., but you can rename 
them if you wish. Just double click the name of an FX channel track in either the 
Track list or the Inspector and type in a new name.
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Adding and setting up effects

As mentioned above, you can add a single insert effect when you cre-
ate the FX channel track if you like. To add and set up effects after the 
FX channel track is created, you can either use the Inspector for the 
track (click the Inserts tab) or the FX Settings window:

1. Click the Edit (“e”) button for the FX channel track (in the Track list, 
mixer or Inspector).
The FX Settings window appears, similar to a regular Channel Settings window.

To the left in the window is the Inserts section with eight effect slots.

2. Make sure the FX channel is routed to the correct output bus.
This is done with the output routing pop-up menu at the top of the fader section (also 
available in the mixer and Inspector).

3. To add an insert effect in an empty slot (or replace the current effect in 
a slot), click on the slot and select an effect from the pop-up menu.
This works just like when selecting insert effects for a regular audio channel.

4. When you add an effect, its control panel will automatically appear. 
Typically you should set the Wet/Dry Mix control to all “wet”.
This is because you control the balance between wet and dry signal with the effect 
sends. For more about making settings in the effect control panels, see page 287.
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• If you like, you can add up to eight effects for the FX channel.
Note that the signal will pass through all the effects in series. It is not possible to adjust 
the effect send- and return levels separately for each effect – this is done for the FX 
channel as a whole. If what you want is several separate send effects (where you can 
control their send and return levels independently) you should instead add more FX 
channel tracks – one for each effect.

• To remove an insert effect from a slot, click the slot and select “No 
Effect” from the pop-up menu.
You should do this for all effects that you don’t intend to use, to minimize unnecessary 
CPU load.

• You can also bypass individual effects (or all effects) by clicking the 
corresponding Bypass Inserts button(s) for the FX channel track.
See page 264.

• You can also adjust level, pan and EQ for the effect return in this 
window.
As always, this can also be done in the mixer or in the Inspector.

• Remember that effects rely heavily on the CPU power in your computer. 
The more activated effect units, the more computer power will be used for effects.

Setting up the sends

The next step is to set up and route a send for an audio channel to the 
FX channel. This can be done in the mixer (in the extended panel), in 
the Channel Settings window or in the Inspector for the audio track. 
The example below shows the Channel Settings window, but the pro-
cedure is similar for all three sections:

1. Click the “e” button for an audio channel to bring up its Channel Set-
tings window.
In the mixer you would select one of the Sends modes for the extended mixer panel; in 
the Inspector you would click the Sends tab.

In the channel settings window, the send section is located to the far 
right. Each of the eight sends has the following controls and options:

• A send on/off switch
• A send level slider
• A pre/post fader switch
• An Edit button
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2. Pull down the routing pop-up menu for a send by clicking in the empty 
slot, and select the desired routing destination.

• If the first item on this menu, “No Bus” is selected, the send isn’t routed any-
where.

• Items called “FX 1”, “FX 2” etc. correspond to existing FX tracks. If you have 
renamed an FX track (see page 274) that name will appear on this menu in-
stead of the default.

• The menu also allows for routing a send directly to output busses, separate 
output bus channels or Group channels.

• Sends on Output busses can only be routed to other Output busses, not to 
FX channels or Group channels.

3. In this case, select an FX channel track from the pop-up menu.
Now the send is routed to the FX channel.

4. Click the power button for the effect send so that it lights up in blue.
This activates the send.
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5. Click and drag the send level slider to a moderate value.
The send level determines how much of the signal from the audio channel is routed to 
the FX channel via the send.

Setting the Send level.

6. If you want the signal to be sent to the FX channel before the audio 
channel’s volume fader in the mixer, click on the Pre Fader button for 
the send so that it lights up.
Normally you want the effect send to be proportional to the channel volume (post fader 
send). The pictures below show where the sends are “tapped” from the signal in pre 
and post fader mode:

A send set to pre fader mode.

Input gain

Insert effects 1-6

EQ

Volume (fader)

Insert effects 7-8

Pre-fader sends

Post-fader sends
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• You can choose whether a send in pre fader mode should be affected 
by the channel’s Mute button or not.
This is done with the option “Mute Pre-Send when Mute” in the Preferences (VST page).

• When one or several sends are activated for a channel, the Send 
Effects buttons light up in blue in the mixer and the Track list. Click the 
button for a channel to bypass (disable) all its effect sends.
When the sends are bypassed, the button is yellow. Click the button again to enable 
the sends. Note that this button is also available in the Inspector and the Channel set-
tings window.

Click this button to bypass the sends.

• You can also bypass individual sends in the channel overview.
See page 265.

• Alternatively, in the same manner you can bypass the send effects by 
clicking the “Bypass Inserts” button for the FX channel.
The difference is that this bypasses the actual send effects which may be used by sev-
eral different channels. Bypassing a send affects that send and that channel only.
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Setting pan for the sends

By default, the sends for an audio channel follow any pan settings – 
stereo or surround – you make for the channel itself. This means that 
if an audio channel is panned to the right, the signal from its effect 
sends will be panned the same way, making the stereo imaging as 
clear and true as possible.

However, you may want to have different pan settings for the sends. 
There are several uses for this:

• If you route a send from a mono channel to a stereo FX channel track, you can 
position the send signal at center pan in the stereo FX channel (or anywhere 
you like).

• If you route a send from a stereo channel to a mono FX channel track, the pan 
control works as a crossfader, determining the balance between the stereo 
sides when the stereo send signal is mixed to mono.

• If you route a send from a mono or stereo channel to a FX channel track in 
surround format, you can use the surround panner to position the send signal 
in the surround image.

You set up send panning the following way:

1. Open the Channel settings window for the audio channel.

2. Pull down the Display Modes pop-up menu, located above the sends 
to the right.
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3. On the menu, select “Routing”.
Each send is now shown as a small routing diagram, showing (from left to right) pre/
post selector, send on/off switch, send level, pan (where applicable) and send routing. 
You can adjust all of these settings here if needed.

4. Deactivate the “Link Send Routing Panners...” button above the rout-
ing display.
When this is activated, the send panners follow the pan for the channel.

5. Click and drag the pan control for the desired send(s) in the display.
As usual, you can reset the pan control to the center position by pressing [Ctrl]/[Com-
mand] and clicking on the pan control slider.

• If the FX channel is configured in a surround format, the pan control will 
be a miniature surround panner, similar to the one found in the mixer.
You can click and drag the “ball” in this figure to position the send in the surround field, 
or double click the figure to bring up the surround panner. See page 311.

• If both the send (the audio channel) and the FX channel is in mono, the 
pan control is not available.

About sends for FX channels

The FX channels themselves have sends, too. However, these can 
only be routed to output busses, not to effects.
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Setting effect levels

After you have set up the sends as described in the previous sections, 
the following is now possible:

• You can use the send level slider in the Channel Settings, Inspector, 
or the extended part of the mixer to set the send level.
By adjusting the send level you control the amount of signal sent from the audio chan-
nel to the FX channel.

Setting the effect send level.

• In the mixer, you can use the level fader for the FX channel to set the 
effect return level.
By adjusting the return level you control the amount of the signal sent from the FX 
channel to the output bus.

Setting the effect return level.
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FX channels and the Solo Defeat function

When mixing, you might sometimes want to solo specific audio chan-
nels, and listen only to these while other channels are muted. How-
ever, this will mute all FX channels as well. If the soloed audio 
channels have sends routed to FX channels, this means you won’t 
hear the send effects for the channels.

To remedy this, you can use the Solo Defeat function for the FX chan-
nel:

1. First press [Alt]/[Option] and click on the Solo button for the FX 
channel.
This activates the Solo Defeat function for the FX channel. In this mode, the FX 
channel will not be muted if you solo another channel in the mixer.

2. You can now solo any of the audio channels without having the effect 
return (the FX channel) muted.

3. To turn off the Solo Defeat function for the FX channel, [Alt]/[Option]-
click the Solo button for the FX channel again.
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Using external effects

Although this program comes with a top selection of VST effect plug-
ins and there’s a huge range of additional plug-ins available on the 
market, you may still have some hardware effect units that you want to 
use - valve compressors, reverb units, vintage tape echo machines, 
etc. By setting up external FX busses you can make your outboard 
equipment part of Nuendo’s virtual studio!

An external FX bus is basically a combination of outputs (sends) and 
inputs (returns) on your audio hardware, along with a few additional 
settings. All external FX busses you have created will appear on the 
effect pop-up menus and can be selected in the same way as any ef-
fect plug-in. The difference is that if you select an external effect as an 
insert effect for an audio track, the audio will be sent to the corre-
sponding audio output, processed in your hardware effect (provided 
that you have connected it properly) and returned via the specified au-
dio input.

Requirements

• To use external effects, you need audio hardware with multiple inputs and out-
puts. This is necessary because your external effect will require at least one 
input and one output (or input/output pairs for stereo effects) - apart from the 
input/output ports you use for recording and monitoring.

• As always, audio hardware with low-latency drivers is a good thing to have. 
Nuendo will compensate for the input/output latency and ensure that the au-
dio processed through the external effect isn’t shifted in time. However, this 
automatic delay compensation results in added latency - if your audio hard-
ware has a high latency to start with, this could be a problem.

Setting up

To set up an external effect device, proceed as follows:

1. Connect an unused output pair on your audio hardware to the input 
pair on your hardware effect.
In this example, we assume that the hardware effect has stereo inputs and outputs.

2. Connect an unused input pair on your audio hardware to the output 
pair on your hardware effect.

3. Open the VST Connections window from the Devices menu.
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4. Click the External FX tab and click “Add External FX”.

5. In the dialog that appears, select Stereo on both pop-up menus 
(Send and Return configurations).
Again, this is because the hardware uses stereo connections in our example. If it uses 
mono connections, you should select Mono on the pop-ups, etc.

This adds a new External FX bus.

6. Click in the Device Port column for the Send Bus “Left” and “Right” 
ports and select the outputs on your audio hardware that you con-
nected in step 1 above.

7. Click in the Device Port column for the Return Bus “Left” and “Right” 
ports and select the inputs on your audio hardware that you con-
nected in step 2 above.

8. Select the bus, click in the Bus Name column and enter a name for 
the external effect (e.g. the name of the actual hardware effect).

9. If you like, make additional settings for the bus.
These are found in the three columns to the right. Note however that you can adjust 
these while using the external effect - that may be easier as you can hear the result.

Setting Description

Delay If your hardware effect device has an inherent delay (latency), 
you should enter this value here. This allows Nuendo to compen-
sate for that delay during playback. Note that you don’t have to 
take the latency of the audio hardware into account - that is han-
dled automatically by the program.
In most cases you should be able to leave this setting at 0 ms. 
Effect devices that may have noticeable latency include digital 
dynamics processors with look-ahead - consult the technical 
specifications of the device if you’re uncertain.
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10.When you are done, close the VST Connections window.

How to use the external effect

If you now click an insert effect slot for any channel and look at the ef-
fect pop-up menu, you will find the new external FX bus listed under 
the “External Plugins” heading.

When you select it, the following happens:

• The external FX bus is loaded into the effect slot just like a regular effect plug-in.
• The audio signal from the channel will be sent to the outputs on the audio 

hardware, through your external effect device and back to the program via the 
inputs on the audio hardware.

• A parameter window appears, showing the Delay, Send Gain and Return Gain 
settings for the external FX bus. You can adjust this as necessary while playing 
back.

Like any effect, you can use the external FX bus as an insert effect or 
as a send effect (an insert effect on an FX channel track). You can de-
activate or bypass the external effect with the usual controls.

Send Gain Allows you to adjust the level of the signal being sent to the ex-
ternal effect.

Return Gain Allows you to adjust the level of the signal from the external ef-
fect. Note however that excessive output levels from an external 
effect device may cause clipping in the audio hardware. Return 
gain cannot be used to compensate for this - lower the output 
level on the effect device instead.

Setting Description



NUENDO
Audio effects 11 – 287

Making settings for the effects

Selecting effect presets

Most VST effect plug-ins come with a number of useful presets for in-
stant selection. You can select presets in the control panel for the ef-
fect, but they are also available for selection from the Channel 
Settings window:

1. Open the Channel Settings for the channel with the insert effects.
This means that to select presets for send effects, you should open the FX Settings 
window for the FX channel track.

2. Pull down the Display Modes pop-up menu above the insert slots and 
select “Preset”.
Now the insert slots show the currently selected presets.

3. Click on a preset name to open the pop-up menu and select another 
preset.
You can also use the small arrow buttons to the right of the Preset field to step through 
the available presets.
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Editing effects

All inserts and sends have an Edit (“e”) button. Clicking this opens the 
selected effect’s control panel in which you can make parameter set-
tings.

The contents, design and layout of the control panel depends on the 
selected effect. However, all effect control panels have a power but-
ton, a Bypass button, Read/Write automation buttons (for automating 
effect parameter changes – see page 337), a preset selection pop-up 
menu and a file pop-up menu for saving or loading programs. In Nu-
endo for Mac OS X these are located at the bottom of the control 
panel, whereas they are at the top of the control panel in Nuendo un-
der Windows.

The Rotary effect control panel.

• Please note that all effects can be edited using a simplified control 
panel (horizontal sliders only, no graphics) if you prefer this. To edit 
effects using this “basic” control panel instead, press [Ctrl]/[Com-
mand]+[Shift] and click on the Edit button for the effect send or slot.

Making settings

Effect control panels may have any combination of knobs, sliders, but-
tons and graphic curves. 

• For specifics about the included effects and their parameters, please re-
fer to the separate pdf document “Audio Effects and VST Instruments”. 
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Naming effects

If you edit the parameters for an effect, these settings are saved auto-
matically in the project. If you want to name the current settings, the 
following points apply:

• The basis for the current settings may have been a preset effect program, in 
which case there is a name in the preset field.

• The basis for the current settings may have been a default setting program lo-
cation in which case “Default” is displayed in the preset field.

In both cases, if you have changed any effect parameter settings, 
these are already saved! To name the current settings, click the Name 
field, type in a new name and press [Return]. The new name replaces 
the previous name on the program pop-up menu.

Saving effects

You can save your edited effects for further use (e.g. in other projects) 
by using the file pop-up menu to the right of the name field.

1. Pull down the file pop-up menu.

• If you want to save the current program only, select “Save Effect”.
Effect programs have the Windows file extension “fxp”.

• If you want to save all programs for the effect, select “Save Bank”.
Effect banks have the Windows file extension “fxb”.

2. In the file dialog that appears, select a name and location for the file 
and click Save.
It might be a good idea to prepare a special folder for your effects.

Loading effects

1. Pull down the file pop-up menu.

2. Select “Load Effect” or “Load Bank”.

3. In the file dialog that opens, locate the file and click Open.
If you loaded a Bank, it will replace the current set of all effect programs. If you loaded 
a single effect, it will replace the currently selected effect program only.

Automating effect parameters

Effects parameters can be automated – see the chapter “Automation”.
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Installing and managing effect plug-ins

There is a wide range of additional effect plug-ins available in the two 
formats supported by Nuendo (VST and DirectX). The two formats are 
handled differently when it comes to installation and organizing:

VST plug-ins

Mac OS X

Plug-ins in Mac OS 9.X format cannot be used.

There is a large number of VST plug-ins available for purchase or 
download. To install a VST plug-in under Mac OS X, quit Nuendo and 
drag the plug-in file to one of the following folders:

• /Library/Audio/Plug-Ins/VST/
This is only possible if you are the system administrator. Plug-ins installed in this folder 
will be available to all users, for all programs that support them.

• Users/Username/Library/Audio/Plug-Ins/VST/
“Username” above is the name you use to log on to the computer (the easiest way to 
open this folder is to go to your “Home” folder and use the path /Library/Audio/Plug-
Ins/VST/ from there). Plug-ins installed in this folder are only available to you.

When you launch Nuendo again, the new effects will appear on the 
effect pop-up menus.

• An effect plug-in may also come with its own installation application, in 
which case you should use this.
Generally, always read the documentation or readme files before installing new plug-ins.

Windows

Under Windows, VST plug-ins are usually installed simply by drag-
ging the files (with the extension “.dll”) into the Vstplugins folder in the 
Nuendo application folder, or into the Shared VST Plug-in folder – 
see below. When you launch Nuendo again, the new effects will ap-
pear on the Effect pop-up menus.

• If the effect plug-in comes with its own installation application, you 
should use this.
Generally, always read the documentation before installing new plug-ins.
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Organizing VST plug-ins

If you have a large number of VST plug-ins, having them all on a single 
pop-up menu in the program may become unmanageable. For this 
reason, the plug-ins installed with Nuendo are placed in appropriate 
subfolders according to the effect type.

• Under Windows, you can rearrange this by moving, adding or renam-
ing subfolders within the Vstplugins folder if you like. 
When you launch the program and pull down an Effects pop-up menu, the subfolders 
will be represented by hierarchical submenus, each listing the plug-ins in the corre-
sponding subfolder.

• Under Mac OS X, you cannot change the hierarchic arrangement of 
the “built-in” VST plug-ins.
You can however arrange any additional plug-ins you have installed (in the /Library/
Audio/Plug-Ins/VST/ folders, see above) by placing them in subfolders. In the pro-
gram, the subfolders will be represented by hierarchical submenus, each listing the 
plug-ins in the corresponding subfolder.

About shared VST plug-ins (Windows only)

While Nuendo’s own plug-ins reside in the Vstplugins folder within 
the Nuendo program folder, the program can also access plug-ins in 
an additional location, called the shared VST plug-ins folder. This lets 
you use plug-ins installed by other VST compatible applications, etc. 
You can change what folder is considered the “shared” Vstplugins 
folder at any time in the Plug-in Information window, see page 292.

About the “Nuendo 1.x Plug-ins”

In the Additional Content folder on the program DVD you can find the 
effects from previous program versions of Nuendo.

The foremost reason for installing these earlier plug-ins is backwards 
compatibility, allowing you to import old Nuendo projects and get the 
correct effect settings.



NUENDO
11 – 292 Audio effects

DirectX plug-ins (Windows only)

To be able to use DirectX plug-ins, you must have Microsoft DirectX 
installed on your computer (Version 8.1 – or later – recommended 
and included on the Nuendo DVD). 

DirectX plug-ins should not be placed in the Vstplugins folder, as 
these are installed under the operating system rather than for Nuendo 
exclusively. Rather, you should follow the installation instructions in-
cluded with the plug-ins. See also page 296.

• On the effect menus, all DirectX plug-ins are listed on the DirectX sub-
menu. 
Selecting, activating and editing them is done as with VST effects.

The Plug-in Information window

On the Devices menu, you will find an item called “Plug-in Informa-
tion”. Selecting this opens a dialog listing all the available VST and Di-
rectX compatible plug-ins in your system (including VST Instruments), 
along with all MIDI plug-ins. The MIDI plug-ins are described in the 
separate PDF document “Working with MIDI”.
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Managing and selecting VST plug-ins

To see which VST plug-ins are available in your system, click the “VST 
Plug-ins” tab at the top of the window. The window now displays all 
plug-ins in the Nuendo and the shared Vstplugins folder. 

• The plug-ins are color-coded to help you find plug-ins of a specific type - re-
fer to the color fields at the top of the window.

• To enable a plug-in (make it available for selection), click in the left column.
Only the currently enabled plug-ins (shown with a check sign in the left column) will 
appear on the effect menus.

• The second column indicates how many instances of the plug-in are currently 
used in Nuendo.
Clicking in this column for a plug-in which is already in use produces a pop-up show-
ing exactly where each use occurs - select an instance to open the control panel for 
the plug-in. 

• Plug-ins which crash when you try to start them, will be marked as “unload-
able” in the VST plugin window and skipped at the next start.
These plug-ins can be activated again in the VST plug-in window.

• If you activate the “Show used only” checkbox, only the plug-ins that are used 
will be shown in the list.

• A plug-in may be in use even if it isn’t enabled in the left column. 
You might for example have opened a project containing effects that currently are dis-
abled on the menu. The left column purely determines whether or not the plug-in will 
be visible on the effect menus.

• All columns can be resized by using the divider in the column header.

The other columns show the following information about each plug-in:

Column Description

Name The name of the plug-in.

Nb I/O This column shows the number of inputs and outputs for each plug-in.

Category This indicates the category of each plug-in (such as VST Instruments, 
Surround Effects, etc.).

Vendor The manufacturer of the plug-in.

VST Version Shows with which version of the VST protocol a plug-in is compatible.
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Update Button

Pressing this button will make Nuendo re-scan the designated Vstplu-
gins folders for updated information about the plug-ins.

Export List button

• If you click this button, a text file with the plug-in info is generated.
This document could be useful if you need to contact Steinberg Technical Support – 
or you might want to use it just as a handy reference of the installed effects.

Delay (sample) This shows the delay (in samples) that will be introduced if the effect is 
used as an Insert. This is automatically compensated for by Nuendo.

Use Delay 
Compensation

This option (checked by default) means that plug-in delay compensa-
tion is used for this plug-in (see page 261). Note that you can tempo-
rarily constrain delay compensation - see the VST Instruments chapter 
in the separate PDF document “Working with MIDI”.

Nb Params The number of parameters for the plug-in.

Nb Programs The number of programs for the plug-in.

Old Host 
Behaviour

Check this column for a specific plug-in if you want it to be processed 
like it was by previous versions of Nuendo, to avoid problems such as 
feedback-like sounds. Note that you have to reload the plug-in for the 
change to take effect. 

Modified The last modification date of the plug-in file.

Path The path and name of the folder in which the plug-in file is located.

Column Description
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Changing the Shared Plug-ins Folder (Windows only)

If you like, you can change what folder is to be the “shared” Vstplugins 
folder. For example, if you have Steinberg’s Cubase installed on your 
computer, you can get access to the Cubase-specific plug-ins in Nu-
endo by switching to the Vstplugins folder within the Cubase folder.

The currently selected Shared Folder is displayed in the text field at 
the top of the window. Clicking the “Change...” button opens a file di-
alog where you can browse to another Vstplugins folder on your hard 
drive. Clicking OK selects the new folder as the shared VST plug-ins 
folder.

After selecting a new shared plug-ins folder, you will first be prompted 
to confirm your choice, and you will then need to restart Nuendo for the 
effects in the new folder to become available.

• Similarly, you can also add additional Shared Plug-ins folders by click-
ing the “Add” button and browsing to another Vstplugins folder on 
your hard drive.
If you have several folders assigned as Shared Plug-ins Folders, you can at any time 
use the text field pop-up menu to decide which of the assigned folders should be the 
designated active one.

• To remove a Shared Plug-ins Folder, select it and click the “Remove” 
button.
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Managing and selecting DirectX plug-ins (Windows only)

To see which DirectX plug-ins are available in your system, click the 
“DirectX Plug-ins” tab at the top of the window.

• To enable a plug-in (make it available for selection), click in the left-
most column.
Only the currently enabled plug-ins (shown with a check sign in the left column) will 
appear on the Effect menus.

The idea here is that there could be a variety of DirectX plug-ins in 
your system, many of which are not intended for musical audio pro-
cessing. Disabling these helps you keep the effect menus in Nuendo 
more manageable.

• The second column indicates how many instances of the plug-in are 
currently used in Nuendo.
Clicking in this column for a plug-in which is already in use produces a pop-up show-
ing exactly where each use occurs.

Please note that a plug-in may be in use even if it isn’t enabled in the left 
column. You might for example have opened a project containing ef-
fects that currently are disabled on the menu. The left column purely de-
termines whether or not the plug-in will be visible on the effect menus.
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Background

What is Surround sound?

Surround is a common name for various techniques for positioning 
audio in reference to the listener. Whereas regular stereo is limited to 
left/right positioning, within a relatively narrow field, surround sound 
opens possibilities of positioning an audio source anywhere around 
the listener.

Surround sound comes in many flavors, from the ill-fated Quadraphonic 
format for vinyl discs launched in the 70s, to today’s more successful 
incarnations.

The differences between the formats are in two areas:

• The number and configuration of speakers.
This varies from two speakers up to 12.

• The intended final coding format.
This depends on the media the audio will be “stored” on: film, broadcast video or DVD, 
for example.

Surround sound is a large topic, there are entire books and regular 
publications devoted to the subject. This chapter will not provide an 
in-depth introduction to surround sound as such. Instead it will con-
centrate on the specific implementation in Nuendo.

Surround sound in Nuendo

Nuendo has integrated surround sound features with support for sev-
eral formats. This support goes all the way through the audio path – all 
audio channels and busses can handle multiple speaker channel con-
figurations (up to 12 channels). An individual channel in the mixer can 
either carry complete surround mixes, or an individual speaker channel 
which is part of a surround setup.

• Audio channels can be routed freely to surround channels.
• The Surround Panner function in the mixer allows you to graphically position 

channels in the surround field.
• The Mixconvert plug-in allows conversion of one surround channel into an-

other with a different speaker configuration. Nuendo places Mixconvert auto-
matically where needed.
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• Nuendo is ready for surround specific plug-ins, that is plug-ins with multi 
channel support specifically designed for surround sound mixing tasks (the 
included “Mix8to2” plug-in is an example of this). 
There are also surround aware plug-ins, which are not designed specifically 
for Surround but which due to their multi-channel support work well in a 
Surround configuration. An example is the Surrounddither plug-in.

• You configure Nuendo for surround by defining input and output busses in 
the desired surround format, and specifying which audio inputs and outputs 
should be used for the different channels in the busses. This is done in the 
VST Connections window.

Requirements for using Surround

The following additional equipment is required for taking advantage of 
Nuendo’s surround sound implementation:

• An audio card with more than two outputs.
The card must have as many outputs as the surround format you plan to select.

• A matching amplifier/speaker configuration.

Encoding

The result of a surround mix in Nuendo is either the multi-channel au-
dio sent from the surround output bus to your surround speaker setup, 
or (if you use the Export audio feature) audio file(s) on your hard disk. 
Exported surround mixes can either be split (one mono file per speaker 
channel) or interleaved (a single file containing all the surround chan-
nels).

Getting from this step to the final product (surround sound on DVD 
disc, DTS etc.) requires special software and possibly hardware. This 
equipment will encode the signal into the desired format, possibly 
compress the audio and store it on the final media.

Exactly what type of software and/or hardware you need depends on 
what kind of format you are mixing for and is not dependent on Nuendo 
in any way.

• Steinberg provides Dolby Digital and DTS encoders for purchase, tai-
lored for use with Nuendo.
For details, please go to www.steinberg.net.
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About surround plug-ins

Included with the program are some specific surround plug-ins. These 
are:

• MatrixEncoder and MatrixDecoder.
These are used for working with LRCS Surround encoded material. In LRCS Sur-
round, four audio channels are converted to two channels, for distribution via regular 
video and broadcast formats. These plug-ins perform such conversions (in both ways) 
and are compatible with the LRCS Surround format.

• Mixconvert
Mixconvert gives you an easy way to take surround mixes and convert them to other 
formats with less channels. For example, Mixconvert can be used to downmix a 5.1 
surround mix to a normal stereo mix. This plug-in is unique in that Nuendo will automat-
ically insert it in place of the channel panner or aux send panner in certain situations. 
Please refer to the Audio Effects and VST Instruments pdf for complete information 
about Mixconvert.

• Mix6to2
The Mix6to2 effect allows you to control the levels of up to six surround channels, and 
to mix these down to a stereo output.

• Mix8to2
The Mix8To2 effect allows you to control the levels of up to eight surround channels, 
and to mix these down to a stereo output.

• Mixer Delay
The Mixer Delay effect is useful for time aligning surround speakers if your room config-
uration does not allow for proper ITU-R speaker placement. It is also handy for re-rout-
ing surround channels to their proper speaker channels in your setup (refer to the 
Nuendo 3 Audio Effects and VST Instruments pdf for more information on setting up 
Mixer Delay).

• SurroundDither
This is a dithering plug-in capable of handling six channels at the same time – use this 
for applying dithering to a surround output bus.

• SurroundPanner
This is described on page 311.

• Surround plug-ins (apart from the SurroundPanner) are described in the 
separate pdf document “Audio Effects and VST Instruments”.
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Window overview

VST Connections

In this window you can add input and output busses. There is a com-
plete selection of common surround configurations available, as well 
as standard mono or stereo busses.

The Bus Name column contains the currently configured busses as 
they will appear in the input and output routing pop-ups in the mixer.

VST Connections showing the Outputs page.

The outputs selected for 
the channels in the busses.

Click here to add a bus.

The currently configured busses.
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Surround in the mixer

Surround sound is supported throughout every stage of the signal 
path in the Nuendo mixer, from input to output bus. Each bus or audio 
channel can carry up to 12 surround speaker channels.

In the output channel section of the mixer you can control the master 
levels for configured busses. The level meter for a bus (or channel in 
the mixer) that carries multiple surround channels will show multiple 
level bars, one for each speaker channel in the surround configuration.

Here, the SurroundPanner is used for 
positioning the sound “dynamically” in 
the surround field.

Using the Output Routing pop-up, audio 
channels can be routed directly to 
surround channels.
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Operations

Setting up the surround configuration

Output bus configuration

Before you can start working with surround sound, you have to config-
ure a surround output bus, through which all the speaker channels of 
the chosen surround format are routed. How to add and set up bus-
ses is described in detail on page 15. Here is a brief run through:

1. Open the VST Connections window from the Devices menu.

2. Click the “Outputs” tab.

3. Click the “Add Bus” button and select one of the preset formats from 
the Configuration pop-up (see below).
The new bus appears with the ports visible.

4. By clicking in the Device Port column you can now route the speaker 
channels to the desired outputs of your audio hardware.

5. If you like, rename the output bus by clicking its name and typing in a 
new one.
This name will appear in the mixer and on routing pop-ups.
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The following surround configurations are included:

Format Description

LRCS
LRCS refers to Left Right Center Surround, where the surround 
speaker is center-rear positioned. This is the original surround 
format that first appeared as Dolby Stereo in cinema and later as 
the home cinema format Dolby ProLogic.

5.0
This is the same as 5.1 (see below) but without the LFE channel. 
The LFE channel is optional in 5.1 and if you don’t plan to use it, 
you might find this option more convenient.

5.1
This format is one of the most popular in cinema and DVD. In its 
various cinema and DVD encoding implementations (established 
by different manufacturers) it is referred to as Dolby Digital, AC-3, 
DTS and MPEG 2 Multichannel. 5.1 has one center speaker 
(mainly used for speech), main left and right speakers, and two 
surround speakers (mostly for sound effects). Additionally a sub-
channel (LFE – Low Frequency Effects) with lower bandwidth is 
used for special low frequency effects.

LRC
Same as LRCS, but without the surround speaker channel.

LRS
Left-Right-Surround, with the surround speaker positioned at 
center-rear.

L C R

S

L C R

SRSL

L C R

SRSL

+

L C R

L R

S
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LRC+Lfe
Same as LRC but with an Lfe sub-channel added.

LRS+Lfe
Same as LRS but with an Lfe sub-channel added.

Quadro
The original Quadraphonic format for music, with one speaker in 
each corner. This format was intended for vinyl record players.

LRCS+Lfe
Same as LRCS but with an Lfe sub-channel added.

Quadro+Lfe
Same as Quadro but with an Lfe sub-channel added.

Format Description

L C R

+

L R

S

+

L R

SRSL

L C R

S

+

L R

SRSL

+
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6.0 Cine
A Left-Right-Center front speaker arrangement with 3 (Left-Right-
Center) surround channels.

6.0 Music
This uses 2 (Left/Right) front channels with Left and Right sur-
round channels and Left and Right Side channels.

6.1 Cine
Same as 6.0 Cine but with an Lfe sub-channel added.

6.1 Music
Same as 6.1 Cine but with an Lfe sub-channel added.

7.0 Cine
A Left, Mid-left, Center, Mid-right, Right front speaker arrange-
ment with Left and Right surround channels.

Format Description

L C R

SRSL S

L R

SRSL

LS RS

L C R

SRSL S

+

L R

SRSL

LS RS+

L C R

SRSL

LC RC
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7.0 Music
Same as 6.0 Music but with a Center front channel added.

7.1 Cine
Same as 7.0 Cine but with an Lfe sub-channel added.

7.1 Music
Same as 7.0 Music but with an Lfe sub-channel added.

8.0 Cine
Same as 7.0 Cine but with the addition of a Center Surround 
channel.

8.0 Music
Same as 7.0 Music but with the addition of a Center Surround 
channel.

Format Description

L R

SRSL

LS RS

C

L C R

SRSL

LC RC

+

L R

SRSL

LS RS

C

+

L C R

SRSL

LC RC

S

L R

SRSL

LS RS

C

S
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Child busses

Essentially a child bus is a bus within a (“bigger”) bus. Typically you 
may want stereo child busses within your surround bus – this allows 
you to route stereo tracks directly to a stereo speaker pair within the 
surround bus. You may also want to add child busses in other sur-
round formats (with fewer channels than the “parent bus”).

Once you have created a surround bus, you can add one or several 
child busses to it by right-clicking (Windows) or [Ctrl]-clicking (Mac) 
the bus and selecting “Add Child Bus”. This is described in detail on 
page 20.

8.1 Cine
Same as 8.0 Cine but with an Lfe sub-channel added.

8.1 Music
Same as 8.0 Music but with an Lfe sub-channel added

10.2
This is an experimental format with ten surrounding speakers and 
two Lfe channels (a combination of two 5.1, one at the top and 
one at the bottom of the room).

Format Description

L C R

SRSL

LC RC

S

+

L R

RSLS

SL

C

S

SR+

L C R

TRRTRL

TFC TFRTFL

SL SR

+ +
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Input bus configuration

To work with surround sound in Nuendo, it is often not necessary to 
configure a surround format input bus. You can record audio files via 
standard inputs, and easily route the resulting audio channels to sur-
round outputs at any stage. You can also directly import multi-channel 
files of specific surround format onto audio tracks of the same format.

You should add a surround input bus in the following circumstances:

• You have existing audio material in a specific surround format, and you 
wish to transfer this material into Nuendo as a single, multi-channel file.

• You wish to record a surround setup “live”.

In both cases, you can add and configure an input bus of the format 
you wish to use in the VST Connections dialog so that each input on 
your audio hardware is routed to the corresponding speaker channel.

To add an input bus, use the same general method as described on 
page 303, but select the “Inputs” tab instead.
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Routing channels directly to surround channels

If you want to place an audio source in one separate speaker channel 
only, you can route it directly to that speaker channel. This is useful for 
pre-mixed material or multi-channel recordings that don’t require pan-
ning.

1. Open the mixer and locate the channel you wish to route.

2. From the output routing pop-up menu, select the corresponding sur-
round speaker channel.

• If a stereo audio channel is routed directly to speaker channel, the left/
right channels will be mixed to mono.
The pan control for the audio channel governs the balance between the left and right 
channel in the resulting mono mix. Center pan will produce a mix of equal proportion.

Routing channels using Child busses

Child busses provide a way to route stereo (or multi-channel) audio 
channels to specific speaker channels in a surround configuration. 

The most obvious application of a child bus is when you wish to add a 
stereo channel to two specific left/right surround speaker channels.

If you have added a child bus within a surround bus (see page 308), it 
appears as a submenu item within the surround bus on the output 
routing pop-up menu. Select this to route a stereo audio channel di-
rectly to that stereo speaker pair in the surround bus.
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Using the Surround Panner

Nuendo has a special feature for graphically positioning a sound 
source in a surround field. This is actually a special plug-in which dis-
tributes the audio from the channel in various proportions to the sur-
round channels.

1. Open the mixer and locate the channel you wish to position.
This could be a mono or stereo channel.

2. From the output routing pop-up menu, select the “whole surround bus” 
option (not a specific speaker channel).
A miniature graph of the surround plug-in interface appears above the fader in the 
channel strip.

When the “whole surround bus” is selected, the channel strip shows a miniature 
surround control. 

3. Click and drag directly in the miniature image to move the sound in 
the surround field.
The horizontal red strip to the right controls the subbass (LFE) level (if available in the 
selected surround format).

• You can also view a slightly larger version of this control by selecting 
“Surround Pan” on the view options pop-up for the extended mixer 
panel.
This mode offers click and drag-panning as well as numerical values for left/right bal-
ance, front/rear balance and LFE amount – type or use a mouse wheel to adjust them.

• For total control over surround panning, you can double click on the 
miniature image to open the full Surround Panner interface in a sepa-
rate window.
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The SurroundPan controls

The SurroundPan plug-in interface in Standard, Position and Angle mode, 
respectively.

The SurroundPan plug-in allows you to position your audio in the sur-
round field. It consists of an image of the speaker arrangement, as de-
fined by the output bus selected on the output routing pop-up menu, 
with the sound source indicated as a grey ball. 

The following options and methods are available:

Mode – Standard/Position/Angle

The Standard Mode/Position Mode/Angle Mode switch allows you to 
work in three modes:

• In both Standard and Position mode, the speakers in the front are aligned, as 
they would normally be in a cinema-type situation. This means that the front 
speakers are at a varying distance from the center. Standard mode (default) is 
the best mode for moving sources between speakers without level attenuation.

• Angle Mode is the traditional surround sound mixing definition. Note that here 
the speakers are defined as being at equal distance from the center. This is 
not really a true representation of for example a cinema, but has still proven to 
work well in many situations.
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Speakers

The speakers in the panel represent the chosen surround configuration. 

• The speakers in the front are aligned, as they would normally be in a 
cinema-type situation. 
This means that the front speakers are at a varying distance from the center, allowing 
you to move sources between speakers without level attenuation.

• You can turn speakers on and off by clicking them with [Alt]/[Option] 
pressed. When a speaker is turned off, no audio will be routed to that 
surround channel.

Positioning and levels

The text below assumes that the Mono/Stereo pop-up is set to “Mono 
Mix”. For more information on the other modes, see below.

A sound source is positioned either by clicking or by dragging the grey 
“ball” around in the panel (or by using key commands, see below). By 
dragging during playback you can record automation, see page 333.

• In Standard Mode, the signal levels from the individual speakers are in-
dicated by colored lines from the speakers to the center of the display.

• In Position Mode, the concentric circles will help you determine the 
level of the signal at a certain position.
The yellow circle represents -3dB below nominal level, the red circle is at -6dB and the 
blue is located at -12dB. These are affected by attenuation, see below.

• In Angle Mode, a red arc helps you determine the perceived “range” 
of a source. The sound will be at its loudest in the middle of the arc 
and will have dropped in level towards the ends.

Exactly how levels are handled may require some explanation:

• When you move a source around, a number will indicate the loudness 
in each speaker.
This is a value in dB (decibel) and is relative to the nominal level of the source. In other 
words, 0.0 (dB) represents full level.

• If you position the source far enough away from a speaker, its level will 
drop to zero (indicated by an infinity symbol).
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• The signal levels from the individual speakers are indicated by colored 
lines from the speakers to the center of the display.

• You can use modifier keys to restrict movement in various ways:

In Standard and Position Mode:

In Angle Mode:

There is also a special set of key commands for working in the 
SurroundPan window.

For a complete list of the available key commands, click on the 
“SurroundPanner” logo and then click again!

Key Movement restriction

[Shift] Horizontally only

[Ctrl]/[Command] Vertically only

[Alt]/[Option] Diagonally (up left, down right)

[Ctrl]/[Command]+ 
[Alt]/[Option]

Diagonally (up right, down left)

Key Movement restriction

[Shift] From center to perimeter only.

[Ctrl]/[Command] Along the perimeter only (at current distance from center)
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The LFE dial (All Modes)

If the selected surround setup includes an LFE (Low Frequency Effects) 
channel, a separate LFE level dial will be available in the SurroundPan 
window. Use this to set the signal amount sent to the LFE channel. You 
can also set this using the small red strip to the right of the Surround 
Panner in the mixer channel strip, or by typing in a numerical value in the 
larger Surround Panner that can be shown in the extended channel 
strip.

The Surround Panner in the channel strip (bottom) and in the extended panel of the 
mixer channel strip (“SurroundPan” activated).

...or drag this control to set the LFE level.

Click here and type in an LFE level value...
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Mono/Stereo pop-up (All Modes)

If you have a mono channel the Mono/Stereo pop-up is by default set 
to Mono Mix. The panner will then behave as described above.

If you have a stereo channel, you have the option of using one of the 
three Mirror modes. Two grey balls will then appear, one for each 
channel (L/R). This will allow you to move the two channels symmetri-
cally, by just dragging one of them. The three modes allow you to se-
lect which axis should be used for mirroring.

• The default mode for stereo channels is the Y-Mirror mode.
• If you run a stereo signal through the panner in Mono Mix mode, the two chan-

nels will be mixed together before entering the plug-in.
• If you run a mono signal through the plug-in in one of the stereo modes, the 

signal will be split before entering the plug-in.

Additional Parameters (Standard Mode)

• Center Level.
This determines how center source signals should be reproduced by the front speak-
ers. With a value of 100%, the center speaker will provide the center source. With a 
value of 0%, the center source will be provided by the ghost image created by the left 
and right speakers. Other values will produce a mix between these two methods.

• Divergence Controls.
The three divergence controls determine the attenuation curves used when positioning 
sound sources, for X-axis front, X-axis back and Y-axis (front/rear), respectively. If all 
three Divergence values are 0% (default), positioning a sound source on a speaker will 
set all other speakers to zero level (-∞) (except for the center speaker which depends 
on the center level). With higher values, the other speakers will receive a percentage of 
the sound source.
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Additional Parameters (Position and Angle Mode)

• Attenuate.
Attenuate can be used to amplify or weaken the source. Exactly what effect this has on 
the level in each speaker can be determined by the level readouts, the concentric cir-
cle (Position mode) and the arc (Angle mode).

• Normalize.
Normalize is a function for controlling the overall loudness from all speakers. When this 
is set to 1.0 (full normalization), the level from all speakers together is always exactly 
0dB. The individual levels will then be boosted or attenuated accordingly.

Please note that this is not a dynamic feature, like compression or limit-
ing. It is instead just a tool for scaling the nominal output levels from the 
surround channels.

Automation

All parameters in the SurroundPan plug-in can be automated, just as 
with any other plug-in. See page 333.

Mixconvert

Mixconvert is a special plugin that converts one multi-channel audio 
source into another multi-channel destination. It is most frequently 
used to “downmix” a multi-channel surround mix into another format 
with less channels (a 5.1 surround mix into a stereo mix for example).

This plugin can be used as an insert effect in the mixer like other plug-
ins but it also has special functions. Nuendo will automatically insert 
Mixconvert in place of the surround panner in cases where the chan-
nel (audio track, group channel etc...) is being routed to a destination 
that has fewer audio paths. Mixconvert will also be inserted in place of 
any aux send panner when the destination has a different audio path 
than the source. The surround panner’s displays and controls will be 
replaced by Mixconvert’s.
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Please refer to the Audio Effects and VST Instruments document for 
detailed information on the operation of Mixconvert.

• There is one exception to this behavior. When a stereo channel is routed 
to a mono destination through the channel routing or an aux send routing, 
a normal panner will appear. However, this panner will control the balance 
of the left and right channels as they are blended into the mono destina-
tion. The center position blends both channels together equally. With the 
pan set all the way to the left, only the left channel will be heard. With the 
pan set all the way to the right, only the right channel will be heard.

Exporting a Surround mix

When you have set up a surround mix you can choose to export it with 
the Export Audio Mixdown function. This function exports a single se-
lected output bus – this means that all channels that you want to be 
part of the mix must be routed to the surround output bus.

You have the following export options when doing surround work:

• Export to “split” format, resulting in one mono audio file for each surround 
channel.

• Export to interleaved format, resulting in a single multi-channel audio file (e.g. 
a 5.1 file, containing all six surround channels).

• Under Windows you can also export a 5.1 surround mix to a file in Windows 
Media Audio Pro format.
This is an encoding format tailored for 5.1 surround – see page 563.

• You can also export a surround mix to a Dolby Digital AC3 file or a DTS file, if 
you have the Steinberg Dolby Digital Encoder or the Steinberg DTS Encoder 
(both optional, separate plug-ins) installed in your system.
Please go to www. steinberg.net for details.

For more about exporting to files, see the chapter “Export Audio Mix-
down”.
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Using effects in surround configurations

Nuendo introduces a special surround format for VST plug-ins, that is 
plug-ins that can process more than two channels. Mix8to2 is an ex-
ample of such a plug-in.

Applying a Surround-aware plug-in

This is not different from applying a regular plug-in. The only differ-
ence is that the plug-in panel may have controls for more than two 
channels.

Using a stereo plug-in in a surround configuration

Normally, when you apply a stereo insert effect to a surround configu-
ration, the first two speaker channels (often L and R) are routed 
through the plug-in and other channels are left unprocessed. 

However, you may want to use the plug-in on other speaker channels. 
This is described on page 266.
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Background

Nuendo provides very comprehensive automation features. Virtually 
every mixer and effect parameter can be automated.

There are two main methods you can use to automate parameter 
settings:

• By manually drawing curves on automation subtracks in the Project 
window.
See page 340.

• By using the Write/Read buttons and adjusting parameters in the mixer.
See page 333.
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The methods are not different in terms of how the automation data is 
applied – they only differ in the way the automation events are created; 
manually drawing them or recording them. Any applied automation 
data will be reflected in both the mixer (a fader will move for example) 
and in a corresponding automation track curve (although this may be 
hidden).

About automation subtracks

Audio tracks, group tracks and FX channel tracks all have automation 
subtracks. These allow you to view and edit the automation of all mixer 
settings for the track, including settings for the track’s insert effects. 
There is one automation subtrack for each parameter, and subtracks 
can be shown or hidden in any combination.

Similarly, MIDI tracks have automation subtracks for mixer settings, 
track parameters as well as send and insert effect settings (if used).

VST Instruments have special automation tracks that appear in the 
Project window when you add a VST Instrument. There is one auto-
mation track for the plug-in parameters and one track for each mixer 
channel used by the instrument. These tracks all have automation 
subtracks, giving you access to all parameters and mixer settings.

Finally, for ReWire channels and input/output channels, automation 
tracks are automatically added as soon as you activate automation 
(with the Write button) in the corresponding mixer channel strip or 
Channel Settings window. These automation tracks have subtracks 
for all parameters as well.
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What can be automated?

Mixing in Nuendo can be completely automated. The following param-
eter settings can be recorded automatically – or manually drawn in – 
on automation subtracks:

For each audio or group track and ReWire channel:

• Volume
• Mute
• Pan left/right
• 8 x insert effect program selection and effect parameters (if inserts are used)
• 8 x effect send on/off switches
• 8 x effect send levels
• Surround panner parameters
• EQ master bypass
• Settings for 4 EQ modules (enable/freq/quality/gain)

For each FX channel track and input/output bus:

• Volume
• Mute
• Pan left/right
• 8 x insert effect program selection and effect parameters (if inserts are used)
• Surround panner parameters
• EQ master bypass
• Settings for 4 EQ modules (enable/freq/quality/gain)

For each VST Instrument

• VST Instrument plug-in parameters and program selection

plus (for each mixer channel/separate output used by the instrument):

• Volume
• Mute
• Pan left/right
• 8 x insert effect program selection and effect parameters (if inserts are used)
• 8 x effect send on/off switches
• 8 x effect send levels
• Surround panner parameters
• EQ master bypass
• Settings for 4 EQ modules (enable/freq/quality/gain)
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For each MIDI track

• Volume
• Pan
• Mute
• Track parameters on/off switch
• Transpose
• Vel. shift
• Random 1-2 min/max/target
• Range 1-2 min/max/target
• 4 x insert effect on/off switches
• 4 x send effect on/off switches
• 4 x MIDI insert effect parameters (if used)
• 4 x MIDI send effect parameters (if used)
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Automation track operations

Opening automation subtracks 

Every track/channel has a number of automation subtracks, each 
showing one automation parameter.

For audio, group, MIDI and FX channel tracks, there are two ways you 
can open an automation subtrack for the channel:

• By right-clicking (Win) or [Ctrl]-clicking (Mac) the track in the Track 
list and selecting “Show Automation” from the pop-up that appears.

• By clicking on the “Show/Hide Automation” button (the plus sign) in 
the Track list for the channel.
An automation subtrack opens in the Track list, and a straight black horizontal line is 
shown as well as a greyed out mirror image of the audio events’ waveform (or MIDI 
events for MIDI tracks) in the event display. By default, the volume parameter is as-
signed to the first subtrack.

Click the “+” button to open an automation subtrack.

For VST Instruments, automation tracks appear automatically when 
you add VST Instruments.
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For ReWire channels and input/output busses, automation tracks are 
automatically created when the Write automation button (see page 
333) is activated in either:

• The corresponding channel strip in the mixer.
• The corresponding Channel Settings window.
• The mixer common panel (“Write All”).
• The area above the Track list (“Write All”)

Opening additional automation subtracks

• If you click on the “Append Automation Track” button (the “+” sign) 
for an automation subtrack, another subtrack opens, by default show-
ing the next parameter in the Add Parameter list (see below).
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Assigning a parameter to an automation subtrack

Default parameters are already assigned to automation subtracks 
when you open them, according to their order in the Add Parameter 
list (see below). To select what parameter an open subtrack should 
display, proceed as follows:

1. If none exists, open an automation subtrack using one of the methods 
described above.

2. Click in the parameter display for the automation subtrack.
A pop-up list is shown containing some of the automation parameters plus the item 
“More...” at the bottom of the list.

• If the parameter you wish to automate is on the pop-up you can select 
it directly.
The parameter will then replace the current parameter in the automation subtrack. 

• If you wish to add a parameter not available on the pop-up and want 
to view all parameters that can be automated, go on to the next step.
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3. Select “More...”.
The Add Parameter dialog appears. This dialog shows a list with all parameters, sorted 
into different categories, that can be automated for the selected channel, including the 
parameters for any assigned insert effects. See page 324 for a list of the available pa-
rameters according to channel type.

The Add Parameter dialog for an audio track.

4. Select a parameter from the list and click OK.
The parameter will then replace the current parameter in the automation subtrack.

• To view the parameters in each category click the “+” sign for the cate-
gory folder.
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• Note that the “replacing” of the parameter displayed in the subtrack is 
completely non-destructive. 
For example, if the subtrack contained any automation data for the parameter you just 
replaced, this data would still be there, although it would not be visible after you re-
placed the parameter. If you click in the parameter display you can switch back to the 
replaced parameter. All automated parameters are indicated by an asterisk (*) after the 
parameter name on the pop-up menu.

The Volume parameter is automated.

You can click the “Show/Hide Automation” button (the plus sign) for 
the automation subtrack to open additional subtracks and repeat the 
above procedure to assign a parameter to each subtrack.

Removing automation subtracks 

To remove automation subtracks from the Track list, proceed as fol-
lows:

• To remove a single subtrack, click the parameter name and select 
“Remove Parameter” from the pop-up menu.
Note that this will also delete any automation events on the subtrack, and the subtrack 
will be closed.

• To remove all currently unused subtracks from a track in the Track list, 
select “Remove Unused Parameters” from any of its subtrack parame-
ter name pop-ups.
All subtracks that do not contain automation events will be closed for the selected track.
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Hiding automation subtracks

• To hide a single automation subtrack, click the “Hide Automation” 
button (the minus sign) in the Track list.

• To hide all automation subtracks for a track, right-click (Win) or [Ctrl]-
click (Mac) the track for which you wish to hide the automation sub-
tracks, and select “Hide Automation” from the pop-up menu that ap-
pears.

• To hide all automation subtracks for all tracks in the Track list, right-
click (Win) or [Ctrl]-click (Mac) any track and select “Hide All Automa-
tion” from the pop-up menu that appears.
This option is also available on the Project menu.

Showing only used automation subtracks

If a lot of automation subtracks are used, it may be impractical to have 
them all open in the Track list. If you want to view only the subtracks 
that are used (i.e. those that actually contain automation events) and 
hide all empty automation subtracks, do one of the following:

• Right-click (Win) or [Ctrl]-click (Mac) any track in the Track list and 
select the option “Show Used Automation for All Tracks” from the 
pop-up menu.
This will close all automation subtracks not containing any automation events, while 
leaving used subtracks open for all tracks. This option is also available on the Project 
menu.

• Right-click (Win) or [Ctrl]-click (Mac) a specific track and select the 
option “Show Used Automation” from the pop-up menu.
This will close all automation subtracks not containing any automation events, while 
leaving used subtracks open for the selected track.
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Muting automation subtracks

You can mute individual automation subtracks by clicking their Mute 
buttons in the Track list. While clicking the Read (R) button (see page 
333) for an automation subtrack will activate or deactivate Read mode 
for all automated parameters of the track, using the Mute button allows 
you to turn off automation for a single parameter.

The “Automation follows Events” setting

If you activate “Automation follows Events” on the Edit menu (or in the 
Preferences–Editing dialog), automation events will automatically fol-
low when you move an event or part on the track. 

This makes it easy to set up automation related to a specific event or 
part, rather than to a specific position in the project. For example, you 
can automate the panning of a sound effect event (having the sound 
pan from left to right, etc.) – if you need to move the event, the auto-
mation will automatically follow! The rules are:

• All automation events for the track between the start and end of the 
event or part will be moved.
If there are automation events in the new position (to which you move the part or 
event), these will be overwritten.

• If you duplicate an event or part (by [Alt]/[Option]-dragging or by us-
ing the Duplicate or Repeat functions) the automation events will be 
duplicated as well.

• This function affects copying and pasting as well.
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Using Write/Read automation

All track types except folder, marker, video and ruler tracks feature 
Write (W) and Read (R) buttons in the mixer, in the Track list and in the 
Channel Settings window. Furthermore, the control panels for all plug-
in effects and VST Instruments also feature Write and Read buttons.

The Write and Read buttons for a channel in the mixer, and for an automation 
subtrack in the Track list.

• If you activate Write for a channel, all mixer parameters you adjust dur-
ing playback for that specific channel will be recorded as automation 
events.

• If you activate Read for a channel, all your recorded mixer actions for 
that channel will be performed during playback, just like you performed 
them in Write mode.

• The W and R buttons for a track in the Track list are mirrors of the W 
and R buttons in the corresponding channel strip in the mixer.

• Some track types require that you activate the Write button (either for 
the track or globally – see below) to create an automation track for it.
These are: VST Instrument, ReWire and Input/Output tracks. The first time the Write 
button is activated for these track types, automation subtracks will be created for them. 
You can then proceed with automating the parameters of the tracks (by editing the au-
tomation subtracks or by writing, as described below). To play back the automation, 
make sure the Read button for the tracks is activated.
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There are also global Read All and Write All Automation buttons in the 
mixer’s common panel and at the top of the Track list:

The global Write and Read buttons in the mixer, and in the Track list.

• When Read All is activated, all your recorded mixer actions for all 
channels will be performed during playback.

• When Write All is activated, all mixer actions you perform during play-
back (for all channels) will be recorded as automation events.

The “MIDI Controller Input to Automation Tracks” preference

If you have set up a remote device to control parameters and settings 
in the program, you can record automation with that remote device - 
just activate Write as usual. However, if you are recording a MIDI track 
and want to record automation at the same time, the controller data 
sent by the remote device will be recorded “twice” - as automation 
and as MIDI controller data on the MIDI track.

To avoid this, activate the MIDI Controller Input to Automation Tracks 
setting in the Preference-MIDI dialog. When this is activated, the con-
trollers will be recorded as automation only, not as MIDI controller 
data on the recorded MIDI track.
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About the five automation modes

When recording automation, you can choose one of five automation 
modes (available on the Project window toolbar):

• When Touch Fader mode is selected, the program starts writing the 
automation as soon as you click the control and stops writing when 
you release the mouse button.
If you are overwriting existing automation, the Automation Return Time setting (next to 
the automation mode pop-up menu) determines how fast the automated parameter re-
turns to its original automated value when you release the mouse button.

For most plug-in parameters (audio effects and VST Instruments), there 
is no way for the program to “know” whether a control is “pressed” or not 
(this information is not passed back by the plug-in interface). For this 
reason, automation of most plug-in parameters will work as in Autolatch 
mode (see below), even if Touch Fader is selected.

• When Autolatch mode is selected, the program starts writing the au-
tomation as soon as you click the control and stops writing when you 
stop playback or turn off the Write function.
The last automation value will be continuously written until you stop or turn off Write. 
This is useful if you want to overwrite a long section of previous automation, and also 
when you are recording automation from a remote device (because then there is no 
way for the program to know when you “release” the control). However, make sure you 
only touch the desired control(s) when recording automation in Autolatch mode – and 
remember to stop playback when you’re done!

• X-Over mode works like Autolatch mode, but with one difference: As 
soon as you “cross” any existing (previous) automation curve, the writ-
ing is automatically turned off.
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• Overwrite mode affects volume automation only. It works like Auto-
latch mode, with one significant difference: the program starts writing 
the automation as soon as you start playback, and stops writing when 
you turn off Write.
This means that automation will be written continuously from the moment you start 
playback until you turn off Write – even if you don’t touch any controls. This is useful if 
you want to have a “clean slate” and redo previous volume automation.

• Trim mode is useful for volume automation only. It offsets the volume 
automation curve without overwriting any previous volume automation, 
letting you adjust the volume for already existing automation.
In Trim mode, the channel’s volume fader in the mixer is initially positioned in the exact 
middle position, regardless of any existing volume automation. By raising the fader rela-
tive to the middle position, you offset the volume curve upwards. By lowering the fader, 
you offset the volume curve downwards. In Trim mode, the program starts writing the 
automation as soon as you click the control and stops writing when you release the 
mouse button.

• Trim mode has a special feature: if you enable Write automation when 
playback is stopped and select Trim mode, you can use the fader to 
trim (offset) the volume curve between the left and right locator.
This makes it easy to e.g. raise the relative volume in a specific area: set the locators 
accordingly, enable Write, select Trim mode and raise the level fader.

Recording your actions – an example

If the settings in your current project are crucial, you may not want to 
“experiment” with automation until you know more about how it all fits 
together. If so, you can create a new project for the following example. 
It doesn’t even have to contain any audio events, just a few audio 
tracks. Proceed as follows:

1. Open the Mixer window.

2. Click the “Write All” button in the mixer common panel.
Nuendo is now in global Write mode. 

3. Start playback, and adjust some volume faders and/or other parame-
ter settings in the mixer or perhaps in a Channel Settings window.
Stop playback when you are done, and return to the position where you started play-
back.
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4. Deactivate Write mode, and click the Read All button in the mixer 
common panel.
Nuendo is now in global Read mode.

5. Start playback, and watch the Mixer window.
All your actions performed during the previous playback will be reproduced exactly.

6. If you wish to redo anything that was recorded, activate Write mode 
again, and start playback from the same position.

• You can have Write and Read activated simultaneously, if you want to 
watch and listen to your recorded mixer actions while you’re recording 
fader movements for another mixer channel, etc.

Recording plug-in automation

Every parameter for every assigned effect or VST Instrument can be 
automated in much the same manner as described above.

The following example assumes that you have assigned an insert ef-
fect to an FX channel track (see page 276), and describes how to 
record automation for the effect:

1. Activate Write All in the mixer common panel or in the Track list to put 
Nuendo in global Write mode.

2. Select the FX channel track in the Track list and open its Inserts sec-
tion in the Inspector.
If the Inspector is hidden, click the “Show Inspector” button in the Project window 
toolbar.

3. Open the control panel for the effect by clicking the Edit button (“e”) 
above the insert effect slot in the Inspector.

4. Click the Write button in the control panel to activate Write mode.
All effects and VST Instruments have Write/Read buttons on their control panels. These 
work exactly like the corresponding buttons in the mixer or in the Track list. In the previ-
ous example, we used global Write mode, in which mixer and parameter changes are 
recorded on all tracks, but in this example we’ll use Write mode for one track only.

5. Start playback and adjust some effect parameters in the control panel.
When you are finished, stop playback and return to the position where you started 
playback.
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6. Deactivate Write and instead click the Read button on the control 
panel.

7. Start playback, and watch the control panel.
All actions you performed during the previous playback will be reproduced exactly.

Assigning an automated parameter to an automation subtrack

To select which parameter is currently shown in the automation track 
for the FX channel, proceed as follows:

1. Click in the parameter display for the FX channel automation subtrack.
The parameter display pop-up list is shown containing the automation parameters for 
the plug-in. The parameter(s) you previously automated are indicated by an asterisk af-
ter the parameter name in the list.

Automated parameters for the DoubleDelay effect.

2. Select the parameter you wish to view from the parameter display 
pop-up.
The automation curve for the parameter you selected is displayed on the automation 
subtrack.

• To view VST Instrument parameters you use the same method, but for 
the first automation track for the instrument.
As described earlier, each VST Instrument have two or more automation tracks – one 
for the plug-in settings and one for each VST Instrument mixer channel.
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Where did the automation data I recorded end up?

When using Write All automation, you can write automation data on 
all channels’ automation tracks. In the previous write operations, you 
probably added automation events for many different channels and 
parameters.

• To view all the automation events you recorded during the operations, 
select “Show Used Automation” from the Project menu.
Now the automation data for every channel parameter that you adjusted in the mixer 
during Write mode is shown on corresponding subtracks in the Project window. The 
automation events recorded are shown as points in the automation curves. 

Working with automation curves

About automation curves 

There are two kinds of automation curves, “ramp” and “jump”:

• Jump curves are created for any parameter that only has on/off values, 
like a Mute button, for example.

• Ramp curves are created for any parameter that generates continuous 
multiple values, such as fader or dial movements etc. 

Examples of jump and ramp automation curves shown in the event display.
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About the static value line

When you first open an automation subtrack for a parameter, it 
doesn’t contain any automation events (unless you have previously 
adjusted that parameter with write automation activated), and this is 
reflected in the event display as a straight horizontal black line, the 
“static value” line. This line represents the current parameter setting.

• If you have manually added any automation events or used write auto-
mation for the corresponding parameter, and then deactivate Read 
mode, the automation curve will be greyed-out in the automation sub-
track event display and the static value will be used instead.
As soon as Read mode is activated the automation curve will become available.

Editing automation events

Drawing automation events

By using write automation in the mixer, you generate automation events 
by moving parameter dials and fader settings in the mixer. You can also 
add them manually, by drawing automation curves on an automation 
subtrack. Proceed as follows:

1. Open a volume automation subtrack for an audio track by clicking the 
“+” sign.
The static value line is shown in the event display.

2. Select the Pencil tool.
You can also use the various modes of the Line tool for drawing curves, see below.
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3. If you click on the static value line, an automation event is added, read 
automation mode is automatically activated, and the static value line 
changes to a blue automation curve.

4. If you click and hold, you can draw a curve, by adding a multitude of 
single automation events.

5. When you release the mouse button, the number of automation events 
is reduced to a few events, but the basic shape of the curve still remains 
the same.
This “thinning” of events is governed by the Automation Reduction Level setting in the 
Preferences dialog, see page 347.

6. If you now activate playback, the volume will change with the automa-
tion curve.
In the mixer the corresponding fader moves accordingly.

7. Simply redo the operation if you are not happy with the result.
If you draw over existing events, a new curve is created.
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• If the automation subtrack is in Read mode already, you can also add 
automation events by clicking with the Arrow tool.
If you are trying to add a point between two existing points and the new point doesn’t 
deviate from the existing curve, it will be removed by reduction (see page 347) as soon 
as you release the mouse button.

Using the various modes of the Line tool to draw automation curves

The Line tool can be very useful for drawing automation events. The 
various modes are accessed by clicking on the Line tool on the tool-
bar and selecting from the pop-up that appears.

• Clicking and dragging with the Line tool in Line mode shows a line in the au-
tomation subtrack, and creates automation events aligned with this line.
This is a quick way to create linear fades, etc.

• The Line tool in Parabola mode works in the same way, but aligns the automa-
tion events with a parabolic curve instead, giving more “natural” curves and 
fades.
Note that the result depends on the direction from which you draw the parabolic curve.

• The Sine, Triangle and Square Line tool modes create automation events 
aligned with continuous curves.
If snap is activated and set to Grid, the period of the curve (the length of one curve 
“cycle”) is determined by the grid setting. If you press [Shift] and drag, you can set the 
period length manually, in multiples of the grid value.
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Selecting automation event points

• To select a single automation event point, click on it with the Arrow tool.
The point turns red, and you can drag it in any horizontal or vertical direction between 
two points.

• To select multiple curve points, you can either [Shift]-click or drag a 
selection rectangle with the Arrow tool.
All events inside the selection rectangle will become selected.

Drawing a selection rectangle around some points to select them.

When selected, several points can be moved in all directions as “one”, 
i.e. the curve shape formed by the selected event points remains intact.

• To select all automation events on a subtrack, right-click (Win) or 
[Ctrl]-click (Mac) the automation subtrack in the Track list and choose 
“Select All Events” from the context menu.

Removing automation events

There are several ways to remove event points:

• By selecting points and pressing [Backspace] or [Delete] or selecting 
Delete from the Edit menu.

• By clicking on a point with the Eraser tool.

• By selecting a range (with the Range Selection tool), and pressing 
[Backspace] or [Delete] or selecting Delete from the Edit menu.
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• By clicking in the parameter display on a subtrack and selecting “Re-
move Parameter” from the pop-up.
This will remove all automation events from the subtrack, and the subtrack will be closed.

Editing automation events

Automation events can be edited much like other events. You can use 
cut, copy and paste, you can group and nudge events etc. There are 
however four items on the Edit menu that are not applicable to auto-
mation events. These are:

• Split at Cursor
• Split Loop
• Move to Front
• Move to Back

Editing automation events in the Project Browser

You can also edit automation events in the Project Browser. Proceed 
as follows:

1. Open the Project Browser by selecting it from the Project menu.
The Browser window opens. The window is divided into two sections, the Structure 
list to the left, and the event display to the right.

2. Click on the “+” sign for a track in the structure list.
Automated tracks have two subitems: Track Data and Automation. The Automation 
item corresponds to the automation subtrack in the Project window, and contains the 
track’s automation events.

3. Click on the plus sign for the Automation item.
All automated parameters for the track are shown in the structure list. 



NUENDO
Automation 13 – 345

4. Clicking on a parameter in the structure list brings up the automation 
events in the event display.

The following parameters are available for all automation subtracks:

Parameter Description

Position The position of the automation event.

Value The value (0.000 to 1.000) of the automation event. 
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Tips and common methods

There are no hard and fast rules when it comes to describing which 
automation method you should use. You can for example never even 
open an automation subtrack, and stick with write automation through-
out a project. Or you can stick to drawing automation curves to auto-
mate settings in a project. Both methods have their advantages, but it 
is of course up to you to decide what to use and when.

• Editing curves on automation subtracks offers a graphical overview in 
relation to the track contents and the time position.
This makes it easy to quickly change parameter values at specific points, without hav-
ing to activate playback. For example, this method gives you a good overview if you 
have a voice-over or a dialog on one track and a music bed on another track, the level 
of which needs to be lowered with a specific amount every time the dialog occurs.

• By using write automation in the mixer you don’t have to manually se-
lect parameter subtracks from the Add Parameter list.
You can work much like you would using a “real” physical mixer. Every action you per-
form is automatically recorded on subtracks which you can later open for viewing and 
editing of the parameters you changed.

These are just two examples of advantages for each method. Generally, 
editing curves and using write automation are two methods that com-
plement each other, and depending on the nature of your projects you 
will probably work out what method works best for a given situation.
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Options and Settings

About the Automation Reduction Level preference

This item can be found on the Editing page in the Preferences dialog. 
Automation reduction reduces the number of automation events after 
you have used write automation or added automation events manually. 
When you write (or draw with the Pencil tool) automation events, these 
are added as a continuous stream of densely packed events. This is 
necessary because the program cannot “guess” what you will be doing 
next! However, when you are done, the reduction function will remove 
all superfluous event points and the automation curve now contains 
only the event points necessary to reproduce your actions.

For example, all event points that might exist between two other points, 
but do not deviate from the curve, will be automatically removed by re-
duction.

If you try to add an event that doesn’t deviate from the existing curve between two 
existing points...

...it will be removed when the mouse is released. If you moved the selected event by 
any amount so that the resulting curve isn’t a straight line, the event would of course 
be added.

• If you feel you need a lower (or higher) reduction level of events than 
the default setting of roughly 75% reduction, you can change it, but 
normally the default setting works well. 

• A minimum reduction level setting is not recommended as this will 
simply retain a lot of unnecessary events.
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About this chapter

It is possible to control the Nuendo mixer via MIDI. A large number of 
MIDI control devices are supported. This chapter describes how to 
set up Nuendo for remote control.

• For specific information about the supported remote control devices, 
see the separate “Remote Control Devices” pdf document.

• There is also a Generic Remote Device, allowing you to use any MIDI 
controller to remote control Nuendo.
How to set this up is described on page 354.

Setting Up

Connecting the remote device

Connect the MIDI Out on the remote unit to a MIDI In on your MIDI in-
terface. Depending on the remote unit model, you may also need to 
connect a MIDI Out on the interface to a MIDI In on the remote unit 
(this is necessary if the remote unit features “feedback devices” such 
as indicators, motorized faders, etc.).

If you will be recording MIDI tracks, you don’t want any MIDI data from 
the remote unit to accidentally be recorded as well. To avoid this, you 
should also make the following setting:

1. Open the Device Setup dialog from the Devices menu.

2. Select “All MIDI Inputs” in the list to the left.

3. Check the list to the right and locate the MIDI input to which you have 
connected the MIDI remote unit.

4. Click in the “Active” column for that input to set it to “No”.

5. Click OK to close the Device Setup dialog.

Now you have removed the remote unit input from the “All MIDI Inputs” 
group. This means that you can record MIDI tracks with the “All MIDI 
Inputs” port selected without risking to record the data from the remote 
unit at the same time.
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Selecting a remote device

1. Pull down the Devices menu and select Device Setup.
A dialog window opens with a list of devices shown in the left part of the window. 

2. If you can’t find the remote device you are looking for, click on the plus 
sign in the top left corner and select the device from the pop-up that 
appears.
It is added to the Devices list.

• Note that it is possible to select more than one remote device of the 
same type.
If you have more than one remote device of the same type, these will be numbered in 
the Devices list. For example, if you have a Mackie Control Extender, it will require a 
second Mackie control device to be installed.

3. Now select your MIDI control device model from the Devices list.
Depending on the selected device, either a list of programmable function commands 
or a blank panel is shown in the right half of the dialog window.

A JL Cooper MCS-3000 selected as remote control device.
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4. Select the correct MIDI input from the pop-up menu.
If necessary, select the correct MIDI output from the pop-up menu.

5. Click OK to close the dialog.
You can now use the MIDI control device to move faders and knobs, activate Mute and 
Solo, etc. The exact parameter configuration depends on which external MIDI control 
device you are using.

Sometimes communication between Nuendo and a remote device is in-
terrupted or the handshaking protocol fails to create a connection. You 
can use the Reset button to re-establish communication with any device 
in the Device list by selecting it and clicking the Reset Button. Also, the 
“Reset all” button at the top of the Device Setup window will reset every 
device in the Device list.

Operations

Writing automation using remote controls

Automating the mixer using a remote control device is basically done 
in the same way as when you operate on-screen controls in Write 
mode. However, when it comes to replacing existing automation data, 
there is one important difference:

• If you activate Write mode and move a control on the remote control 
device, all data for the corresponding parameter is replaced from the 
position where you moved the control, up until the position where 
playback is stopped!
In other words, as soon as you have moved a control in Write mode, it remains “active” 
until you stop playback. The reason for this is explained below.

As a consequence, an additional precaution must be taken:

• Make sure you move only the controller you want to replace!

In order to replace existing automation data for a control, the computer 
needs to know how long the user actually “grabbed” or used the con-
trol. When doing this “on screen”, the program simply detects when the 
mouse button is pressed and released. When you are using an external 
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remote control device, however, there is no mouse button involved, and 
Nuendo cannot tell whether you “grab and hold” a fader, or simply move 
it and release it. Instead, you have to indicate that you have “released” 
the control by stopping playback.

The above does not apply to the JLCooper MCS 3000 device. This de-
vice has touch sensitive faders, which means that it stops writing as 
soon as you release the fader.

This is only relevant when you are using a remote control device and 
Write mode is activated in the mixer.

Assigning remote key commands

For some of the supported remote devices, you can assign any Nuendo 
function (that can be assigned a key command) to generic buttons, 
wheels or other controls. As of this writing, these devices are:

• JL Cooper MCS 3000
• JL Cooper CS-10
• Tascam US-428
• Yamaha 01x
• Yamaha DM 2000v2
• Yamaha DM 1000v2
• Radical SAC-2k
• Steinberg Houston

Proceed as follows:

1. Open the Device Setup dialog and select one of the remote devices 
that support this feature.
On the right side of the window there are three columns. This is where you assign 
commands.

2. Use the “Button” column to locate a Remote device control or button 
to which you wish to assign a Nuendo function.

3. Click in the “Category” column for the control, and select one of the 
Nuendo function categories from the pop-up menu that appears.
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4. Click in the “Command” column, and select the desired Nuendo func-
tion from the pop-up menu that appears.
The available items on the pop-up menu depend on the selected category.

5. Click “Apply” when you are done.

The selected function is now assigned to the button or control on the 
remote device.

A note about remote controlling MIDI tracks

While most remote control devices will be able to control both MIDI 
and audio channels in Nuendo, the parameter setup may be different. 
For example, audio-specific controls (such as EQ) will be disregarded 
when controlling MIDI channels.

The Generic Remote device

If you have a generic MIDI controller, you can use this for remote con-
trol of Nuendo by setting up the Generic Remote device:

1. Open the Device Setup dialog on the Devices menu.
If the Generic Remote device isn’t on the Devices list, you need to add it:

2. Click the “+” sign in the top left corner and select the “Generic Re-
mote” device from the pop-up menu.

• When the Generic Remote device is added in the Device Setup dia-
log, you can open the Remote Status window by selecting “Generic 
Remote” from the Devices menu.

The Remote Status window
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3. Click the Setup tab and select the Generic Remote device in the 
Devices list to the left.
The settings for the Generic Remote device are displayed, allowing you to specify 
which control on your device should control which parameter in Nuendo.

4. Use the MIDI Input and Output pop-up menus to select the MIDI 
Port(s) to which your remote device is connected.

5. Use the pop-up menu to the right to select a bank.
The concept of banks is based on the simple fact that most MIDI devices can control 
a limited number of channels at a time (often 8 or 16). For example, if your MIDI control 
device has 16 volume faders, and you are using 32 mixer channels in Nuendo, you 
would need two banks of 16 channels each. When the first bank is selected you con-
trol channel 1 to 16; when the second Bank is selected you control channel 17 to 32. 
Since you can control Transport functions as well, you may need several banks.
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6. Set up the upper table according to the controls on your MIDI control 
device.
The columns have the following functionality:

• If you find that the upper table holds too many or too few controls, you 
can add or remove controls with the Add and Delete buttons to the 
right of the upper table.

Column Description

Control Name Double clicking this field allows you to enter a descriptive name for the 
control (typically a name written on the console). This name is automat-
ically reflected in the Control Name column in the lower table.

MIDI Status Clicking in this column pulls down a pop-up menu, allowing you to 
specify the type of MIDI message sent by the control. The options are 
Controller, Program Change, Note On, Note Off, Aftertouch and Poly-
phonic Pressure. Also available are Continuous Control NRPN and 
RPN, a way to extend the available control messages. The “Ctrl JLCoo-
per” option is a special version of a Continuous Controller where the 
3rd byte of a MIDI message is used as address instead of the 2nd byte 
(a method supported by various JL-Cooper remote devices).

MIDI Channel Clicking in this column pulls down a pop-up menu, allowing you to se-
lect the MIDI channel on which the controller is transmitted.

Address The Continuous Controller number, the pitch of a note or the address of 
a NRPN/RPN Continuous Controller.

Max. Value The maximum value the control will transmit. This value is used by the 
program to “scale” the value range of the MIDI controller to the value 
range of the program parameter.

Flags Clicking in this column pulls down a pop-up menu, allowing you to acti-
vate or deactivate three flags:
Receive – activate this if the MIDI message should be processed on re-
ception.
Transmit – activate this if a MIDI message should be transmitted when 
the corresponding value in the program changes.
Relative – activate this if the control is an “endless” dial, which reports 
the number of turns instead of an absolute value.
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• If you are uncertain of which MIDI message a certain controller sends, 
you can use the Learn function:
Select the control in the upper table (by clicking in the Control Name column), move 
the corresponding control on your MIDI device and click the Learn button to the right 
of the table. The MIDI Status, MIDI Channel and Address values are automatically set 
to those of the moved control.

7. Use the lower table to specify which Nuendo parameters you want to 
control.
Each row in the table is associated to the controller in the corresponding row in the 
upper table (as indicated by the Control Name column). The other columns have the 
following functionality:

Column Description

Device Clicking in this column pulls down a pop-up menu, used for determining 
which device in Nuendo should be controlled. The special option 
“Command” allows you to perform certain command actions by remote 
control. One example of this is the selection of remote banks.
If you have a Yamaha DSP Factory card installed (Windows version 
only), this will also appear as an option on the Device pop-up menu.

Channel/
Category

This is where you select the channel to be controlled or, if the “Com-
mand” Device option is selected, the Command category.

Value/Action Clicking in this column pulls down a pop-up menu, allowing you to se-
lect the parameter of the channel to be controlled (typically, if the “VST 
Mixer” Device option is selected you can choose between volume, pan, 
send levels, EQ, etc.).
If the “Command” Device option is selected, this is where you specify 
the “Action” of the category.

Flags Clicking in this column pulls down a pop-up menu, allowing you to acti-
vate or deactivate three flags:
Push Button – When activated, the parameter is only changed if the re-
ceived MIDI message shows a value unequal to 0.
Toggle – When activated, the parameter value is switched between 
minimum and maximum value each time a MIDI message is received. 
The combination of Push Button and Toggle is useful for remote con-
trols which do not latch the state of a button. One example is controlling 
mute status with a device on which pressing the Mute button turns it on, 
and releasing the Mute button turns it off. If Push Button and Toggle are 
activated, the Mute status will change between on and off whenever the 
button is pressed on the console.
Not Automated – When activated, the parameter will not be automated. 
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8. If needed, select another bank and make settings for this.
Note that you only need to make settings in the lower table for this – the upper table is 
already set up according to the MIDI remote device.

• If you need, you can add banks by clicking the Add button below the 
Bank pop-up.
Clicking the Rename button allows you to assign a new name to the currently selected 
bank, and you can remove an unneeded bank by selecting it and clicking the Delete 
button.

9. When you are finished, close the Generic Remote Setup window.
Now, you can control the specified Nuendo parameters from the MIDI remote device. 
To select another bank, use the pop-up menu in the Remote Status window (or use a 
control on the MIDI remote device, if you have assigned one for this).

Importing and Exporting Remote Setups

The Export button in the upper right corner of the Generic Remote 
Setup window allows you to export the current setup, including the 
Control configuration (the upper table) and all banks. The setup is 
saved as a file (with the Windows file extension “.xml”). Clicking the 
Import button allows you to import saved Remote Setup files.

• The last imported or exported Remote Setup will automatically be 
loaded when the program starts or the Generic Remote control is 
added in the Device Setup dialog.
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Background
Audio processing in Nuendo can be called “non-destructive”, in the 
sense that you can always undo changes or revert to the original ver-
sions. This is possible because processing affects audio clips rather 
than the actual audio files, and because audio clips can refer to more 
than one audio file. This is how it works:

1. If you process an event or a selection range, a new audio file is created 
in the Edits folder, within your project folder. 
This new file contains the processed audio, while the original file is unaffected. 

2. The processed section of the audio clip (the section corresponding to 
the event or selection range) is then made to refer to the new, pro-
cessed audio file.
The other sections of the clip will still refer to the original file.

• Since all edits are available as separate files, it is possible to undo any 
processing, at any point and in any order!
This is done in the Offline Process History dialog, as described on page 386.

• Furthermore, the original, unprocessed audio file can still be used by 
other clips in the project, by other projects or by other applications.

...the clip will refer both to the original file and a 
new file, containing the processed section only.

This event plays a section of this clip... ...which refers to this audio file.

After processing the event...
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Audio processing

Basically, you apply processing by making a selection and selecting a 
function from the Process submenu on the Audio menu. Processing is 
applied according to the following rules:

• Selecting events in the Project window or the Audio Part Editor will apply pro-
cessing to the selected events only.
Processing will only affect the clip sections that are referenced by the events.

• Selecting an audio clip in the Pool will apply processing to the whole clip.
• Making a selection range will apply processing to the selected range only.

Other sections of the clip are not affected.

If you attempt to process an event that is a shared copy (i.e. the event 
refers to a clip that is used by other events in the project), you are 
asked whether you want to create a new version of the clip or not.

Select “New Version” if you want the processing to affect the selected event only. 
Select “Continue” if you want the processing to affect all shared copies. 

• If you activate the “Do not show this message again” option, any and all 
further processing you do will conform to the selected method (“Con-
tinue” or ”New Version”). 
You can change this setting at any time by using the “On Processing Shared Clips” 
pop-up menu in the Preferences dialog (Audio page).
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Common settings and features

If there are any settings for the selected Audio processing function, 
these will appear when you select the function from the Process sub-
menu. While most settings are specific for the function, some features 
and settings work in the same way for several functions:

The “More...” button

If the dialog has a lot of settings, some options may be hidden when 
the dialog appears. To reveal these, click the “More...” button.

To hide the settings, click the button again (now labeled “Less...”).

The Preview, Process and Cancel buttons

These buttons have the following functionality:

Pre/post crossfade

Some processing functions allow you to gradually mix the effect in or 
out. This is done with the pre and post crossfade parameters. If you 
activate Pre-crossfade and specify a value of e.g. 1000 ms, the pro-
cessing will be applied gradually from the start of selection, reaching 
full effect 1000 ms after the start. Similarly, if you activate post-cross-
fade, the processing will gradually be removed, starting at the speci-
fied interval before the end of the selection.

The sum of the pre- and post-crossfade times cannot be larger than the 
length of the selection.

Button Description

Preview Allows you to listen to the result of the processing with the current set-
tings. Playback will continue repeatedly until you click the button again 
(the button is labeled “Stop” during Preview playback). You can make ad-
justments during Preview playback, but the changes are not applied until 
the start of the next “lap”. Some changes may automatically restart the 
Preview playback from the beginning.

Process Performs the processing and closes the dialog.

Cancel Closes the dialog without processing.



NUENDO
Audio processing and functions 15 – 363

Acoustic Stamp

The Acoustic Stamp function is a convolution tool, which allows you 
to apply room characteristics (reverb) to the audio. This is done by 
processing the audio signal according to an impulse response – gen-
erally a stereo or mono recording of a very short signal (the impulse) in 
a room or other location. As a result, the processed audio will sound 
as if it were played in the same location.

This function requires a lot of processing power, especially when using 
the Preview function. If you are working with long impulse response 
files or stereo files, you may find that Preview playback stutters or stops. 
In that case, it’s better to process the material, listen to the result and 
modify it in the Offline Process History (see page 386) if necessary.
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The dialog contains the following settings:

Impulse and Envelope display

This display shows the loaded impulse response (in white) and the 
Envelope (in red). You can zoom in vertically on the impulse response 
using the slider to the right of the display (this can be useful since im-
pulse responses typically are very weak). Zooming does not affect the 
processing in any way.

Load Impulse button

Clicking the “Load Impulse” button allows you to load an impulse re-
sponse file from disk. These are ordinary wave or aiff audio files, with a 
maximum duration of 12 seconds. The name of the currently loaded 
impulse response file is shown above the display.

• A number of demonstration impulse response files are included in the 
Nuendo program folder. 
For proper use of the Acoustic Stamp function, we recommend that you acquire files 
from a professional impulse response library.

Play Impulse button

Plays back the currently loaded impulse response.

Channel selector

If the currently loaded impulse response is a stereo file, this pop-up 
menu allows you to select whether the left channel, right channel or 
both (stereo) should be used for the convolution process.
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Envelope controls

The five sliders below the display are used for setting up the “reverb 
envelope”, that is, a gain curve modifying how the impulse response is 
applied over time, and thereby the reverb character. These settings 
are reflected in the red Envelope display above. The sliders have the 
following functionality:

Filter controls

The three sliders to the right allow you to tailor the tonal character of 
the processed sound. In essence, this is a graphic equalizer with three 
broad bands: the LPF slider governs the low frequency content, the 
BPF governs the midrange and the HPF governs the high frequency 
content.

• Setting a slider to 100% means that the corresponding filter is “fully 
open”.
When all three sliders are set to 100%, the processed audio is not filtered at all.

Reset button

Sets all parameters in the upper section of the dialog to their default 
values.

Parameter Description

First Reflections A level control for the first section of the reverb (the length of which 
is set with the next parameter, see below). Usually, this governs the 
volume of the first reflection(s) of the reverb.

First Ref. Length This determines the length of the First Reflections section (the level 
of which is controlled by the previous parameter). Usually you would 
want to set this so that it includes the first reflection in the impulse 
response (normally about 5% of the total length).

After Hall A level control for the end section of the reverb (the section after the 
First Reflections, see above).

Reverb Length Governs the reverb time, in milliseconds.

Gain Allows you to adjust the gain of the impulse response. This may be 
necessary for optimal results, since different impulse response files 
may be recorded at different levels.
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Wet/Dry Mix

These two sliders allow you to specify the balance between wet (pro-
cessed) and dry (original) signal in the resulting Clip.

Normally the two sliders are “reverse-ganged”, so that raising the Wet 
mix slider lowers the Dry mix slider by the same amount. However, if 
you press [Alt]/[Option] and drag a slider, you can move it indepen-
dently. This allows you to set e.g. 80% dry and 80% wet signal. Be 
careful to avoid distortion.

Tail

This parameter allows you to “add space” after the original audio sec-
tion, to avoid that the reverb tail is cut off. When the checkbox is acti-
vated, you can specify a tail length using the slider. The tail time is 
included when playing back with the Preview function, allowing you to 
find the appropriate tail length. A good value would be the Reverb 
Length value, displayed in ms to the right of the Reverb Length para-
meter.

Pre- and Post-Crossfade

See page 362.
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Envelope

The Envelope function allows you to apply a volume envelope to the 
selected audio. The dialog contains the following settings:

Curve Kind buttons

These determine whether the envelope curve should consist of spline 
curve segments (left button), damped spline segments (middle but-
ton) or linear segments (right button).

Fade display

Shows the shape of the envelope curve. The resulting waveform shape 
is shown in dark grey, with the current waveform shape in light grey. 
You can click on the curve to add points, and click and drag existing 
points to change the shape. To remove a point from the curve, drag it 
outside the display.

Presets

If you have set up an envelope curve that you may want to apply to other 
events or clips, you can store it as a preset by clicking the Store button. 

• To apply a stored preset, select it from the pop-up menu. 

• To rename the selected preset, double click on the name and type a 
new one in the dialog that appears. 

• To remove a stored preset, select it from the pop-up menu and click 
Remove.
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Fade In and Fade Out

These function are described in the chapter “Fades, crossfades and 
envelopes” (see page 186).

Gain

Allows you to change the gain (level) of the selected audio. The dialog 
contains the following settings:

Gain

This is where you set the desired gain, between -50 and +20dB. The 
setting is also indicated below the Gain display as a percentage.

Clip detection text

If you use the Preview function before applying the processing, the 
text below the slider indicates whether the current settings result in 
clipping (audio levels above 0 dB). If that is the case, lower the Gain 
value and use the Preview function again.

• If you want to increase the level of the audio as much as possible with-
out causing clipping, you should use the Normalize function instead 
(see page 371).

Pre- and Post-Crossfade

See page 362.
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Merge Clipboard

This functions mixes the audio from the clipboard into the audio 
selected for processing, starting at the beginning of the selection.

For this function to be available, you need to have Cut or Copied a range 
of audio in the Sample Editor first.

The dialog contains the following settings:

Sources mix

Allows you to specify a mix ratio between the Original (the audio se-
lected for processing) and the Copy (the audio on the clipboard).

Pre- and Post-Crossfade

See page 362.
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Noise Gate

Scans the audio for sections weaker than a specified threshold level, 
and replaces them with silence. The dialog contains the following 
settings:

Threshold

The level below which you want audio to be silenced. Levels below 
this value will close the gate.

Attack Time

The time it takes for the gate to open fully after the audio level has 
exceeded the threshold level.

Min. Opening Time

This is the shortest time the gate will remain open. If you find that the 
gate opens and closes too often when processing material that varies 
rapidly in level, you should try raising this value.

Release Time

The time it takes for the gate to close fully after the audio level has 
dropped below the threshold level.

Linked Channels

This is available for stereo audio only. When it is activated, the Noise 
Gate is opened for both channels as soon as one or both channels 
exceed the Threshold level. When Linked Channels is deactivated, 
the Noise Gate works independently for the left and right channel.
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Dry/Wet mix

Allows you to specify a mix ratio between “dry” and processed sound.

Pre- and Post-Crossfade

See page 362.

Normalize

The Normalize function allows you to specify the desired maximum 
level of the audio. It then analyzes the selected audio and finds the 
current maximum level. Finally it subtracts the current maximum level 
from the specified level, and raises the gain of the audio by the result-
ing amount (if the specified maximum level is lower than the current 
maximum, the gain will be lowered instead). A common use for Nor-
malizing is to raise the level of audio that was recorded at too low an 
input level. The dialog contains the following settings:

Maximum

The desired maximum level for the audio, between -50 and 0dB. The 
setting is also indicated below the Gain display as a percentage.

Pre- and Post-Crossfade

See page 362.
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Phase Reverse

Reverses the phase of the selected audio, turning the waveform “up-
side down”. The dialog contains the following settings:

Phase Reverse on

When processing stereo audio, this pop-up menu allows you to spec-
ify which channel(s) should be phase reversed.

Pre- and Post-Crossfade

See page 362.

Pitch Shift

This function allows you to change the pitch of the audio with or with-
out affecting its length. You can also create “harmonies” by specifying 
several pitches, or apply pitch shift based on a user specified envelope 
curve.
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When the “Transpose” tab is selected, the dialog contains the follow-
ing parameters:

Keyboard display

This offers a way to specify the transpose interval in semitones, and 
gives a graphic overview of the transposition setting.

• The “root note” is indicated in red.
This has nothing to do with the actual key or pitch of the original audio, it just provides 
a way to display transpose intervals. If you like, you can change the root note by using 
the settings to the right below the keyboard display, or by pressing [Alt]/[Option] and 
clicking in the keyboard display.

• To specify a transpose interval, click on one of the keys.
The key is indicated in blue, and the program plays test tones in the base pitch and 
transpose pitch, to give you an audible confirmation.

• If “Multi Shift” is activated (see below), you can click on several keys 
to create “chords”.
Clicking on a blue (activated) key removes it.

Pitch Shift settings

The “Semitones” and “Fine tune” settings allow you to specify the 
amount of pitch shift. You can transpose the audio ±16 semitones, 
and fine tune it by ±200 cents (hundredths of semitones).

Volume

Allows you to lower the volume of the pitch shifted sound.

Multi Shift

When this is activated, you can add more than one transpose value, 
creating multi-part harmonies. This is done by adding intervals in the 
keyboard display, as described above.

• If the intervals you add make up a standard chord, this chord is dis-
played to the right.
Note however, that to include the base pitch (the original, untransposed sound) in the 
processed result, you need to click the base key in the keyboard display as well, so 
that it is displayed in blue.
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Listen Key/Chord button

Clicking this button plays a test tone, pitched according to the acti-
vated interval key on the keyboard display. If “Multi Shift” is activated, 
this button is called “Listen Chord”, and plays all activated intervals, 
as a chord.

Pitch Shift Base

This allows you to set the root note (the red key in the keyboard dis-
play). This has no actual relation to the pitch of the audio material, but 
should be viewed as an aid for easily setting up intervals and chords.

Algorithm

Allows you to select one of two algorithms: Timebandit Standard and 
MPEX. Timebandit Standard gives lower audio quality but is faster 
while MPEX is slower and gives higher audio quality. 

The MPEX mode has 4 quality settings, 1 to 4, which can also be set 
using the Mono-Poly slider: 1 should be used for single voices/instru-
ments, 2 for polyphonic material (fast), three for polyphonic material 
(medium) and 4 for polyphonic material with highest quality results 
(slow). 

You cannot use the Preview function in MPEX mode, since the MPEX 
algorithm isn’t designed for real time processing.

Formant Mode (MPEX only)

If you are processing vocal material, you should activate this option in 
order to preserve the vocal characteristics of the pitch shifted audio.

Time Correction

When this is activated, the pitch shift process will not affect the length 
of the audio. When this is deactivated, raising the pitch will shorten 
the audio section and vice versa, much like changing the playback 
speed on a tape recorder.
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Using envelope based Pitch Shift

When the “Envelope” tab is selected, you can specify an envelope 
curve on which the pitch shift should be based. This allows you to cre-
ate pitch bend effects, pitch shift different sections of the audio by dif-
ferent amounts, etc.

Envelope display

Shows the shape of the envelope curve, over the waveform image of 
the audio selected for processing. Envelope curve points above the 
center line indicate positive pitch shift, while curve points below the 
center line indicate negative pitch shift. Initially, the envelope curve will 
be a horizontal, centered line, indicating zero pitch shift.

• You can click on the curve to add points, and click and drag existing 
points to change the shape. To remove a point from the curve, drag it 
outside the display.
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Curve Kind

These buttons determine whether the envelope curve should consist 
of spline curve segments (left button), damped spline segments (mid-
dle button) or linear segments (right button).

Spline curve segment envelope.

The same envelope with damped spline segments selected

The same envelope with linear segments selected.
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Range

This parameter determines the vertical pitch range of the envelope. If 
set to “4”, moving a curve point to the top of the display corresponds 
to pitch shifting by + 4 semitones. The maximum range is +/- 16 
Semitones. 

Transpose and Fine Tune

Allows you to adjust the value of a curve point numerically:

1. Click on a curve point to select it.
The selected point is shown in red.

2. Adjust the Transpose and Fine Tune parameters to change the pitch 
of the curve point in semitones and cents, respectively.

Pitch Shift Mode

These are the same parameters as on the Transpose tab.

Example

Let’s say that you wish to create a pitch bend effect, so that the pitch 
is raised linearly by exactly 2 semitones in a specific part of the se-
lected audio.

1. Remove all curve points by clicking the Reset button.

2. Select a linear curve by clicking the right Curve Kind button.

3. Create a point where you want the pitch bend to start by clicking on 
the envelope line.
Since this is the starting point for the pitch bend, you want its pitch to be zero (the en-
velope line should still be straight). If necessary, use the Fine Tune parameter to set the 
curve point to 0 cents, because this point governs the start point, where you want the 
pitch transition to begin.

4. Create a new curve point at the horizontal position where you want 
the pitch bend to reach the full value.
This curve point determines the rise time of the pitch bend effect, i.e. the further away 
from the starting point the new point is positioned, the longer it will take for the pitch 
bend to reach the full value, and vice versa.

5. Make sure the Range parameter is set to 2 semitones or higher.
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6. With the second point still selected, use the Transpose and Fine Tune 
parameters to set the pitch to exactly 2 semitones.

7. Create a new curve point to set the duration of the pitch bend, i.e. the 
time the pitch should remain transposed by 2 semitones.

8. Finally, create a point where you want the pitch bend to end.
You don’t need to create a new point if this should be the end of the audio file being 
processed. There is always an end point at the right side of the waveform display.

9. If necessary, make additional settings in the Pitch Shift Mode section.

10.Click Process.
The pitch bend is applied according to the specified settings.

Remove DC Offset

This function will remove any DC offset in the audio selection. A DC 
offset is when there is too large a DC (direct current) component in 
the signal, sometimes visible as the signal not being visually centered 
around the “zero level axis”. DC offsets do not affect what you actually 
hear, but they affect zero crossing detection and certain processing, 
and it is recommended that you remove them.

It is recommended that this function is applied to complete audio clips, 
since the DC offset (if any) is normally present throughout the entire re-
cording.

There are no parameters for this function. Note that you can check for 
DC Offset in an audio clip using the Statistics function (see page 398).
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Resample

The Resample function can be used for changing the length, tempo 
and pitch of an event.

The original sample rate of the event is listed in the dialog. Resample 
the event to a higher or lower sample rate by either specifying a sam-
ple rate or by specifying the difference (in percentages) between the 
original sample rate and the desired new one.

• Resampling to a higher sample rate will make the event longer and cause the 
audio to play back at a slower speed with a lower pitch.

• Resampling to a lower sample rate will make the event shorter and cause the 
audio to play back at a faster speed with a higher pitch.

• You can audition the result of the resampling by entering the desired 
value and clicking “Preview”.
The event will then be played back as it will sound after the resampling.

• When you are satisfied with the preview result, click “Process” to 
close the dialog and apply the processing.

Reverse

Reverses the audio selection, as when playing a tape backwards. 
There are no parameters for this function.

Silence

Replaces the selection with silence. There are no parameters for this 
function.
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Stereo Flip

This function works with stereo audio selections only. It allows you to 
manipulate the left and right channel in various ways. The dialog con-
tains the following parameters:

Mode

This pop-up menu determines what the function does:

Option Description

Flip Left-Right Swaps the left and right channel.

Left to Stereo Copies the left channel sound to the right channel.

Right to Stereo Copies the right channel sound to the left channel.

Merge Merges both channels on each side, for mono sound.

Subtract Subtracts the left channel information from the right and vice 
versa. This is typically used as a “Karaoke effect”, for removing 
centered mono material from a stereo signal.
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Time Stretch

This function allows you to change the length and “tempo” of the se-
lected audio, without affecting the pitch. The dialog contains the fol-
lowing parameters:

Input section

This section contains information and settings regarding the “input”, 
the audio selected for processing:

Parameter Description

Length in Samples The length of the selected audio, in samples.

Length in Seconds The length of the selected audio, in seconds.

Tempo in BPM If you are processing music, and know the actual tempo of the 
audio, you can enter it here as beats per minute. This makes it 
possible to time stretch the audio to another tempo, without hav-
ing to compute the actual time stretch amount.

Bars If you use the tempo setting, you need to specify the length of 
the selected audio here, as bars, beats, 1/16-notes and ticks 
(with 120 ticks per 1/16-note).

Time Signature If you use the tempo setting, you specify the time signature here.
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Output section

These settings are used if you want to stretch the audio to fit within a 
specific time span or tempo. The values will change automatically if 
you adjust the Timestretch amount (see below).

Timestretch

The Timestretch parameter determines the amount of timestretch, as 
a percentage of the original length. If you use the settings in the Out-
put section to specify the amount of timestretch, this value will change 
automatically. The possible timestretch range depends on the “Effect” 
option:

• If the “Effect” checkbox is deactivated, the range is 75-125%.
This is the preferred mode if you want to preserve the character of the sound.

• If the “Effect” checkbox is activated, you can specify values between 
10 and 1000%. 
This mode is mainly useful for special effects, etc.

Parameter Description

Samples The desired length in samples.

Seconds The desired length in seconds.

BPM The desired tempo (beats per minute). For this to work, you have to 
know the actual tempo of the audio, and specify this (along with time 
signature and length in bars) in the Input section to the left.

Range Allows you to specify the desired length as a range between two 
time positions.

Set to Locators 
Range

Clicking this button sets the Range values to the length of the Cycle.
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Algorithm

Allows you to select one of four time stretch algorithms: Standard, 
MPEX 2, Drum and Realtime mode. Standard is quicker and gives 
lower audio quality while MPEX 2 is slower and gives the highest 
audio quality.

The MPEX mode has 4 quality settings, 1 to 4, which can also be set 
using the Mono-Poly slider: 1 should be used for single voices/instru-
ments, 2 for polyphonic material (fast), three for polyphonic material 
(medium) and 4 for polyphonic material with highest quality results 
(slow). 

• About the MPEX 2 algorithm:
This mode is based on Prosoniq's proprietary MPEX (Minimum Perceived Loss Time 
Compression/Expansion) algorithm. This algorithm (which is also used in Prosoniq’s 
TimeFactory™ application) uses an artificial neural network for time series prediction in 
the scale space domain to achieve high end time and pitch scaling. This gives the best 
possible audio quality result. 
Note that you should not use the Preview function in MPEX mode, since the MPEX al-
gorithm isn’t designed for realtime processing. 

• Drum mode:
This is a special algorithm, optimized for processing rhythmic material. The Accuracy 
parameter and Preview function are not available in Drum mode.

• Realtime mode:
This is the algorithm used for the realtime time stretching features in Nuendo. Although 
this algorithm is optimized for time stretching in realtime, you can use it for offline pro-
cessing as well. The Presets pop-up contains the same presets as found in the Warp 
settings pop-up in the Sample Editor, see page 448.
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Applying plug-ins

As described in “Audio effects”, you can add plug-in effects in real-
time during playback. However, sometimes it’s useful to “permanently” 
apply effects processing to one or several selected events. In Nuendo, 
this is done in the following way:

1. Make a selection in the Project window, the Pool or an editor.
Effects are applied according to the same rules as Processing (see page 362).

2. Select “Plug-ins” from the Audio menu.

3. Select the desired effect from the submenu that appears.
The Process Plug-in dialog appears.

About stereo and mono

If you are applying an effect to mono audio material, only the left side 
of the effect’s stereo output will be applied.

The process plug-in dialog

The process plug-in dialog for the Chorus effect.

The upper section of the process plug-in dialog contains the actual 
effect parameters of the selected plug-in. For details on the included 
plug-ins’ parameters, see the separate “Audio Effects and VST Instru-
ments” pdf document.
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The lower section of the dialog contains settings for the actual pro-
cessing. These are common to all plug-ins.

• If the lower section is hidden, click the “More...” button to display it.
Clicking the button again (now labeled “Less...”) will hide the lower section.

The following settings and functions are available in the common, 
lower section of the dialog:

Wet mix/Dry mix

These two sliders allow you to specify the balance between wet (pro-
cessed) and dry (original) signal in the resulting clip. 

Normally the two sliders are “reverse-ganged”, so that raising the Wet 
mix slider lowers the Dry mix slider by the same amount. However, if 
you press [Alt]/[Option] and drag a slider, you can move it indepen-
dently. This allows you to set e.g. 80% dry and 80% wet signal. Be 
careful to avoid distortion.

Tail

This parameter is useful if you are applying an effect that adds material 
after the end of original audio (such as reverb and delay effects). When 
the checkbox is activated, you can specify a tail length using the slider. 
The tail time is included when playing back with the Preview function, 
allowing you to find the appropriate tail length.

Pre/Post Crossfade

These settings allow you to gradually mix the effect in or out. If you ac-
tivate Pre-Crossfade and specify a value of e.g. 1000 ms, the effect 
will be applied gradually from the start of selection, reaching full effect 
1000 ms after the start. Similarly, if you activate Post-Crossfade, the 
processing will gradually be removed starting at the specified interval 
before the end of the selection.

The sum of the Pre- and Post-Crossfade times cannot be larger than the 
length of the selection.
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Preview button

Allows you to listen to the result of the processing with the current 
settings. Playback will continue repeatedly until you click the button 
again (the button is labeled “Stop” during Preview playback). You can 
change the effect settings during Preview playback if needed.

Process button

Applies the effect and closes the dialog.

Cancel button

Closes the dialog without applying the effect.

The Offline Process History dialog

Procedures

If you find you want to remove some or all processing from a clip, this 
can be done in the Offline Process History dialog. Processing that can 
be modified in the Offline Process History dialog includes the functions 
on the Process menu, any applied plug-in effects, and Sample Editor 
operations such as Cut, Paste, Delete and drawing with the Pencil tool.

Due to the clip-file relationship (see page 360), it is even possible to 
modify or remove some processing “in the middle” of the Process His-
tory, while keeping later processing! This feature depends on the type of 
processing performed (see page 388).

Proceed as follows:

1. Select the clip in the Pool or one of its events in the Project window.
You can see which clips have been processed by checking the Status column in the 
Pool – the waveform symbol indicates that processing or effects have been applied to 
the clip (see page 388).

2. Select “Offline Process History...” from the Audio menu.
The Offline Process History dialog appears.
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The left part of the dialog contains a list of all processing you have 
added to the clip, with the most recent operations at the bottom of the 
list. The “Start” and “Length” columns indicate which section of the 
clip was affected by each operation. The “Status” column indicates if 
the operation can be modified or removed.

3. Locate the operation you want to edit and select it by clicking on it in 
the list.

• To modify the settings of the selected processing, click the “Modify” 
button.
This opens the dialog for the processing function or applied effect, allowing you to 
change the settings. This works just as when you applied the processing or effect the 
first time.

• To replace the selected operation with another processing function or 
effect, select the desired function from the pop-up menu and click the 
“Replace By” button.
If the selected function has settings, a dialog will appear as usual. The original opera-
tion will then be removed and the new processing will be inserted in the Offline Pro-
cess History.

• To remove the selected operation, click the “Remove” button.
The processing is removed from the clip.

• To undo the selected operation and remove the processing from the 
clip click the “Deactivate” button.
The processing is removed from the clip, but the operation remains in the list. To redo 
the operation and apply the processing again, click the button, now renamed to “Acti-
vate”, again.
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• To save the list of processing operations as a Batch Process, click the 
“Save As Batch” button.
See page 388 for information about Batch Processing.

4. Click “Close” to close the dialog.

Restrictions

• If there are no settings for the processing function, you can’t modify it.

• If you have applied processing that changes the length of the clip 
(such as Cut, Insert or Time Stretch), you can only remove this if it is 
the most recent processing in the Offline Process History (at the bot-
tom of the list in the dialog). If an operation can not be removed or 
modified, this is indicated by an icon in the “Status” column. Also, the 
corresponding buttons will be greyed out.

• The list must contain at least two processing operations in order to be 
saved as a Batch Process (see page 388).

Batch Processing

Nuendo features a Batch Processing function that lets you apply a 
chain of audio processing to one or several events in one go – in ei-
ther the Project window or the Pool. Batch Processing is based on 
operations in the Offline Process History dialog, described above. 
That is, the list of applied processes in this dialog is what can be 
made to constitute a batch process.

Batch Processing is therefore a convenient way to apply the same ef-
fects with the same settings to several audio events in a project.

It can also be used to “store” effect settings for future use. You may 
for example have performed a series of elaborate audio processing 
with a good result, and want to retain the particular combination and 
settings of effects you applied, so that you may quickly and easily ap-
ply them again to other events in the future.
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To set up a batch process, proceed as follows:

1. Apply the desired processing to an audio event or selection range in 
the project.
Note that you must apply at least two audio processes in order to set up a batch pro-
cess.

From here, there are two ways to go:

2. Pull down the Audio menu, and from the Batch Processes submenu, 
select “Create from Process History...”.

3. In the dialog that appears, type in a name for the batch process, and 
click OK.

or...

4. Pull down the Audio menu and select “Offline Process History”.
The Offline Process History dialog opens. In this dialog you can modify settings or re-
move operations as desired (see page 386).

5. In the Process History Dialog, click “Save As Batch”, and then type in 
a name for the batch process in the dialog that appears and click OK.

Regardless of which of the above two methods you use, the batch 
process is now saved and available for use:

6. In the Project window, select all the audio events you want to process.
You can also make a selection range that spans multiple tracks and batch process the 
selection for all the audio events.

7. Pull down the Audio menu and open the Batch Processes submenu.
At the top of the menu you can now find the name of the batch process you created. 
The menu will list the names of any batch processes you create, until you delete them 
(see below).
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8. Select the batch process you want to apply from the menu.
All the selected events will now be processed accordingly.

• Note that even if you clear the Offline Process History dialog of all the 
operations that make up a batch process, this will not affect the saved 
batch process. It will still contain and perform the operations on which it 
was based when created.

Managing Batch Processes

You can delete and rename created batch processes by selecting 
“Manage...” from the Batch Processes submenu on the Audio menu.

In the dialog that appears, the created batch processes are listed in 
the left column, and the operations each batch process contains are 
listed in the right column.

If you want to remove a batch process or change its name, just select 
it in the list and click “Delete” or “Rename”.
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Freeze Edits

The Freeze Edits function on the Audio menu allows you to make all 
processing and applied effects permanent for a clip:

1. Select the clip in the Pool or one of its events in the Project window.

2. Select “Freeze Edits…” from the Audio menu.

• If there is only one edit version of the clip (no other clips refer to the 
same audio file), the following dialog will appear:

If you select “Replace”, all edits will be applied to the original audio file (the one listed 
in the clip’s Path column in the Pool). If you select “New File”, the Freeze Edits opera-
tion will create a new file in the Audio folder within the project folder (leaving the origi-
nal audio file unaffected).

• If the selected clip (or the clip played by the selected event) has sev-
eral edit versions (i.e. there are other clips referring to the same audio 
file), the following alert will appear:

As you can see, you don’t have the option to Replace the original audio file in this case. 
This is because that audio file is used by other clips. Select “New File” to have a new 
file created in the Audio folder within the project folder.

Now, the clip refers to a new, single audio file. If you open the Offline 
Process History dialog for the clip, the list will be empty.
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Detect Silence

The Detect Silence function on the advanced submenu of the Audio 
menu isn’t really a processing function, since it doesn’t actually affect 
the audio clip. Instead, it searches for silent sections in an event, and 
either splits the event, removing the silent parts from the project, or 
creates regions corresponding to the non-silent sections. Proceed as 
follows:

1. Select the event in the Project window or the Audio Part Editor.
You can select several events if you like, in which case you will be allowed to make 
separate settings for each selected event.

2. Select “Detect Silence” from the Audio menu.
The Detect Silence dialog appears.
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3. Adjust the settings in the area below the waveform display.
They have the following functionality:

4. Click the “Compute” button.
The audio event is analyzed, and the waveform display is redrawn to indicate which 
sections will be considered “silent”, according to your settings.

Setting Description

Open Threshold When the audio level exceeds this value, the function will “open”, i.e. 
let the sound through.
Set this low enough to open when a sound starts, but high enough to 
remove unwanted noise during “silent” sections.

Close Threshold When the audio level drops below this value, the function will “close”. 
This value cannot be higher than the Open Threshold value. 
Set this high enough to remove unwanted noise during “silent” sec-
tions.

Linked If this checkbox is ticked, Open and Close Threshold will have the 
same value.

Min. Opening 
Time

Determines the minimum time that the function will remain “open” af-
ter the audio level has exceeded the Open Threshold value.
If the audio contains repeated short sounds, and you find that this re-
sults in too many short “open” sections, try raising this value.

Min. Closing 
Time

Determines the minimum time that the function will remain “closed” af-
ter the audio level has dropped below the Close Threshold value.
Usually you would want to set this to a low value, to avoid removing 
sounds.

Pre-Roll Allows you to have the function “open” slightly before the audio level 
exceeds the Open Threshold value. In other words, the start of each 
“open” section is moved to the left according to the time you set here.
This is useful to avoid removing the attack of sounds.

Post-Roll Allows you to have the function “close” slightly after the audio level 
drops below the Close Threshold value.
This is useful to avoid removing the natural decay of sounds.
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• If you like, you can use the Preview function to listen to the result.
The event is played back repeatedly in its entire length, but with the “closed” sections 
silenced.

5. Repeat steps 3 and 4 until you are satisfied with the result.

6. Select what you want the function to do, by activating either the “Add 
as Regions” checkbox, the “Strip Silence” checkbox, or both.
“Add as Regions” will create regions according to the non-silent sections. “Strip Si-
lence” will split the event at the start and end of each non-silent section, and remove 
the silent sections in between.

7. If you activated “Add as Regions”, you can specify a name for the Re-
gions in the Regions Name field.
In addition to the name, the regions will be numbered, starting with the number speci-
fied in the Auto Number Start field.

8. Click “Process”.
The event is split and/or regions are added.

The result of the “Strip Silence” option.

• If you selected more than one event in step 1 above, the dialog will 
appear again, allowing you to make separate settings for each se-
lected event.
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The Spectrum Analyzer

This function analyzes the selected audio, computes the average 
“spectrum” (level distribution over the frequency range) and displays 
this as a two-dimensional graph, with frequency on the x-axis and level 
on the y-axis.

1. Make an audio selection (a clip, an event or a range selection).

2. Select “Spectrum Analyzer” from the Audio menu.
A dialog with settings for the analysis appears.

The default values are chosen to give good results in most situations, 
but you can adjust the settings if you like:

Setting Description

Size in Samples The function divides the audio into “analysis blocks”, the size of 
which is set here. The larger this value, the higher the frequency 
resolution of the resulting spectrum.

Size of Overlap The overlap between each analysis block.

Window used Allows you to select which window type should be used for the 
FFT (Fast Fourier Transform, the mathematical method used for 
computing the spectrum). 

Normalized values When this is activated, the resulting level values are scaled, so that 
the highest level is displayed as “1” (0 dB).

From Stereo When analyzing stereo material, there is a pop-up menu with the 
following options:
Mono mix – the stereo signal is mixed to mono before analyzing.
Mono left/right – the left or right channel signal is used for analysis.
Stereo – both channels are analyzed (two separate spectrums will 
be displayed).
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3. Click the “Process” button.
The spectrum is computed and displayed as a graph.

4. You can adjust the display with the settings in the display window:

Setting Description

dB When this is activated, the vertical axis shows dB values. When it is 
deactivated, values between 0 and 1 are shown.

Freq. log When this is activated, frequencies (on the horizontal axis) are dis-
played on a logarithmic scale. When it is deactivated, the frequency 
axis is linear.

Precision Indicates the frequency resolution of the graph. This value cannot 
be changed here, but is governed by the Size in Samples setting in 
the previous dialog.

Frequency/Note Allows you to select whether you want the frequencies to be dis-
played in Hertz or with note names.

Min. Sets the lowest frequency shown in the graph.

Max. Sets the highest frequency shown in the graph. By adjusting the Min 
and Max values, you can take a closer look at a smaller frequency 
range.

Active When this is activated, the next Spectrum Analysis will appear in the 
same window. When deactivated, new Spectrum Analysis results 
will appear in separate windows.
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5. If you move the mouse pointer over the graph, a crosshair cursor fol-
lows the graph curve and the display in the upper right corner shows 
the frequency/note and level at the current position.
To compare the level between two frequencies, move the pointer to one of the frequen-
cies, right-click (Win) or [Ctrl]-click (Mac) once and move the pointer to the second fre-
quency. The delta value (the difference in level between the current position and the 
right/[Ctrl]-click position) is displayed in the upper right corner (labeled “D”).

• If you analyzed stereo audio and selected the “Stereo” option in the first 
dialog, the graphs for the left and right channel are superimposed in the 
display, with the left channel graph in white and the right channel graph 
in yellow.
The display in the upper right corner shows the values for the left channel – to see the 
right channel values, hold down [Shift]. An “L” or “R” is displayed to indicate which 
channel values are shown.

6. You can leave the window open or close it by clicking the “Close” 
button.
If you leave it open and the “Active” checkbox is ticked, the result of the next Spectrum 
Analysis will be displayed in the same window.



NUENDO
15 – 398 Audio processing and functions

Statistics

The Statistics function on the Audio menu analyzes the selected audio 
(events, clips or range selections) and displays a window with the fol-
lowing information:

Item Description

Min. Sample 
Value

The lowest sample value in the selection, as a value between -1 and 
1 and in dB.

Max. Sample
Value

The highest sample value in the selection, as a value between -1 
and 1 and in dB.

Peak Amplitude The largest sample value (in absolute numbers) in the selection, in 
dB.

DC Offset The amount of DC Offset (see page 378) in the selection, as a per-
centage and in dB.

Estimated 
Resolution

Even though an audio file is in 16 or 24 bits, it may have been con-
verted from a lower resolution. The Estimated Resolution value 
makes an educated guess about the actual audio resolution, by 
computing the smallest level difference between two samples.

Estimated Pitch The estimated pitch of the audio selection.

Sample Rate The sample rate of the audio selection.

Min. RMS Power The lowest loudness (RMS) measured in the selection.

Max. RMS Power The highest loudness (RMS) measured in the selection.

Average The average loudness over the whole selection.
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The Sample Editor
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Background

The Sample Editor allows you to view and manipulate audio at the au-
dio clip level, by cutting and pasting, removing or drawing audio data 
or applying effects. This editing can be called “non-destructive”, in the 
sense that you can undo changes or revert to the original versions at 
any point, using the Offline Process History. 

For details, see the section about non-destructive processing on page 
360 and the description of the Offline Process History on page 386.

The Sample Editor also contains most of the Audio warp related fea-
tures. These are described in a separate chapter, see page 434.

Opening the Sample Editor

You open the Sample Editor by double clicking an audio event in the 
Project window or the Audio Part Editor, or by double clicking an au-
dio clip in the Pool. You can have more than one Sample Editor open 
at the same time.

• Note that double clicking on an audio part in the Project window will 
open the Audio Part Editor, even if the part only contains a single au-
dio event.
See page 422.
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Window overview

The Elements menu

If you right-click (Win) or [Ctrl]-click (Mac) in the Sample Editor to 
bring up the Quick menu, you will find a sub menu called “Elements”. 
By activating or deactivating options on this submenu, you can decide 
what you want shown in the editor window. Some of these options are 
also available as icons on the toolbar.
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The toolbar

The toolbar contains tools and various settings:

• You can customize the toolbar by right-clicking it (Win) or [Ctrl]-clicking 
it (Mac) and using the pop-up menu to hide or show items.

Selecting Setup from the pop-up menu allows you to reorder sections 
on the toolbar, store presets, etc. See page 678.

The Sample Editor tools Audition, Loop & 
Volume controls

Show regions

AutoscrollShow Event

Show info line

Snap to Zero Crossing Length of the current selection range

Start and end of current selection rangeHitpoint mode Hitpoint controls

Warp Control Settings

Musical controls Musical Mode Show Warp tabs
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The thumbnail display

The thumbnail display provides an overview of the whole clip. The sec-
tion currently shown in the Sample Editor’s main waveform display is in-
dicated by a blue rectangle in the thumbnail, while the current selection 
range is shown in blue.

• You can move the blue rectangle in the thumbnail to view other sec-
tions of the clip.
Click in the lower half of the rectangle and drag it to the left or right to move it.

• You can resize the blue rectangle (by dragging its left or right edge) to 
zoom in or out, horizontally.

• You can define a new viewing area by clicking in the upper half of the 
overview and dragging a rectangle with the pointer.

The ruler

The Sample Editor ruler is located between the thumbnail and the 
waveform display. It shows the timeline in the display format specified in 
the Project Setup dialog (see page 111). If you like, you can select an 
independent display format for the ruler by clicking on the arrow button 
to the right of it and selecting an option from the pop-up menu that ap-
pears (this affects the values in the info line too). For a list of the display 
format options, see page 108.



NUENDO
16 – 404 The Sample Editor

The waveform display and the level scale

The waveform display shows the waveform image of the edited audio 
clip – in the style selected in the Preferences dialog (Event Display–
Audio page), see page 117. To the left of it, a level scale can be 
shown, indicating the amplitude of the audio.

• When the level scale is shown, you can select whether the level 
should be shown as a percentage or in dB.
This is done by right-clicking the level scale and selecting an option from the pop-up 
menu that appears. This also allows you to hide the level scale.



NUENDO
The Sample Editor 16 – 405

• To display the level scale after hiding it, right-click (Win) or [Ctrl]-click 
(Mac) to bring up the Quick menu and activate “Level Scale” on the 
Elements submenu.
This submenu also allows you to select whether you want the zero axis and/or the half 
level axis indicated in the waveform display.

The info line

The info line at the bottom of the window shows information about the 
edited audio clip. You cannot edit the values on the info line.

• To hide or show the info line, click the Show Info button on the toolbar.

• Initially, length and position values are displayed in the format speci-
fied in the Project Setup dialog (see page 111), but you can change 
this by clicking in the middle field of the info line and selecting another 
display format from a pop-up menu.
This selection affects the Sample Editor ruler as well.

Half level axisZero axis

Audio format and length Current selection range

Selected display format (for info line and ruler) Number of edits made to clip

Zoom factor
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Operations

Zooming

Zooming in the Sample Editor is done according to the standard 
zoom procedures, with the following special notes:

• The vertical zoom slider changes the vertical scale relative to the height 
of the editor window, in a way similar to the waveform zooming in the 
Project window (see page 113).
The vertical zoom will also be affected if you drag a rectangle with the Zoom tool and 
the option “Zoom Tool Standard Mode” (Preferences – Editing dialog) is deactivated.

• The following options relevant to the Sample Editor are available on 
the Zoom submenu on the Edit menu:

• You can also zoom by resizing the rectangle in the thumbnail display.
See page 403.

• The current zoom setting is shown in the info line, as a “samples per 
screen pixel” value.

• Note that you can zoom in horizontally to a scale with less than one 
sample per pixel! 
This is required for drawing with the Pencil tool (see page 417).

Option Description

Zoom In Zooms in one step, centering on the position cursor.

Zoom Out Zooms out one step, centering on the position cursor.

Zoom Full Zooms out so that the whole clip is visible in the editor.

Zoom to Selection Zooms in so that the current selection fills the screen.

Zoom to Event Zooms in so that the editor shows the section of the clip corre-
sponding to the edited audio event. This is not available if you 
opened the Sample Editor from the Pool (in which case the 
whole clip is opened for editing, not an event).

Zoom In/Out Vertical This is the same as using the vertical zoom slider (see above).
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• If you have zoomed in to one sample per pixel or less, the appearance 
of the samples depend on the option “Interpolate Audio Images” in 
the Preferences dialog (Event Display–Audio page).
If the option is deactivated, single sample values are drawn as “steps”. If the option is 
activated they are interpolated to “curves” form.

Auditioning

While you can use the regular play commands to play back audio when 
the Sample Editor is open, it is often useful to listen to the edited ma-
terial only. Below are two ways to do this.

• When auditioning, audio will be routed directly to the Audition bus, see 
page 29.

• You can adjust the auditioning level with the miniature level fader on the 
toolbar.

By using the Speaker tool

If you click somewhere in the waveform display with the Speaker tool 
and keep the mouse button pressed, the clip will be played back from 
the position at which you clicked. Playback will continue until you re-
lease the mouse button.

By using the Play icon

Clicking the Play icon on the toolbar plays back the edited audio, ac-
cording to the following rules:

• If you have made a selection, this selection will be played back.
• If there is no selection, but the option “Show Event” is activated (see page 418), 

the section of the clip corresponding to the event will be played back.
• If there is no selection, and “Show Event” is deactivated, the playback will 

start at the cursor position (if the cursor is outside the display, the whole clip 
is played back).

• If the Loop icon is activated, playback will continue repeatedly until you deac-
tivate the Play icon. Otherwise, the section will be played back once.

• Note that there is a separate Play button for auditioning Regions. See 
page 415.
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Scrubbing

The Scrub tool allows you to locate positions in the audio by playing 
back, forwards or backwards, at any speed:

1. Select the Scrub tool.

2. Click in the waveform display and keep the mouse button pressed.
The project cursor is moved to the position at which you click.

3. Drag to the left or right.
The project cursor follows the mouse pointer and the audio is played back. The speed 
and pitch of the playback depends on how fast you move the pointer.

• You can adjust the response of the Scrub tool with the Scrub Re-
sponse (Speed) setting in the Preferences dialog (VST page).
There you will also find a separate Scrub Volume setting.

Adjusting the snap point

The snap point is a marker within an audio event (or clip – see below). 
This is used as a reference position when you are moving events with 
snap activated, so that the snap point is “magnetic” to whatever snap 
positions you have selected. 

By default, the snap point is set at the beginning of the audio event, 
but often it is useful to move the snap point to a “relevant” position in 
the event, such as a downbeat, etc.: 

1. Activate the “Audio Event” option so that the event is displayed in the 
editor.

2. Scroll so that the event is visible, and locate the “S” flag in the event.
If you haven’t adjusted this previously, it will be located at the beginning of the event.
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3. Click on the “S” flag and drag it to the desired position.
When you drag the snap point, a tool tip shows its current position (in the position for-
mat selected on the Sample Editor ruler.

• If the Scrub tool is selected when you move the snap point, you will 
hear the audio while dragging (just like when scrubbing).
This makes it easier to find the correct position.

You can also adjust the snap point by setting the project cursor:

1. Place the cursor at the desired position (intersecting the event).
You may want to do this by scrubbing, to spot the right position exactly.

2. Pull down the Audio menu and select “Snap Point To Cursor”.
The snap point will be set to the position of the cursor. This method can also be used 
in the Project window and the Audio Part Editor.

• It is also possible to define a snap point for a clip (for which there is no 
event yet).
To open a clip in the Sample Editor, double click it in the Pool (or drag it from the Pool 
to the Sample Editor). After having set the snap point using the procedure described 
above, you can insert the clip into the project from the Pool or the Sample Editor, tak-
ing the snap point position into account.
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Making selections

To select an audio section in the Sample Editor, you click and drag 
with the Range Selection tool.

• If Snap to Zero Crossing is activated on the toolbar, the start and end 
of the selection will always be at zero crossings (see page 419).

• You can resize the selection by dragging its left and right edge or by 
[Shift]-clicking.

• The current selection is indicated to the right on the toolbar.
You can fine-tune the selection by changing these values numerically. Note that the 
values are relative to the start of the clip, rather than to the project timeline.

Using the Select submenu

The Select submenu on the Edit menu contains the following selec-
tion functions:

Function Description

All Selects the whole clip.

None Selects no audio (the selection length is set to “0”).

In Loop Selects all audio between the left and right locator.

From Start to Cursor Selects all audio between the clip start and the project cursor.

A selected range



NUENDO
The Sample Editor 16 – 411

Editing selection ranges

Selections in the Sample Editor can be manipulated in several ways. 
Please note:

• If you attempt to edit an event that is a shared copy (i.e. the event re-
fers to a clip that is used by other events in the project), you are asked 
whether you want to create a new version of the clip or not (if you ha-
ven’t made a “permanent” choice already – see below).
Select “New Version” if you want the editing to affect the selected event only. Select 
“Continue” if you want the editing to affect all shared copies. 
Note: If you activate the option “Do not show this message again” in the dialog, any 
and all further editing you do will conform to the selected method (“Continue” or “New 
Version”). You can change this setting at any time with the “On Processing Shared 
Clips” pop-up menu in the Preferences dialog (Editing – Audio page).

• Any changes to the clip will appear in the Offline Process History, 
making it possible to undo them at a later point (see page 386).

Cut, Copy and Paste

The Cut, Copy and Paste commands on the Edit menu work accord-
ing to the following rules:

• Selecting Copy copies the selection to the clipboard.

From Cursor to End Selects all audio between the project cursor and the end of the 
clip. For this to work, the project cursor must be within the clip 
boundaries.

Select Event Selects the audio that is included in the edited event only. This is 
not available if you opened the Sample Editor from the Pool (in 
which case the whole clip is opened for editing, not an event).

Left Selection Side 
to Cursor

Moves the left side of the current selection range to the project 
cursor position. For this to work, the cursor must be within the 
clip boundaries.

Right Selection Side 
to Cursor

Moves the right side of the current selection range to the project 
cursor position (or the end of the clip, if the cursor is to the right 
of the clip).

Function Description



NUENDO
16 – 412 The Sample Editor

• Selecting Cut removes the selection from the clip and moves it to the 
clipboard.
The section to the right of the selection is moved to the left to fill out the gap.

• Selecting Paste copies the data on the clipboard into the clip.
If there is a selection in the editor, this will be replaced by the pasted data. If there is no 
selection (if the selection length is “0”), the pasted data will be inserted starting at the 
selection line. The section to the right of the line will be moved to make room for the 
pasted material.

The pasted data will be inserted at the selection line.

Insert Silence

Selecting “Insert Silence” from the Range submenu on the Edit menu 
will insert a silent section with the same length as the current selec-
tion, at the selection start. 

• The selection will not be replaced, but moved to the right to make 
room. 
If you want to replace the selection, use the “Silence” function instead (see page 379).

Delete

Selecting Delete from the Edit menu (or pressing [Backspace]) re-
moves the selection from the clip. The section to the right of the se-
lection is moved to the left to fill out the gap.
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Processing

The functions on the Process submenu on the Audio menu can be 
applied to selections in the Sample Editor, as can the effects on the 
Plug-ins submenu. See the chapter “Audio processing and functions”.

Creating a new event from the selection

You can create a new event that plays only the selected range, using 
the following method:

1. Make a selection range.

2. Press [Ctrl]/[Command] and drag the selection range to the desired 
audio track in the Project window.

Creating a new clip or audio file from the selection

You can extract a selection from an event and either create a new clip 
or a new audio file, in the following way:

1. Make a selection range.

2. Select “Bounce Selection” from the Audio menu.

A new clip is created and added to the Pool, and another Sample Ed-
itor window will open with the new clip. The new clip will refer to the 
same audio file as the original clip, but will only contain the audio cor-
responding to the selection range.

• You can also use the Bounce Selection function to create new audio 
files on disk from regions in the Pool – see page 494.
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Working with regions

Regions are sections within a clip. One of the main uses for regions is 
Cycle recording, in which the different “takes” are stored as regions 
(see page 66). You can also use this feature for marking important 
sections in the audio clip. Regions can be dragged into the Project 
window from the Editor or the Pool, to create new audio events. You 
can also export a region to disk as a new audio file, from the Pool.

Regions are best created, edited and managed in the Sample Editor:

Creating a region

1. Select the range you want to convert to a region.

2. Click the “Show Regions” icon on the toolbar, or activate the “Re-
gions” option on the Elements submenu on the Quick menu.
The regions list is displayed to the right in the Sample Editor window.

3. Click the Add region button above the Regions list (or select “Create 
Region(s)” from the Audio menu).
A region is created, corresponding to the selected range.

4. To name the region, click on it in the list and type in a new name.
Regions can be renamed at any time, using this procedure.

• When a region is selected in the Regions list, it is instantly displayed 
and selected in the Sample Editor.
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Editing regions

The region selected in the list is displayed in grey in the waveform dis-
play and thumbnail.

There are two ways to edit the start and end position of a region:

• Click and drag its start and end handles in the waveform display (with 
any tool).
When you move the pointer over the handles, it will automatically change to an arrow 
pointer, to indicate that you can drag the handles.

• Edit the Start and End positions numerically in the Regions list.
The positions are shown in the display format selected for the ruler and info line, but 
are relative to the start of the audio clip, rather than the project timeline.

Auditioning regions

You can listen to a region by selecting it in the list and clicking the 
Play Region button (above the list). The region will play back once or 
repeatedly, depending on whether the Loop icon on the toolbar is ac-
tivated or not.
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Making selections from regions

If you select a region in the list and click the Select Region button 
above, the corresponding section of the audio clip is selected (as if 
you had selected it with the Range Selection tool). This is useful if you 
want to apply processing to the region only, etc.

• Note that you can also double click a region in the Pool, to have its au-
dio clip open in the Sample Editor with the area of the region automat-
ically selected.

Creating new events from regions

You can create new audio events from regions, using the following 
method:

1. Click in the Region’s leftmost column in the list and keep the mouse 
button pressed.

2. Move the pointer to the desired audio track and position in the Project 
window.

3. Release the mouse button.
A new event is created.

• You can also use the function “Events from Regions” for this (see page 
151).

Removing regions

To remove a region from a clip, select it in the list and click the Re-
move Region button above the list.

Exporting regions as audio files

If you create a region in the Sample Editor, the region can be exported 
to disk as a new audio file. This is done from the Pool, and is described 
on page 494.
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Drawing in the Sample Editor

It is possible to edit the audio clip at sample level, by drawing with the 
Pencil tool. This can be useful if you need to manually edit out a spike 
or click, etc.

1. Zoom in to a zoom value lower than 1.
This means that there is more than one screen pixel per sample.

2. Select the Pencil tool.

3. Click and draw at the desired position in the waveform display.
When you release the mouse button, the edited section is automatically selected.

Any changes created by drawing will appear in the Offline Process His-
tory, making it possible to undo them at a later stage (see page 386).
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Options and settings

Show audio event

This is only available if you opened the Sample Editor by double clicking 
on an audio event in the Project window or the Audio Part Editor.

When the option “Audio Event” is activated on the Elements submenu 
on the Quick menu (or the Show Audio Event button is activated on 
the toolbar), the section corresponding to the edited event is shown 
with a white background in the waveform display and Thumbnail. The 
sections of the audio clip that are “outside” the event are shown with 
a grey background.

• In this mode, you can adjust the start and end of the event in the clip, 
by dragging the event handles in the waveform display.
When you move the pointer over the event handles (no matter what tool may be se-
lected), it takes on the shape of an arrow, to indicate that you can click and drag.
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Snap to Zero Crossing

Snap to Zero Crossing activated.

When this option is activated, all audio edits are done at zero cross-
ings (positions in the audio where the amplitude is zero). This helps 
you avoid pops and clicks which might otherwise be caused by sud-
den amplitude changes.

• This setting affects the Sample Editor only. In the Project window and 
other editors, the Snap to Zero Crossing setting in the Preferences 
dialog (Editing–Audio page) is used.

Autoscroll

Autoscroll activated.

When this option is activated, the waveform display will scroll during 
playback, keeping the project cursor visible in the editor.
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Background

The Audio Part Editor allows you to view and edit the events inside 
audio parts. Essentially, this is the same type of editing that you do in 
the Project window, which means that this chapter contains a lot of 
references to the chapter “The Project window”.

Audio parts are created in the Project window, in one of the following 
ways:

• By selecting one or several audio events on the same track, and se-
lecting “Events to Part” from the Audio menu.

• By gluing together two or more audio events on the same track with 
the Glue Tube tool.

• By drawing an empty part with the Pencil tool.

• By double clicking between the left and right locator on an audio 
track.
With the last two methods, an empty part is created. You can then add events to the 
part by pasting, or by using drag and drop from the Pool.

Opening the Audio Part Editor

You open the Audio Part Editor by selecting one or more audio part(s) 
in the Project window and double clicking on any one of them (or us-
ing the Edit-Open key command, by default [Ctrl]/[Command]-[E]). 
The Audio Part Editor can display several parts at once, and you can 
also have more than one Audio Part Editor open at the same time.

• Note that double clicking on an audio event in the Project window will 
open the Sample Editor (see page 400).
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Window overview

The toolbar

The tools, settings and icons on the toolbar have the same functional-
ity as in the Project window, with the following differences:

• A Solo button (see page 426).
• Separate tools for audition (Speaker) and scrubbing (see page 427).
• No Line, Glue Tube or Color tool.
• Play and Loop icons and an Audition Volume control (see page 426).
• Independent Track Loop settings (see page 427).
• Part List controls for handling several parts: Activating parts for editing, re-

stricting editing to active parts only and showing part borders (see page 428).

• You can customize the toolbar, hiding or reordering its items.
This is described on page 678.

The ruler and info line

These have the same functionality and appearance as their counter-
parts in the Project window.

• Note that you can select a separate display format for the Audio Part 
Editor ruler by clicking on the arrow button on the right and selecting 
an option from the pop-up menu that appears.
For a list of the available formats, see page 108.
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About lanes

If you make the editor window larger, this will reveal additional space 
below the edited events. This is because an audio part is divided ver-
tically in lanes. 

Lanes can make it easier to work with several audio events in a part:

In the left figure it is unnecessarily hard to discern, select and edit the 
separate events. In the right figure, some of the events have been 
moved to a lower lane, making selection and editing much easier.

• To move an event to another lane without accidentally moving it hori-
zontally, press [Ctrl]/[Command] and drag it up or down.
This is the default modifier key for this – you can adjust this in the Preferences if you 
like.

Lanes
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Overlapping events

Only one event per track can be played back at the same time! This 
means that if you have overlapping events, on the same lane or differ-
ent lanes, these will cut each other off, according to the following 
rules:

• For events on the same lane, the ones that are on top (visible) will be 
played.
To move overlapping events to the front or back, use the Move to Front and Move to 
Back functions on the Edit menu.

• For events on different lanes, the event on the lowest lane gets play-
back priority.

The “overlapping” sections of the upper event will not be played since the event on 
the lower lane has playback priority.
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Operations

Zooming, selecting and editing in the Audio Part Editor is done just as in 
the Project window (see page 111).

• Note that if a part is a shared copy (i.e. you have previously copied the 
part by [Alt]/[Option]+[Shift]-dragging), any editing you perform will 
affect all shared copies of this part.
To indicate that it is a shared copy, a symbol is displayed in the right corner of the part 
in the Project window (see page 133).

Auditioning

There are three ways to listen to the events in the Audio Part Editor:

By using the Speaker tool

If you click somewhere in the editor’s event display with the Speaker 
tool and keep the mouse button pressed, the part will be played back 
from the position at which you clicked. Playback will continue until you 
release the mouse button.

By using the Audition icon

The Audition and Audition Loop icons.

Clicking the Audition icon on the toolbar plays back the edited audio, 
according to the following rules:

• If you have selected events in the part, only the section between the first and 
last selected event will be played back.

• If you have made a range selection, only this section will be played back.
• If there is no selection, the whole part will be played back. If the project cursor 

is within the part, playback starts from the current cursor position. If the cursor 
is outside the part, playback starts from the beginning of the part.

• If the Audition Loop icon is activated, playback will continue until you deacti-
vate the Audition icon. Otherwise, the section will be played back once.

• When auditioning with the Speaker tool or Audition icon, audio will be routed 
directly to the Audition bus.
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By using regular playback

You can of course use the regular playback controls while in the Au-
dio Part Editor. Furthermore, if you activate the Solo Editor button on 
the toolbar, only the events in the edited part will be played back.

The independent track loop function

The independent track loop is a sort of “mini-cycle”, affecting only the 
edited part. When the loop is activated, the events in the parts that are 
within the loop will be repeated continuously and completely indepen-
dent – other events (on other tracks) are played back as usual. The 
only “interaction” between the loop and the “regular playback” is that 
every time the cycle starts over again, so does the loop.

To set up the independent track loop, proceed as follows:

1. Turn on the loop by clicking on the Loop button on the toolbar.
If it isn’t visible, you need to right-click (Windows) or [Ctrl]-click (Mac) the toolbar and 
add the Independent Track Loop Settings section – see page 678.

When the loop is activated, the cycle isn’t shown in the editor’s ruler. 
Now you need to specify the length of the loop:

2. Either [Ctrl]/[Command]-click and [Alt]/[Option]-click in the ruler to 
set the start and end of the loop, respectively…

3. …or edit the loop start and end positions numerically in the fields next 
to the Loop button.

The loop is indicated in purple in the ruler.

• The events will be looped as long as the Loop button is activated and 
the Audio Part Editor window is open.

Scrubbing

In the Audio Part Editor, the Scrub tool has a separate icon on the 
toolbar. Apart from that, scrubbing works exactly as in the Project win-
dow (see page 129).
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Handling several parts

When you open the Audio Part Editor with several parts selected – all 
on the same track or on different tracks – they might not all “fit” in the 
editor window, which can make it hard to get an overview of the differ-
ent parts when editing.

Because of this, the toolbar features a few functions to make working 
with multiple parts easier and more comprehensive:

• The Part List menu lists all parts that were selected when you opened 
the editor, and lets you select which part should be active for editing.
When you select a part from the list, it is automatically made active and centered in the 
display.

• Note that it is also possible to activate a part by clicking on it with the 
Arrow tool.

• The button “Edit Active Part Only”, lets you restrict editing operations 
to the active part only.
If you for example select “All” from the Select submenu on the Edit menu with this op-
tion activated, all events in the active part will be selected but not the events in other 
parts.

“Edit Active Part Only” activated on the toolbar.

• You can zoom in on an active part so that it fills the screen by select-
ing “Zoom to Event” from the Zoom submenu on the Edit menu.
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• The button “Show Part Borders” can be used if you want to see 
clearly defined borders for the active part.
When this is activated, all parts except the active one are grayed out, making the bor-
ders easily discernible. There are also two “markers” in the ruler with the name of the 
active part, marking its beginning and end. These can be moved freely to change the 
part borders.

“Show Part Borders” activated on the toolbar.

• It is possible to cycle between parts, making them active, with key 
commands.
In the Key Commands dialog – Edit category, there are two functions: “Activate Next 
Part” and “Activate Previous Part”. If you assign key commands to these, you can use 
them to cycle between parts. Please refer to page 699 for instructions on how to set 
up key commands.
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Common methods

Assembling a “perfect take”

When you record audio in Cycle mode, either an event or a region (or 
both) is created for each recorded lap (see page 66). These events 
and regions are named “Take X”, where “X” is the number of the take. 
You can create a perfect take by putting together sections of the dif-
ferent takes in the Audio Part Editor.

• The procedure below will not work if you recorded with “Keep Last” 
mode selected on the Transport panel.
In that case, only the last take will be kept on the track (although the previous takes will 
be available as regions in the Pool)

First, you have to create an audio part from the takes. This procedure 
is slightly different depending on whether you choose to create events 
or regions.

Creating an audio part from events

1. In the Project window, use the Object Selection tool to draw a rectan-
gle around the recorded events.
This is necessary, since clicking on the event may just select the event on top (the last 
take). If in doubt, check the info line – the info text should be yellow.

2. Pull down the Audio menu and select “Events to Part”.
The events are converted to an audio part.

• Note that the events cycle record mode also makes it easy to combine 
different takes in the Project window – see page 67.

Creating an audio part from regions

1. In the Project window, select the event you recorded in Cycle mode.
After recording, this will play the last take.

2. Pull down the Audio menu and select “Events to Part”.
You are asked whether you want to “Create Part using Regions”.

3. Click “Regions”.
The regions are converted to an audio part.
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Assembling a take

1. Double click the part to open the Audio Part Editor.
Now, the different takes will be placed on different lanes, with the last take at the bottom.

2. Use the tools to cut out pieces of the takes and assemble the final 
result.
This can include splitting with the Scissors tool, resizing events with the Arrow tool or 
deleting with the Eraser tool. 

• Remember that the events on the lowest lane have playback priority. 
Use the Audition icon to audition the result.

3. Close the Audio Part Editor.
You have now assembled a “perfect take”!
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Options and Settings

The following options and settings are available in the Audio Part Editor:

• Snap
You can specify an independent Snap mode (and snap value for the Grid mode) in the 
editor. The functionality is exactly the same as in the Project window.

• Autoscroll
When Autoscroll is activated on the toolbar, the window will scroll during playback, 
keeping the project cursor visible in the editor. This setting can be activated or deacti-
vated individually for each window.
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Background

Audio warp is the generic name for the realtime time stretching and 
pitch shifting functions in Nuendo. The main audio warp features are 
as follows:

• Tempo match any audio loop to the project tempo – see page 435.
• Match up an audio clip with fluctuating tempo to a fixed tempo – see page 442.
• Pitch shift any number of audio clips in realtime – see page 451. 
• Quantize audio – see page 449.
• Freeze the realtime processing to optimize the audio sound quality and lessen 

the CPU load – see page 452.

Hitpoints and Audio warp features

Hitpoints are also used for some of the realtime processing features. 
When you use hitpoints for this purpose, you should not create audio 
slices. Instead hitpoints are used to create warp tabs, which can, 
amongst other things, be used to quantize audio - see page 449. In 
the “Working with hitpoints and slices” chapter, the focus is placed on 
using hitpoints for slicing audio. However, all the basic operations for 
creating and editing hitpoints are the same, apart from creating audio 
slices.

About Musical mode

Musical mode is one of the key audio warp features. It allows you to 
lock audio clips to the project tempo by using realtime time stretching. 

Before you can activate Musical mode you have to specify a length or 
tempo for an audio file or loop using the Audio Tempo Definition tool – 
see page 435. In Musical mode, audio events will adapt to any tempo 
changes in Nuendo, just like MIDI events.

About ACID® loops

Nuendo supports ACID® loops. These loops are standard audio files 
but with embedded tempo/length information. When ACID® files are 
imported into Nuendo, Musical mode is automatically activated and 
the loops will adapt to the tempo set in the project.
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Using the Audio Tempo Definition tool

The Audio Tempo Definition tool can be found in the Sample Editor, 
where most audio warp related editing takes place. 

When this tool is selected, you can set the tempo, length (in bars and 
beats) and time signature for an audio file. Once these parameters have 
been set correctly, you can activate Musical mode and the audio file will 
sync to the project tempo in Nuendo by using realtime time stretching. 
The Audio Tempo Definition tool is also used when calculating hitpoints. 

It can basically be used in the following ways:

• To determine the tempo of an audio loop.
This is virtually an automatic process – simply enter the length of the loop and the cor-
rect tempo will be calculated, see below. 

• To determine the tempo of an audio clip.
In case you have an audio clip with an unknown length and tempo you can calculate 
the tempo by defining the length of one bar, see page 438.

Determining the tempo of an audio loop and activating 
Musical mode

Files that already contain tempo information (i.e. ACID® files – see page 
434) will automatically have Musical mode activated when imported, and 
the below steps are not necessary.

To determine the tempo of an audio file with an unknown source tempo 
and length, see page 438.

You can adapt the tempo of an audio loop, i.e. an audio clip of a given 
musical length, to the project tempo in Nuendo. Once Musical mode 
has been set, the loop will follow any tempo variations in realtime.

The first step is to import a loop. This could be any loop, just as long 
as it meets the basic criteria, e.g. a loop that is exactly 2 or 4 bars long 
at a given tempo (if you don’t know the tempo it doesn’t matter).

1. Import a suitable loop, for example a drum loop.

2. Double-click the loop in the Project window to open the Sample Editor.
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On the toolbar you can find three numerical edit fields for setting the 
time signature, audio tempo and bars & beats. You can only edit these 
values when the Audio Tempo Definition tool is selected.

The signature, audio tempo and tempo fields in the Sample Editor.

3. Select the Audio Tempo Definition tool (the button with a note symbol 
between arrows).
A grid appears in the waveform display, and the ruler resolution is automatically set to 
Bars and Beats.

The Audio Tempo Definition tool.

A suggested bar length and tempo is set automatically, based on the 
length of the loop. You will get the best results with short loops (1 or 
2 bars) that are cut precisely. 

But if the project tempo and loop tempo differ a lot, or if the loop should 
have a time signature other than 4/4, the calculated settings will be in-
correct. 

If so, simply determine how many bars the loop is (and/or what time 
signature it is in) by listening (most loops are typically 1 to 4 bars long 
and in 4/4 time). 

4. Enter the correct number of bars in the Bars field (and if necessary the 
time signature in the Signature field).

• Alternatively, should you know the tempo (the tempo is often part of 
the loop name, e.g. “SloGroove_105bpm”) but not the length, you can 
enter the tempo to calculate the correct loop length.

Once you have set the correct tempo and length you are ready to ac-
tivate Musical mode for the loop.
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5. Click the Musical mode button (the note button to the right of the Bars 
and Beats field) so that it lights up.

The Musical mode button.

Now the loop is automatically stretched. To the far right on the Sample 
Editor toolbar you can find a warp setting pop-up and a warp icon. The 
warp icon is lit up if the audio clip is stretched. 

On the “warp setting” pop-up you can find various warp options that 
govern the audio quality of the realtime time stretching. There are pre-
sets for common types of audio material, and an Advanced option 
where you can manually set warp parameters. See page 448 for a de-
scription of the warp setting parameters.

6. Select the warp setting preset that best corresponds to the audio 
loop material and close the Sample Editor.

7. Activate playback.

Now the loop will automatically adjust to the project tempo, and follow 
any further tempo changes you make! In the Project window, the audio 
event will have a note symbol and two arrows in the lower right corner. 
The note symbol indicates Musical mode and the arrow indicates that 
the file is stretched.
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Activating Musical mode in the Pool

It is also possible to activate/deactivate Musical mode from the Pool. 
When you have correctly set a tempo or length for an audio clip, this in-
formation is saved with the project. This allows you to import files into 
the project with Musical mode already activated. If you import a new file 
into the Pool, or if a clip in the pool has not had tempo or length set us-
ing the Audio Tempo Definition tool, the tempo is unknown. If you try to 
activate Musical mode in the Pool for such files, a dialog appears where 
you have to enter the tempo before Musical mode is activated.

Determining the tempo of an audio clip

You can also use the Audio Tempo Definition tool to determine the 
tempo of an audio clip with an unknown length and source tempo. 

For this to work properly the audio clip must have a steady tempo that 
doesn’t vary over time. 

After importing the audio file, the first thing you should do is to make 
sure that, with the Audio Tempo Definition tool selected, the first down-
beat of the audio clip is aligned with the first beat of the first bar in the 
Sample Editor:

1. Import the audio file.

2. Double-click the audio event to open the Sample Editor.

3. Select the Audio Tempo Definition tool.

When the Audio Tempo Definition tool is selected the Sample Editor 
ruler does not reflect the audio event position in the Project window, 
but instead displays the length of the audio file in bars and beats. 

In case the audio file starts with a downbeat there is no problem. But 
in case it doesn’t, you can offset the ruler in the Sample Editor.

4. Audition the file to determine where the first downbeat occurs.
Stop the auditioning when you have located it.
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5. Move the mouse pointer to the upper part of the ruler until the pointer 
changes to a hand symbol.

6. Click and drag the ruler to the right until the first bar in the ruler 
matches the first downbeat in the sample.

7. Release the mouse button.
Now the ruler grid is offset so that it starts on the first downbeat in the sample.

8. Audition the file to determine where the next downbeat occurs, i.e. the 
first beat of the second bar in the sample.
Stop the auditioning when you have located it.
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9. In this example the second downbeat in the sample is located at the 
start of the second beat of the second bar (at the cursor position in 
the picture).

10.Place the mouse pointer at the start of bar 2 in the waveform display.
The pointer changes to a metronome icon with a blue line indicating the pointer posi-
tion. The pointer will snap to the grid positions.
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11.Click and drag the grid to the right until the second bar in the ruler is 
aligned with the position of the second downbeat of the sample, and 
release the mouse button.
The correct tempo is automatically calculated, based on the time it takes for one bar to 
finish.

12.Now you can enter Musical mode, and the audio clip will adapt to the 
tempo in Nuendo.
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Warp tabs and the Warp Samples tool

Warp tabs are a kind of marker or anchor that can be attached to mu-
sically relevant time positions in an audio event, e.g. the first beat of 
every bar. Warp tabs can be dragged to the corresponding time posi-
tions in the project, and the audio will be stretched accordingly. 

A typical application of warp tabs is to make an audio file with a vary-
ing tempo lock to a strict tempo. Using this method, any performance 
recorded “live” with natural tempo variations can be adapted to a spe-
cific, exact tempo. 

Using warp tabs

Warp tabs are created using the Warp Samples tool in the Sample Ed-
itor, but can also be created from hitpoints (see page 448) or by using 
Quantize Audio (see page 449). In this example we will demonstrate 
how a file with a slightly varying tempo can be locked to a steady tempo 
by using warp tabs.

1. Open an audio file you wish to process in the Sample Editor.

2. Select the Audio Tempo Definition tool and enter the original tempo 
(if this is non-varying) or the length of the file.

3. Enter Musical mode so that the audio event is stretched to the project 
tempo.
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4. Select the Warp Samples tool (the arrow and clock button) on the 
Sample Editor toolbar.
A grid appears in the waveform display, and warp tabs are automatically added at the 
start and end of the audio clip. These are locked and cannot be removed. 

The Warp Samples tool.

For aligning the tempo you should use Bars and Beats as the ruler 
resolution. When you place the mouse pointer in the waveform display 
it changes to a clock with arrows on either side, and a vertical line in 
the middle which represents the pointer. When you move the pointer 
in the waveform window it shows the position in bars, beats and ticks 
as well as in seconds.

5. Line up the audio file so that the first beat of the first bar (in the audio 
event) starts on the first beat of a bar in the project.
If the audio file doesn’t start on a downbeat you can use the Event Start handle in the 
Sample Editor and adjust the position in the Project window so that the first downbeat 
in the sample is aligned with the first beat of a bar in the grid.

Now the musical first downbeat should be aligned with the first beat of a bar in the 
project. The next step is to see where the first warp tab needs to be added. It may be 
useful to hear the metronome click to determine when the tempo of the audio clip drifts 
from the project tempo. To hear the metronome you have to activate Click on the 
Transport panel and play back using the transport controls.

6. Play back the audio file, either by auditioning in the Sample Editor or 
from the Transport panel, and see (and listen for) where the first beat 
of a bar in the audio event does not match the corresponding ruler po-
sition in the project.
If you find it difficult to pinpoint an exact position in the audio event you can switch to 
the Scrub tool and/or zoom in the view. Switch back to the Warp Samples tool when 
you have found the position.
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7. In our example the first beat of bar 3 in the audio event is slightly offset 
from the corresponding grid position and thus needs to be moved 
back a bit.

The arrow points to the third downbeat in the audio event.

8. Place the pointer at the position of the first beat in the audio event and 
click and hold.
When you click a warp tab is added.

9. With the mouse button still pressed, drag the warp tab so that the po-
sition lines up with the first beat of the bar in the ruler.
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10.Release the mouse button.
Now the first beat in the audio event is perfectly aligned with the corresponding posi-
tion in the project! 

• If you prefer, you can first add warp tabs at the relevant musical posi-
tions and change their positions later – see page 446.

Beside the warp tab handle in the ruler, a number is shown. This num-
ber indicates the warp factor, i.e. the amount of stretch. Warp factor 
numbers higher than 1.0 indicate that the audio region preceding the 
warp tab is expanded and will play back slower. Warp factor numbers 
lower than 1.0 indicate that the audio region preceding the warp tab 
is compressed and will play back faster. 

11.Continue to use the same general method to align the first beat in 
each bar to the corresponding ruler position.
You only have to add warp tabs where the downbeat in the audio file drifts from the 
ruler position, and/or if you want to fixate a warp tab so that it is not moved when edit-
ing other points. 

When you are done, the previously varying tempo of the audio event 
will be metronome steady and will adapt to any tempo in Nuendo.

This example illustrates the general methods of using warp tabs and 
the Warp Samples tool. But you can of course use warp tabs for other 
operations than aligning downbeats to grid positions. With the Warp 
Samples tool you can literally stretch any region within a sample to 
any position!
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Editing warp tabs

Moving the destination position of existing warp tabs

• To move an anchored destination position of a warp tab (and thus 
stretch the audio), select the Warp Samples tool and position the 
pointer on the Warp line in the waveform so that the line in the middle 
of the pointer becomes blue. Then click and hold to move the position 
of the warp tab. 

Moving the source position of existing warp tabs

• If you simply wish to move the position of a warp tab without stretch-
ing the audio, click and drag the warp tab header in the ruler.

Deleting warp tabs

• To delete a warp tab, press [Shift] so that the pointer becomes an 
eraser and click on the warp tab.
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Unstretching audio files

By selecting “Unstretch Audio” from the Realtime Processing sub-
menu on the Audio menu, all time stretching (by sizing or by warp 
tabs) can be removed.

Whether the “Unstretch Audio” menu item is available depends on 
whether the time stretching was applied on the event or clip level: 

• If you sized an audio event in the Project window using the “Sizing 
Applies Time Stretch” tool (see page 138), you can undo the time 
stretching by selecting the event in the Project window and then ap-
plying “Unstretch Audio”.
This will remove all time stretching and warp tabs.

• If you added warp tabs to a clip in the Sample Editor, you have to 
open the audio file in the Sample Editor to be able to invoke the 
“Unstretch Audio” function. 
Selecting “Unstretch Audio” will then remove all warp tabs in the clip, but not any time 
stretching applied in the Project window (on the event level).

• Note that if Musical Mode is activated, realtime stretching is still active. 
When you have entered a tempo and/or length using the Audio Tempo 
Definition tool, this information is saved for the source clip.

Showing/hiding warp tabs

When you are using other Sample Editor tools than the Warp Samples 
tool you can decide whether to show or hide warp tabs by clicking the 
Show Warp Tab button.
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Warp settings

The “warp settings” pop-up menu, which is located on the Sample 
Editor toolbar, contains various presets affecting the realtime time 
stretching sound quality. These presets have self-explanatory names 
like “Drums” and “Mix”, where the parameters involved have been 
optimized for the corresponding type of audio material. 

Advanced settings

If you select the Advanced menu item, a dialog opens where you can 
manually change the three parameters that govern the sound quality 
of the time stretching:

Creating warp tabs from hitpoints

You can also create warp tabs from hitpoints selecting “Create Warp 
Tabs from Hitpoints” on the Audio menu – Realtime Processing sub-
menu. This can be useful when applying Audio Quantize, see below.

For descriptions of how hitpoints are created and edited please refer 
to the chapter “Working with hitpoints and slices”.

Parameter Description

Grainsize The realtime time stretching algorithm splits the audio into small pieces 
called “grains”. This parameter determines the size of the grains. For 
material with a lot of transients you should use low Grainsize values for 
best results. 

Overlap Overlap is the percentage of the whole grain that will overlap with 
other grains.

Variance Variance is also a percentage of the whole length of the grains, and 
sets a variation in positioning so that the overlapping area will sound 
smooth. A Variance setting of 0 will produce a sound akin to time 
stretching used in early samplers, whereas higher settings will pro-
duce more “smearing” effects but less audio artefacts.
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Quantizing audio

You can use realtime time stretch to quantize audio. This is achieved 
by using hitpoint detection and adding warp tabs at the positions of 
each detected transient in the audio clip. When you apply audio quan-
tize the warp tabs stretch the detected “hits” to the grid positions the 
selected quantize-grid is set to. Warp tabs that are not quantized will 
be removed.

The quantizing can either be applied by automatically creating warp 
tabs at the position of existing hitpoints, or you can first create hitpoints, 
then create warp tabs from these before finally applying the quantizing.

For descriptions of how hitpoints are created and edited please refer 
to the chapter “Working with hitpoints and slices”.

In the following description we shall apply Quantize Audio after first 
creating hitpoints, and then creating warp tabs from these. 

1. Open the audio clip in the Sample Editor, specify the length or tempo 
with the Audio Tempo Definition tool selected, and activate Musical 
mode.

2. Calculate hitpoints in the audio event using the normal methods, but 
don’t create slices.
Note that if Q points are used (see page 466), the quantizing will be applied to the po-
sition of the Q point. Also note that when creating hitpoints for audio quantizing – as 
opposed to for creating audio slices – it is not necessary to have hitpoints at all “hits” 
in the sample. You might just want to quantize a section of an audio clip, and leave the 
rest unprocessed. 

3. When you have finished setting hitpoints, select “Create Warp Tabs 
from Hitpoints” from the Audio menu - Realtime Processing submenu.

4. Close the Sample Editor and select the audio event in the Project 
window.



NUENDO
18 – 450 Audio warp realtime processing

5. Select a quantize resolution from the Quantize Type pop-up, e.g. 1/8.

Here is a section of the sample before applying Quantize Audio. The hitpoints are 
not on exact grid positions.

6. Select “Quantize Audio” from the Audio menu – Realtime Processing 
submenu.
Now the audio event is quantized by applying time stretch.

7. Open the audio event in the Sample Editor, and either select the Warp 
Samples tool or activate the “Show Warp Tabs” button on the toolbar.
Warp tabs have automatically been added at the hitpoint positions needed to quantize 
the audio to the set resolution.

Here is the same audio event after applying Quantize Audio with a 1/8 quantize 
resolution. The hitpoints are now quantized (or stretched) to exact grid positions.

• To remove the quantizing from an audio clip, select “Unstretch Audio” 
from the Realtime Processing submenu on the Audio menu. 
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Quantizing without hitpoints

It is also possible to apply Quantize Audio without creating hitpoints 
first. Although this method is quicker, it is in most cases better to cal-
culate hitpoints using the normal method, as this gives you more con-
trol over where the warp tabs will end up. 

• If you apply Quantize Audio to a selected audio event after just having 
set the length or tempo, the whole event will be quantized. 
Hitpoints are detected automatically, using the current settings set up in the Hitpoints 
Detection dialog. Warp tabs – not hitpoints – are created at each “hitpoint” found dur-
ing the process.

Realtime pitch shifting of audio events

Audio events can be pitch shifted in real time just like MIDI events. 

The process is very simple:

1. Select one or several audio events in the Project window.
Audio parts can not be transposed.

2. Open the event info line.

3. Set a value in the Transpose field to the far right on the info line.
The value range is up/down two octaves in semitone steps. 

4. Press [Enter].
All selected audio events are now transposed to the set value using pitch shift. The 
same general rules apply as for other event editing on the info line, see page 106.

• You can also fine tune selected audio events in cent (100th of a semi-
tone) steps by entering a value in the Finetune field to the right.

Audio and MIDI events can not be transposed simultaneously.
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Freezing the realtime processing

You can “freeze” any realtime processing at any time. This can be done 
to serve two purposes; to conserve CPU power, and to optimize the 
sound quality of the processing. 

• Select the audio event(s) that you wish to process and select “Freeze 
Timestretch and Transpose” from the Audio menu - Realtime Process-
ing submenu.
You should also use this function before applying any offline processing. When the 
freeze processing is applied, a copy of the original file is automatically created in the 
audio Pool so that the original audio clip remains intact.

Selecting an algorithm for the freeze

When you freeze the realtime processing you can use the MPEX 2 al-
gorithm to process the audio, which may produce better sound quality 
than the realtime processing. Proceed as follows:

1. Select the audio event(s) that you wish to process.

2. Select “Freeze Timestretch and Transpose” from the Audio menu – 
Realtime Processing submenu.

A dialog appears where you can select an algorithm for the processing. 
You can either select the MPEX 2 algorithm, which will produce the 
highest sound quality, or the Realtime algorithm which is much quicker 
but will not improve the audio quality of the processing (although it will 
lessen the CPU load). 
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3. Select an algorithm and click OK.
When the processing is finished, any loop that was previously stretched in realtime or 
had been pitch shifted will play back exactly the same, but Musical mode will be deac-
tivated and the realtime pitch shifting will be set to 0.

The audio clip is now like any standard audio clip before applying 
realtime processing, i.e. it will not follow tempo changes. The freeze 
processing is best used when you have determined the tempo or key 
of a project, but you can of course always adapt the audio to a new 
key or tempo should you change your mind. It is then best to revert 
back to the original audio clip rather than to process the already pro-
cessed file again.
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Background

Hitpoint detection is a special feature of the Sample Editor. It auto-
matically detects attack transients in an audio file, and then adds a 
type of marker, a “hitpoint”, at each transient. These hitpoints allow 
you to create “slices”, where each slice ideally represents each indi-
vidual sound or “beat” in a loop (drum or other rhythmic loops work 
best with this feature). When you have successfully sliced the audio 
file, you can do a number of useful things with it:

• Change the tempo without affecting pitch.
• Extract the timing (a groove map) from a drum loop. This can then be applied 

to quantize other events.
• Replace individual sounds in a drum loop.
• Edit the actual playing in the drum loop without affecting the basic feel.
• Extract sounds from loops.

• The term “loop” is used throughout this chapter. Loop in this context 
usually means an audio file with a musical timebase, i.e. the length of 
the loop represents a certain number of bars and/or beats at a certain 
tempo. Playing the loop back at the right tempo in a cycle set to the cor-
rect length will produce a continuous loop, without gaps.

Using hitpoints
The basic functionality of using hitpoints to slice up a loop is to make 
a loop fit the tempo of a song, or alternatively to create a situation that 
allows the song tempo to be changed whilst retaining the timing of a 
rhythmic audio loop, just like when using MIDI files. 

What audio files can be used?

Here are some guidelines to what type of audio files will render the 
best results when slicing files using hitpoints:

• Each individual sound in the loop should have some noticeable attack. 
Slow attacks, legato playing etc. may not produce the desired result.

• Poorly recorded audio might be difficult to slice correctly.
However, the hitpoint detection function can automatically normalize the audio to im-
prove the detection results – see below.

• There may be problems with sounds drowned in smearing effects, like short 
delays.
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Calculating hitpoints and slicing a loop – a quick tutorial

Before proceeding, find a suitable loop using the criteria above. At 
this point it doesn’t matter whether you know the original tempo of the 
loop, as this will be automatically detected. Proceed as follows:

1. Open the event or clip for editing in the Sample Editor.
You could do this by double clicking an event on an audio track in the Project window 
or a clip in the Pool. In this example, we assume you work with an event on a track.

2. Select the Audio Tempo Definition tool on the Sample Editor toolbar.

3. Enter the length and the time signature of the loop in the respective 
fields on the toolbar. The tempo is calculated automatically.

4. Click the Hitpoint Mode button on the toolbar.
Now the Sensitivity slider is added, and the Use menu is activated. The items on this 
pop-up don’t affect the actual detection but rather which hitpoints will be shown after-
wards. If you e.g. know that your loop is based on 1/16th notes, select “1/16”. If you’re 
uncertain, set this to “All” – you can change this setting afterwards if needed.

5. Select “Calculate Hitpoints” on the Audio menu – Hitpoints submenu.

Now a dialog appears with settings for the hitpoint detection. On the 
Presets pop-up you can choose a preset detection mode best suited 
to the audio material. Alternatively you can select “Advanced” where 
you can specify settings yourself. 

• The “Sense” parameter sets the sensitivity of the detection. 
The higher the setting the more transients will be detected.

• The “Threshold” parameter sets the level threshold.
The lower you set this the more low level transients will be detected.
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6. Click Process.
The hitpoints are detected.

As you now can see, hitpoints have been set at the beginning of each 
sound in the loop (or at least at most of them).

7. If you now move the hitpoint sensitivity slider to the left, this gradually 
hides the hitpoints. Moving the slider to the right increases the sensitiv-
ity to reveal additional hitpoints detected during the calculate process.
The basic aim is to add, remove or in various other ways edit the hitpoints so that one 
individual sound is played between each hitpoint. This is described in detail starting on 
page 460.

In the next step, the loop will adapt to the project tempo set in Nuendo.

8. Pull down the Audio menu, and select “Create Audio Slices from Hit-
points” from the Hitpoints submenu.
Now the following happens:

• The Sample Editor closes.
• The audio event is “sliced” so that there is a separate event for each hitpoint. 
• The audio event is replaced by an audio part, containing the slices (double 

click the part to view the slices in the Audio Part Editor).
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• The loop is automatically adapted to the project tempo.

The slices in the Audio Part Editor. Here, the project tempo was higher than the 
loop’s original tempo – this means the slice events will overlap slightly.

• If you opened the Sample Editor for a clip in the Pool, you will find that 
the icon for the clip changes in the Pool (to indicate that it is sliced).
Dragging the sliced clip from the Pool to an audio track will create an audio part with 
the slices adapted to the project tempo, just as above.

9. If you activate cycle playback on the Transport panel, the loop should 
now play back seamlessly at the tempo set in the program!

10.To make the loop follow any further tempo changes, make sure it’s set 
to “Musical time base” by using the toggle button in the Track list or 
Inspector (the button should show a note symbol – see page 124).

• Note that if the project tempo is lower than the loop’s original tempo, 
there may be audible gaps between each slice event in the part.
This can be remedied by using the Close Gaps function on the Advanced submenu – 
see page 471. You should also consider activating auto fades for the part’s audio track 
– fade-outs set to about 10 ms will help eliminate any clicks between the slices when 
you play back the part. See page 204.

• If the project tempo is higher than the loop’s original tempo, you may 
want to activate auto crossfades for the track.
You can use the Close Gaps functions in this case as well if needed.
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Editing hitpoints

In this section, we go back a bit and look at what can be done with hit-
points in the Sample Editor. There are two ways to invoke the hitpoint 
calculation:

• Select Calculate Hitpoints from the Hitpoints submenu on the Audio menu.
• Select the Hitpoint Edit tool from the toolbar or Quick menu.

The last method will calculate hitpoints if they haven’t already been calculated.

As outlined in the previous section, this makes the program calculate 
(or detect) hitpoints in the audio event, and you can use the Sensitivity 
slider to change how many hitpoints are shown. 

For some loops, this may be all that is needed to set the hitpoints so 
that each slice to be created will contain a single “hit” or sound. How-
ever there will almost certainly be cases when the automatic calcula-
tion may add a hitpoint where there shouldn’t be one, and fail to add a 
hitpoint where one is needed, even if the Sensitivity slider is set to max-
imum. If there are too many or too few hitpoints in a loop, it will most 
probably not play back properly.

When this occurs, you have to edit the hitpoints manually in the Sam-
ple Editor.

Auditioning slices

A slice is a section of the waveform, from one hitpoint to the next. 
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The first thing you should do before editing hitpoints is to listen to each 
slice in the Sample Editor, to determine what they contain. The aim is 
basically to avoid “double hits”, like a snare hit being followed by a hi-
hat hit within the same slice. You also want to determine whether any 
hitpoints have been added that should be removed: 

1. Open a loop in the Sample Editor.
If you have already created slices you can open them in the Sample Editor by double 
clicking any event in the Audio Part Editor. If it is a new loop, follow the instructions in 
the tutorial.

2. Select the Hitpoint Edit tool.
When you point in the waveform display the pointer changes to a speaker icon.

3. Now you can simply point and click in any slice area and the corre-
sponding slice will be played back, from the beginning to the end.
Listen for “double hits” and slices that contain parts of a single sound. 

If you find hitpoints that need to be removed or instances where a hit-
point needs to be added, the first thing to try is to change the sensitiv-
ity setting – see the following section.

Setting the sensitivity
The loop is first analyzed to determine where hitpoints should appear 
(where the individual “beats” in the loop are), then you manually set the 
sensitivity with the Sensitivity slider to determine how many hitpoints 
there should be.

• Try raising the sensitivity to add “missing” hitpoints, and lowering it to 
remove unwanted hitpoints.
This may or may not work, depending on the situation, but as a general rule you should 
try this first.

• Audition the slices again to determine if changing the sensitivity has 
improved matters.
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The “Use” pop-up menu

The “Use” pop-up menu on the toolbar affects which hitpoints are 
shown and is a useful tool for removing unwanted hitpoints. The op-
tions on the pop-up menu are:

How many slices do I need?

If your main reason for slicing the loop is to change the tempo, you 
generally need as many slices as you can get, but never more than 
one per individual “hit” in the loop.

If you want to create a groove (see page 468), you should try to get 
approximately one slice per eighth note, sixteenth note or whatever 
the loop requires.

Option Description

All All hitpoints are shown (taking the Sensitivity slider into account).

1/4, 1/8, 1/16, 1/32 Only hitpoints that are close to the selected note value positions 
within the loop (e.g. close to exact sixteenth note positions, if you 
have selected the 1/16 option) will be shown. Again, the Sensi-
tivity slider is taken into account.

Metric Bias This is like the “All” mode, but all hitpoints that are close to even 
meter divisions (1/4 notes, 1/8 notes, 1/16 notes, etc.) get a 
“sensitivity boost” – they are visible at lower Sensitivity slider set-
tings. This is useful if you are working with dense or cluttered ma-
terial with a lot of hitpoints, but you know that the material is 
based on a strict meter. By selecting Metric Bias it will be easier 
to find the hitpoints close to the meter position (although most 
other hitpoints are also available, at higher sensitivity settings).
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Disabling slices

You might run into situations where there are too many slices – a sin-
gle sound may have been split into two slices for example. You could 
of course reduce the sensitivity to get rid of the hitpoints you don’t 
want, but then other hitpoints could disappear too, which may be un-
desirable. What you need to do in a situation like this is to disable an 
individual slice, using the Hitpoint Edit tool:

1. Select the Hitpoint Edit tool.

2. Press [Alt]/[Option] and move the pointer to the handle (the triangle).
The pointer turns into a cross in the Sample Editor window. 

3. Click on the handle of the hitpoint you wish to disable.
The hitpoint handle is diminished and its line disappears to indicate that it is disabled.

4. Now, the hitpoint won’t be taken into account when you create slices.

5. To reactivate a disabled hitpoint, [Alt]/[Option]-click on the hitpoint 
handle with the Hitpoint Edit tool.

Locking slices

If you lock a hitpoint by clicking on its handle with the Hitpoint Edit tool, 
it will stay even if you drag the Sensitivity slider all the way to zero. This 
can be used in situations where one or several slices contain double 
hits, but raising the sensitivity adds a lot of unwanted slices.

1. Find the place where you hear double hits when auditioning.

2. Remember the current slider setting.
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3. Raise the Sensitivity slider to a higher value so that a hitpoint appears, 
separating the two sounds.
Most likely this will add a lot of other unwanted hitpoints as well.

4. Audition to make sure you got what you wanted.

5. Select the Hitpoint Edit tool and point at the handle.
The speaker icon changes to a normal arrow pointer.

6. Lock the new slice by clicking on its handle.
Locked hitpoints are dark blue in color.

7. Drag the Sensitivity slider to the original setting.
The locked hitpoint will remain shown.

• You can unlock a locked hitpoint by clicking it again with the Hitpoint 
Edit tool with [Alt]/[Option] pressed.

Setting hitpoints manually

If you cannot get the desired result by adjusting sensitivity, disabling 
or locking, you can add, move and delete hitpoints manually.

Adding hitpoints

Manually adding hitpoints can be done in situations where a hitpoint is 
missing at a specific point, but doesn’t appear even if the sensitivity is 
set to full.

1. Zoom in on the waveform at the point where you wish to add a hitpoint.

2. Audition the area with the Hitpoint Edit tool to make sure that the start 
of the sound is in view.

3. Activate Snap to Zero Crossing on the Sample Editor toolbar.
By finding zero crossings in the waveform (positions where the amplitude is close to 
zero), manually added slices won’t introduce any clicks or pops. All hitpoints found by 
the Calculate function are automatically placed at zero crossings.
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4. Press [Alt]/[Option] with the Hitpoint Edit tool selected so that the 
mouse pointer changes to a pencil tool and click just before the start 
of the sound.
A new hitpoint appears. Manually added hitpoints are locked by default.

• If you click and keep the mouse button pressed, you can adjust the 
position of the new hitpoint by dragging.
Releasing the mouse button adds the hitpoint.

5. Audition the new slice with the Play tool to make sure you got what 
you wanted.

Moving hitpoints

If you manually added a hitpoint, and it was either placed too far away 
from the start of the sound, or too far into the sound, you can manually 
move the hitpoint. It is also possible to move calculated hitpoints this 
way.

1. Make sure Snap to Zero Crossing is activated on the Sample Editor 
toolbar.

2. Select the Hitpoint Edit tool.

3. Click on the hitpoint handle and drag it to the new position.

Deleting hitpoints

To delete a hitpoint, select the Hitpoint Edit tool and drag it to the left 
out of the Sample Editor window. Hitpoints that you have created man-
ually can also be deleted by clicking its handle with the Hitpoint Edit 
tool.
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About Q-points

Optionally, hitpoints can have individual Q-points. These are mainly 
used for audio quantizing. Their function is to define the point to which 
the quantizing will apply. Sometimes a slice might have a slow attack, 
and a peak further into the slice which you wish to use as the Q-point. 
When you apply quantize, the Q-point will define where the warp tab 
will be added and thus the point which will be stretched to a grid po-
sition when quantizing.

• To activate Q-points, open the Preferences–Editing–Audio page on 
the File menu and check the “Hitpoints have Q-Points” option.
Next time you use the Calculate Hitpoints function, the hitpoints will have Q-points. 
Manually added hitpoints do not have Q-points.

• To offset the position of a Q-point in relation to the hitpoint, simply 
point and click on the “Q” icon and drag it to the right to the desired 
position.

For a description of quantizing audio, see page 449.
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Creating slices

After you have specified the correct loop length and time signature and 
worked on the hitpoints in the Sample Editor so that one sound per 
slice is heard, it is time to actually slice the file (if that is what you want 
to do – there are other uses for hitpoints as well, as described on the 
following pages). This is done by selecting “Create Audio Slices from 
Hitpoints” from the Hitpoints submenu on the Audio menu.

Now the following happens:

• If you edited an event on an audio track, the Sample Editor closes.

• The audio event is “sliced” so that there is a separate event for each 
hitpoint.
In other words, the sections between the hitpoints become separate events, all refer-
ring to the same original file.

• On the audio track, the audio event is replaced by an audio part, con-
taining the slices.
If you edited a clip from the Pool, you need to drag it to an audio track to get a part with 
the slices.

• The loop is automatically adapted to the tempo set in Nuendo.
This takes the loop length settings you made into account: if the loop was e.g. one bar 
long, the part is resized to fit exactly one bar in the Nuendo tempo, and the slices are 
moved accordingly – keeping their relative positions intact within the part.

Now, you can change the tempo and have the loop automatically follow 
(provided that the track is set to musical time base – see page 124). 
Furthermore, you can double click the part to edit the slices in the Au-
dio Part Editor. You can: 

• Remove or mute slices.
• Change the loop by reordering, replacing or quantizing slices.
• Apply processing or effects to individual slices.
• Create new files from individual slices using the “Bounce Selection” function 

on the Audio menu.
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Creating groove quantize maps

You can generate groove quantize maps based on the hitpoints you 
have created in the Sample Editor. Groove quantizing is not meant for 
correcting errors, but for creating rhythmic feels. This is done by com-
paring your recorded music with a “groove” (a timing grid generated 
from the file) and moving the appropriate notes so that their timing 
matches the one of the groove. In other words, you can extract the 
timing from an audio loop and use it for quantizing MIDI parts (or other 
audio loops, after slicing them).

Proceed as follows:

1. Create and edit hitpoints as described earlier in this chapter.
You don’t have to create slices – just set up the hitpoints.

• You should try to get approximately one slice per eighth note, sixteenth 
note or whatever the loop requires when setting hitpoints for extracting 
a groove.
It can be helpful to use one of the note value-based options on the “Use” pop-up menu 
when you’re setting up the hitpoints (see page 462).

2. When you have finished setting the hitpoints, select “Create Groove 
Quantize from Hitpoints” from the Hitpoints submenu on the Audio 
menu.
The groove is extracted.

3. If you now pull down the Quantize pop-up in the Project window you 
will find an additional item at the bottom of the list, with the same 
name as the file from which you extracted the groove.
This groove can now be selected as a base for quantizing, just like any other quantize 
value. See the chapter “MIDI Processing” in the separate PDF document “Working 
with MIDI”.

• You can also create grooves from a MIDI part, by selecting the part and 
selecting “Part to Groove” from the Advanced Quantize submenu on the 
MIDI menu.
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Other hitpoint functions

On the various submenus on the Audio menu you will also find the fol-
lowing functions:

Create Markers from Hitpoints

This is located on the Hitpoints submenu. If an audio event contains 
calculated hitpoints, this function can be used to add markers – one 
for each hitpoint – to an automatically created marker track (see page 
178). This can be useful for locating to hitpoints, and for using the 
Timewarp tool (see page 517) to snap to hitpoints.

Divide Audio Events at Hitpoints

This Hitpoints submenu item can be used when you simply wish to 
create separate events according to the hitpoints for a file. This means 
that you do not have to make the same considerations as when slicing 
for tempo changes. You can use any method you like to set hitpoints, 
use sensitivity, note values, manually or any combination.

• The slices created will appear in the Project window as separate 
events.

Set Audio Event from Loop

This Advanced submenu function will resize the event according to 
the loop range in the Sample Editor. For example, if you have a long 
loop event and want to “extract” the first bar only, select the Audio 
Tempo Definition tool and adjust the end loop point handle in the ruler 
to one bar. Then use Set Audio Event from Loop before calculating 
hitpoints.
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Set Tempo from Event

This Advanced submenu function sets the project tempo according to 
the original tempo of the loop (as calculated by the Audio Tempo Def-
inition tool). The result depends on whether you are using the Tempo 
track or a fixed tempo.

• If you are using fixed tempo, you will be asked to confirm that you want to 
change this – click Yes to set the fixed tempo to the event’s original tempo.

• If you are using the Tempo track, but there are no tempo changes, you will be 
asked whether to change the global tempo or not:
Click Yes to change the global tempo (the first tempo event on the Tempo track) or No 
to insert tempo events at the beginning and end of the audio event (i.e. the project 
tempo will be adapted to the loop tempo but only during the course of the event).

• If you are using the Tempo track with tempo changes, new tempo events will 
be inserted at the beginning and end of the audio event.
The project tempo will be adapted to the loop tempo during the course of the event.

Stretch to Project Tempo

The Stretch to Project Tempo function on the Advanced submenu 
(Audio menu) makes use of the tempo calculated by the Audio Tempo 
Definition tool and applies time stretch to the selected event, so that it 
fits the current project tempo.

This can be used for stretching a whole loop (not sliced) to the project 
tempo. Note: for this function to be available, you must close the Sam-
ple Editor and select the audio event in the Project window.
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Using the Close Gaps function

If you have sliced a loop for tempo changes, lowering the tempo be-
low the loop’s original tempo will create gaps between the slices. The 
lower the tempo is in relation to the original tempo, the wider the gaps 
will be. This can be fixed using the “Close Gaps” function on the Ad-
vanced submenu on the Audio menu:

1. Set the desired tempo.

2. Select the part in the Project window.

3. Select “Close Gaps” from the Advanced submenu.
Now time stretch is applied on each slice to close the gaps. Depending on the length 
of the part, this can take a little while.

4. The waveform is redrawn and the gaps are now closed!

• Note that this feature creates new clips in the Pool, one for each slice.

• Close Gaps can also be used when the project tempo is higher than 
the original loop tempo.
This will use the time stretch function to shrink the slices to fit.

• If you decide to change the tempo again after using the Close Gaps 
function, you should undo the Close Gaps operation or start over 
again, using the original unstretched file.

• You can also use this function on individual events (in the Audio Part 
Editor or Project window).
The events don’t have to be slices – you can use Close Gaps simply to stretch an au-
dio event to the start position of the next event.
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Background

What is the Pool?

Every time you record on an audio track, a file is created on your hard 
disk. A reference to this file – a clip – is also added to the Pool. Two 
general rules apply to the Pool:

• All clips, audio or video, that belong to a project are listed in the Pool. 

• There is a separate Pool for every project.

The way the Pool displays folders and their contents is similar to the 
way the Mac OS X Finder and the Windows Explorer display folders 
and lists of files.

What can you do in the Pool?

In the Pool you can, amongst other things, perform the following oper-
ations:

Operations that affect files on disk

• Import clips (audio files can automatically be copied and/or converted).
• Convert file formats.
• Rename clips (this will also rename the referred files on disk), and Regions.
• Delete clips (if you select the “Move to Trash” option and empty the Trash 

folder – see page 484).
• Prepare File Archives for backup.
• Minimize Files.

Operations that only affect clips

• Copy clips.
• Audition clips.
• Organize clips.
• Apply audio processing to clips.
• Save or import complete Pool files.
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Opening the Pool

You open the Pool in any of the following ways:

• By clicking the Pool icon in the Project window.

• By selecting “Pool” on the Project menu or “Open Pool Window” on the Pool 
menu.

• By using a key command (by default [Ctrl]/[Command]-[P]).
The content of the Pool is divided into three main folders: 

• The Audio folder
This contains all audio clips and regions currently in the project.

• The Video folder
This contains all video clips currently in the project.

• The Trash folder 
Unused clips can be moved to the Trash folder for later permanent removal from the 
hard disk.

These folders cannot be renamed or deleted from the Pool, but any 
number of subfolders can be added (see page 495).
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Window Overview

Toolbar overview

Audio folder

Trash folder Video folder

Audio clip name

 Region name

Waveform image

Column HeadingsToolbar

Open/Close 
all Folders

View/Attributes 
Pop-up

Hide/show 
info line

Import Button Project Folder Path

Pool Record Folder PathPlay and Loop buttons, 
audition volume control

Search Button
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The info line

Click the “Show Info” button on the toolbar to show or hide the info line 
at the bottom of the Pool window. It shows the following information:

How clips and regions are displayed in the Pool

• Audio clips are represented by a waveform icon followed by the clip name.

• Audio regions are represented by a region icon followed by the region name.

• Video clips are represented by a camera icon followed by the clip name.

Number of audio 
files in the Pool

Number of files in the Pool that are not in 
the project folder (e.g. video files)

Total size of all audio 
files in the Pool

Number of audio 
files in use
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The Pool window columns

Various information about the clips and regions can be viewed in the 
Pool window columns. The columns contain the following information:

Column Description

Media This column contains the Audio, Video and Trash folders. If the folders are 
opened, the clip or region names are shown and can be edited. This column 
is always shown.

Used This column displays the number of times a clip is used in the project. If a 
column row is empty, the corresponding clip is not used.

Status This column displays various icons that relate to the current Pool and clip 
status. See page 479 for a description of the icons.

Musical The checkbox in this column allows you to activate or deactivate Musical 
Mode. If the Tempo column (see below) displays “???”, you have to enter 
the correct tempo before you can activate Musical Mode.

Tempo This shows the tempo of audio files for which a tempo has been set using 
the Audio Tempo Definition tool. If no tempo has been specified, the column 
displays “???”. 

Info This column shows the following information for audio clips: The sample 
rate, bit resolution, number of channels and the length in seconds. For re-
gions, it displays start and end times in frames, and for video clips the frame 
rate, number of frames, and length in seconds.

Type This column shows the file format of the clip.

Date This column shows the date when the clip was created.

Origin Time This column shows the original start position where a clip was recorded in 
the project. As this value can be used as a basis for the “Insert into Project” 
Pool menu item (and other functions), you can change it if the Origin Time 
value is redundant. This can either be done by editing the value in the col-
umn, or by selecting the corresponding clip in the Pool, moving the project 
cursor to the new desired position and selecting “Update Origin” from the 
Pool menu. 

Image This column displays waveform images of audio clips or regions. 

Path This column shows the path to the location of a clip on the hard disk.

Reel Name If you have imported an OMF file (see page 649), they may include this at-
tribute, in which case it is shown in this column. The Reel Name describes 
the 'physical' reel or tape from which the media was originally captured.

User At-
tributes

If you have created User definable attributes for your project, they will 
each be displayed in their own column (see page 480).



NUENDO
The Pool 20 – 479

About the Status column symbols

The Status column can display various symbols that relate to the clips 
status. The following symbols can be shown:

Symbol Description

This indicates the current Pool Record folder (see page 494).

This symbol is shown if a clip has been processed.

The question mark indicates that a clip is referenced to the project but is 
missing from the Pool (see page 488).

This indicates that the clip file is external, i.e. located outside the current 
Audio folder for the project.

This indicates that the clip has been recorded in the currently open version 
of the project. This is useful for finding recently recorded clips quickly.
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User Attributes

You can define your own attributes for elements in the pool. Simply 
select the “Define User Attributes” from the View/Attributes pop-up 
and create as many new attributes as you need. Each attribute can be 
either a number, text or a simple check mark. You can use them to sort 
items in the pool or merely keep track of some aspect of your project.

Setting up a talent name attribute to keep track of ADR takes.

Sorting the Pool contents

You can sort the clips in the Pool by name, date etc. This is done by 
clicking on the corresponding column heading. Clicking again on the 
same heading switches between ascending and descending sort order.

The arrow indicates the 
sort column and sort order.
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Operations

Renaming clips or Regions in the Pool

Renaming one clip or region

To rename a clip in the Pool, select it and click on the existing name, 
type in a new name and press [Return].

Renaming a clip in the Pool is much preferred to renaming it outside 
Nuendo (for example on the computer desktop). This way Nuendo already 
“knows” about the change, and won’t lose track of the clip the next time 
you open the project. See page 488 for details about lost files.

Renaming multiple clips or regions

You can also rename multiple clips or regions in the Pool using the 
“Rename…” command from the Edit menu.

1. Select one or more audio clips, video clips or regions in the Pool. 
You can only select one type of object at a time.

2. From the Edit menu, select “Rename...”.
A dialog with several options for renaming objects automatically will open.

3. Set the parameters for renaming objects and press [Return].
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Setting parameters of the Rename Object dialog

The Rename Object dialog provides a great deal of flexibility and op-
tions when renaming multiple objects in Nuendo. In addition to simple 
prefix, suffix, and incremental numeric additions to names, you can re-
move certain characters, include timestamp information and more.

The Rename Objects dialog

Each of the eight items found in the Rename Objects dialog can be 
used to add an element to the name generated for each object. 

The first line will create text or numbers at the left of the new name. 
The eighth and last line will create text or numbers at the very right of 
the new name.

Each of the eight lines can add one of the following elements includ-
ing a prefix and suffix for each item: (You can use a prefix to create a 
space separating items in the generated name.)

• Free Text – Any text you would like to include in the name.
• Original Name – The original name given to the object. There are options to 

remove all numbers or non-alphanumerics or just the ones on the left or right 
sides.

• Number – An increasing or decreasing number starting with a minimum 
amount of digits and a starting number (i.e. 001, 002 etc.).

• Project Time – The current location of the clip in the project window using any 
of the seven ruler formats (Bars+Beats, Timecode etc.).
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• Date – The date that the file was created in several formats.
• File Extension – The file type.
• Audio Bitsize – The bit depth of the audio file. 
• Samplerate – The samplerate of the audio file.
• Audio Tempo – The audio tempo for that clip if it has been assigned.
• User Attribute – Any one of the custom attributes created in the Setup User 

Attributes dialog (see page 480).

An example of the result is displayed in the bottom of the window for 
reference. All of these parameters can be saved as a preset as well.

Copying clips in the Pool

To make a duplicate clip, proceed as follows:

1. Select the clip you wish to copy.

2. Select “New Version” on the Pool menu.
A new version of the clip appears in the same Pool folder, with the same name but with 
a “version number” after it, to indicate that the new clip is a duplicate. The first copy 
made of a clip will logically get the version number “2” and so on.

Copying a clip does not create a new file on disk, but just a new edit ver-
sion of the clip (referring to the same original file).

Inserting clips into a project

Using menus

1. Select the clip(s) you want to insert into the project.

2. Pull down the Pool menu and select an “Insert into Project” option.
The “At Cursor” option will insert the clip(s) at the current project cursor position. 
The “At Origin” option will insert the clip(s) at their Origin Time position(s).

• Note that the clip will be positioned so that its snap point is aligned 
with the selected insert position.
You can also open the Sample Editor for a clip by double clicking it, and perform the 
insert operation from there. This way you can set the snap point before inserting a clip.

3. The clip is inserted on a new audio track, created automatically, or on 
a selected track.
If several tracks are selected, the clip will be inserted on the first selected track.
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By using drag and drop

You can use drag and drop to insert clips into the Project window. You 
can also use drag and drop from the Sample Editor for a clip by making 
a selection range and pressing [Ctrl]/[Command] while dragging. Note:

• Snap is taken into account if activated.

• While you drag the clip in the Project window, its position will be indi-
cated by a marker line and a numerical position box.
Note that these indicate the position of the snap point in the clip. For example, if you 
drop the clip at the position 22.00, this will be where the snap point ends up. See 
page 408 for info about how to set the snap point.

• If you position the clip in an empty area in the event display (i.e. below 
existing tracks), a new track is created for the inserted event.

Deleting clips

Removing clips from the Pool

To remove a clip from the Pool without deleting it from the hard disk, 
proceed as follows:

1. Select the file(s) and select “Delete” from the Edit menu (or press 
[Backspace] or [Delete]).

• If you try to delete a clip that is used by one or more events, the program 
will ask you if you want to remove these events from the project.

Canceling means that neither the clip nor the associated events are deleted.

Snap point
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2. Click Remove.
A new prompt asks whether you want to move the clip to the Trash or remove it from 
the Pool.

3. Select “Remove from Pool”.
The clip is no longer associated with the project, but still exists on the hard disk, and 
can be used in other projects etc. This operation can be undone.

Deleting from the hard disk

To delete a file permanently from the hard disk, it must first be moved 
to the Trash folder:

• Follow the instructions for deleting clips above and select “Trash”.

When clips are in the Trash folder they can be removed permanently.

• Select “Empty Trash” on the Pool menu.
A dialog box asks you if you are sure you want to follow through. Remember that this 
operation cannot be undone!

Before you permanently delete audio files from the hard disk, you should 
make sure that these aren’t used by another project!

Removing unused clips from the Pool

This function finds all clips in the Pool that are not used in the project, 
and either moves them to the Pool Trash folder where they can be 
permanently deleted, or removes them from the Pool:

1. Select “Remove Unused Media” on the Pool menu.
A prompt appears with the text “Move to Trash or Remove From Pool?”

2. Make your selection.

Locating events referring to a clip in the Pool

If you want to find out which events in the project refer to a particular 
clip in the Pool, proceed as follows:

1. Select the clip in the Pool.

2. Select “Select in Project” on the Pool menu.
All events that refer to the selected clip are now selected in the Project window.
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Locating clips or regions in the Pool

You can perform a search of the Pool to locate particular clips or re-
gions, in the following way:

1. Select “Find in Pool” from the Pool menu.
This opens the Find Media window, in which you can specify various 
criteria to match. You can search by any one (or a combination) of the 
following properties:

• Name.
• Size (in seconds, minutes, frames or bytes).
• Bitsize (resolution).
• Channels (stereo or mono).

2. Tick the box beside the property you would like to search by, and en-
ter the desired name or value.
For the “Size” property, you can search for sizes smaller or greater than a value, or be-
tween two values. This is determined by the second pop-up menu.

3. Press Start.
The search result appears in the lower half of the window. 

• To select the found clips or regions in the Pool, click the “Select in 
Pool” button.

• To insert a found clip or region directly into the project, select it in the 
list in the dialog and select one of the “Insert into Project” options 
from the Pool menu.
The options are described on page 483.

The “Find in Pool” command is also accessible from the Project window 
– the Pool window does not have to be open.

Locating selected events

If you quickly want to find the clip for an event in the Project window, 
you can also use the following method:

1. Select one or several events in the Project window.

2. Pull down the Audio menu and select “Find Selected in Pool”.
The corresponding clip(s) will be located and highlighted in the Pool. If the Pool win-
dow isn’t already open it will be opened.
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Searching for audio files on disk

The Pool can help you locate audio files on your hard disk or other 
media. This works much like the regular file search, but with a couple 
of extra features:

1. Click the Search button in the toolbar.
A lower pane appears in the window, displaying the search functions.

2. Use the Location pop-up menu to specify where to search.
The pop-up menu will list all your local drives and removable media. 

• If you want to limit the search to certain folders, choose “Select 
Search Path” and select the desired folder in the dialog that appears.
The search will include the selected folder and all subfolders. Note also that folders 
you have recently selected using the “Select Search Path” function will appear on the 
pop-up menu, allowing you to quickly select any of them.

3. Specify the name of the file(s) to search for in the Name field.
You can use partial names or wildcards (*), if you like. Note however, that the function 
only searches for audio files of the supported formats.

4. Click the Search button in the search pane.
The search is started and the Search button is labeled Stop – click this to cancel the 
search if needed.

When the search is finished, the found files are listed to the right.

• To audition a file, select it in the list and use the playback controls to 
the left (Play, Stop, Pause and Loop).
If Auto Play is activated, selected files will automatically be played back.

• To import a found file into the Pool, select it in the list and click the Im-
port button in the search pane.

5. To close the search pane, click the Search button in the toolbar again.
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About missing files

When you open a project, you may get a warning that one or more 
files are “missing”. If you click Close in the warning dialog, the project 
will open anyway, without the missing files. In the Pool you can check 
which files are considered missing. This is indicated by a question 
mark in the Status column.

A file is considered missing under one of the following conditions:

• The file has been moved or renamed outside the program since the last 
time you worked with the project, and you ignored the Resolve Missing 
files dialog when you opened the project for the current session.

• You have moved or renamed the file outside the program during the 
current session.

• You have moved or renamed the folder in which the missing files are 
located.

Locate missing files

1. Select “Find Missing Files” from the Pool menu.
The Resolve Missing Files dialog opens. 

2. In the dialog that appears, decide if you want the program to try to find 
the file for you (Search), if you want to do it yourself (Locate) or if you 
want to specify in which directory the program should search for the 
file (Folder).

• If you select Locate, a file dialog opens, allowing you to locate the file 
manually.
Click “Open” when you have located the file.

• If you select Folder, a dialog opens to let you specify the directory in 
which the missing file can be found.
This might be the preferred method if you have renamed or moved the folder contain-
ing the missing file, but the file still has the same name. Once you select the correct 
folder, the program finds the file and you can close the dialog.
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• If you select Search, the program will scan your hard disks for a file 
with the proper name and display them in a list. 
The dialog allows you to specify which folder or disk should be scanned. Click the 
Search Folder button, select a directory or a disk and then click the Start button. If 
found, select the file from the list and click “Accept”. Afterwards Nuendo tries to map 
all other missing files automatically.

Reconstructing missing edit files

If a missing file cannot be found (e.g. if you have accidentally deleted 
it from the hard disk) it will normally be indicated with a question mark 
in the Status column in the Pool. However, if the missing file is an edit 
file (a file created when you process audio, stored in the Edits folder 
within the project folder), it may be possible for the program to recon-
struct it by recreating the editing to the original audio file:

1. Open the Pool and locate the clip(s) for which files are missing.

2. Check the Status column – if this says “Reconstructible”, the file can 
be reconstructed by Nuendo.

3. Select the reconstructible clips and select “Reconstruct” from the 
Pool menu.
The editing is performed and the edit files are recreated.

Removing missing files from the Pool

If the Pool contains audio files that cannot be found or reconstructed, 
you may want to remove these:

• Select “Remove Missing Files” from the Pool menu to remove all 
missing files from the Pool (and remove their corresponding events 
from the Project window).
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Auditioning clips in the Pool

There are two methods you can use to audition clips in the Pool:

• By selecting a clip and activating the Play button.
The whole clip will play back, unless you stop playback by clicking the Play button again.

The Play button.

• By clicking somewhere in the waveform image for a clip.
The clip will play from the position in the waveform you click until the end of the clip, 
unless you stop playback by clicking the Play button, or by clicking anywhere else in 
the pool window.

Clicking in the waveform image to audition a clip.

• The audio will be routed directly to the Audition bus in both cases.
You can adjust the auditioning level with the miniature level fader on the toolbar. This 
does not affect the regular playback level.

If you have activated the Loop button before you audition, the follow-
ing will happen:

The Loop button.

• If you click the Play button to audition a clip, it will repeat indefinitely 
until you stop playback by clicking the Play or Loop button again.

• If you click in the waveform image to audition, the section from the 
point you clicked to the end of the clip will repeat indefinitely until you 
stop playback.
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Opening clips in the Sample Editor

The Sample Editor allows you to perform detailed editing on the clip 
(see the Sample Editor chapter for details). You can open clips in the 
Sample Editor directly from the Pool in the following ways:

• If you double click on a clip waveform icon, the clip will open in the 
Sample Editor.

• If you double click on a region in the Pool, its clip will open in the 
Sample Editor with the region selected.

One practical use for this is to set a snap point for a clip (see page 
408). When you later insert the clip from the Pool into the project, you 
can have it properly aligned according to the set snap point.

Import Medium...

The Import Medium dialog lets you import files directly into the Pool. It 
is opened from the Pool menu or with the Import button in the Pool 
window.

This is a standard file dialog, where you can navigate to other folders, 
audition files etc. The following audio file formats can be imported:

• Wave (Normal or Broadcast, see page 559)
• AIFF and AIFC (Compressed AIFF)
• REX or REX 2 (see page 666)
• Dolby Digital AC3 file (ac3 – if you have the Steinberg Dolby Digital Encoder 

installed in your system)
• DTS file (.dts – if you have the Steinberg DTS Encoder installed in your system)

Clicking the Import button...

...opens the Import dialog:
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• Sound Designer II 
• MPEG Layer 2 and Layer 3 (mp2 and mp3 files – see page 667)
• Ogg Vorbis (ogg files – see page 667)
• Windows Media Audio (Windows – see page 667)
• Wave64 (.w64 files)
• Stereo or mono
• Any sample rate (although files with another sample rate than the one used in 

the project will play back at the wrong speed and pitch – see below).
• 8, 16, 24 bit or 32 bit float resolution

In addition, AVI, QuickTime, WMV (Windows only), DV (Mac OS X 
only) and MPEG 1 and 2 video files can be imported into the Pool.

It is also possible to use the commands on the Import submenu on the 
File menu to import audio or video files into the Pool.

For video files to be played back correctly, the right codecs have to be 
installed.

When you select a file in the Import Medium dialog and click Open, 
the Import Options dialog will appear.
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It contains the following options:

• Copy File to Working Directory.
Activate this if you want a copy of the file to be made in the Project’s Audio folder, and 
have the clip refer to this copy. If the option is off, the clip will refer to the original file in 
the original location (and will thus be marked as “external” in the Pool – see page 479).

• Convert to Project.
Here you can choose to convert the sample rate and/or the sample size (resolution) to 
the current format used in the project. The options will only be available if necessary (if 
the sample rate is different than the one set for the project and/or if the sample size is 
lower than the record format used in the project).
Note that if you are importing several audio files in one go, the Import Options dialog 
will instead contain a “Convert if needed” checkbox. When this is activated, the im-
ported files will be converted only if the sample rate is different or the sample size is 
lower than the project’s.

• Split Channels
If this is activated, stereo and multi-channel files will be split into a corresponding num-
ber of mono files – one for each channel – and these will be imported into the Pool. 
Note that if you use this option, the imported files will always be copied to the Project’s 
Audio folder, as described above.

• Do not Ask again.
If this is ticked, you will always import files according to the settings you have made, with-
out this dialog appearing. This can be reset in the Preferences–Audio Editing dialog. 

You can always convert later should you so wish, by using the Convert 
Files (see page 498) or Conform Files (see page 499) options.

Importing audio CD tracks

You can import tracks (or sections of tracks) from an audio CD directly 
into the Pool by using the “Import Audio CD” function on the Pool 
menu. This opens a dialog in which you can specify which tracks should 
be grabbed from the CD, converted to audio files and added to the 
Pool.

For details about the Import Audio CD dialog, see page 662.
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Exporting regions as audio files

If you have created regions within an audio clip (see page 414) these 
can be exported as separate audio files. To create a new audio file 
from a region, proceed as follows:

1. In the Pool, select the region you wish to export.

2. Pull down the Audio menu and select “Bounce Selection”.
A browser dialog opens.

3. Select the folder in which you want the new file to be created.
A new audio file is created in the specified folder. The file will have the name of the re-
gion and will automatically be added to the Pool.

• If you have two clips that refer to the same audio file (different “versions” 
of clips, e.g. created with the “Convert to Real Copy” function), you can 
use the Bounce Selection function to create a new, separate file for the 
copied clip.
Select the clip and select Bounce Selection – you will be asked for a location and 
name for the new file.

Changing the Pool Record folder

The Pool Record folder.

The Pool Record folder is where all audio clips that you record in the 
project will end up in the Pool. The Pool Record folder is indicated by 
the text “Record” in the Status column, and by a red dot on the folder 
itself, as shown in the picture above. By default, this is the main Audio 
folder. You can, however, at any time create a new Audio subfolder 
and designate this as your Pool Record folder. Proceed as follows:

1. Select the Audio folder or any audio clip.
You cannot designate the Video folder (or a subfolder in it) as the Pool Record folder.

2. Select “Create Folder” on the Pool menu.
A new empty audio subfolder appears in the Pool.
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3. Select the new folder.

4. Select “Set Pool Record Folder” on the Pool menu, or click in the new 
folders Status column.
The new folder now becomes the Pool Record folder, and any audio recorded in the 
project will from this point on end up in this folder.

Organizing clips and folders

If you accumulate a large number of clips in the Pool, it may sometimes 
be difficult to quickly find specific items. In such cases, organizing clips 
in new subfolders with suitable names that reflect the content can be a 
solution. For example, you could put all sound effects in one folder, all 
lead vocals in another etc. Proceed as follows:

1. Select the type of folder, audio or video, in which you want to create a 
subfolder.
You cannot put audio clips in a video folder and vice versa.

2. Select “Create Folder” on the Pool menu.
A new empty subfolder named “New Folder” appears in the Pool.

3. Click on the name and type in a new appropriate name for the folder.

4. Select and drag the clips you wish to move to the new folder.

5. Repeat steps 1-4 as necessary.

Applying processing to clips in the Pool

You can apply audio processing to clips from within the Pool, just like 
you can to events in the Project window. Simply select the clip(s) and 
select a processing method from the Audio menu. To find out more 
about audio processing, see page 360.

Freeze Edits

If you have applied processing to a clip, either in the Project window 
or in the Pool, this is indicated by the red and grey waveform symbol in 
the Status column. This processing can always be undone using the 
Offline Process History (see page 386). You can also use the Freeze 
Edits function to create a new file with processing applied or replace 
the original with a processed version – see page 391.
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Minimize File

This item on the Pool menu allows you to change the size of audio 
files according to the audio clips referenced in a project. The files pro-
duced using this option will only contain the audio file portions actu-
ally used in the project, which can significantly reduce the size of the 
project (given that large portions of the audio files are unused). 

• This operation will permanently alter the selected audio files in the Pool 
(the process cannot be undone), so be careful with this command!
If this is not what you want, you can use the “Save Project to New Folder” File menu 
item instead. This function also has the option of minimizing files, but copies all files 
into a new folder, leaving the original project untouched. See page 642.

It is useful for archiving purposes. If you have completed a project and 
wish to minimize the project size as much as possible, use this function. 

Proceed as follows:

1. Select the file(s) you wish to minimize in the Pool.

2. Select “Minimize File” from the Pool menu.
An alert appears informing you that the entire Edit History will be cleared. You will at 
this point have the option of cancelling or continuing the operation.

3. After the operation is finished, another alert asks you to save the 
project, to update the new file references.
Do so.

The audio file(s) in the Pool Record folder will now be cropped so that 
only the audio actually used in the project remains in the correspond-
ing audio file.
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Prepare Archive

This Pool menu command should be used when you want to archive a 
project. It checks that every clip referenced in the project is located in 
the same folder. To be more precise, it does the following:

• Any files that are located outside the current project folder will be 
copied to it.
Please note that audio files that reside within the project folder will not be copied to 
the audio folder. You will therefore have to copy them there manually before backing 
up the audio folder or save them separately during backup, see below.

• If any processing has been applied, you will be asked whether you 
want to Freeze Edits.
If you do this, you don’t have to archive the Edit folder. Everything belonging to the 
project will be contained in the project file and the Audio folder.

• Once you have performed a Prepare Archive, you can copy the project 
file, the Audio folder and any other audio material you saved in the 
project folder to backup disks, etc.
It is not necessary to archive the Images folder, since these can be recreated by Nuendo. 
You may also find a file with the extension “.csh” in the project folder. This contains image 
information for edited clips and other data that can be recreated, and can safely be de-
leted.

Video clips are always referenced, and are not stored in the project folder.

Importing and exporting Pool files

You can export a Pool as a separate file (file extension “.npl”), by using 
the Export Pool command on the Pool menu. If you import a Pool file 
with the Import Pool command, the file references in it are “added” to 
the current Pool.

• The audio and video files themselves are not saved in the Pool file, only 
a reference to them. 
For there to be any point in importing a Pool file, you need access to all reference files 
(which preferably should have the same file paths as when the Pool was saved).

• You can also save and open libraries – stand-alone Pool files that are 
not associated with a project.
See page 643.
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Convert Files

Selecting Convert Files on the Pool menu opens the Convert Options 
dialog which operates on selected files. Use the pop-up menus to 
specify which audio file attributes you want to keep and which you 
want to convert. The options are:

• Sample Rate
Keep as is, or convert to a sample rate between 8.000 and 96.000 kHz.

• Sample Width
Keep the sample width (resolution) as is, or convert to 16 bit, 24 bit or 32 Bit float.

• Channels
Keep as is, or convert the file to Mono or Stereo Interleaved.

• File Format
Keep as is, or convert to Wave, AIFF, Wave 64 or Broadcast Wave format.

Options

When you convert a file, you can use the Options pop-up to set one 
of the following options regarding what to do with the new file:

Option Description

New Files Creates a copy of the file in the audio folder and converts this new file 
according to the chosen attributes. The new file is added to the Pool, 
but all clip references will still point to the original, unconverted file.

Replace Files Converts the original file without changing clip references. The refer-
ences are however saved with the next save action.
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Conform Files

By using this Pool menu command, you will change all selected files 
that have different file attributes than what is specified for the project, 
to conform to this standard. Proceed as follows:

1. Select all clips in the Pool.

2. Select “Conform Files” on the Pool menu.
A dialog opens allowing you to choose between keeping or replacing the original un-
converted files in the Pool. The following applies:

• Clip/event references in the pool are always redirected to the conformed files.
• If any 'keep' option is selected, original files remain in the Project’s Audio 

folder and new files are created.
• If you select the “Replace” option, files in the Pool and in the Project’s Audio 

folder are replaced.

Extract Audio from Video

This Pool menu item allows you to extract the audio from a video file 
on disk and automatically generate a new audio clip that will appear in 
the Pool Record folder. The resulting clip will have the following prop-
erties:

• It will get the same file format and sample rate/width as is used in the 
current project.

• It will get the same name as the video file.

• This function is not available for mpeg video files.

New + Replace 
in Pool

Creates a new copy with the chosen attributes, replaces the original 
file with the new one in the Pool and redirects the current clip refer-
ences from the original file to the new file. This is the option to select 
if you want your audio clips to refer to the converted file, but still want 
to keep the original file on disk (e.g. if the file is used in other projects).

Option Description
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Options and Settings

Customizing the view

• You can specify which of the columns should be shown or hidden by 
selecting the View/Attributes pop-up on the toolbar and ticking items 
on or off.

• You can rearrange the order of the columns by clicking on a column 
heading and dragging the column to the left or to the right.
The mouse pointer changes to a hand when you place it on the column heading.

• The width of a column can also be adjusted by placing the pointer be-
tween two column headers and dragging left or right.
The pointer changes to a divider when you place it between two column headers.



21
Working with the Tempo track
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Background

For each audio or MIDI track in Nuendo, you can specify whether it 
should be time based or tempo based (see page 124). For tempo 
based tracks, the tempo can either be fixed through the whole project 
(this is called “Fixed tempo mode”) or follow the Tempo track (this is 
called “Tempo track mode”), which may contain tempo changes.

• To switch between Fixed tempo mode and Tempo track mode, use 
the Tempo button on the Transport panel:

When the Tempo button is lit (and the text “Track” is shown), the tempo follows the 
Tempo track, when it is deactivated (and the text “Fixed” is shown), the Fixed tempo 
is used (see page 510). You can also switch tempo mode in the Tempo Track 
Editor (see below).

The Tempo track also contains time signature events. These are al-
ways active, regardless of whether Fixed tempo mode or Tempo track 
mode is selected.

A note about tempo based audio tracks

For tempo based tracks, the start time position of audio events de-
pends on the current tempo setting. However, it is important to realize 
that the actual audio (“within” the events) will play back as recorded, 
regardless of any tempo changes you make. Therefore, it’s good prac-
tice to make the proper tempo and time signature settings before you 
start recording tempo based audio.

• To make an already recorded audio track follow the tempo changes, you 
can use the Hitpoints and Slicing features, as described on page 456.
How well this works depends on the character of the audio recordings, since the Hit-
point detection feature works best with fairly rhythmical material.

• To adapt the tempo track to time based material, you can use the Time 
Warp tool, as described on page 517.
This allows you to adjust the tempo track so that tempo-based material (e.g. positions 
in music) coincides with time-based material (e.g. positions in narration, video, etc.).
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The Tempo Track Editor – overview

To make changes to the actual Tempo track you need to open the 
Tempo Track Editor, by selecting “Tempo Track” on the Project menu.

The toolbar

The toolbar contains various tools and settings. The tempo and time 
signature displays to the right allow you to view and edit the value of 
the selected tempo curve point or time signature event, much like the 
info line in other editors.

Tools

Tempo track on/off Autoscroll

Snap on/off

Curve type selector

Curve type for new tempo events

Time signature

The selected tempo

Tempo record slider Snap pop-upSnap pop-upSnap pop-up

Open Process Tempo dialog
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The ruler

The ruler in the Tempo Track Editor shows the timeline. As in other 
windows, you can select a display format by clicking on the arrow but-
ton to the right of the ruler, and selecting an option from the pop-up 
menu that appears.

The two additional items at the bottom of the menu have the following 
functionality:

• If “Time Linear” is selected, the ruler, time signature area and tempo 
curve display will be linear in relation to the timeline.
This means that if the ruler shows bars and beats, the distance between the bar lines 
will vary depending on the tempo.
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• If “Bars+Beats Linear” is selected, the ruler, time signature area and 
tempo curve display will be linear in relation to beats.
If the ruler shows bars and beats, the distance between beats will be constant.

The time signature area

The area below the ruler contains time signature events. 

The tempo curve display

The main display shows the tempo curve (or, if Fixed tempo mode is 
selected, the Fixed tempo – see page 510). To the left of the display 
is a tempo scale to help you quickly locate the desired tempo.

• Note that the vertical “grid lines” correspond to the display format 
selected for the ruler.



NUENDO
21 – 506 Working with the Tempo track

Operations

Zooming

Changing the magnification is done using any of the following meth-
ods:

• By using the zoom sliders in the lower right corner of the window.

• By using the Magnifying Glass tool.
This works according to the standard procedures.

• By using the Zoom submenu on the Edit menu.
The options on the menu work as in other windows.

Editing the tempo curve

This section assumes that you are working in Tempo track mode, i.e. the 
Tempo button is lit on the Transport panel.

Adding tempo curve points

1. Use the “insert curve” pop-up menu in the toolbar to select whether 
you want the tempo to change gradually from the previous curve point 
to the new one (“Ramp”) or change instantly to the new value 
(“Jump”).

2. Select the Pencil tool.

3. Click at the desired time position in the tempo curve display, and keep 
the mouse button pressed.
If Snap is activated on the toolbar, this determines at which time positions you can in-
sert tempo curve points, see page 513.

When you click, the tempo display in the toolbar shows the tempo value.
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4. Drag the curve point to the desired tempo value (indicated in the tempo 
display), and release the mouse button.
The tempo curve point is inserted. The result depends on whether you selected “Ramp” 
or “Jump” in step 1 above:

• You can also just click and draw a tempo curve with the Pencil tool, 
having curve points automatically inserted as you draw.
You would probably want to select the “Ramp” Insert Curve mode when doing this.

• Instead of using the Pencil tool, you can press [Alt]/[Option] and use 
the Arrow tool. 
This will only insert a single point (i.e. you cannot draw a curve with the Arrow tool).

You can also have tempo values automatically inserted by the Beat 
Calculator, see page 514.

Selecting tempo curve points

Selecting curve points is done using any of the following methods:

• Use the Arrow tool.
The standard selection techniques apply.

• Use the Select submenu on the Edit menu.
The options are:

Option Description

All Selects all curve points on the Tempo track.

None Deselects all curve points.

In Loop Selects all curve points between the left and right locator.

Insert curve set to “Ramp”: Insert curve set to “Jump”:
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• You can also use the left and right arrow keys on the computer key-
board, to go from one curve point to the next.
If you press [Shift] and use the arrow keys, the current selection will be kept, allowing 
you to select several points.

Editing tempo curve points

Curve points can be edited in the following ways:

• By clicking and dragging horizontally and/or vertically.
If several points are selected, all of them are moved. If Snap is activated on the toolbar, 
this determines to which time positions you can move curve points, see page 513.

• By adjusting the tempo value in the tempo display on the toolbar.
For this to work, a single tempo curve point must be selected.

Dragging tempo curve points with a time based display format (any 
other format than “Bars+Beats”) may give confusing results. This is be-
cause moving a point will change the relationship between tempo and 
time. Specifically, let’s say you move a tempo point to the right and drop 
it on a certain time position. When you release the mouse button, the 
mapping between tempo and time will be adjusted (since you have 
changed the tempo curve). As a result, the moved point will appear at 
another position. For this reason, we recommend that you use the 
Bars+Beats display format when editing tempo curves.

From Start to Cursor Selects all points to the left of the project cursor.

From Cursor to End Selects all points to the right of the project cursor.

Option Description
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Adjusting the curve type

You can change the curve type of a tempo curve segment at any time, 
using the following method:

1. Select all curve points within the segment you want to edit.

2. Pull down the Curve pop-up menu on the toolbar and select “Jump” or 
“Ramp”.
The curve sections between the selected points are adjusted.

Removing tempo curve points

To remove a curve point, either click on it with the Eraser tool or select 
it and press [Backspace]. The first tempo curve point cannot be re-
moved.

Recording tempo changes

The tempo record slider on the toolbar allows you to record tempo 
changes “on the fly”: simply start playback and use the slider to raise 
or lower the tempo at the desired positions. Useful for creating natural 
sounding ritardandos, etc.
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Setting the Fixed tempo

When the Tempo track button is deactivated, the Tempo track curve 
is greyed out (but still visible). Since the Fixed tempo is constant 
throughout the whole project, there are no tempo curve points. In-
stead, the Fixed tempo is displayed as a horizontal black line in the 
tempo curve display.

There are two ways to set the tempo in Fixed mode:

• Drag the tempo line up or down with the Arrow tool.

• Adjust the value numerically in the tempo display on the toolbar.

Adding and editing time signature events

• To add a time signature event, click in the time signature area with the 
Pencil tool. 
This adds a default 4/4 time signature event at the closest bar position. You can also 
do this by pressing [Alt]/[Option] and clicking with the Arrow tool.

• To edit the value of a time signature event, select it and adjust the 
value in the signature display on the toolbar.
Note that there are two thumbwheel controls for the signature display; the left adjusts 
the numerator and the right adjusts the denominator.
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• You can move a time signature event by clicking and dragging it with 
the Arrow tool.
Again, note that time signature events can only be positioned at the start of bars.

• To remove a time signature, either click on it with the Eraser tool or se-
lect it and press [Backspace].
The first time signature event cannot be removed.

Exporting and importing Tempo tracks

You can export the current tempo track for use in other projects by se-
lecting “Tempo Track” from the “Export” submenu on the File menu. 
This allows you to save the tempo track information (including time 
signature events) as a special xml file (file extension “.smt”).

To import a saved tempo track, select “Tempo Track” from the “Im-
port” submenu on the File menu. Note that this replaces all tempo 
track data in the current project (although the operation can be un-
done if needed).
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Process Tempo
Process Tempo allows you to define a specific length or end time for 
a set range, and the Tempo track will automatically set a tempo that 
will fit the range in the specified time. 

It works as follows:

1. Open the Tempo Track window and specify a region or range that you 
wish to tempo process by setting the left and right locators. 

2. Click on the button furthest to the right on the Tempo Track toolbar.
The Process Tempo dialog appears.

3. In the Process Range fields, the range specified is shown, in Bars and 
Beats (PPQ) and in a time format, selectable from the Time Display 
Format pop-up.
The range defined in step 1 will already be set, but you can edit the range by adjusting 
the values in the Process Range fields if you wish.

Now you can either specify a new Range Length or a new Range End 
time. What to chose depends on whether the range should have a 
specific length or whether it should end at a specific time position.

4. Enter the desired End or Length in the corresponding fields of the 
New Range section.
You can select a time format for the new range in the Time Display Format pop-up.

5. Click Process.
Now the tempo track is automatically adjusted and the range will have the specified 
duration.
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Options and settings

Snap

You activate or deactivate Snap by clicking the Snap icon on the tool-
bar. The behavior of the function depends on the display format se-
lected for the ruler:

• If “Bars+Beats” is selected, tempo curve points will snap to the set 
resolution on the Snap pop-up.
If this is set to 1/1 curve points will snap to the start of bars.

• If any other display format is selected, tempo curve points will snap to 
the vertical grid lines in the tempo curve display.
The spacing of the grid lines depends on the horizontal magnification.

• Time signature events can only be positioned at the start of bars, re-
gardless of whether Snap is activated or not.

Autoscroll

When this option is activated, the tempo curve display will scroll dur-
ing playback, keeping the project cursor visible.
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The Beat Calculator

The Beat Calculator is a tool for calculating the tempo of freely re-
corded audio or MIDI material. It also allows you to set the tempo by 
tapping.

Calculating the tempo of a recording

1. In the Project window, make a selection that covers an exact number 
of beats of the recording.

2. Select “Beat Calculator…” from the Project menu.
The Beat Calculator window appears.

3. Enter the number of beats that the selection encompasses in the 
Beats field.
The corresponding tempo is calculated and displayed in the BPM field.

• If you need to adjust the selection, you can just go back to the Project 
window, leaving the Beat Calculator open.
To re-calculate the tempo after adjusting the selection, click Refresh.

4. If you like, you can insert the calculated tempo into the Tempo track, 
by clicking one of the buttons in the lower left corner of the Beat Cal-
culator window.
Clicking “At Tempo Track Start” will adjust the first tempo curve point, while “At Selec-
tion Start” will add a new tempo curve point at the selection’s start position, using the 
“Jump” curve type (see page 506).

If Fixed tempo mode is selected when you insert the calculated tempo, 
the Fixed tempo will be adjusted, regardless of which button you click.
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Using Tap Tempo

The Tap Tempo function allows you to specify a tempo by tapping:

1. Open the Beat Calculator.

2. If you want to tap the tempo to some recorded material, activate play-
back.

3. Click the Tap Tempo button.
The Tap Tempo window appears.

4. Tap the tempo on the computer keyboard’s space bar or with the 
mouse button.
The tempo display will update the calculated tempo between each tap.

5. When you stop tapping, the program calculates the average timing of 
the taps and displays it.

6. Click OK to close the Tap Tempo window.
The tapped tempo is now shown in the Beat Calculator’s BPM display. If you like, you 
can insert it into the Tempo track as described on the previous page.
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Merge Tempo From Tapping

This function allows you to create a complete tempo track based on 
your tapping. Typically, you would use this if you have an audio file 
with no tempo mapping, and want to be able to add sequenced mate-
rial afterwards, etc.

1. Create an empty time-based MIDI track and, while playing back your 
audio material, tap the new tempo on your MIDI keyboard and record 
the created notes onto the new MIDI track.
Note that you must create note events – pedal events cannot be used for this function.

2. Play back the audio and check that the timing of the MIDI notes corre-
sponds to that of the audio. 
If necessary edit the MIDI notes in an editor.

3. Select the part (or the individual notes, in an editor) that you want to 
use for the calculation.

4. Select “Merge Tempo From Tapping” from the Functions submenu on 
the MIDI menu.
A dialog opens.

5. In the dialog, specify what type of note (1/2, 1/4 etc.) you tapped dur-
ing the recording.
If you activate the “Begin at Bar Start” option, the first note will automatically start at 
the beginning of a bar when calculating the new tempo curve.

6. Click OK.
The project’s tempo is adjusted to the tapped notes.

7. Open the Project menu and select “Tempo Track” to check that the 
new tempo information is reflected in the tempo curve.

• Another way of creating a tempo map for freely recorded audio would 
be to use the Time Warp tool – see page 517.
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The Time Warp tool

The Time Warp tool lets you adjust the Tempo track so that “musical 
time based” material (positions related to the tempo) matches “linear 
time based” material (positions in time). Some typical applications:

• When you have recorded music (audio or MIDI) without tempo reference or 
metronome click – the Time Warp tool can be used for creating a tempo map 
that fits the recording (allowing you to rearrange or add sequenced material).

• When you are creating music for a movie and want to match certain positions 
in the video with certain positions in the music.

The Time Warp tool makes use of the fact that tracks can be based on 
time positions (linear time base) or positions related to tempo (musical 
time base) – see page 124 for a description of these modes.

Basic procedure

You use the Time Warp tool to drag a musical position (a position in 
bars+beats format) to a certain position in time. This can be done in 
the Project window or in editor windows, as described below. Here is 
the general procedure:

1. Make sure Tempo track mode is selected.
You cannot use the Time Warp tool in Fixed tempo mode.

2. Select the Time Warp tool.

Bars+Beats format is automatically selected for the ruler in the active window and 
the ruler is shown in dark red.
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3. Click in the window at a musical position and drag it so that it 
matches a position in the material you are editing – e.g. the start of an 
event, a certain “hit” within an audio event, a frame in a video clip, etc.
When you click with the Time Warp tool it snaps to the grid in the window.

Dragging the start of bar 9 to the start of the audio event.

While you are dragging, the track(s) you are editing are temporarily 
switched to linear time base – this means that the contents of the 
tracks remain at the same time positions regardless of the tempo 
(there is an exception to this in the Project window – see below).

4. When you release the mouse button the musical position you clicked 
on matches the time position you dragged it to.
This is because the Time Warp tool changed the last tempo event on the Tempo track 
(and/or added new ones, depending on window and usage), thereby scaling the 
tempo track to fit.

Rules

• When you use the Time Warp tool, the tempo value of the last tempo 
event (before the click position) is adjusted.

• If later tempo events exist, a new tempo event will be created at the 
click position. This way, the later tempo event(s) will not be moved.

• If you press [Shift] and use the Time Warp tool, a new tempo event is 
created at the click position.
[Shift] is the default modifier for this – you can adjust this in the Preferences dialog 
(Editing-Tool Modifiers page, under the Warp Tool category).

• If you use the Time Warp tool in an editor, a tempo event will be cre-
ated at the start of the edited part or event. Only the track being ed-
ited will be affected – but note that events after the edited events or 
parts (on the edited track) will be affected as well.
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• If you have made a selection range (in the Project window, Audio Part 
Editor or Sample Editor) and use the Time Warp tool within that 
range, the tempo changes will be confined to that range.
This means tempo events will be inserted at the start and end of the selection range, if 
needed – useful if you need to adjust the tempo within a certain area but want all ma-
terial outside that range to stay in place.

• When you click with the Time Warp tool, it snaps to the tempo grid in 
the window.

• When you drag the tempo grid to a new position, it can be magnetic 
to events in the window.
In the Project window, this requires that Snap is activated and “Events” is selected on 
the Snap pop-up menu – the grid will then snap to the start and end of events or parts, 
and to markers. In the Sample Editor, this requires that Snap to Zero Crossings is ac-
tivated – the grid will then snap to hitpoints (if any). In the MIDI editors, this requires 
that Snap is activated – the grid will then snap to the start and end of notes.

• The function will create tempo values up to 300 bpm.

Viewing and adjusting tempo events

When you select the Time Warp tool, the ruler of the active window is 
shown in dark red. Existing tempo events are shown in the ruler as 
“flags” with the tempo values displayed.

This helps you see what’s going on, but you can also use this for edit-
ing the tempo track:

• If you press the create/erase modifier key (by default [Shift]) and click 
on a tempo event in the ruler, it is deleted.

• You can click on a tempo event in the ruler and drag to move it.
This automatically edits the tempo value in the event so that elements to the right keep 
their positions.

• If you press [Alt]/[Option] and move (or delete) a tempo event in the 
ruler, the tempo value is not adjusted – this means elements to the 
right will be moved.
This is the default modifier key for this – you can adjust this in the Preferences dialog 
(Editing-Tool Modifiers page, under the Warp Tool category).
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Using the Time Warp tool in the Project window

In the Project window there are two modes for the Time Warp tool:

• In the default mode, all tracks are temporarily switched to linear time base 
when you use the tool. This means that all tracks will keep their absolute time 
positions when you adjust the tempo track.

• In the “musical events follow” mode, no tracks are switched to linear time 
base. This means that all tracks (that are not set to linear time base) will follow 
the changes you make to the tempo track.

You select the Time Warp mode by selecting the tool, clicking on the 
tool icon and selecting from the pop-up menu that appears.

Matching a musical score to video

Here’s an example of how to use the Time Warp tool in “musical 
events follow” mode. Let’s say you are creating the music for a film. 
You have a video track, an audio track with a commentary and some 
audio and/or MIDI tracks with your music. Now you want to match the 
position of a musical cue to a position in a video film. The musical cue 
happens in bar 33. There are no tempo changes in the project (yet).

1. Make sure tempo track mode is selected in the Transport panel.

2. Now you need to locate the position in the video. If you don’t need 
very high precision, you can simply locate it looking at the thumbnails 
on the video track – otherwise you can pinpoint the exact position and 
add a marker to the Marker track (that you can snap to later on).
You can also make a note of the exact position and add an extra ruler track set to show 
time code.
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3. Make sure the correct tracks are set to linear time base or musical 
time base, respectively.
In our example we want the video track and the audio track with a commentary voice-
over to be linear time based (as well as the marker track, if you are using one). All other 
tracks should be set to musical time base. You change this by clicking the time base 
button in the Track list or Inspector.

4. Set up the Grid Type pop-up menu as desired.
When you click with the Time Warp tool, it snaps to the selected grid. In this case, the 
musical cue happens at the start of bar 33, so we can set the grid to “Bar”.

• Note that this affects the snapping to the ruler (tempo grid) when you 
click! In addition, the tool can be “magnetic” to events in the Project 
window when you drag – for this you need to activate Snap and se-
lect “Events” on the Snap pop-up menu. 
In our example, this would be useful if you created a marker at the desired position in 
the video – when you drag the grid (see below), it will snap to the marker.

5. Select the Time Warp tool and select the “musical events follow” mode.

Musical time base selected. Linear time base selected.
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6. Click in the event display at the start of bar 33 and drag to the desired 
position in the video.
As mentioned above, this can mean dragging to a position indicated by the thumbnails 
on the video track, to a marker on the Marker track or to a time position on an additional 
ruler track.

When you drag, you will see the ruler being scaled – and the music 
tracks will follow.

7. Release the mouse button.
If you look in the ruler at the beginning of the project, you will see that the first (and 
only) tempo event has been adjusted.

8. Try playing back.
The musical cue should now happen at the correct position in the video.

OK, let’s say you need to match another cue to another position later 
on in the video. If you simply repeat this procedure, you will find that 
the first cue gets out of sync – since you are still changing the first 
(and only) tempo event on the Tempo track!
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You need to create a “lock point” – a tempo event at the first cue po-
sition:

9. Press [Shift] and click with the Time Warp tool in the event display at 
the cue position.
In our case this is bar 33.

As you can see, a tempo event (with the same value as the first one) is 
added at that position.

10.Now match the next musical cue to the next video position, by drag-
ging the musical position to the desired time position as before.
The new tempo event is edited – the first tempo event is unaffected and the original 
cue is still matched.

• If you know you are going to match several cues this way, you should 
make it a habit to press [Shift] each time you use the Time Warp tool 
to match positions.
This adds a new tempo event – that way you don’t have to add tempo events after-
wards as in step 9 above.

About snapping

If Snap is activated in the Project window and “Events” is selected on 
the Snap pop-up menu, the Time Warp tool will be magnetic to events 
when you drag the tempo grid. This makes it easier to snap a tempo 
position to a marker, the start or end of an audio event, etc.
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Using the Time Warp tool in an audio editor

Using the Time Warp tool in the Sample Editor or Audio Part Editor is 
different from using it in the Project window, in the following ways:

• When you use the Time Warp tool, a tempo event is automatically inserted at 
the beginning of the edited event or part – this tempo event will be adjusted 
when you warp the tempo grid with the tool. This means that material before 
the edited events won’t be affected.

• There is only one mode for the Time Warp tool in the audio editors: When you 
use the tool, the edited track is temporarily switched to linear time base.

Making a tempo map for a “free” recording

The following example shows how to use the Time Warp tool in the 
Sample Editor to create a tempo map matching freely recorded music. 
Let’s say you have recorded a drummer, playing without a metronome 
– this typically means the tempo varies ever so slightly. To be able to 
add sequenced material and easily rearrange the recorded audio, you 
want the tempo in Nuendo to match the recorded drum track:

1. If necessary, move the recorded event to its desired start position.
Move it so that the first downbeat (“one”) happens on the start of the desired bar – 
zoom in if needed.

2. Open the drum recording in the Sample Editor and make sure Hit-
point mode isn’t selected.
The Time Warp tool cannot be used in Hitpoint mode – however, if you have calcu-
lated hitpoints already these will be visible when the Time Warp tool is selected (see 
below).

3. Set the zoom so that you can see the individual drum hits clearly.
To achieve this type of “visual” beat matching, it’s important to have a fairly clean re-
cording, such as the drum track in this example.

4. Select the Time Warp tool.

You have already matched the first downbeat with the start of a bar. 
However, if the recording starts before the first downbeat (with a fill, 
some silence, etc.) you want to “lock” the first downbeat so that it 
stays in position:
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5. Press [Shift] and click in the event at the position of the first downbeat 
(the start of the bar).
When you press [Shift], the pointer turns into a pencil. Clicking adds a tempo event at 
the first downbeat – when you later adjust the tempo with the Time Warp tool, the first 
downbeat will stay in place. Note: if the event started exactly on the first downbeat (no 
audio before the “one”) you wouldn’t need to do this. This is because a tempo event is 
automatically added at the start of the edited event.

6. Now, locate the start of the next bar in the ruler. 

7. Click at that position in the event display and drag the position to the 
downbeat of the second bar in the recording.
When you click, the pointer will snap to the ruler grid.

You mustn’t necessarily match the downbeats (“ones”) – in this figure beat “2” in the 
second bar is matched to the “two” in the recording’s second bar (simply because 
the snare drum hits on the upbeats are easier to spot in the waveform image).

When you dragged the grid you changed the tempo value in the 
tempo event at the first downbeat. If the drummer held a fairly consis-
tent tempo, the following bars should now match pretty well too.
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8. Check the following bars and locate the first position where the audio 
drifts from the tempo.

Now, if you simply adjusted that beat in the tempo grid to match the 
beat in the recording, the tempo event at the first downbeat would be 
changed – this would ruin the match in the previous bars! We need to 
lock these by inserting a new tempo event.

9. Locate the last beat that’s in sync.
This would be the beat just before the position where the audio and tempo drift apart.

10.Press [Shift] and click at that position to insert a tempo event there.
This locks this matched position – the material to the left will not be affected when you 
make adjustments further along.

11.Now match the tempo grid to the next (unmatched) beat by clicking 
and dragging with the Time Warp tool.
The tempo event you inserted in step 10 will be adjusted.

12.Work your way through the recording this way – when you find that 
the recording drifts from the tempo, repeat steps 9 to 11 above.

Now the Tempo track follows the recording and you can add se-
quenced material, rearrange the recording etc.

Matching to hitpoints

If you have calculated hitpoints for the audio event you are editing, 
these will be shown when the Time Warp tool is selected.

• The number of hitpoints shown depends on the Hitpoint Sensitivity slider set-
ting you’ve made in Hitpoint mode.

• If you activate the Snap to Zero Crossing button on the toolbar, the Time 
Warp tool will snap to hitpoints when you drag the tempo grid.

• If you use the Create Markers function on the Audio-Advanced submenu, 
markers will be created at the hitpoint positions. This can be useful when us-
ing the Time Warp tool in the Project window, as the tool will be magnetic to 
markers (if Snap to Events is activated on the toolbar).
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Using the Time Warp tool in a MIDI editor

This is very similar to using the tool in an audio editor:

• When you use the Time Warp tool, a tempo event is automatically inserted at 
the beginning of the edited part – this tempo event will be adjusted when you 
warp the tempo grid with the tool. This means that material before the edited 
part won’t be affected.

• There is only one mode for the Time Warp tool in the MIDI editors: When you 
use the tool, the edited MIDI track is temporarily switched to linear time base.

• The rulers in the MIDI editors can be set to “Time Linear” or “Bars+Beats Lin-
ear” mode (see the separate PDF document “Working with MIDI”) – the Time 
Warp tool requires Time Linear mode. If necessary, the ruler mode will be 
switched when you select the Time Warp tool.

• If Snap is activated on the toolbar in the MIDI editor, the tool will snap to the 
start and end of MIDI notes when you drag the tempo grid.

Typically, you would use the Time Warp tool in a MIDI editor to match 
the Nuendo tempo to freely recorded MIDI material (much like the au-
dio example above).



NUENDO
21 – 528 Working with the Tempo track



22
The Project Browser



NUENDO
22 – 530 The Project Browser

Background

While the Project window and the editors display events and other 
data graphically, the Project Browser window provides a list based 
representation of the project. This allows you to view and edit all 
events on all tracks by using regular value editing in a list.

Opening the Project Browser

You open the Project Browser by selecting “Browser” from the Project 
menu. The Browser window can be open while you are working in other 
windows; any changes made in the Project window or an editor are im-
mediately reflected in the Project Browser and vice versa.

Window Overview

The Project Structure list. This is where 
you navigate through the project.

The event display. This is where you view 
and edit parts, events and Regions.

The time Format (display 
format) pop-up menu.

The Add pop-up menu and Add button, for 
creating new parts, events and regions.

The Filter pop-up menu, 
used when editing MIDI.



NUENDO
The Project Browser 22 – 531

Navigating in the Browser

You use the Project Browser much like you use the Mac OS X Finder 
and Windows Explorer for browsing folders on your hard disk:

• Click on an item in the Project Structure list to select it for viewing.
The contents of the item are shown in the event display.

In this figure, the parts on a MIDI track are displayed.

• Items with hierarchical substructures can be folded out by clicking the 
plus symbols or the “closed folder“ symbols in the Project Structure list.
When the substructure of an item is revealed, a minus symbol or an “open folder“ sym-
bol is shown instead – click this to hide the substructure.

• To reveal or hide all substructures in the Project Structure list, use the 
buttons “(+) All” and “(–) All” above the list.

• The actual editing is done in the event display, using regular value ed-
iting techniques.
There is one exception: You can rename items in the Project Structure list by clicking 
on their names and typing.
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Customizing the View

You can drag the divider between the Project Structure list and the 
event display to make one of them wider and the other narrower. Fur-
thermore, the event display can be customized in the following ways:

• You can change the order of the columns by dragging the column 
headings to the left or right.

• You can resize columns by dragging the dividers between the column 
headings.

• To select a display format for all position and length values, use the 
Time Format pop-up menu.

• You can sort events in the display by columns, by clicking the column 
heading.
If you for example want to sort events by their start positions, click that column head-
ing. An arrow appears in the column heading, indicating that events are sorted by that 
column. The direction of the arrow indicates whether the events are sorted in ascend-
ing or descending order. To change the direction, click the column heading again.

About the Sync Selection option

If the “Sync Selection” checkbox is activated (in the upper right corner 
of the Project Browser), selecting an event in the Project window auto-
matically selects it in the Project Browser, and vice versa. This makes it 
easy to locate events in the two windows.

• This function is only available when a single event or part is selected.
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Editing audio tracks

Audio tracks can have two “subitems”: Track Data and Automation. 

• The Automation item corresponds to the Automation subtrack in the Project 
window, and contains the track’s automation events (see page 538).

• The Track Data item corresponds to the actual audio track in the Project win-
dow. It contains audio events and/or audio parts, which in turn can contain 
audio events.

Note, that if you have not performed any automation or opened an au-
tomation subtrack, the Browser will only contain the audio data.

The following parameters are available for the different items:

The list columns for audio parts:

Parameter Description

Name The name of the part. Double clicking on the part symbol beside it opens 
the Audio Part Editor for the part.

Start The start position of the part. Editing this value is the same as moving the 
part in the Project window.

End The end position of the part. Editing this value is the same as resizing the 
part in the Project window.

Length The length of the part. Editing this value is the same as resizing the part 
in the Project window.

Offset This adjusts the start position of the events within the part. Adjusting this 
value is the same as sliding the contents of the part in the Project win-
dow (see page 139): setting a positive Offset value is the same as slid-
ing the contents to the left, while a negative Offset corresponds to 
sliding the contents to the right.

Mute Click in this column to mute or unmute the part.

The audio track

The Track Data sub-
item of the track

An audio part

The Automation 
subtrack Audio events
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The list columns for audio events:

Creating audio parts

When the “Audio” item of an audio track is selected in the Project 
Structure list, you can create empty audio parts on the track by click-
ing the Add button on the toolbar. This will insert a part between the 
left and right locator.

Parameter Description

Name Allows you to enter a descriptive comment for the event. Double clicking 
on the waveform image beside it opens the Sample Editor for the event.

File The name of the audio file referred by the event’s audio clip.

Start The start position of the event. If the event belongs to an audio part, you 
cannot move it outside the part.

End The end position of the event. 

Snap The absolute position of the event’s snap point. Note that adjusting this 
value will not change the position of the snap point within the event – in-
stead it is another way of moving the event!

Length The length of the event. 

Offset This determines “where in the audio clip” the event starts. Adjusting this 
value is the same as sliding the contents of the event in the Project win-
dow (see page 139). 
You can only specify positive Offset values, since the event cannot start 
before the start of the clip. Likewise, it cannot end after the end of the 
clip. If the event already plays the whole clip, the Offset cannot be ad-
justed at all.

Volume The volume of the event, as set with the Volume handle or on the info line 
in the Project Window.

Fade In
Fade Out

The length of the fade-in and fade-out areas respectively. If you use 
these settings to add a fade (where there previously was none), a linear 
fade will be created. If you adjust the length of an existing fade, the pre-
vious fade shape will be maintained.

Mute Click in this column to mute or unmute the event.

Image Displays a waveform image of the event inside a grey box corresponding 
to the clip. The image is scaled according to the width of the column.
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Editing MIDI tracks

Just like audio tracks, MIDI tracks can have two “subitems”: Track 
Data and Automation.

• The Track Data item corresponds to the actual MIDI track in the Project win-
dow and can contain MIDI parts (which in turn can contain MIDI events).

• The Automation item corresponds to the automation subtrack in the Project 
window, and contains the track’s automation events (see page 538).

Note, that if you have not performed any automation or opened an au-
tomation subtrack, the Browser will only contain the MIDI data.

When editing the Track Data, the following parameters are available:

The list columns for MIDI parts:

Parameter Description

Name The name of the part.

Start The start position of the part. Editing this value is the same as moving 
the part.

End The end position of the part. Changing this is the same as resizing the 
part (and will automatically affect the Length value as well).

Length The length of the part. Changing this resizes the part and automatically 
changes the End value.

Offset This adjusts the start position of the events within the part. Adjusting 
this value is the same as sliding the contents of the part in the Project 
window (see page 139): setting a positive Offset value is the same as 
sliding the contents to the left, while a negative Offset corresponds to 
sliding the contents to the right.

Mute Click in this column to mute or unmute the part.
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The list columns for MIDI events:

• For SysEx (system exclusive) events, you can only edit the position 
(Start) in the list.
However, clicking the Comment column opens the SysEx Editor, in which you can per-
form detailed editing of system exclusive events. This and other aspects of working 
with system exclusive messages are described in the “System Exclusive” chapter in 
the separate PDF document “Working with MIDI”.

Parameter Description

Type The type of MIDI event. This cannot be changed.

Start The position of the event. Editing this value is the same as moving the 
event.

End This is only used for note events, allowing you to view and edit the end 
position of a note (thereby resizing it).

Length This is only used for note events. It shows the length of the note – 
changing this resizes the note and automatically changes the End value 
as well.

Data 1 The property of this value depends on the type of MIDI event:
For notes, this is the note number (pitch). This is displayed and edited 
as a note name and an octave number, with the values ranging be-
tween C-2 and G8.
For Controller events, this is the type of Controller, displayed in words. 
Note that you can edit this by entering a number – the corresponding 
Controller type is automatically displayed.
For Pitch Bend events, this is the fine adjustment of the bend amount.
For Poly Pressure events, this is the note number (pitch).
For other event types, this is the value of the event.

Data 2 The property of this value depends on the type of MIDI event:
For notes, this is the note-on velocity.
For Controller events, this is the value of the event.
For Pitch Bend events, this is the coarse bend amount.
For Poly Pressure events, this is the amount of pressure.
For other event types, this is not used.

Channel The event’s MIDI Channel. See page 83.

Comment This column is used for some event types only, providing an additional 
comment about the event.
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Filtering MIDI events

When you are editing MIDI in the Project Browser, the large number 
of different MIDI events displayed can make it hard to find your way. 
To remedy this, the Filter pop-up menu allows you to select a single 
event type for display.

When this option is selected, only Program Change events will be shown in the 
event display. To reveal all event types, select the top item (“---”) from the menu.

Creating MIDI parts

When a MIDI track is selected in the Project Structure list, you can 
create empty MIDI parts on the track by clicking the Add button. This 
will insert a part between the left and right locator.

Creating MIDI events

You can use the Project Browser to create new MIDI events:

1. Select a MIDI part in the Project Structure list.

2. Move the project cursor to the desired position for the new event.

3. Use the Add pop-up above the event display to select which type of 
MIDI event to add.

4. Click the Add button.
An event of the selected type is added to the part, at the project cursor position. If the 
cursor is outside the selected part, the event is added at the beginning of the part.
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Editing Automation tracks

All kinds of Nuendo automation (the automation subtracks for MIDI, au-
dio, group and FX channel tracks or the individual automation tracks for 
VST Instruments, ReWire channels or Input/Output busses) are han-
dled in the same way in the Project Browser. Each Automation item in 
the Project Structure list will have a number of subentries, one for each 
automated parameter. Selecting one of these parameters in the Project 
Structure list shows its automation events in the list:

You can use the two columns in the list to edit the position of the 
events and their values.

Editing the Video track

When the Video track is selected in the Project Structure list, the 
event display lists the video events on the track, with the following 
parameters:

Column Description

Name The name of the video clip that the event refers to.

Start The start position of the event. Editing this value is the same as moving 
the event.

End The end position of the event. Editing this value is the same as resizing 
the event, and will automatically change the Length value as well.

Length The length of the event. Editing this value is the same as resizing the 
event, and will automatically change the End value as well.

Offset This determines “where in the video clip” the event starts.
Note that the event cannot start before the start of the clip, or end after 
the end of the clip. Thus, if the event already plays the whole video clip, 
the Offset cannot be adjusted at all.
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Editing the Marker track

Marker events have the following parameters:

When the Marker track is selected, you can insert markers selecting 
“Marker” or “Cycle Marker” from the Add pop-up menu and clicking 
the Add button. Regular markers will be added at the current project 
cursor position while cycle markers will be added between the current 
left and right locator positions.

Column Description

Name The name of the marker. This can be edited for all markers except the 
left and right locator.

Start The position of “regular” markers or the start position of cycle markers.

End The end positions of cycle markers. Editing this value is the same as 
resizing the cycle marker, and will automatically change the Length 
value as well.

Length The length of cycle markers. Editing this value is the same as resizing 
the marker, and will automatically change the End value as well.

ID The number of the marker. For regular (non-cycle) markers, this corre-
sponds to the key commands used for navigating to the markers. For 
example, if a marker has ID 3, pressing [3] on the computer keyboard 
will move the song position to that marker. By editing these values, you 
can assign the most important markers to key commands.
Note that you cannot edit the “L” and “R” marker IDs (Left and Right 
locator) or assign IDs 1 and 2 to markers (since these are reserved for 
the locators).
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Editing the Tempo track

When Tempo track is selected in the Project Structure list, the event 
display shows the events on the Tempo track, with the following pa-
rameters:

You can add new Tempo events by clicking the Add button. This cre-
ates a Jump-type event with the value 120 bpm, at the project cursor 
position. Make sure that there is no other tempo event at the current 
cursor position.

Editing Time Signatures

When “Signature track” is selected in the Project Structure list, the 
event display shows the Time Signature events in the project:

You can add new Time Signature events by clicking the Add button. 
This creates a 4/4 event, at the beginning of the bar closest to the 
project cursor position. Make sure that there is no other time signature 
event at the current cursor position.

Parameter Description

Position The position of the Tempo event. You cannot move the first event on 
the Tempo track.

Tempo The tempo value of the event.

Type This indicates whether the tempo should jump to the value of the event 
(“Jump” type) or whether it should change gradually from the previous 
Tempo event, creating a ramp (“Ramp” type). See page 506.

Parameter Description

Position The position of the event. Note that you cannot move the first Time 
Signature event.

Signature The value (time signature) of the event. 
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Deleting Events

The procedure for deleting Events is the same for all different Track 
types:

1. Click on an Event (or a Part) in the Event display to select it.

2. Select Delete from the Edit menu or press [Delete] or [Backspace].

Note that you cannot delete the first Tempo Event or the first Time Sig-
nature Event.
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Overview

The Track Sheet provides a text-form “flow-chart” representation of the 
Project. It lists all audio (and video) tracks and their contents, and can 
easily be printed out. 

To open the Track Sheet window, select “Track Sheet” from the 
Project menu.

The actual Track Sheet is displayed in the lower part of the window. It 
contains the following items:

• The leftmost time column contains a list of time positions in the display 
format selected in the Project Setup dialog.
The time positions relate to start and end times of audio or video events or parts on the 
tracks.

• The following columns display the tracks in the order they appear in 
the Track list.
Only audio and video tracks are shown.

• The events are listed in their corresponding track columns in the order 
they appear (starting at the top).

• For each event, the start and end times are shown, with a vertical line 
binding the two together.
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Viewing the pages in the Track Sheet

If your project is large (i.e. there are many tracks and/or many events) 
or if you are working with a large scale factor (see below), the result-
ing Track Sheet may have more than one page.

The more tracks you have, the larger the number of pages next to 
each other (horizontally). The more Events you have, the larger the 
number of pages below each other.

To select which page should be visible in the Track Sheet window, 
you use the “Y Page” and “X Page” fields in the upper left part of the 
Track Sheet window. You could think of the Track Sheet as divided 
into rows and columns, with “Y Page” determining which row should 
be viewed and “X Page” determining the column. The numbers in pa-
renthesis show the total number of rows and columns, respectively.

• The size and proportions of the Track Sheet pages are set with the 
Page Setup dialog, as described on page 548.

In this case, the page in row 2 and column 3 is shown:

X

Y

1 2 3 4

1

2
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Adjusting the view

The two sliders at the bottom of the Track Sheet window have the fol-
lowing functionality:

• The slider in the lower left corner is the scale slider.
Use this to adjust the actual size of the Track Sheet contents (including the font sizes). 
This will also affect the number of tracks and events shown on each page. 

• The slider in the lower right corner governs the display zoom.
This affects how much of the Track Sheet is shown in the Track Sheet window – the 
printout is not affected.

You can also adjust the width of the columns by dragging the edges 
of the “Timecode” and “Tracks” fields at the top of the window - this 
resizes the corresponding columns in the Track Sheet.

Resizing the track columns. If the Timecode and Tracks fields are hidden, click the 
“More” button.
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Additional settings

• The “Pen Width” determines the thickness of the vertical lines that 
bind together the start and end times for events and parts.

• If the Track Sheet is more than one page wide, you can use the “Time 
Code Column” pop-up menu to determine whether the time column 
should appear only on the first page, on each new page, or not at all.

The following settings can be shown or hidden by clicking the “More/
Less” button.

Setting Description

Project By default, this is the name of the current project, but you can ad-
just this if you like. The project name will be shown in the top left 
corner of each Track Sheet page.

Editor The editor name you enter will be shown below the project name in 
the Track Sheet.

Heading Allows you to enter a heading (shown centered at the top of each 
Track Sheet page).

Do not show 
end times if
length is under...

If this checkbox is ticked, the Track Sheet will not display the end 
times of Events shorter than the time specified in the field to the 
right. This is useful if you have many short events, like spot effects, 
where only the start time is of any relevance.

No leading 
zeroes

By default, the time positions of events will be listed in a syntax with 
“leading zeroes”. E.g. if the display format is seconds, hours and 
minutes will be listed as “01”, “02” etc. If this is activated, the time 
column will not display the leading zeroes.

Merge events
if gap is less 
or equal...

If events on a track are lined up end to end – i.e. there is no gap be-
tween them – they will be considered as a single event in the Track 
Sheet. By defining a value in this box, you can specify how large a 
gap between events has to be for them to be considered as sepa-
rate events. If gaps between events are smaller than or equal to the 
value you specify, they will be listed as a single event. Otherwise 
they will be listed as separate events.

Name Filter This allows you to filter out certain event names of your choice so 
that they are not displayed in the Track Sheet. Click in the text field 
and type in the name(s) – to enter several names, separate each 
with a semi-colon (;). Partial names are OK, so if you e.g. want to fil-
ter out the event name “Crossfade”, you could just write “Cross”. 
However, this would filter out other events starting with the word 
cross as well – e.g. “Crosstalk” would also be filtered out.



NUENDO
23 – 548 The Track Sheet

Printing the Track Sheet

Printing is done using the standard procedures:

1. Make sure the correct page size and page orientation is selected in 
the Page Setup dialog on the File menu.
You may also want to make additional printer settings, following the standard Windows/
Mac procedures.

2. Select “Print...“ from the File menu.
Make the desired printer settings in the dialog that appears, and click OK. The Track 
Sheet is printed.
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Introduction

The Export Audio Mixdown function in Nuendo allows you to mix down 
audio from the program to a file on your hard disk, in a number of for-
mats. You can choose to mix down one of the following:

• An output bus.
For example, if you have set up a stereo mix with tracks routed to a stereo output bus, 
mixing down that output bus would give you a mixdown file containing the whole mix. 
Similarly, you can mix down a complete surround bus, either to a single multi-channel 
file (interleaved) or to one file per surround channel (split).

• The channel for an audio track.
This will mix down the channel for the track, complete with insert effects, EQ, etc. This 
can be useful for turning a number of events into a single file, or if you are using CPU-
intensive insert effects – by exporting the track and re-importing it into the project you 
can turn off the insert effect, saving processor power.

• Any kind of audio channel in the mixer.
This includes VST Instrument channels, effect return channels (FX Channel tracks), 
Group channels and ReWire channels. There are many uses for this – for example, you 
can mix down an effect return track or turn individual ReWire channels into audio files.

Notes

• The Export Audio Mixdown function mixes down the area between the 
left and right locator.

• When you mix down, you get what you hear – mutes, mixer settings 
and insert effects are taken into account.
Note though that you will only include the sound of the bus or channel you select for 
mixdown.

• MIDI tracks are not included in the mixdown!
To make a complete mixdown containing both MIDI and audio, you first need to record 
all your MIDI music to audio tracks (by connecting the outputs of your MIDI instruments 
to your audio inputs and recording, as with any other sound source).

• You can also export selected tracks – this is a different function that 
doesn’t create an audio mixdown.
Rather, this is a way to transfer complete tracks (including clips and events) from one 
project to another. See page 645.
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Mixing down to an audio file

1. Set up the left and right locator to encompass the area that you want 
to mix down.

2. Set up your tracks, so that they play back the way you want.
This includes muting unwanted tracks or parts, making manual mixer settings and/or 
activating the R (Read) automation buttons for some or all mixer channels.

3. Pull down the File menu and select “Audio Mixdown…” from the 
Export submenu.
The Export Audio Mixdown dialog appears.

The upper half of this dialog is a standard file dialog, while the lower 
half contains file format options and settings for the mixdown function. 
Note that the available settings and options differ depending on the 
selected file format (see page 554).
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4. Select the bus or channel you want to mix down with the Outputs 
pop-up menu.
This lists all output busses and channels in the active project.

5. Select the channel configuration for the mixdown file with the Channels 
pop-up menu.
Typically you would select the same channel configuration as the bus or channel you’re 
mixing down, but it’s also possible to e.g. mix down a stereo bus to a mono file. In this 
case a warning will appear, asking if that’s what you want to do.
Here you will also find the “N. Chan. Split” and “N. Chan. Interleaved” options – these 
allow you to create a surround mixdown file, either as one mono file per surround chan-
nel – split – or as a single multi-channel file – interleaved.

• The Channels pop-up and the “N. Chan” options are only available when 
an uncompressed file format is selected (AIFF, uncompressed Wave, 
Wave64 or Broadcast Wave).
For the other formats you can select stereo or mono using controls that are specific to 
each format. When mixing down to 5.1 Surround, you also have the option to mix down 
to Windows Media Audio Pro (Windows only) – see page 563.

6. Select a file format with the File type pop-up menu.

7. Make additional settings for the file to be created.
This includes selecting sample rate, resolution, quality, etc. The available options de-
pend on the selected file format – see page 554.

8. If you want to automatically import the resulting audio file back into 
Nuendo, activate the “Import to” checkboxes.
If you activate the “Pool” checkbox, a clip referring to the file will appear in the Pool. 
Activating the “Audio Track” checkbox as well will create an audio event that plays the 
clip, and place it on a new audio track, starting at the left locator.

• The Import options are only available if you have selected an uncom-
pressed file format (AIFF, uncompressed Wave, Wave64 or Broadcast 
Wave files).

9. If you activate Real-Time Export, the export will happen in real time, i.e. 
the process will take the same time as regular playback.
Some VST plug-ins require this to have time to update correctly during the mixdown – 
consult the plug-in manufacturers if uncertain.
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• When Real-Time Export is activated, the exported audio will be played 
back on the Audition bus.
The fader below the Real-Time Export checkbox allows you to adjust the volume of the 
Audition bus.

10. If you activate Update Display, the meters will be updated during the 
export process.
This allows you to check for clipping, for example.

11.Select a folder and a name for the audio file to be created.

• With some file formats you can create split stereo files (see page 555). 
This will create two files (one for each side) with the same name, but 
with the letter “L” appended for the left channel file and “R” for the right 
channel file.
In the same way, split multi-channel (surround) files will have the same name followed 
by a number indicating the surround channel.

12.Click Save.

• Depending on the file format, an additional dialog may appear.
For example, when exporting to MP3 format a dialog appears where you can add info 
about the song title, artist, etc. Make the desired settings and click OK to proceed.

A dialog with a progress bar is displayed while the audio file is cre-
ated. If you change your mind during the file creation, you can click the 
Abort button to abort the operation.

• If you have activated any of the “Import to” options, the file will be im-
ported back into the project.
When playing back the re-imported file in Nuendo, remember to mute the original 
tracks so that you really hear the true result.
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File format specifics

The following pages describe the different export file formats, and 
their options and settings.

• AIFF files (see page 554).
• Sound Designer II files (Mac OS X only, see page 557).
• Wave files (see page 557).
• Wave 64 files (see page 559).
• Broadcast Wave files (see page 559).
• MP3 files (see page 560).
• Ogg Vorbis files (see page 561).
• Real Audio G2 files (Windows only, see page 562).
• Windows Media Audio files (Windows only, see page 562).
• Windows Media Audio Pro files (Windows, see page 563).

• Steinberg also offers optional Dolby Digital (AC3) and DTS encoders for 
export directly to AC3 or DTS format. 
Please go to www.steinberg.net for more information.

AIFF files

AIFF stands for Audio Interchange File Format, a standard defined by 
Apple Computer Inc. AIFF files have the extension “.aif” and are used 
on most computer platforms. The following settings are available for 
the AIFF export file format:
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Channels

Resolution

Allows you to select 8, 16, 24 bit or 32 bit (float) files.

• If the file is an “intermediate mixdown” that you plan to re-import and continue 
working on in Nuendo, we recommend that you select the 32 bit (float) option.
32 bit (float) is a very high resolution (the same resolution as used internally for audio 
processing in Nuendo), and the audio files will be twice the size of 16 bit files.

Option Description

Mono The audio is mixed down to mono.

Stereo Split Two mono files are created, one for each side of the stereo mix. 
The files will have the name you specify in the dialog, but with “L” 
and “R” added, respectively. Select this format if you plan to use 
the resulting file in another application that doesn’t support stereo 
interleaved files.
If you plan to re-import the file into Nuendo, we recommend that 
you use the Stereo Interleaved option instead, since Nuendo 
doesn’t automatically handle stereo split files as one entity.

Stereo Interleaved A stereo audio file is created. This is the recommended stereo op-
tion if you want to re-import the file into Nuendo.

N. Chan. Split This is used when you want to export surround channels or mixes 
(busses). Exporting with this option will create a set of mono files, 
with each file containing the audio of one of the surround channels. 
The number and configuration of the channels depends on the for-
mat of the output bus (or channel) you have selected on the Out-
puts pop-up menu.
For example, if you have selected a 5.1 output bus this will result in 
six mono audio files. They will have the name specified in the File 
name field above, followed by a number (1-6).

N. Chan. 
Interleaved

This is used when you want to export surround channels or mixes 
(busses). Exporting with this option will create a single audio file 
containing all surround channels. The number and configuration of 
channels in the interleaved file depends on the format of the output 
bus (or channel) you have selected on the Outputs pop-up menu.
For example, if you have selected a 5.1 output bus this will result in 
a 5.1 audio file (containing six channels).
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• If you are making a mixdown for CD burning, you should use the 16 bit option, 
as CD audio is always 16 bit.
In this case, we recommend that you activate the UV-22HR dithering plug-in (see page 
269). This reduces the effects of quantization noise and artifacts from being introduced 
when converting the audio down to 16 bit.

• 8 bit resolution should only be used if required, since it will result in limited au-
dio quality.
8 bit audio may be suitable in some multimedia applications, etc.

Sample Rate

This is the sample rate of the exported file. In most cases, you should 
select the sample rate set for the project, since a lower sample rate 
will degrade the audio quality (mainly reducing the high frequency 
content) and a higher sample rate will only increase the file size, with-
out adding to audio quality. Also consider the future usage of the file – 
if you e.g. plan to import the file into another application, you should 
select a sample rate supported by that application.

• If you are making a mixdown for CD burning, you should select 44.100 
kHz, since this is the sample rate used on audio CDs.

Broadcast options (embedded information)

AIFF files exported from Nuendo can have some additional information 
embedded: date and time of creation, a timecode position (allowing 
you to insert exported audio at the correct position in other projects, 
etc.) along with author, description and reference text strings.

• If the option “Include Broadcast Options in created AIFF Files” is acti-
vated in the Preferences (Record-Broadcast Wave page), the exported 
AIFF file will contain embedded information.
Some applications may not be able to handle AIFF files with embedded info – if you 
get problems using the file in another application, turn off the option and re-export.

• If the option “Show Broadcast Options for AIFF Export” is activated 
on the same page, a dialog will appear when you click Save to export 
the file – use this to enter the desired embedded information.
You can enter default text strings for author, description and reference on the same 
Preferences page – these will automatically appear in the Broadcast Options dialog 
when it appears.
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Sound Designer II files (Mac OS X only)

The SD II format was developed by Digidesign. It is one of the most 
popular audio file formats on the Macintosh, especially for professional 
audio work. The following export settings are available:

Channels

Allows you to select mono or stereo files, with the same options as for 
AIFF files (see page 555).

Resolution

The bit resolution of the file, with the same options as for AIFF files 
(see page 555), except that 32-bit (float) files are not supported.

Sample Rate

The options are the same as for AIFF files. See page 556.

Wave files

Wave files have the extension “.wav” and are the most common file 
format on the PC platform. Wave files can be uncompressed or com-
pressed, as described below. For uncompressed Wave files (the 
most common choice), the following settings are available:

Channels

Allows you to select mono, stereo or multi-channel files with the same 
options as for AIFF files (see page 555).

Resolution

The bit resolution of the file, with the same options as for AIFF files 
(see page 555).

Sample Rate

The options are the same as for AIFF files. See page 556.
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Coding (Windows only)

The Coding pop-up menu allows you to select a compression scheme 
for the Wave file, creating smaller files (with a loss of audio quality).

• Which options are available depends on the installed and activated codecs in 
the ACM (Audio Compression Manager) under Windows.
See the operating system documentation for details.

• When a compression option is selected, not all Channels, Resolution and 
Sample Rate options may be available (depending on the selected compres-
sion scheme).
The Attributes pop-up menu displays the currently selected properties for the file.

• For regular, uncompressed Wave files, select “PCM / uncompressed 
Waves”.

Wave files exported by Nuendo for Mac OS X are always uncompressed.

Broadcast options (embedded information)

Wave files exported from Nuendo can have some additional information 
embedded: date and time of creation, a timecode position (allowing you 
to insert exported audio at the correct position in other projects, etc.) 
along with author, description and reference text strings.

• If the option “Include Broadcast Options in created WAVE Files” is 
activated in the Preferences (Record-Broadcast Wave page), the ex-
ported Wave file will contain embedded information.
Some applications may not be able to handle Wave files with embedded info – if you 
get problems using the file in another application, turn off the option and re-export.

• If the option “Show Broadcast Options for WAVE Export” is activated 
on the same page, a dialog will appear when you click Save to export 
the file – use this to enter the desired embedded information.
You can enter default text strings for author, description and reference on the same 
Preferences page – these will automatically appear in the Broadcast Options dialog 
when it appears.
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Wave64 files

Wave64 is a proprietary format developed by Sonic Foundry Inc. In 
terms of audio quality, Wave64 files are identical to standard wave 
files, but there is one major difference:

• In the file headers, Wave64 files use 64-bit values for addressing where 
wave files use 32-bit values. The consequence of this is that wave64 
files can be considerably larger than standard wave files. Wave64 is 
therefore a good file format choice for really long recordings (file sizes 
over 2GB), e.g. live surround recordings.

Wave64 files have the same options as regular wave files (see page 
557) and have the extension “.w64”.

• If the option “Show Broadcast Options for WAV64 Export” is acti-
vated in the Preferences (Record-Broadcast Wave page) a dialog will 
appear when you click Save to export the file.
This allows you to enter information (date and time, description strings etc.) to be em-
bedded in the file. Note that you can enter default text strings for author, description 
and reference on the same Preferences page – these will automatically appear in the 
Broadcast Options dialog when it appears.

Broadcast Wave files

Audio-wise, Broadcast Wave files are the same as regular Wave files. 
They have the same options as Wave files, but there are no Coding 
(compression) options for Broadcast Wave files.

If the option “Show Broadcast Options for Broadcast WAVE Export” 
is activated in the Preferences (Record-Broadcast Wave page) a dia-
log will appear when you click Save to export the file. This allows you 
to enter information to be embedded in the file: date and time of cre-
ation, a timecode position (allowing you to insert exported audio at the 
correct position in other projects, etc.) and author, description and 
reference text strings.

• You can enter default text strings for author, description and reference 
in the Preferences dialog (Record–Broadcast Wave page).
These will automatically appear in the Broadcast Options dialog when it appears.

• If you don’t want to add embedded information, you can deactivate 
“Show Broadcast Options” in the Preferences.
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MPEG Layer 3 files

MPEG Layer 3 files have the extension “.mp3”. By use of advanced 
audio compression algorithms, mp3 files can be made very small, 
maintaining good audio quality.

The following options are available for MPEG Layer 3 files:

Channels

Use the radio buttons to select mono or stereo files. This setting af-
fects which options are available on the Attributes pop-up menu (see 
below).

Sample Rate

Determines the frequency range of the audio – the lower the sample 
rate, the lower the highest audible frequency in the audio. This setting 
will also affect which options are available on the Attributes pop-up 
menu, as described below.

Attributes

This pop-up menu allows you to select a bit rate for the mp3 file. As a 
rule, the higher the bit rate, the better the audio quality and the larger 
the file. For stereo audio, 128 kBit/s is often considered to result in 
“good” audio quality.

• Note that the available options on this pop-up menu depend on the 
Channels and Sample Rate settings.
This is because for mono audio and/or low sample rates, there is no point in using the 
highest bit rates – they would simply create larger files without adding to audio quality.

Quality

These options determine the “depth” of the encoding algorithm and 
thus the quality of the resulting file. In the “Highest” mode, the encod-
ing will take the longest time, while in the “Fast” mode, the audio qual-
ity may be lower. The file size is not affected by these options.
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Options

When you click the Save button, an Options dialog opens in which 
you can enter information about the file. This additional information 
(called the ID3 tag) will be embedded as text strings in the file, and 
can be displayed by some mp3 playback applications.

• For the information to be included in the file, you need to activate the 
“Insert Options” checkbox in the dialog.

Ogg Vorbis files

Ogg Vorbis is an open, patent-free audio encoding and streaming 
technology, offering compressed audio files (extension “.ogg”) of 
small size but with comparatively high audio quality.

The following options are available for Ogg Vorbis files:

Channels

Use the radio buttons to select mono or stereo files.

Sample Rate

Determines the frequency range of the audio – the lower the sample 
rate, the lower the highest audible frequency in the audio.

Quality

The Ogg Vorbis encoder uses variable bit rate encoding, and the 
Quality setting determines between which limits the bit rate will vary. 
Generally speaking the higher the Quality setting, the higher the 
sound quality but also the larger the files.

Options

When you click the Save button, an Options dialog opens in which you 
can enter information about the file, as when creating mp3 files.

• For the information to be included in the file, you need to activate the 
“Insert Options” checkbox in the dialog.
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Real Audio G2 files

Real Audio files (extension “.rm”) allow very high compression rates and 
can therefore be made very small. This makes the format especially use-
ful for downloading and streaming multimedia from the internet.

The following options are available for Real Audio files:

Coding and Content

This is where you specify the desired audio quality for the file. In the 
Real Audio G2 format, this information is divided in two pop-up menus: 
Coding (determining the bit rate) and Content (specifying the typical 
audio content – voice, music, etc.).

When you select a Coding/Content, a descriptive text appears in the 
field below the pop-up menu, describing the suitable use of the se-
lected format.

• Note that the choice of mono or stereo is included in the Coding/Content 
options.

Options

When you click the Save button, an Options dialog opens in which you 
can select one or more modes (each explained in the dialog) for the 
file. You can also enter information about the file. These text strings 
will be embedded in the file and can be displayed by some Real Audio 
playback applications.

Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by Microsoft Inc. 
Due to advanced audio compression algorithms, Windows Media Au-
dio files can be made very small, maintaining good audio quality. The 
files have the extension “.wma”.



NUENDO
Export Audio Mixdown 24 – 563

The following options are available for Windows Media Audio files:

Attributes

This pop-up menu allows you to select a bit rate for the WMA file. As 
a rule, the higher the bit rate, the better the audio quality and the larger 
the file. For stereo audio, 96 kBit/s is often considered to give “good” 
audio quality.

Options

When you click the Save button, an Options dialog opens in which 
you can enter information about the title and author of the file, as well 
as copyright information and a description. These text strings will be 
embedded in the file and can be displayed by some Windows Media 
Audio playback applications.

Windows Media Audio Pro files (Windows only)

This is a continuation of the Windows Media Audio format (described 
above) developed by Microsoft Inc. Due to the advanced audio codecs 
and lossless compression used, WMA Pro files can be decreased in 
size with no loss of audio quality. Furthermore, WMA Pro features the 
possibility of mixing down to 5.1 surround sound. The files have the ex-
tension “.wma”.
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• Click the Options button to open a dialog in which you can make set-
tings for the Windows Media Audio files. When you have made the 
desired settings, click OK to encode the file.

The following options are available:

Input Stream

Here you set the sample rate (44.1, 48 or 96 khz) and the bit resolu-
tion (16 bit or 24 bit) of the encoded file. These should be set to 
match the sample rate and bit resolution of the source material. If no 
value matches that of your source material, use the closest highest 
available value. E.g. if you’re using 20 bit source material, set the bit 
resolution to 24 bit rather than 16 bit.

Encoding Scheme

These settings are used for defining the desired output from the en-
coder, e.g. whether it should be a stereo file or a 5.1 surround file. 
Make settings appropriate for the intended use of the file. If the file will 
be downloaded or streamed on the Internet, you might not want too 
high bit rates for example. See below for descriptions of the options.
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• Mode
The WMA Pro encoder can use either a constant bit rate or a variable bit rate for en-
coding to 5.1 surround, or it can use lossless encoding for encoding to stereo. The op-
tions on this menu are as follows:

Note that if you encode to a surround file, it can only be played as in-
tended on computers using Windows XP, since no other Windows ver-
sion supports WMA surround. With other operating systems than XP, the 
surround file will instead be reproduced as a stereo file.

Mode Description

Constant Bitrate 
(CBR)

This will encode to a 5.1 surround file with a constant bit rate 
(set in the Bit Rate/Channels menu, see below). Constant bit 
rate is preferably used if you want to limit the size of the final file. 
The size of a file encoded with constant bit rate is always the bit 
rate times the duration of the file.

Variable Bitrate with 
Quality

Encodes to a 5.1 surround file with a variable bit rate, according 
to a quality scale (the desired quality is set in the Bit Rate/Chan-
nels menu, see below). When you encode with variable bit rates, 
the bit rate fluctuates depending on the character and intricacy 
of the material being encoded, The more complex passages in 
the source material, the higher the bit rate – and the larger the fi-
nal file – will be.

Unconstrained VBR 
(Average)

Encodes to a 5.1 surround file with an unconstrained variable bit 
rate. Unconstrained means that there will be no limitation to the 
bit rate used for encoding certain complex passages in the 
source material. You can however set a recommended average 
bit rate to somewhat help constrain the size of the final file in the 
Bit Rate/Channels menu.

Constrained VBR 
(Maximum)

Encodes to a 5.1 surround file with a constrained variable bit 
rate. This means that even though the bit rate fluctuates, it will 
never be allowed to exceed the maximum value you set in the Bit 
Rate/Channels menu.

Lossless Encodes to a stereo file with lossless compression.
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• Bit Rate/Channels
This menu allows you to set the desired bit rate – from 128 kbps to 768 kbps, depend-
ing on the selected Mode (see above). If the Mode “Variable Bitrate with Quality” is 
used (see above), the menu allows you to select from six levels of desired quality, with 
10 being the lowest and 100 the highest. Generally, the higher the bitrate or quality 
you select, the larger the final file will be. The menu also shows the channel format (5.1 
or stereo).

• Method
Lets you choose between “One Pass” and “Two Pass”. 

• One pass means that the source material is passed through the encoder just 
once, and analyzed as well as encoded during the process. 

• Two pass, on the other hand, means that the source material is passed 
through the encoder twice. During the first pass, the material is analyzed, and 
the actual encoding is applied during the second pass.

Two pass encoding can result in a file of better quality, but the pro-
cess takes longer.

Dynamic Range Control

These controls allow you to define the dynamic range of the encoded 
file. The dynamic range is the difference in dB between the average 
loudness and the peak audio level (the loudest sounds) of the audio. 
These settings affect how the audio is reproduced if the file is played 
on a Windows XP computer with a player in the Windows Media 9 
series, and the user activates the special “Quiet Mode” feature of the 
player to control the dynamic range.

The dynamic range is automatically calculated during the encoding 
process, but you can specify it manually as well.

If you want to manually specify the dynamic range, first put a check-
mark in the box to the left by clicking in it and then enter the desired 
dB values in the Peak and Average fields. You can enter any value be-
tween 0 and -90 dB. Note however that it is usually not recommended 
to change the Average value, since it affects the overall volume level 
of the audio and therefore can affect the audio quality adversely.

The Quiet Mode in a Windows Media 9 player can be set to one of 
three settings. Below, these settings are listed together with an expla-
nation of how the Dynamic Range settings affect them:
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• Off: If Quiet Mode is off, the dynamic range settings that were automatically 
calculated during the encoding will be used.

• Little Difference: If this is selected and you have not manually changed the dy-
namic range settings, the peak level will be limited to 6 dB above the average 
level during playback. If you have manually specified the dynamic range, the 
peak level will be limited to the mean value between the peak and average val-
ues you specified.

• Medium Difference: If this is selected and you have not manually changed the 
dynamic range settings, the peak level will be limited to 12 dB above the av-
erage level. If you have changed the dynamic range, the peak level will be lim-
ited to the peak value you specified.

Surround Reduction Coefficients

Here you can specify which amount of volume reduction, if any, should 
be applied to the different channels in a surround encoding. These set-
tings affect how the audio is reproduced on a system incapable of 
playing back the file in surround, in which case the surround channels 
of the file will be combined into two channels and played back in ste-
reo instead.

The default values will normally produce satisfactory results, but you 
can change the values manually if you wish. You can enter any value 
between 0 and -144 dB for the surround channels, the center chan-
nel, the left and right channels and the LFE channel respectively.

Output Media Description

In these fields you can enter a number of text strings with information 
about the file – title, author, copyright information and a description of 
its contents. This information will then be embedded in the file header 
and can be displayed by some Windows Media Audio playback appli-
cations.
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Background

What is synchronization?

Synchronization is said to exist when you make two pieces of equip-
ment agree on time or tempo and location. You can establish synchro-
nization between Nuendo and a number of other types of devices, 
including tape recorders and video decks, but also MIDI devices that 
“play back”, such as other sequencers, drum machines, “workstation 
sequencers” etc.

When you set up a synchronization system you must decide which 
unit is the master. All other devices are then slaved to this unit, which 
means they will adjust their playback speed to the master’s.

Nuendo as a slave

When a synchronization signal is coming in to Nuendo, from another 
device (such as a tape recorder, video recorder etc.), this device is 
the master and Nuendo is the slave. Nuendo will adjust its playback to 
the other device.

Nuendo as a master

When you set up Nuendo to transmit synchronization information to 
other devices, Nuendo is the master and the other devices are the 
slaves; they will adjust their playback to Nuendo.

Nuendo – both master and slave

Nuendo is a very capable synchronization device. It can operate as 
both a master and a slave at the same time. For example, Nuendo 
might be slaved to a tape recorder transmitting timecode, while at the 
same time transmitting MIDI Clock to a drum machine, acting as a 
master for that.

The VST System Link feature (with which you can synchronize separate 
computers running Nuendo or Cubase SX for example) is described in a 
separate chapter. See page 598.
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Timecode, MIDI clock and word clock

Basically there are three types of synchronization signals for audio: 
timecode, MIDI clock and word clock.

Timecode (SMPTE, EBU, MTC, VITC etc.)

Timecode appears in a number of guises. No matter which “format” it 
has, it always supplies a “clock on the wall” type of synchronization, 
that is, a synchronization related to hours, minutes, seconds and two 
smaller units called “frames” and “subframes”.

• LTC (SMPTE, EBU) is the audio version of timecode. This means that it can 
be recorded on the audio track of an audio or video recorder.

• VITC is the video format timecode, that is it is stored in the actual video image.
• MTC is the MIDI version of timecode, transmitted in MIDI cables.
• ADAT sync (Alesis) is only used with the ASIO Positioning Protocol, see page 

575.
• Sony 9-pin is a standard that uses serial (RS-422) communication. Sony 9-

Pin contains timecode as well as machine control messages (see page 588).

For the ASIO Positioning Protocol, other high precision timecode for-
mats may also be supported.

Format recommendations for timecode – without ASIO Positioning 
Protocol

• When synchronizing your system to external timecode, via a synchronizer, the 
most common timecode format is MTC. Contrary to some reports you might 
have heard, MTC delivers good precision for external sync. This is due to the 
fact that the operating system can “time stamp” incoming MIDI messages, 
which increases precision.

• Sony 9-Pin is not recommended for external sync and should only be used 
when no other option is available. However, you might of course use 9-Pin for 
machine control, see page 577.

Format recommendations for timecode – with ASIO Positioning Protocol

• LTC and VITC are the formats with the highest precision and are recommended 
when available.

• MTC is the next best option and probably the most common choice, since few 
audio hardware solutions have built in LTC or VITC readers. However, LTC 
and VITC offer even higher precision when available.

• The choice with the least precision is Sony 9-Pin.
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MIDI Clock

MIDI Clock is a tempo based type of synchronization signal, that is it is 
related to the number of “beats per minute”. MIDI Clock signals are 
suitable for synchronizing two devices that agree on tempo, such as 
for example Nuendo and a drum machine.

MIDI Clock is not suitable as a master sync source for an application 
like Nuendo. Therefore Nuendo will transmit MIDI Clock signals to other 
devices, but it will not receive MIDI Clock.

Word Clock

Word clock is basically a replacement for the sample rate clock in for 
example an audio card. Word clock hence runs at the same rate as 
the sample rate in the audio, 44.1kHz, 48kHz etc.

Word clock does not contain any position information, it is only a 
“simple” signal for clocking the audio at its sample rate.

Word clock comes in many formats, analog on coaxial cable, digital as 
part of an S/PDIF, AES/EBU or ADAT audio signal, etc.

Synchronizing the transport vs. synchronizing audio

How timing is handled in a non-synchronized system

Let’s first look at the situation where Nuendo is not synchronized to 
any external source.

Any digital playback system has an internal clock that ultimately af-
fects the playback speed and stability, and PC audio hardware is no 
exception. This clock is extremely stable.

When Nuendo is playing back with no external synchronization, all 
playback is internally synchronized to the internal digital audio clock, 
to ensure synchronization between digital audio and MIDI.
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Synchronizing Nuendo’s playback

Let’s assume now that we use external timecode synchronization, with 
Nuendo. For example, we might synchronize playback to a tape re-
corder.

Timecode coming from an analog tape recorder will always vary slightly 
in speed. Different timecode generators and different tape recorders 
will also supply timecode with slight differences in speed. In addition, 
the shuttling of tape mechanisms due to overdubs and re-recordings 
can cause the physical tape to wear and stretch, which affects the 
speed of the timecode.

If you set up Nuendo to sync to incoming timecode, it will vary its over-
all playback speed to compensate for such fluctuations in the speed 
of the timecode – that’s the whole purpose of synchronization.

What happens with the digital audio?

The fact that Nuendo’s playback is synchronized to the timecode 
does not affect the playback of the digital audio. It still relies on the 
perfectly stable, built-in clock in the audio hardware.

As you may understand by now, problems will appear when the per-
fectly stable digital audio gets related to the slightly varying speed of a 
system synchronized to timecode.

The playback timing of each event will not be in total accordance with 
the tape or the MIDI playback, since the playback speed of the audio 
is determined by the digital audio hardware’s built-in clock.

Resolving to word clock

The solution to this problem is to use one external clock for all compo-
nents in the system. One master clock is used to derive whatever type 
of clock signal each component in the system needs. For example, 
something called a house clock can be used to generate sample rate 
clocks for the digital audio hardware and timecode for Nuendo. This 
ensures all components in the system use the same reference source 
for their timing.

Synchronizing digital audio to external clocks running at sample rate is 
often called “resolving” or “synchronizing to word clock”. 
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If you aim to perform synchronization to external signals, we strongly 
recommend that you obtain proper synchronization equipment. This 
encompasses:

• An audio card that can be slaved to external word clock.
• A synchronizer that can read timecode (and possibly house clock) and gener-

ate the required sync signals from that, such as the Steinberg TimeLock Pro.

or...

• An audio system with complete built-in synchronization possibilities, prefera-
bly supporting the ASIO Positioning Protocol.

Using timecode without word clock

Of course, it is possible to set up a synchronization system where you 
lock Nuendo to timecode without using word clock. However, please 
note that the timing of audio vs. MIDI cannot be guaranteed and that 
fluctuations in speed in the incoming timecode will not affect the play-
back of audio events. This means that synchronizing to timecode may 
work in the following situations:

• When the timecode was originally generated by the audio card itself.

• When the source providing the timecode is extremely stable (such as 
a digital video system, a digital tape recorder or another computer).

• When you remain synchronized to that same stable source through-
out the entire process, both while recording and playing back audio.
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About the ASIO Positioning Protocol (APP)

ASIO Positioning Protocol requires audio hardware with specific ASIO 
drivers. As of this writing, APP is not available for audio hardware with 
non-ASIO drivers under Mac OS X.

The ASIO Positioning Protocol is a technology that expands on the 
type of sync described above and makes sample accurate positioning 
possible.

When transferring audio digitally between devices, it is important that 
synchronization using word clock and timecode is completely corre-
lated. If not, the audio will not be recorded at the exact intended (sam-
ple accurate) position, which can cause various types of problems, 
such as inaccurately positioned audio material, clicks and pops etc.

A typical situation is when transferring material from a digital multi-
track tape recorder to Nuendo (for editing) and then back again. If you 
do not have sample accurate synchronization set up, you cannot be 
sure that the material will appear in its exact original position, when 
transferred back to the tape recorder.

In order to take advantage of the ASIO Positioning Protocol, your au-
dio hardware must be suitably equipped and the functionality must be 
included in the ASIO driver for the hardware.

An example of a system for doing sample accurate transfers, would be 
transferring audio tracks from an Alesis ADAT to Nuendo. Here the 
ADAT will be the sync master (though it doesn’t necessarily have to 
be). It provides both the digital audio (with an inherent word clock) 
and positional information (timecode) via its ADAT sync protocol. The 
master clock is generated by the ADAT itself.

Hardware and software requirements for APP

• Your computer audio hardware (in our example above this would be an ADAT 
card in your computer) must support all the functionality required for the ASIO 
Positioning Protocol. That is, it must be able to read the digital audio and the 
corresponding positional information from the external device.

• There must be an ASIO 2.0 driver for the audio hardware.
• For resolving to external timecode, the audio hardware must have a timecode 

reader/writer on-board.
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• For information about which audio hardware models currently support APP, 
see the Steinberg web site (www.steinberg.net).

The ASIO Positioning Protocol exploits the specific advantage of having 
an audio card that has a built-in timecode reader. With such a card and 
the ASIO Positioning Protocol, you can achieve constant sample accu-
rate synchronization between the audio source and Nuendo.

Machine control

Nuendo can control external tape transports and similar devices via 
MIDI Machine Control or Sony 9-Pin. This allows you to operate an 
external tape transport from Nuendo’s Transport panel. That is, Nu-
endo can make the tape recorder locate to a certain position, start, 
stop, rewind etc.

About sync and machine control

Controlling tape transports is a two-way process:

• Nuendo sends out machine control commands to the tape recorder, asking it 
to locate to a certain position and activate playback etc.

• The tape recorder locates to the requested position, starts and delivers time-
code back to Nuendo, to which Nuendo is synchronized.

Even though it appears as if Nuendo is controlling the tape recorder 
completely, it is important to remember that in this setup, Nuendo is 
still being synchronized to the external tape transport, not vice versa.

Also note that the two processes of sync and machine control are 
completely separated, in terms of protocols used. You can for exam-
ple synchronize to MTC while sending out transport commands via 
MMC.

MIDI Machine Control (MMC)

This is a standard MIDI protocol for controlling tape transports. There 
are a number of tape recorders and hard disk recording systems on 
the market that support this protocol. Nuendo allows you to control 
the transport of an external MMC device and arm tracks for recording.
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Sony 9-Pin

This is a standard protocol established by Sony, for controlling audio 
and video tape transports. It is implemented via regular serial port 
communication (RS-422). The correct cabling varies between com-
puter platforms and models. Please refer to page 587 to find out more 
about the correct setup for your computer.

• If your Sony 9-pin device supports RS-232, you need a “null modem cable”.
• The Sony 9-pin device most likely needs to be switched from local control to 

remote control in order to be controlled by Nuendo. If the device is not set to 
the correct mode, Nuendo will inform you. Most video decks have a switch on 
the front panel for this.

• Normally you should not lock Nuendo to timecode from the Sony 9-Pin device. 
There is timecode information in the 9-pin signal but it is primarily used for lo-
cating and shuttling. It is erratic and not stable enough to use as a timing or 
speed reference. Timecode should be read from either an LTC source or VITC 
source on a video tape machine.

• Nuendo implements Start, Stop, Record, Fast-Forward, Rewind, Shuttle, 
Nudge and Locate commands for 9-Pin devices, along with some special fea-
tures, described on page 593.



NUENDO
25 – 578 Synchronization

Window Overview

The Synchronization Setup dialog

This dialog box is used for setting up everything that has to do with 
Nuendo’s synchronization to other units. You reach it from the Trans-
port menu.

Settings for 
sync to exter-
nal timecode.

Options for 
incoming 
timecode. Machine Control 

Settings/
Machine Control 
Options.

Outputs for 
MIDI Clock.

Outputs for MIDI 
Timecode.

Input port for 
MIDI Timecode.
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Operations

Making connections and basic settings

The descriptions below are for a basic setup with a separate synchro-
nizer and audio card. Depending on your exact situation and require-
ments for communication with external devices, there are endless 
variations on this theme. Please consult your dealer for more detailed 
recommendations.

The following connections are required for external sync via a syn-
chronizer, including resolving of the audio card. For details on audio 
card and synchronizer settings and connections, see the manuals for 
those devices.

• Route the master clock signal (LTC, VITC, etc.) to an input on the syn-
chronizer.

• Connect the word clock output on the synchronizer to a word clock 
input on the audio card.

• Connect the MIDI Timecode (MTC) or 9-Pin output on the synchronizer 
to the corresponding input on the computer.

• Set up the synchronizer and make sure the frame rate settings are in 
accordance with the master clock.
For more information on frame rates, see page 594.

A typical synchronization setup.

SynchronizerMIDI Interface Video transport

MIDI Timecode

Word Clock
to audio card

LTC Timecode

Audio

Amplifier and
speakers
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Setting up the audio card for external synchronization

1. Open the Device Setup dialog from the Devices menu and under “VST 
Audiobay”, select the subpage with the name of your audio interface.

2. Click the Control Panel button to open the card’s proprietary setup 
dialog.
If this card is accessed via a special ASIO driver (as opposed to MME or Direct X), this 
dialog is provided by the card, not by Nuendo. Hence the settings vary with the card 
brand and model.

3. Adjust the settings as recommended by the card manufacturer, then 
close the dialog.
The dialog may also contain various diagnostic tools that allow you to verify for exam-
ple whether word clock is arriving correctly.

4. From the Clock Source pop-up, select the input to which you routed 
the word clock signal.
This pop-up may not be used if you selected an input in the Control Panel dialog instead.

Setting up Nuendo for external sync to timecode

1. In the Synchronization dialog, set Timecode Source to MIDI Timecode, 
one of the 9-Pin options or ASIO Audio Device (if your hardware is 
compatible with the ASIO Positioning Protocol).

2. For MIDI Timecode, use the MTC Input pop-up menu in the MIDI Time-
code Settings section to the right to select an input for the timecode.
If you are using the ASIO Positioning Protocol, this is not required, since the timecode 
is then coming in directly via your audio hardware.

Sync settings for MIDI Timecode.

Sync to MIDI timecode activated This is where you set the MIDI 
Input for the timecode
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3. For Sony 9-pin timecode, select a port from the Serial Port pop-up 
menu. See page 588 for more on actually connecting 9-pin devices to 
your computer.

4. Close the Synchronization Setup dialog and open the Project Setup 
dialog from the Project menu.

5. Use the Start value to set which frame on the external device (e.g. a 
video tape) should correspond to the beginning of the project.
Most video projects have a program start time of 01:00:00:00 for convenience. It is 
recommended in most cases to have a project start time of 00:59:00:00 to allow for 
synchronizer lockup times, test tones, timing beeps and so forth.

• You can also set this with the function “Set Timecode at Cursor” on 
the Project menu.
This is useful if you know that a certain position in your project would coincide with a 
certain timecode position in the external device. Move the project cursor to the desired 
position, select “Set Timecode at Cursor” and specify the corresponding timecode 
position in the dialog that appears – the Start value is adjusted accordingly.

6. In the dialog that appears, you are asked if you want to keep the 
project content at its timecode positions. Select “No”.
This will make all events and parts keep their positions relative to the project start. 

7. Close the Project Setup dialog.

8. On the Transport panel, activate the Sync button (or select Sync 
Online from the Transport menu).

Sync to 9-Pin activated Selecting a serial port.

Set this to the timecode 
position where you want 
the project to start.
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9. Start the tape (or video, or other master device) that contains the 
timecode. Nuendo starts playing when it receives timecode with a po-
sition “higher” than, or equal to, the project Start frame.

You can wind the device that sends the timecode to any position and 
start from there.

When the master device with the timecode is stopped, you can use the 
Nuendo transport controls as you normally do, when it is not synchro-
nized. 

You should also look into the Sync Options, see page 596.

The Sync indicator

On the Transport panel you can check the status of incoming time-
code by observing the sync indicator. 

• If you have selected MIDI Timecode as Timecode Source and MIDI 
Machine Control as Machine Control Option, the sync indicator 
switches between “Offline” (not waiting for sync), “Idle” (ready for 
sync but no signal is coming in), and “Lock xx” (where xx is indicating 
the frame rate of the incoming signal).

• If you have selected one of the 9-pin options as Machine Control 
Option, the following applies:

• When the Sync button is activated for the first time, the Sync indicator displays 
the name of the machine.

• When Nuendo is ready for synchronization, but no signal is coming in, the 
Sync indicator reads “Stopped”.

• When the Start button is pressed, the Sync indicator reads “Waiting”.
• When Nuendo is locked to timecode (when correct timecode was detected 

and the sequencer is running), “Locked” is displayed.
• While shuttling, the Sync indicator displays “Shuttle”.
• When you are rewinding, the Sync indicator reads “REW”.
• During Fast Forward, “FF” is displayed.
• If a communication error occurred, the indicator reads “Timeout”.

The Sync indicator
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• If the external device is not in Remote mode, the indicator reads “Local”.
• If you are using an external tape machine and no tape has been inserted, the 

Sync indicator reads “No Tape”.
• While positioning on the external machine, the Sync indicator reads “Locate”.
• While using the Auto Edit function, “Auto Edit” is displayed.

Synchronizing other Equipment to Nuendo

You may have other MIDI devices that you want to synchronize to 
Nuendo. There are two types of synchronization that Nuendo can 
transmit: MIDI Clock and MIDI Timecode.

Transmitting MIDI Clock

If you transmit MIDI Clock to a device supporting this type of synchro-
nization signal, the other device will follow Nuendo’s tempo. The 
tempo setting in the other device is of no relevance. Instead it plays at 
the same tempo as Nuendo. If the device also reacts to Song Position 
Pointers (which Nuendo transmits) it will follow when you wind, rewind 
and locate using the Nuendo Transport panel.

• MIDI Clock transport commands include “Start”, “Stop” and “Continue”. 
However, some MIDI equipment (e.g. some drum machines) do not 
recognize the “Continue” command. If this is the case with your equip-
ment, activate the option “Always Send Start Message” in the Synchro-
nization Setup dialog (MIDI Clock Destinations section).
When this is activated, only the Start command is used.

Transmitting MIDI Timecode

If you transmit MIDI Timecode to a device supporting this type of syn-
chronization signal, the device will synchronize time-wise to Nuendo, 
that is, the time displays on Nuendo’s Transport panel and on the 
other device will agree. When you wind and locate Nuendo and then 
activate playback, the other device will follow from the same position 
(if it has this capability and is set up for it!).

• If you want to be able to loop, jump and locate during playback in Nuendo 
and have the other device follow, activate the MIDI Timecode Follows 
Project Time checkbox.
When this is activated the sent MIDI Timecode will follow the sequencer time position 
at all times.
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Setting Up

1. Connect the desired MIDI Outputs from Nuendo to the device(s) that 
you plan to synchronize.

2. Open the Synchronization Setup dialog from the Transport menu.

3. Activate the sync outputs by using the corresponding checkboxes in 
the lower right part of the dialog.
You can output any combination of MIDI Timecode and MIDI Clock to any combination 
of outputs (however, you probably don’t want to send MTC and MIDI Clock to the 
same output).

Some MIDI Interfaces will automatically send MIDI Clock to all MIDI out-
puts, regardless of the MIDI Clock Port selection you make in Nuendo. If 
this is the case, you should only select one MIDI Clock Port (consult the 
documentation of the MIDI Interface if in doubt).

4. Set the other device(s) to their “external synchronization” mode (or 
some other mode with a similar name) and activate playback on them 
if necessary.

5. Activate playback in Nuendo, and the other device(s) will follow.

MIDI Timecode transmitted 
to Outputs 1 and 2.

MIDI Clock transmitted to 
Output 3.
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Machine Control

Machine Control commands can be sent using one of two different 
protocols: MIDI Machine Control (MMC) or Sony 9-Pin. The setup 
procedures are slightly different for the two formats:

MIDI Machine Control

1. Set up and test basic timecode synchronization, as described earlier 
in this chapter.

2. Connect a MIDI Out on your MIDI interface to MIDI In on the tape re-
corder (or similar device).
If you have not already done so (when setting up for MIDI Timecode), also connect a 
MIDI cable from the MIDI Output on the tape recorder to a MIDI In on the computer.

3. Make sure you have timecode recorded on the tape recorder, and that 
it is set up to use MMC.

4. Open the Synchronization Setup dialog on the Transport menu in 
Nuendo.

5. In the Machine Control Options section, select “MIDI Machine Control”.

6. In the Machine Control Settings section, select the correct MMC 
Inputs and Outputs from the respective pop-up menus.

7. Make sure that the MMC Device ID corresponds to the ID of the con-
trolled device.
If more that one machine is connected or if you do not know the Device ID, this can be 
set to “All”, the “Broadcast” device ID.

8. Set the “Number of Audio Tracks” setting to the number of tracks on 
the external tape recorder.

MIDI ports selected 
for MMC
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9. Open the Preferences dialog from the File menu (on the Mac, this is 
located on the Nuendo menu), select the MIDI Filter section and make 
sure Sysex is activated in the Thru section.
This is necessary since MMC uses two-way communication (the tape recorder “replies” 
to the MMC messages it receives from Nuendo). By filtering out Sysex Thru, you ensure 
that these MMC System Exclusive replies are not echoed back to the tape recorder.

10.Close the Preferences and open the Project Setup dialog from the 
Project menu.

11.As when synchronizing without using transport control, use the Start 
value to specify which frame on the tape should correspond to the be-
ginning of the project.

12.Close the Project Setup dialog.

13.Pull down the Devices menu and select MMC Master.
The MIDI Machine Control master transport panel appears.

It is now possible to control the external tape recorder independently 
or together with Nuendo:

• If you activate the Online button on the MMC Master panel you can use 
the transport buttons on the panel to control the transport of the device.

• If you activate the Sync button on Nuendo’s Transport panel, the 
MMC Master transport buttons (or the buttons on the main Transport 
panel) will control the external tape recorder and Nuendo in sync.

• You can also use the buttons to the left on the MMC Master panel to 
arm tape tracks for recording.
The number of record arm buttons depends on the “Number of Audio Tracks” setting 
in the MMC section of the Synchronization Setup dialog.

• The “A1, A2, TC, VD” items refer to additional tracks usually found on 
video tape recorders.
Refer to the manual of your VTR device to see if these tracks are supported.

• Whenever you want to turn off the synchronization between the tape 
recorder and Nuendo, simply deactivate Sync on the Transport panel.
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Nuendo as MMC slave

This is set up in the Machine Control Settings section in the Synchro-
nization Setup dialog.

Some mixers support the MMC-Master protocol for controlling exter-
nal devices, including Tascam DM-24, Yamaha DM2000 and SSL. 
This means that Nuendo can be used as a “recorder”, where track 
arming and transport commands can be sent from the master device. 
In addition, some digital audio workstations (DAWs) can only operate 
in MMC-Master mode.

Connecting a Sony 9-pin compatible device

On Windows computers

The serial port (9-pin D-SUB connector) of your computer is used to 
establish communication with your Sony 9-pin compatible device (VTR, 
DAT, Multitrack etc.). However, PCs provide an RS-232 signal at the 
serial port, not the RS-422 signal expected by Sony 9-pin devices. Ex-
ternal RS-232 to RS-422 converters are available from various manu-
facturers at your local dealer or can be purchased via the internet. If you 
are planning to cover distances exceeding a few meters please make 
sure that this adapter also balances the signal.

On Macintosh computers

The serial port of your computer is used to establish communication 
with your Sony 9-pin compatible device. As newer Macintosh com-
puters do not provide serial ports, you have to install extra serial ports 
on these Macintosh computers using one of the following methods.

• Stealth Serial Port.
This is a very common device used to provide a serial port on Macintosh 
computers lacking this kind of connectivity. This card can be bought in 
Macintosh stores or via the internet. It is inserted in the modem slot in-
side your Macintosh and is recognized by the operating system as a 
serial port. The signal present at the 9-pin D-SUB connector is already 
RS-422 but you need to adapt between the 8-pin Mini DIN connector 
of the Stealth Card and the 9-pin D-SUB connector found on your 
Sony 9-pin device using an appropriate cable.
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• USB to serial adapter.
These USB devices are used to provide a serial port on Macintosh 
computers lacking this kind of connectivity. Such devices are avail-
able from various manufacturers at your local dealer or can be pur-
chased via the internet. Make sure to install the driver of the device 
properly so the operating system can register the device as a serial 
port. The Keyspan USB to serial converter USA-19W has been used 
in this capacity with much success.

Depending on the kind of product you are using, the electrical signal 
available at the 9-pin D-SUB connector of the adapter can be either 
RS-422 or RS-232. Refer to the technical specification of the adapter 
used to find out more. If an RS-232 signal is used, you must convert 
this to the RS-422 signal expected by your Sony 9-pin device. Exter-
nal RS-232 to RS-422 converters are available from various manu-
facturers at your local dealer or can be purchased via the internet. If 
you are planning to cover distances exceeding a few meters please 
make sure that this adapter also balances the signal.

Setting up Sony 9-Pin

1. Set up and test basic timecode synchronization, as described earlier 
in this chapter.

2. Connect an unused serial port (COM port) on the computer to the ex-
ternal tape transport.
As mentioned earlier, you may need a RS-232 to RS-422 converter or conversion cable.

A typical Sony 9-Pin setup.

• Note that you can have two separate 9-Pin devices connected to the 
computer when using Nuendo!

SynchronizerMIDI Interface Video transport

MIDI Timecode

Word Clock
to audio card

Sony 9-Pin via serial connection (possibly with conversion cable, etc.)

LTC Timecode
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3. Make sure you have timecode recorded on the tape recorder, and that 
it is set up to utilize Sony 9-Pin.

4. In the Synchronization Setup choose either 9 Pin Control 1 or 2 from 
the Machine Control Options.

5. Use the Serial Port pop-up menu to select the correct serial (COM) 
port.
By selecting different ports for the two 9-Pin Devices, you can separate two different 
external tape recorders, video systems, etc. The other options in this dialog are de-
scribed on the following pages.

6. Set the number of audio tracks available on the 9-pin device by click-
ing on the arrows in the respective field or by entering a number di-
rectly. There can be up to 48 audio tracks for each 9-pin device.
You will be able to remotely arm each audio track for recording from the 9-pin control 
window. This is very handy when working in a large facility that utilizes a common ma-
chine room where all the tape machines are located.

7. Click OK to apply your changes and close the Synchronization Setup.

8. Open the Project Setup dialog from the Project menu.

9. As when synchronizing without using transport control, use the Start 
value to specify which frame on the tape should correspond to the be-
ginning of the project.

10.Close the Project Setup dialog.
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11.Pull down the Devices menu and select “9-Pin Device 1” or “9-Pin 
Device 2”.
The corresponding 9-Pin Device control panel appears. This has a separate set of 
transport buttons, for controlling the transport in the 9-pin device. There’s also a sep-
arate Online button, above the transport controls.

The 9-pin control panel. Most professional video tape machines have four audio tracks 
and if they are digital, use a 48k sampling rate. Tracks 1 and 2 are record enabled.

It’s now possible to control the transport and track arming of the 9-pin 
device independently or together with Nuendo:

• If you activate the Online button on the 9-Pin Device control panel you 
can use the transport buttons on the panel to control the transport in 
the device.

• If you activate the Sync button on Nuendo’s Transport panel, the 9-Pin 
Device transport buttons (or the buttons on the main Transport panel) 
will control the 9-pin device and Nuendo in sync.

• When using Sony 9-Pin it is possible to advance the external transport 
frame by frame by using the Nudge Position buttons on the Transport 
panel. You can assign a keyboard shortcut for this as well.

• Whenever you want to turn off the synchronization between the tape 
recorder and Nuendo, simply deactivate Sync on the Transport panel.

9-Pin Setup Options

In the Device Setup dialog, you will find two additional options for each 
9-pin device:

• “Control Playback Speed”.
This checkbox instructs Nuendo to attempt to control the playback speed of the 9-pin 
device in order to keep it in sync with Nuendo’s internal clock. This should be a last re-
sort option as it is very difficult to achieve acceptable results. Use this if there is no other 
way to lock to timecode coming from the 9-pin device other than through the 9-pin con-
nection. This option is also available in the Synchronization Setup dialog.
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• “Display Follows Locating Device”.
This is a very useful option for tape-based machines that take a certain amount of time 
to locate to new positions. When this option is checked and sync is enabled, the project 
cursor in Nuendo will reflect the position of the 9-pin machine’s transport as it locates 
to different positions. For instance, if you place the cursor several minutes ahead of the 
current tape position, Nuendo can immediately locate there but the tape machine will 
take several seconds to arrive at the same position. During that time, the cursor will 
move with the tape machine, giving the user visual feedback as to its location. This is 
necessary in larger facilities that have a central machine room where the tape machine 
is located. Since the Nuendo system is in another room, the user will not know when the 
tape machine has located to the correct position.
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9-Pin Preferences

There are several options for 9-pin control in the Preferences dialog 
on the Transport–Machine Control page. They are as follows:

• “Machine position follows mouse edits”. 
When this option is activated and the transport in Nuendo is set to “Edit Mode,” the 9-
pin device will track the edits you make with the mouse in the project window. Actions 
such as adjusting event boundaries, moving fade handles and even selecting events will 
cause the 9-pin machine to follow the mouse position as you make the edit. This emu-
lates the response of a video file playing in Nuendo under Edit Mode.

• “Machine position follows jog”.
When this option is activated, Nuendo will send Locate commands to the 9-pin device 
when you use the jog wheel on the Transport panel, allowing you to see each frame of 
video as you scroll through the tape. When it is deactivated, the positioning of the de-
vice takes place when the jog wheel has been released.

• “Send Shuttle Command instead of Fast Forward/Rewind”.
When the fast forward and rewind buttons are pressed on the Transport panel, Nuendo 
can send either fast forward and rewind commands to the 9-pin device or send shuttle 
commands. Each 9-pin device will react differently to these commands so some exper-
imentation will be necessary. Tape machines will most likely respond best to fast for-
ward and rewind commands. This option is deactivated by default.

• “Send Still Command instead of Stop”.
Many video tape machines will not display an image when in stop mode as the tape is 
typically retracted from the playback heads in this mode. Using a still or pause com-
mand instead will allow most video tape machines to display the current frame of video 
while paused. Many video tape machines have internal settings that affect this as well, 
allowing images to be displayed in stop mode.

• “Allow machine controlled cycle”.
Nuendo can behave in two ways when in cycle mode and using machine control. When 
this option is not activated, Nuendo will begin the cycle normally from the left locator. 
But when it gets to the right locator, Nuendo will go back to the left locator to start the 
cycle again while the tape machine (or other external transport) will continue on until 
stop is pressed. When this option is activated, once Nuendo reaches the right locator, 
playback will stop on both the machine and in Nuendo. Both will locate back to the left 
locator and begin playback automatically. This will continue until stop is pressed. Also, 
if there are pre and post roll values activated in the Transport panel, Nuendo will in-
clude these in the cycle, playing past the right locator by the post-roll amount and then 
locating to a point before the left locator by the pre-roll amount and playing from there. 
The tape machine will follow all of this in sync.
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Audio Layback for 9-Pin Devices

Nuendo has some special features for working with 9-Pin devices 
(typically video decks). These allow you to transfer audio to the 9-Pin 
device by recording it from Nuendo, manually or automatically. A typi-
cal application would be audio layback – if you have edited audio for a 
video in Nuendo and want to transfer the audio back to the audio 
track(s) in the video deck, at the correct positions.

This assumes that Machine Control of the 9-Pin device has been set up, 
and that the proper audio connections have been made for recording 
audio from Nuendo to the 9-Pin device.

1. Open the Device Setup dialog and select the 9-Pin device (1 or 2) in 
the Device list.

2. Make sure the Number of Audio Tracks value is correct.
This should be set to the number of audio tracks in the 9-Pin device. The maximum 
number of audio tracks supported is 48.

• If you have activated the “Try to Recognize Device” option and the 9-Pin 
Device model is known to Nuendo, the number of audio tracks is auto-
matically set to the correct value.

3. Close the Device Setup dialog.

4. Select “9-Pin Device 1” (or 2, depending on your connections and 
setup) from the Devices menu.
The control panel for the 9-Pin Device appears.

The numbered buttons to the left correspond to the set number of audio tracks.

5. Make sure the Online button is not activated.

6. To record enable an audio track in the 9-Pin device, click the corre-
sponding numbered button in the panel.
The button lights up, indicating that the corresponding audio track is record enabled.
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7. Set the locators in Nuendo to encompass the audio section you want 
to transfer.

8. Click the Auto Edit button in the 9-Pin device panel.
This is the button to the right of the transport controls.

• If the Auto Edit function is supported by the 9-Pin device, the device 
will automatically go to a position just before the left locator, start 
playback, activate recording at the left locator and punch out at the 
right locator.
Assuming you have connected the proper outputs from Nuendo to the correct inputs 
of the tape machine, the audio section will be played back in Nuendo and recorded on 
the audio tracks of the 9-Pin device.

• If the Auto Edit function is not supported by the 9-Pin device, you 
have to activate recording “manually”.
Use the 9-Pin device control panel transport (or the main Transport panel) to rewind to 
a position before the left locator, activate automatic punch-in and punch-out and start 
playback. If no Nuendo tracks are record enabled, recording will only be performed by 
the 9-Pin device.

Please consult the documentation for the 9-Pin device for information 
about whether the Auto Edit function is supported or not.

Options

Making Project Settings

About Frame Rates

The frame rate is the number of frames per second in a film or on a 
video tape. Just as there is always sixty seconds to a minute, there is 
always a certain number of frames to each second. However, the frame 
rate used varies with the type of media (film or video), which country 
the video tape has been produced in, and other circumstances.
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In the Project Setup dialog are two settings for frame rates:

• The Frame Rate pop-up is automatically adjusted to the frame rate of 
the incoming timecode.
There is an exception to this when you are synchronizing Nuendo to MIDI Timecode: If 
you have selected 29.97 fps or 30 dfps as Frame Rate in Nuendo, this selection will be 
kept, since these frame rates are not included in the MTC format.

The Project Setup dialog contains six frame rates to choose from:

• The Display Format pop-up contains a number of formats that when 
selected work as the “master” setting for the display format used in 
the various windows’ rulers and position displays.
The item “60 fps (user)” on this menu represents a user definable frame rate. To make 
editing with frame accuracy correspond to the actual frame rate in an external sync 
source, you need to set this frame rate to the same value as the Frame Rate pop-up.

Proceed as follows:

1. Open the Preferences dialog (accessed from the File menu under Win-
dows or the Nuendo menu on the Mac) and select the Transport page.

2. Enter the desired frame rate under “User Definable Framerate”.
Either type the desired value directly or use the arrow buttons to increase/decrease 
the value. You can enter any value between 2-200.

Frame Rate Description

24 fps The traditional frame rate of 35mm film.

25 fps The frame rate used for all video and audio in Europe (EBU).

29.97 fps Straight 29.97 frames per second.

30 fps Straight 30 frames per second. This is often used in the United States 
for audio only work.

29.97 dfps “Drop frame” code running at 29.97 frames per second, most often 
used in the United States of America for work with color video.

30 dfps Very rarely used.
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3. When you’re done, click OK to close the dialog and save the settings.

The Frame Rate you specified will now be the one used when you se-
lect “60 fps (user)” in the Display Format pop-up.

Sync Options

The following options are available in the Application section in the 
Synchronization Setup dialog:

Drop Out Frames

On an analog tape with timecode, dropouts may occur. If a drop-out is 
very long, Nuendo may (temporarily) stop. In the Dropout Time field 
you can set how long a drop-out (in frames) should be tolerated until 
Nuendo decides that the tape isn't good enough to synchronize to. If 
you have a very stable timecode source, you may lower this number to 
make Nuendo stop more swiftly after the tape recorder has been 
stopped.

Lock Frames

Using this field you can set how many frames of “correct” timecode 
Nuendo should receive before attempting to “lock” (synchronize) to 
incoming timecode. If you have an external tape transport with a very 
short start-up time, you could try lowering this number to make lock-
up even faster than it already is.

Inhibit Restart

Some synchronizers will still transmit MIDI Time Code for a short pe-
riod after an external tape machine has been stopped. These extra 
frames of timecode can sometimes cause Nuendo to restart suddenly. 
Inhibit Restart allows you to control the amount of time in milliseconds 
that Nuendo will wait to restart (ignoring incoming MTC) once it has 
stopped.
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Introduction

VST System Link is a network system for digital audio that allows you 
to have several computers working together in one large system. Un-
like conventional networks it does not require Ethernet cards, hubs, or 
CAT-5 cables; instead it uses the kind of digital audio hardware and 
cables you probably already possess in your studio.

VST System Link has been designed to be simple to set up and oper-
ate, yet give enormous flexibility and performance gains in use. It is ca-
pable of linking computers in a “ring” network (the System Link signal 
is passed from one machine to the next, and eventually returns to the 
first machine). VST System Link can send its networking signal over 
any type of digital audio cable, including S/PDIF, ADAT, TDIF, or AES, 
as long as each computer in the system is equipped with a suitable 
ASIO compatible audio interface.

So, why would you want to link up two or more computers? Well, the 
added computer power gives you vast possibilities:

• Dedicate one computer to running VST instruments while recording audio 
tracks on another.

• If you need lots of audio tracks, you may simply add tracks on another com-
puter.

• You could have one computer serve as a “virtual effect rack”, running CPU-
intensive send effect plug-ins only.

• Since you can use VST System Link to connect different VST System Link ap-
plications on different platforms, you can take advantage of effect plug-ins 
and VST instruments that are specific to certain programs or platforms.

This chapter describes how to set up and use VST System Link in 
Nuendo.
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Preparations

Requirements

The following equipment is required for VST System Link operation:

• Two or more computers.
These can be of the same type or use different operating systems – it doesn’t matter. 
For example, you can link an Intel-based PC to an Apple Macintosh without problems.

• Each computer must have audio hardware with specific ASIO drivers, 
installed and working.

• The audio hardware must have digital inputs and outputs.
Of course, to be able to connect the computers the digital connections must be com-
patible (i.e. the same digital formats and connection types must be available).

• At least one digital audio cable for each computer in the network.

• A VST System Link host application installed on each computer.
As of this writing, VST System Link is implemented for Nuendo (version 1.6 or later), 
Cubase SX/SL and Cubase 5.2s (System Link version). Any VST System Link applica-
tions can connect to each other.

Additionally, we recommend that you use a KVM switchbox:

Using a KVM switchbox

If you want to set up a multi-computer network, or even a small net-
work in a limited space, it's a good idea to invest in a KVM (Keyboard, 
Video, Mouse) switchbox. With one of these switchers you can use 
the same keyboard, monitor, and mouse to control each computer in 
the system, and switch between computers very rapidly. KVM switch-
ers are not too expensive, and very easy to setup and operate. It you 
decide not to go this route, the network will function just the same, but 
you may end up doing a lot of jumping from one machine to the other 
while setting up!



NUENDO
26 – 600 VST System Link

Making connections

Below, we will assume that you are connecting two computers. 
Should you have more than two computers, it’s still best to start with 
two and add the others one by one once the system is working – this 
makes troubleshooting easier if you run into problems. For two com-
puters, you will need two digital audio cables, one in each direction:

1. Connect a digital audio cable from the digital output of Computer 1 to 
the digital input of Computer 2.

2. Connect the other cable from the digital output of Computer 2 into 
the digital input of Computer 1.

• If a card has more than one set of inputs and outputs, choose which-
ever one that suits you – for simplicity usually the first set is best.

Setting up clock sync

Before you proceed you need to make sure that the clock signals on 
your ASIO cards are synchronized correctly. This is essential when 
cabling any kind of digital audio system, not just VST System Link.

All digital audio cables by definition always carry a clock signal as well as 
audio signals, so you don't need to use a special Word Clock input and 
output for this (although you may find that you get a slightly more stable 
audio system if you do, especially when using multiple computers).

The Clock Mode or Sync Mode is set up in the audio hardware’s 
ASIO control panel. In Nuendo, you proceed as follows:

1. Pull down the Devices menu and open the Device Setup dialog.

2. Select your audio interface from the VST Audiobay subpage.

3. Click the Control Panel button.
The ASIO control panel appears.

4. Open the ASIO control panel on the other computer as well.
If you are using another VST System Link host application on that computer, check its 
documentation for details on how to open the ASIO control panel.
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5. Now, you need to make sure that one audio card (and only one!) is set 
to be the Clock Master, and all the other cards must be set to listen 
for the clock signal coming from the Clock Master i.e. they must be 
Clock Slaves.
The naming and procedure for this differs depending on the audio hardware – consult 
its documentation if required. If you are using Steinberg Nuendo ASIO hardware, all 
cards default to the “AutoSync” setting – in this case you must set one of the cards 
(and only one) to “Master” in the Clock Mode section of the control panel.

• Typically, the ASIO control panel for an audio card contains some in-
dication of whether the card receives a proper sync signal or not, and 
the sample rate of that signal.
This is a good indication that you have connected the cards and set up clock sync 
properly. Check your audio hardware’s documentation for details.

It’s very important that one and only one card is the clock master, other-
wise the network cannot function correctly. Once you have set this up, 
all the other cards in the network will take their clock signal from this 
card automatically.

The only exception to this procedure is if you are using an external 
clock – which could be from a digital mixing desk or special Word 
Clock synchronizer for example. If so, you must then leave all your 
ASIO cards in Clock Slave or AutoSync mode, and make sure that 
each of them is listening for the signal coming from the synchronizer, 
usually passed through your ADAT cables or Word Clock connectors 
in a daisy chain fashion.

Minimizing the latency

The general definition of latency is the amount of time it takes any sys-
tem to respond to whatever messages are sent to it. For example, if 
your system’s latency is high and you play VST instruments in real 
time, you will get a noticeable delay between when you press a key 
and when you hear the sound of the VST instrument. Nowadays, most 
ASIO-compatible audio cards are capable of operating with very low 
latencies. Also, all VST applications are designed to compensate for 
latency during playback, making the playback timing tight.
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However, the latency time of a VST System Link network is the total 
latency of all the ASIO cards in the system added together. Therefore 
it’s extra important to minimize the latency times for each computer in 
the network.

• The latency does not affect the synchronization – it's always perfectly in 
time. But, it can affect the time it takes to send and receive MIDI and au-
dio signals, or make the system seem sluggish.

To adjust the latency of a system, you typically adjust the size of the 
buffers in the ASIO control panel – the lower the buffer size, the lower 
the latency. Generally speaking it's best to keep to fairly low latencies 
(buffer sizes) if your system can handle it – about 12 ms or less is 
usually a good idea.

Setting up your software

Now it’s time to set up your programs. The procedures below describe 
how to set things up in Nuendo; if you are using another program on 
the other computer, please refer to its documentation.

Setting the sample rate

The projects in both programs must be set to use the same sample 
rate. Select “Project Setup…” from the Project menu and make sure 
the sample rate is the same in both systems.

Streaming digital audio between applications

1. Create input and output busses in both applications and route these 
to the digital inputs and outputs.
The number and configuration of the busses depends on your audio hardware and on 
your needs. If you have a system with eight digital i/o channels (such as an ADAT con-
nection), you could create several stereo or mono busses or a surround bus together 
with a stereo bus, or any combination you need. The important thing is that you should 
have the same configuration in both applications – if you have four stereo output bus-
ses on Computer 1, you want four stereo input busses on Computer 2, etc.

2. Set things up so that Computer 1 plays back some audio.
You could for example import an audio file and play this back in Cycle mode.

3. In the Inspector or mixer, make sure the playing audio channel is 
routed to one of the digital output busses you set up.



NUENDO
VST System Link 26 – 603

4. In Computer 2, open the mixer and locate the corresponding digital 
input bus.
The audio being played back should now “appear” in the program running on Com-
puter 2. You should see the input bus level meters moving.

5. Reverse this procedure so that Computer 2 plays back and Computer 
1 “listens”.

Now you have verified that the digital connection works as it should.

• From this point on in this chapter, we refer to the busses connected to 
the digital inputs and outputs as “VST System Link busses”.

Settings for the audio hardware

When you send VST System Link data between computers, it is im-
portant that the digital information isn’t changed in any way between 
the programs. Therefore, you should open the control panel (or addi-
tional application) for your audio hardware and make sure that the fol-
lowing conditions are met:

• If there are additional “format settings” for the digital ports that you 
use for VST System Link data, make sure these are turned off.
For example, if you are using an S/P DIF connection for VST System Link, make sure 
that “Professional format”, Emphasis and Dithering are turned off.

• If your audio hardware has a mixer application allowing you to adjust 
the levels of digital inputs and outputs, make sure that this mixer is 
disabled or that the levels for the VST System Link channels are set to 
(± 0dB).

• Similarly, make sure no other forms of DSP (pan, effects, etc.) are ap-
plied to the VST System Link signal.

Notes for Hammerfall DSP users

If you are using RME Audio Hammerfall DSP audio hardware, the 
Totalmix function allows for extremely complex signal routing and mix-
ing in the audio hardware. This can in some situations lead to “signal 
loops” in which case the VST System Link won’t work. If you want to 
make absolutely sure this won’t cause any problems, make sure the 
default or “plain” preset is selected for the Totalmix function.



NUENDO
26 – 604 VST System Link

Activating VST System Link

After setting up the inputs and outputs, you now need to define which 
input/output should carry the actual VST System Link information.

The System Link networking signal is carried on only one bit of one 
channel. This means that if you have an ADAT based system which 
normally carries eight channels of 24-bit audio, once you activate VST 
System Link you will have seven channels of 24-bit audio and one 
channel of 23-bit audio (the least significant bit of this last channel is 
what we will use for networking). In practice this makes no discernible 
difference to the audio quality, since you will still have around 138dB 
headroom on this channel.

To set things up we need to open the VST System Link panel:

1. Open the Device Setup dialog on the Devices menu.

2. Select the VST System Link device from the VST Audiobay subpage.



NUENDO
VST System Link 26 – 605

3. Use the ASIO Input and ASIO Output pop-up menus to define which 
channel should be the networking channel (and thus become a 23-bit 
audio channel, in our example).
Quite often you will be able to just leave these pop-ups the way they are. 

4. Click the Active checkbox at the top of the panel.

5. Repeat the steps above for every computer on the network. 

As the computers are made active, you should see the small T (Trans-
mit) and R (Receive) lights flashing on each active computer, and the 
name of each computer should appear in the list at the bottom of the 
pane. Each computer is assigned a random number – don't worry 
about this, it's just so the network knows internally which one is which.

• You can double click on the name in bold (which is the name of the 
computer you’re currently working on) and set it to whatever other 
name you wish.
This name will appear in the System Link window of every computer on the network.

• If you don't see the name of each computer appearing once you have 
made it active, you may have to check your settings. 
Go through the procedure above again and make sure that all ASIO cards are listening 
to the digital clock signals correctly, and that each computer has the correct inputs 
and outputs assigned to the System Link network.

Putting the network online

After each computer's name you will see whether it is online or not. 
When a computer is online, it will receive transport and timecode 
signals, and its sequencer application can be started and stopped by 
remote control. If it is off-line it can only be started from its own key-
board – it is effectively an independent machine, although it is still on 
the network.

• Note that any computer can control any and all of the others – VST Sys-
tem Link is a peer to peer network and there is no absolute “master” 
computer.
However, most users do like to think of one machine as the master (in a one person/two 
computer network, this would be the machine you actually sit behind most of the time). 

For now, let's put all computers online:
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1. Activate the Online checkbox in the VST System Link panel for all 
computers. 

2. Check that the system is working by pressing Play on one computer – 
all computers should start almost instantly and play perfectly in time, 
with sample accurate precision.

• The Offset setting to the right allows you to adjust whether one ma-
chine will play back slightly ahead or behind the rest.
This is normally not needed, but occasionally with some hardware you may find that the 
lock is a few samples out. In that case you can adjust the lock with the Offset value. For 
now, leave it set to 0 – it will most likely be what you want.

VST System Link sends and understands all transport commands, so 
you can play, stop, fast forward, rewind etc. the entire network from 
one computer without a problem – try it! If you jump to a locator point 
on one machine, all other machines will also instantly jump to that lo-
cator point. You can even scrub on one computer and have the video 
and audio on another computer actually scrub right along with you.

Don't forget to make sure that all computers have their tempos set to the 
same value, otherwise your synchronization will be seriously skewed.

Using MIDI

As well as supplying transport and sync control, VST System Link also 
supplies up to 16 MIDI ports, each with 16 channels. You set this up 
as follows:

1. Use the MIDI Ins and Outs value boxes to specify the number of MIDI 
ports you need.
The default value is 0 MIDI In and 0 MIDI Out ports.

2. Create a MIDI track in the Project window and open the Inspector 
(top section).
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3. If you now pull down the “in” or “out” pop-ups, you will find the spec-
ified System Link ports added to the list of MIDI Inputs and Outputs.

This allows you to route MIDI tracks to VST instruments running on 
another computer, as described in the application examples (see 
page 611).

The “Active ASIO Ports for Data only” setting

If you are sending huge amounts of MIDI data at once, there is a small 
possibility that you might run out of bandwidth on your VST System 
Link network. This will manifest itself by notes “choking” or timing be-
coming erratic.

If this happens, you can devote more bandwidth to MIDI by selecting 
Active ASIO Ports for Data only in the VST System Link Setup panel. 
When this is active, the VST System Link information will be sent on 
the entire channel instead of just one bit, more than enough for all the 
MIDI you could ever hope to use. The downside is that you can no 
longer use this ASIO channel for audio transfer (do not connect it to a 
speaker!), thus leaving you only 7 channels of audio in our ADAT ca-
ble example. Depending on how you work this might be a reasonable 
compromise.
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Hearing the network audio

If you are using an external mixing desk, hearing your audio really isn't 
an issue – just plug the outputs of each computer into the desired 
channels on the external mixing desk, press Play on one of the com-
puters, and you're good to go.

However, many people prefer to mix internally inside the computer and 
just use a desk for monitoring (or maybe not use any external mixer at 
all). In this case you'll need to select one computer to be your “main 
mix computer” and send the audio from your other computers into this.

In the following example, we assume you are using two computers, 
with Computer 1 as your main mix computer and Computer 2 running 
two additional stereo audio tracks, an FX channel track with a reverb 
plug-in and a VST instrument plug-in with stereo outputs.

1. First you want to set things up so that you can listen to the audio play-
back from Computer 1.
In other words, you need an unused set of outputs, e.g. an analog stereo output, con-
nected to your monitoring equipment.

2. Go to Computer 2 and route each of the two audio tracks to a sepa-
rate output bus.
These should be busses connected to the digital outputs – let’s call them Bus 1 and 2.

3. Route the FX channel track to another VST System Link bus (Bus 3).

4. Route the VST instrument channel to yet another bus (Bus 4).

5. Go back to Computer 1 and check the corresponding four VST Sys-
tem Link input busses.
If you start playback on Computer 2, the audio should “appear” on the input busses on 
Computer 1. However, to mix these audio sources you need actual mixer channels:

6. Add four new stereo audio tracks on Computer 1 and route these to 
the output bus you use for listening, e.g. to the analog stereo outputs.

7. For each of the audio tracks, select one of the four input busses.
Now, each Computer 2 bus is routed to a separate audio channel on Computer 1.

8. Activate monitoring for the four tracks.
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If you now start playback, the audio from Computer 2 will be sent 
“live” to the new tracks on Computer 1, allowing you to hear them to-
gether with any tracks you play back on Computer 1.

Adding more tracks

OK, but if you have more audio tracks than you have VST System Link 
busses (physical outputs)? Then you just use the Computer 2 mixer 
as a submixer: Route several audio channels to the same output bus 
and adjust the output bus level if needed.

Note also that if your audio cards have multiple sets of input and out-
put connections you can link up e.g. multiple ADAT cables and send 
audio via any of the busses on any of the cables.

Internal mixing and latency

One problem with mixing inside the computer is the latency issue we 
mentioned earlier. The VST engine always compensates for record la-
tencies, but if you are monitoring through Computer 1 you will hear a 
processing delay while you listen to signals coming from your other 
computers (not on your recording!). If your audio card in Computer 1 
supports ASIO Direct Monitoring you should definitely turn this on – 
you'll find the setting in the VST Audiobay Device Setup panel (see 
page 63). Most modern ASIO cards support this function. If yours 
doesn't you may want to change the Offset value in the VST System 
Link Setup panel to compensate for any latency issues.

Setting up a larger network

This is not much more difficult than a two computer network. The main 
thing to remember is that VST System Link is a daisy chain system. In 
other words, the output of Computer 1 goes to the input of Computer 
2, the output of Computer 2 goes to the input of Computer 3, and so 
on around the chain. The output of the last computer in the chain must 
always go back into the input of Computer 1, to complete the ring.

Once you've done this, the transmission of all the transport, sync, and 
MIDI information to the whole network is handled pretty much auto-
matically. However, where you may run into confusion in a large net-
work is in the transmission of audio signals back to a central mix 
computer.
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If you have lots of hardware inputs and outputs on your ASIO cards you 
don't need to send audio via the chain at all, but can transmit it directly 
to the master mix computer via one or more of its other hardware In-
puts. For example, if you have a Nuendo Digiset interface or 9652 card 
on Computer 1 you could use ADAT cable 1 for networking, ADAT ca-
ble 2 as a direct audio input from Computer 2, and ADAT cable 3 as a 
direct audio input from Computer 3.

You can also transmit audio via the ring system if you don't have 
enough hardware I/Os for direct audio transmission. For example, in a 
four computer scenario you could send audio from Computer 2 into a 
channel in the mixer in Computer 3, and from there to a channel in the 
mixer in Computer 4, and from there back to the master mixer in Com-
puter 1. This can certainly be tricky to set up, so generally it is recom-
mended that if you want to set up a complex network, you should 
make sure to use ASIO cards with at least three separate digital I/Os. 
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Application examples

Using one computer for VST instruments

In this example, you are using one computer as your main record and 
playback machine, and want to use another computer as a virtual 
synth rack.

1. Record a MIDI track into Computer 1.

2. Once you have finished recording, route the MIDI output of that track 
to System Link MIDI port 1.

3. Now go to Computer 2, open up the VST Instrument rack and assign 
an instrument to the first slot in the rack.

4. Route the VST Instrument channel to the desired output bus.
If you are using Computer 1 as your main mixing computer, this would be one of the 
VST System Link output busses, connected to Computer 1.

5. Create a new MIDI track in the Project window of Computer 2, and 
assign the MIDI output of the track to the VST Instrument you created. 

6. Assign the MIDI input of the track to be VST System Link port 1.
Now, the MIDI track on Computer 1 is routed to the MIDI track on Computer 2, which 
in turn is routed to the VST Instrument.

7. Now activate monitoring for the MIDI track on Computer 2, so that it 
will listen and respond to any MIDI commands coming in.
In Nuendo, you would click the monitor button in the Track list or Inspector.

8. Press play on Computer 1.
It will now send the MIDI information on the track to the VST Instrument loaded on 
Computer 2.

Even with a slow computer you should be able to stack a whole bunch 
of extra VST Instruments this way, expanding your sound palette con-
siderably. Don't forget that VST System Link MIDI is also sample ac-
curate, and thus has much tighter timing than any hardware MIDI 
interface ever invented!
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Creating a virtual effect rack

The effect sends for an audio channel in Nuendo can either be routed 
to an FX channel track or to any activated Group or output bus. This 
allows you to use a separate computer as a “virtual effect rack”, by 
setting things up in the following way:

1. Go to Computer 2 (the machine you will use as effect rack) and add a 
new stereo audio track.
You cannot use an FX channel track in this case, since the track must have an audio 
input.

2. Add the desired effect as an insert effect for the track.
Let’s say you add a high-quality reverb plug-in.

3. In the Inspector, select one of the VST System Link busses as input 
for the audio track.
You want to use a separate System Link bus, which will only be used for this purpose.

4. Route the channel to the desired output bus.
If you are using Computer 1 as your main mixing computer, this would be one of the 
VST System Link output busses, connected to Computer 1.

5. Activate monitoring for the track.

6. Now, go back to Computer 1 and select a track to which you want to 
add some reverb.

7. Bring up the effect sends for the track, in the Inspector or the mixer.

8. Pull down the send routing pop-up menu for one of the sends, and 
select the VST System Link bus assigned to the reverb in step 3.

9. Use the send slider to adjust the amount of effect as usual.

The signal will be sent to the track on Computer 2 and processed 
through its insert effect, without using any processor power on Com-
puter 1.

You can repeat the steps above to add more effects to the “virtual ef-
fect rack”. The number of effects available this way is only limited by 
the number of ports used in the VST System Link connection (and of 
course by the performance of Computer 2, but given that it won’t have 
to handle any recording or playback, you should be able to use quite a 
lot of effects).
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Getting extra audio tracks

All computers on a VST System Link network are locked with sample 
accuracy. Therefore, if you find that the hard drive on one computer 
isn’t fast enough to run as many audio tracks as you need, you could 
record new tracks on one of the other computers instead. This would 
create a “virtual RAID system”, with several disks all operating to-
gether. All tracks will remain locked together just as tightly as if they 
were all running on the same machine. This means that you effectively 
have an unlimited track count! Need another 100 tracks? Just add an-
other computer.

Dedicated Video Playback

Playback of high-resolution video can be taxing on a system’s CPU. 
By dedicating one computer for video playback via System Link, you 
can free up resources on your main CPU for audio and MIDI process-
ing. Since all transport commands will respond on the System Link 
computers, scrubbing video is possible even when it is coming from 
another computer. Spotting sound effects to picture in Edit Mode will 
work the same way as it does on one computer. This is a viable and 
economic alternative to dedicated hard disk video systems like the 
Doremi V1.
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Background

Video support in Nuendo

Nuendo plays back video films in a number of formats. 
Under Windows, video playback can be done using the playback 
engines DirectShow, DirectX Video or Quicktime. 
Under Mac OS X, Quicktime is always used as playback engine.

There are several ways to play back video:

• Without any special hardware.
While this will be fine in many situations it does put a limit on the size of the internal 
video window as well as the quality of the image.

• Using FireWire (Mac OS X)
Using a FireWire port, you can play back video on an external monitor using a DV-to-
analog converter or a DV camera.
This is valid for DV video and QuickTime is used for playback and can reduce the load 
on the CPU since the external device is decoding the DV video stream.

• Using Graphics cards (Windows).
Multi-head graphics cards which support overlay functionality can be used to display 
the video picture on an external monitor. As of this writing, the following manufacturers 
have working solutions available: nVIDIA and Matrox.

• Using Video cards.
Video cards can also be used to display the video on an external monitor. Please note 
that this utilizes some of the CPU to process the video data. As of this writing, the fol-
lowing cards can be used:
Mac OS X: Decklink (Blackmagic)
Windows: Liquid Chrome (Pinnacle Systems) and Decklink (Blackmagic).
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Operations

About the video playback engine

In Nuendo for Windows, you select a playback engine in the Device 
Setup - Video Player page.

What playback engine to select depends largely on which type of 
video system you are using, as well as on the file format and codec of 
the video files you want to work with. 

• As a general rule, Nuendo should be able to use a certain video file, if 
the native video player on your system (Windows Media Player on the 
PC or Quicktime Player on the Mac) can play this file. Make sure to read 
the section “Before you start” on page 625.

• Generally, you can expect most Windows hardware to work with Direct-
Show and DirectX Video.
On a Windows system, the DirectShow and DirectX Video players are provided by the 
operating system, you don’t have to install any additional software. Make sure you are 
using the latest version of DirectX software available from Microsoft’s website.

• For the Quicktime playback method to be available, you must have 
QuickTime installed on your computer.
There is a freeware version (a QuickTime installer is included on the Nuendo DVD if re-
quired, or you can download it from www.quicktime.com) and a “pro” version, which 
offers additional video cutting options. The player engine is the same in both versions, 
so for mere playback in Nuendo there is no need to purchase the “pro” version.

Under Mac OS X, there is only one standard player option. The Quick-
time playback engine is always used, supporting the formats AVI, MPEG, 
QuickTime and DV. If your system has a FireWire port, there is also a 
FireWire option – see below.
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Importing a video file

Video files are imported in the same manner as audio files.

• By using the File menu (Import Video File).

• By using drag and drop.

• By importing to the Pool first and then dragging to the Project window 
(see the chapter “The Pool” for details).

Note:

• To be able to play back the video, you must add a video track (by using the 
Add Track submenu on the Project menu or Quick menu). You can only have 
one video track in each project.

• You can have multiple video files on the track but all files must be of the same 
size and compression format.

• You may trim video files in the project window as needed, adjusting the event 
boundaries as you would for an audio event.

• The Import submenu on the File menu has an option for extracting the audio 
from a video file – see page 623.

Adopting the Video Framerate

When using video files within Nuendo, it is important to set the 
project’s framerate to that of the imported video. This ensures that the 
time displayed in the SMPTE readout of Nuendo corresponds to the 
actual frames in the video.

1. Pull down the Project menu and select “Project Setup...” (or press 
[Shift]+S) to open the Project Setup dialog.

2. If a video file has been placed on a video track in the Project window, 
a button now appears in the framerate section of the Project Setup di-
alog called “Get From Video.” This will automatically detect the frame-
rate of the video file and apply that setting to the project.

The framerate setting will change to that of the video file and the project 
start time will be altered to reflect the change in framerate if needed. For 
example, when switching the project framerate from 30fps to 29.97fps, 
the start time will be changed so that all the events currently in the project 
will remain at the same positions in relation to realtime. If you want the 
project start time to remain the same, you must manually change it back 
after pressing the “Get From Video” button.
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Playing back a video file

Video files are displayed as events/clips on the video track, with 
thumbnails representing the frames in the film (if the option Show 
Video Thumbnails is activated in the Preferences).

A video event on a video track.

In the track list and Inspector, you will find two options for how the 
thumbnails should be shown:

To view the video on the computer screen (as opposed to on an exter-
nal monitor, see below), proceed as follows:

• First open the Device Setup dialog from the Devices menu, click 
Video Player in the list and make sure “Onscreen Window” is se-
lected in the Video Output section of the dialog. 

• Pull down the Devices menu and select Video (or use a key command 
– by default [F8]).
A video window appears. In Stop mode, this displays the video frame at the project 
cursor position.

Playback of the video is performed together with all other audio and 
MIDI material, using the Transport panel.

Button Description

Show Frame 
Numbers

When this is activated, each thumbnail is shown with the corre-
sponding video frame number.

Snap Thumbnails When this is activated, the individual thumbnail images will be 
positioned exactly at their respective start time position. Also, no 
more than one thumbnail per frame will be shown, even if you 
zoom in a lot.
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Setting the Window size

If you are playing back video in a window on your computer screen, 
you may want to adjust the size:

• If you are using Direct Show, open the Device Setup dialog from the 
Devices menu, click Video Player in the list and use the Video Win-
dow buttons to select a size.

• If you are using DirectX or QuickTime, the window is fully sizable: Just 
click and drag its’ edges to adjust the window size.

Playing back video in full screen mode

When viewing video on the computer screen you can choose to let 
the video occupy the whole screen, during playback or in Stop mode:

• Right-click (Win) or [Ctrl]-click (Mac) in the video window to switch to 
full screen. Click again to exit full screen.

Disabling Video Playback

In the track list area and Inspector of a video track, there is a mute but-
ton. (Note that this can be hidden for the track list area, see page page 
680.) When you mute a video track, the video will not play and the 
CPU resources it used will be freed up for other purposes. When per-
forming complex editing tasks that do not require watching the video, 
temporarily muting the video track can help speed up performance of 
Nuendo by reducing the strain on the CPU.

Using Video Pull-up and Pull-down

Using either the DirectX or the Quicktime player, it is possible to play-
back movie files at a slightly different speed than normal (+/- 0.1%) in 
order to compensate for speed changes made during a film transfer or 
telecine process.

When film is transferred to NTSC video tape, a process known as 2-
3 pull-down occurs that allows film at 24 frames per second (fps) to 
be transferred to video at 29.97 fps in a regular manner. This process 
requires that the film be slowed down by 0.1% in order to have a di-
rect mathematical relationship to the video tape’s framerate. To keep 
the audio in sync with the video, it too must be slowed down by the 
same amount.
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Since most film productions record audio to DAT machines or other 
portable digital recorders at 48kHz, the resulting speed change during 
transfer to video yields a very odd samplerate of 47.952kHz (called 
48kHz pull-down). Normally, this is transferred to the video tape via 
analog connections, thereby avoiding the equipment needed to per-
form a samplerate conversion back to 48kHz.

However, many post production professionals prefer to use the origi-
nal source tapes when working on a film instead of the audio from the 
film transfer to video. This requires dealing with the speed change re-
sulting from the telecine process. There are two ways to go about this.

• One way is to import the original source audio from the DAT tapes and 
adjust the sample clock of the audio hardware to run at 47.952kHz 
(48kHz pull-down), so that the audio stays in sync with the video 
transfer. (Most films are edited on video and then transferred back to 
film for the final version, reversing the 2-3 pull-down process.)
Once the film’s soundtrack is completed, the audio clock is returned to 48kHz to make 
a final audio mix that will then stay in sync with the final film print running at 24fps. This 
requires an audio clock source capable of running at the pulled down samplerate 
(47.952kHz).

• The second, and simpler, option is to speed the video back up to the 
original film speed. That way the audio clock can run at 48kHz and re-
main in sync with the video. This avoids expensive audio master clocks 
and confusing transfer processes. This is possible with digital video 
files used within Nuendo.
Both the DirectX and Quicktime players have the option of playing back the video at 
normal speed, pull-up speed (+0.1%) or pull-down speed (-0.1%). Typically, the pull-
up speed would be used more often since it correlates to common film making prac-
tices. The video pull-down speed would only be used in special situations or to correct 
an error that has occurred somewhere during the transfer process. There might be a 
rare instance when you have a 24fps video file that you want to playback at video 
speed which would require using the video pull-down function.

Here are some basic conventions regarding film and NTSC video:

• 48kHz audio is running at film speed.
• 47.952 or 48kHz pull-down is film audio running at video speed.
• Video pull-up is running at film speed.
• SMPTE running at 30fps is for audio running at film speed.
• SMPTE running at 29.97 is running at NTSC video speed.
• SMPTE running at 29.97 is also film audio running at video speed or pulled-

down.
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The relationship between film and PAL video is different. The 0.1% video 
pull-up does not work for PAL systems. The descriptions above apply to 
NTSC video systems.

Playing back a video file via FireWire (Mac OS X only)

For Apple computers equipped with a FireWire port, you can easily 
use this to connect to external video hardware, as OS X has built-in 
video support for the most common formats (NTSC/PAL/DVCPRO). 
FireWire is capable of high data-transfer speed and is the most com-
mon standard for communicating with video-related peripheral equip-
ment.

• To play back a video file via hardware connected to the FireWire port, 
select “FireWire” in the Outputs pop-up of the Device Setup–Video 
Player dialog.
When FireWire is selected as output, a number of format options appear on the For-
mat pop-up, allowing you to select between various video formats and resolutions.

• Adjust the Frame Offset value to compensate for DV processing delays in the 
external device.
Due to delays while processing DV video through the FireWire port, the video image will 
be behind or later than the corresponding audio in Nuendo. By using the frame offset 
parameter, you can compensate for this effect. Each hardware setup could have differ-
ent processing delays so you must experiment to determine what value is appropriate. 
Usually, 7 frames is a good starting point. All values for the frame offset are positive and 
indicate how many frames the video will be delivered earlier in order to compensate for 
the processing time.

• Note that there is a difference in the frame offset in stop versus play-
back. The frame offset is defeated in stop and scrub modes so that you 
can see the correct frame of video since the processing delays are not 
an issue in these modes. It is only used during playback when process-
ing delays are noticeable.
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Playing back a video file using graphics cards (Windows only)

Multi-head graphics cards which support overlay functionality can be 
used to display the video picture on an external TV or computer mon-
itor in full screen mode. As of this writing, the manufacturers nVIDIA 
and Matrox have working solutions available. Check the card’s docu-
mentation for information on how it handles video output and how to 
set it up for multi-monitor display.

Playing back a video file using video cards

Video cards can also be used to display the video on an external TV or 
computer monitor. As of this writing, the following cards can be used:
Mac OS X: Decklink (Blackmagic)
Windows: Liquid Chrome (Pinnacle Systems) and Decklink (Black-
magic). For further information, check the documentation of the video 
card.

Extracting audio from a video file

If a video file contains audio, it can be extracted. Regardless of the au-
dio format in the actual file, the imported audio file will always be in the 
format (Sample Rate and Record Format) that is specified for the 
Project in the Project Setup dialog.

There are three ways to extract audio from a video file:

• By checking the Extract audio option in the Import Video dialog.
This will add the audio to the currently active audio track. The new audio event will start 
at the same time as the video event, so that they are in sync with each other.

• By using Import Audio from Video File from the File menu.
This is just as above, but no video clip is created, only an audio event (starting at the 
project cursor position on the selected track).

• By using Extract Audio from Video File on the Pool menu.
This creates an audio clip in the Pool, but doesn’t add any events to the Project window.

These functions are not available for mpeg video files.
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Replacing the audio in a video file

Nuendo has a special function for replacing the audio in a video file:

1. Pull down the File menu and select Replace Audio in Video File.

2. In the file dialog that appears, locate and select the video file on your 
hard disk, and click Open.
A new file dialog appears.

3. Locate and select the audio file that you want to insert into the video 
file, and click Open.
The audio is added to the video file, replacing its current audio track (if any).

• By combining the functions Extract Audio, Export Audio Mixdown and 
Replace Audio in Video File, you can create a complete audio track for 
a video file.

Project window and Browser editing operations

Video clips are played back by events just as audio clips are. You can 
use all the basic editing operation on video events, just as with audio 
events. The following operations are not possible on the video track:

• Drawing, Gluing, Muting and Scrubbing.

• The video track has no editor and does not make use of parts.

Pool operations

For more about operations on video clips in the Pool, see page 499.
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Before you start

When working on a project involving a video file, there are several 
points to bear in mind:

Have you selected the right player?

The player is used not only for playback of the video file, but also to pro-
vide file information in the Pool and in the Import Video dialog. There-
fore, to make sure that you have chosen the right player for a particular 
type of video file, check the file information displayed in the Import 
Video dialog or the Pool prior to trying to import or playing back the file.

When this information reads “0x0 pixel”, “0.000 s” and “0 Frames”, 
the video file is either corrupt, or the format is not supported by the 
codecs available to the selected video player. You will either have to 
change the video player, or install the required codec.

Trying to import or play back a file not supported by the selected video 
player leads to unpredictable results – if no information on the number 
of frames, the length and the pixel resolution is available in the Import 
Video dialog or the Pool, you cannot import/play this file properly with 
this particular video player.

You can change the video player in the Device Setup dialog. After hav-
ing done so, make sure to remove any previously imported video file 
from the Pool first, and re-import it.

Editing a video file

Nuendo allows you to cut, copy, paste and trim video events, i.e. your 
video track may contain more than one video event. Make sure that 
these video files are of the same file format and resolution in order for 
them to play properly. 

• When using the DirectShow video player on a Windows system, you may 
find that only the first event on the video track is played back correctly. 
In such a case make sure that the video track contains no more than 
one video event. When you need to edit your video files (i.e. cut, copy, 
paste or trim video events), it is therefore recommended to use the Di-
rectX Video player.



NUENDO
27 – 626 Video

When working with a Windows operating system, you may find that 
you are unable to edit a video file copied from a CD. This is because 
files copied from CD are write protected by default. Right-click the file, 
and uncheck the “Read-Only” option in the File Properties dialog.

When you have a video file in a format not supported by Nuendo, use 
an external application to convert it to a format that Nuendo can import.

Options

In the Preferences dialog (Event Display–Video page), there are two 
options for video playback:

• Show Video Thumbnails.
When this is activated, thumbnail frames of the video contents are shown in the track.

• Video Cache Size.
This determines how much memory is available for video thumbnails. If you have long 
video clips and/or work with a large zoom factor (so that a lot of frames are shown in 
the thumbnails), you may have to raise this value.

The Edit Mode

Video playback follows the Nuendo transport, so that the video frame 
at the current project cursor position is shown, during playback and in 
Stop mode (e.g. if you move the project cursor manually or use fast 
forward/rewind). Nuendo has a special Edit Mode that makes use of 
this fact, allowing you to edit audio while getting continuous visual 
feedback on the video display:

• If you activate “Edit Mode” on the Transport menu, the project cursor 
will automatically follow when you make selections or perform editing 
operations (such as moving, resizing, adjusting fades, etc.).
Since the video automatically follows the project cursor, you will instantly get a visual 
feedback when you edit! This makes it very easy to e.g. move an audio event to a cer-
tain spot in the video.

• To avoid obscuring the view, the project cursor will be hidden from the 
event display in Stop mode if Edit Mode is selected.
However, it will still be shown in the ruler. 
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Application Examples

Listed below are three examples of how you can use Nuendo’s Edit 
Mode for matching audio and MIDI to video.

1. If required, set the snap point in the audio event so that it identifies a 
significant point in the audio recording.
This would be the position in the audio that you want to match to a certain position in the 
video. If you don’t set the snap point, the start of the audio event will be used instead.

2. Activate Edit Mode on the Transport menu.

3. Select the audio event.
The project cursor position is automatically moved to the position of the snap point.

4. While watching the video display, move the audio event towards the 
correct position.
Since the project cursor automatically follows the snap point position and the video 
automatically follows the project cursor, you just need to move the event until the de-
sired video frame is displayed!

If you have a video section and an audio event for it, that doesn’t quite 
fit, you can use time stretch to change the length of the audio:

1. Use the method described above to position the start of the audio 
event at the correct position according to the video.

2. In Edit Mode, select the Range Selection tool and double click in the 
audio event.
This creates a selection range that spans the whole audio event.

3. Click the right edge of the selection range and drag to adjust it to the 
desired length.
While you are dragging, the project cursor position follows the right edge of the range, 
allowing you to pinpoint the desired end position in the video.

4. Use “Locators to Selection” (on the Transport menu) to set the locators 
to the selection range you just made.

5. With the Arrow tool, select the audio clip to be stretched.

6. Select Time Stretch from the Process submenu on the Audio menu.

7. Click the Set To Locators Range button.
The time stretch factor is set up so that the audio event will fit the locator range.

Make sure you don’t exceed the 75% to 125% limit!
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8. Make Accuracy and Algorithm settings as desired, and click Process.
The audio is stretched or compressed to fit the range.

If you want the audio to fade in, reaching full volume at a certain posi-
tion in the video, and fade out at another position, here is a quick way 
of achieving this:

This assumes that the audio event is already positioned and sized cor-
rectly according to the video.

1. In Edit Mode, select the Range Selection tool.

2. Make a selection range in the audio event, roughly covering the sec-
tion that should be played at full volume.

3. Click and drag the edges of the selection range so that they exactly 
correspond to the end of the fade-in and the start of the fade-out, re-
spectively.
While you are dragging, the project cursor position follows the edge of the range, al-
lowing you to pinpoint the desired fade-in and fade-out position in the video.

4. Pull down the Audio menu and select “Adjust Fades to Range”.
The fade-in and fade-out handles of the audio events are automatically adjusted.

• When using the Fades handles of an audio event in Edit Mode, the cursor 
will follow their position as well, allowing you to adjust fades to picture in 
this manner.
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Introduction

ReWire and ReWire2 are special protocols for streaming audio be-
tween two computer applications. Developed by Propellerhead Soft-
ware and Steinberg, ReWire provides the following possibilities and 
features:

• Real-time streaming of up to 64 separate audio channels (256 with 
ReWire2), at full bandwidth, from the “synthesizer application” into 
the “mixer application”.
In this case, the “mixer application” is of course Nuendo. An example of a “synthesizer 
application” is Propellerhead Software’s Reason.

• Automatic, sample accurate synchronization between the audio in the 
two programs.

• The possibility to have the two programs share one sound card and 
take advantage of multiple outputs on that card.

• Linked transport controls that allow you to play, rewind etc, either from 
Nuendo or from the synthesizer application (provided it has some kind 
of transport functionality).

• Automatic audio mixing functions of separate channels as required.
In the case of Reason for example, this allows you to have separate mixer channels for 
the different devices.

• Additionally, ReWire2 offers the possibility to route MIDI tracks in 
Nuendo to the other application, for full MIDI control.
For each ReWire2 compatible device, a number of extra MIDI outputs will be made 
available in Nuendo. In the case of Reason, this allows you to route different MIDI 
tracks in Nuendo to different devices in Reason, having Nuendo serve as main MIDI 
sequencer.

• Less total system requirements than when using the programs together 
in the conventional way.
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Launching and quitting

When using ReWire, the order in which you launch and quit the two 
programs is very important:

Launching for normal use with ReWire

1. First launch Nuendo.

2. Enable one or several ReWire channels in the ReWire Device dialog 
for the other application.
This is described in detail on page 632.

3. Launch the other application.
It may take slightly longer for the application to start when you are using ReWire.

Quitting a ReWire session

When you are finished, you also need to quit the applications in a 
special order:

1. First quit the synthesizer application.

2. Then quit Nuendo.

Launching both programs without using ReWire

We don’t know exactly why you would want to run Nuendo and the 
synthesizer application at the same time on the same computer, with-
out using ReWire, but you can:

1. First launch the synthesizer application.

2. Then launch Nuendo.

Please also note that the two programs now compete for system re-
sources such as audio cards, just as when running either with other, 
non-ReWire audio applications.
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Activating ReWire channels

ReWire supports streaming of up to 64 separate audio channels, 
while ReWire2 supports 256 channels. The exact number of available 
ReWire channels depends on the synthesizer application. Using the 
ReWire Device panels in Nuendo, you can specify which of the avail-
able channels you want to use:

1. Pull down the Devices menu and select the menu item with the name 
of the ReWire application. All recognized ReWire compatible applica-
tions will be available on the menu.
The ReWire panel appears. This consists of a number of rows, one for each available 
ReWire channel.

The ReWire panel for Reason.

2. Click on the power buttons to the left to activate/deactivate the de-
sired channels.
The buttons light up to indicate activated channels. Please note that the more ReWire 
channels you activate, the more processing power is required.

• For information about exactly what signal is carried on each channel, 
see the documentation of the synthesizer application.
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3. If desired, double click on the labels in the right column, and type in 
another name.
These labels will be used in the Nuendo mixer to identify the ReWire channels.

Using the transport and tempo controls

This is only relevant if the synthesizer application has some sort of built-
in sequencer or similar.

Basic transport controls

When you run ReWire, the transports in the two programs are com-
pletely linked. It doesn’t matter in which program you Play, Stop, Fast 
Forward or Rewind. However, recording (if applicable) is still com-
pletely separate in the two applications.

Loop settings

If there is a loop or cycle facility in the synthesizer application, that 
loop will be completely linked to the Cycle in Nuendo. This means that 
you can move the start and end point for the loop or turn the loop on 
or off in either program, and this will be reflected in the other.

Tempo settings

As far as tempo goes, Nuendo is always the Master. This means that 
both programs will run in the tempo set in Nuendo.

However, if you are not using the Tempo track in Nuendo, you can ad-
just the tempo in either program, and this will immediately be reflected 
in the other.

If you are using the Tempo track in Nuendo (if the Tempo button is acti-
vated on the Transport panel), you should not adjust the tempo in the 
synthesizer application, since a tempo request from ReWire will auto-
matically deactivate the Tempo switch in Nuendo!
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How the ReWire channels are handled in 
Nuendo

When you activate ReWire channels in the ReWire Device panels, 
they will become available as channel strips in the mixer. The ReWire 
channel strips have the following properties:

• ReWire channels appear to the right of the other audio and MIDI 
channel strips in the mixer.
ReWire channel strips are denoted by a yellow label in the mixer.

• ReWire channels may be any combination of mono and stereo, de-
pending on the synthesizer application.

• ReWire channels have the same functionality as regular audio channels.
This means you can set volume and pan, add EQ, insert effects and sends and route 
the channel outputs to groups or busses (done in the Inspector or in the mixer). How-
ever, ReWire channels have no monitor buttons.

• All ReWire channel settings can be automated using the Read/Write 
buttons.
When you write automation, channel automation tracks will automatically appear in the 
Project Window. This allows you to view and edit the automation graphically, just as 
with VST Instrument channels, etc.

• You can mix down the audio from ReWire channels to a file on your 
hard disk with the Export Audio Mixdown function (see page 551).
In Nuendo, you can export the output bus to which you have routed the ReWire chan-
nels. You can also export individual ReWire channels directly – “rendering” each Re-
Wire channel to a separate audio file.



NUENDO
ReWire 28 – 635

Routing MIDI via ReWire2

This feature is only available with ReWire2-compatible applications.

When using Nuendo with a ReWire2-compatible application, addi-
tional MIDI outputs will automatically appear on the MIDI Output pop-
up menus for MIDI tracks. This allows you to play the synthesizer ap-
plication via MIDI from Nuendo, using it as one or several separate 
MIDI sound sources.

The MIDI outputs for a Reason song. Here, each output goes directly to a device in 
the Reason rack.

• The number and configuration of MIDI Outputs depends on the syn-
thesizer application.
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Considerations and limitations

Sample rates

Synthesizer applications may be limited to audio playback in certain 
sample rates. If Nuendo is set to a sample rate other than those, the 
synthesizer application will play back at the wrong pitch. Consult the 
documentation of the synthesizer application for details.

ASIO drivers

ReWire works well with ASIO drivers. By using the Nuendo bussing 
system you can route sounds from the synthesizer application to vari-
ous outputs on an ASIO compatible audio card.
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File Operations

New Project

The New Project command on the File menu allows you to create a 
new project, either empty or based on a template:

1. Select New Project from the File menu.
A list of templates is displayed. When you install Nuendo, templates for various pur-
poses are included, but you can also create your own (see page 641).

2. Select a template from the list, or select “Empty”.
A file dialog appears, allowing you to specify a folder for the new project.

3. Select an existing project folder or create a new one by typing its 
name in the dialog.
A new, untitled project is created.

Open

The Open command on the File menu is used for opening saved 
project files. Both Nuendo project files (extension “.npr”) and project 
files created in Steinberg’s Cubase SX/SL (extension “.cpr”) can be 
opened (although Cubase-specific settings will be ignored).

• Several projects can be open at the same time.
The active project is indicated by the blue Activate button in the upper left corner of 
the Project window. To make another project active, click its Activate button.

An active project.

• You can also open project files by selecting a shortcut from the 
“Recent Projects” submenu on the File menu.
This submenu lists the projects you have recently worked with, with the most recent 
one at the top of the list.

• Projects can also automatically be opened when you launch Nuendo 
(see page 669).
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About the “Pending Connections” dialogs

If you open a Nuendo project created on another setup (other audio 
hardware), the program tries to find matching audio inputs and outputs 
for the i/o busses (this is one of the reasons why you should use de-
scriptive, generic names for your input and output ports – see page 17).

If the program cannot resolve all audio inputs and outputs used in the 
project, a Pending Connections dialog will appear. This will allow you 
to manually re-route any ports specified in the project to ports avail-
able in your system.

Similarly, a Pending Connections dialog will appear if you open a 
project with MIDI ports that don’t match the current MIDI setup. 
Again, use the dialog to re-route ports.

Close

The Close command on the File menu closes the active window. If a 
Project window is active, selecting Close will close the corresponding 
project.

• If the project contains unsaved changes, you will be asked whether 
you want to save the project before closing it.
If you select “Don’t Save”, and have recorded or created new audio files since saving, 
you get the choice to delete or keep these.

Save and Save As

The commands Save and Save As allow you to save the active project 
as a project file (file extension “.npr”). The Save command stores the 
project under its current name and location, while Save As allows you 
to rename and/or relocate the file. If you haven’t yet saved the project, 
or if it hasn’t been changed since it was last saved, only Save As will 
be available.

Generally, we recommend that you save project files in their project 
folders, to keep the projects as manageable as possible.
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A word about file extensions

Under Windows, file types are indicated by three letter file name exten-
sions (such as *.npr for Nuendo project files). Under Mac OS X, it is not 
necessary to use file name extensions, since the file types are stored in-
ternally in the files. However, if you want your Nuendo projects to be 
compatible with both platforms, you should make sure the option “Use 
File Extension in File Dialog” is activated in the Preferences dialog – this 
is the default setting. When this is activated, the proper file name exten-
sion is automatically added when you save a file.

Saving a Default project

If you always want the same default project to open when you launch 
Nuendo, you can save a default project:

1. Set up a project the way you want it.

2. Select “Save As” from the File menu and save the project with the 
name “default.npr”. The location depends on the operating system:
Mac OS X: the folder “Library/Preferences/Nuendo/” in your “home” directory. The full 
path would be: Users/<user name>/library/preferences/Nuendo. 
Windows: Among the User Settings for Nuendo. The full path is:
\Documents and Settings\<user name>\Application Data\Steinberg\Nuendo\

This is the one case when the file name extension is crucial under Mac 
OS X as well!

3. Open the Preferences dialog and select the General page.

4. Open the “On Startup” pop-up and select “Open Default Project”.
The next time you launch Nuendo, the default project is automatically opened. For de-
tails on the other Startup options, see page 669.
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Save New Version

This function is only available as a key command, by default 
[Ctrl]+[Alt]+S (Windows) or [Command]+[Option]+S (Mac). When 
you use this function, a new version of the project is saved (or in other 
words, the project is saved under a new name). The new file will have 
the same name as the original project but with an incremental number 
attached. For example, if your project is called “My Project” you will 
get new versions called “My Project-01”, “My Project-02”, and so on.

Save New Version is useful if you are experimenting with edits and ar-
rangements and want to be able to go back to a previous version at 
any time. The most recent new versions you have created will be listed 
on the Recent Projects submenu on the File menu, for instant access.

Save as Template

This function allows you to save the current project as a template. Tem-
plates are always stored in the Templates folder, which on a Windows 
system is created under \Documents and Settings\<username>\Ap-
plication data\Steinberg\Nuendo 3\templates. On the Mac they are 
stored inside /Users/<username>/Library/Preferences/Nuendo 3. 
When you create a new project, the available templates will be listed, 
allowing you to base the new project on a template.

• Templates can contain clips and events, just like regular projects.
If this is not what you want, make sure to remove all clips from the Pool before you save 
the project as a template.
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Save Project to New Folder

This function is very useful if you want to move or archive your project. 
If you select this item, you will first be asked where to store the saved 
project. Then a dialog will appear, with the following options:

When you’ve made your settings, click OK to save the project in the 
new folder. The original project isn’t removed or affected.

Revert

If you select Revert from the File menu, you will be asked whether you 
really want to revert to the last saved version of the project. If you click 
“Revert”, all changes you have made since saving will be discarded.

• If you have recorded or created new audio files since saving, you will 
be asked whether you want to delete or keep these.

Item Description

Project Name By default, this will be the current name of the project you’re saving, 
but you can change it if you like.

Minimize 
Audiofiles

If this is activated, only the audio file portions that are actually used in 
the project will be included. This can significantly reduce the size of 
the project folder (if you are using small sections of large files), but it 
will also mean you cannot make use of the remaining audio file por-
tions if you continue working with the project in its new folder.

Freeze Edits This will perform a Freeze Edits operation, making all processing and 
applied effects permanent to each clip in the Pool. See page 391.

Remove Unused 
Files

When this is activated, only files in the Pool that are actually used in 
the project will be stored in the new folder.
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Working with Libraries

A Library is a stand-alone Pool, that is not associated with a project 
file. You can use Libraries to store sound effects, loops, Video Clips, 
etc., and transfer media from a Library into a project by using drag and 
drop. The following library functions are available on the File menu:

New Library

Creates a new library. Just as when creating new projects, you will be 
asked to specify a project folder for the new library (in which media 
files will be stored). The Library will appear as a separate Pool window 
in Nuendo.

Open Library

Opens a file dialog for opening a saved library file.

Save Library

Opens a file dialog for saving the library file (file extension “.npl”).

The Cleanup function

The Cleanup function on the File menu helps you to save hard disk 
space by locating, and if you like, deleting unused audio files in the 
project folders on your disk.

1. Select “Cleanup…” from the File menu.
If there are any open projects, an alert will appear, allowing you to close these. Clicking 
“Close” closes all open projects and brings up the Cleanup dialog.

2. If you want to restrict the Cleanup function to a certain folder only, 
click the “Search Folder” button and select the folder.
You should only select a specific folder if you are certain it doesn’t contain audio files 
used in other projects (outside the folder)! See the note below.
If you want the Cleanup function to be applied to all folders on all hard disks, you don’t 
need to make any special settings, as this is the default mode. After selecting a folder 
you can reset the function to search all folders by opening the “Search Folder” dialog 
again and clicking “Cancel”.
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3. Click the Start button.
Nuendo will now scan the selected folder (or all hard disks) for Nuendo project folders 
and check for audio and image files (in the Audio, Edits and Images subfolders) that 
are not used by any project. The found files are listed in the dialog.

4. When the scan is complete, you can select files by clicking in the list.
Use [Ctrl]/[Command]-click to select several files, and [Shift]-click to select a range of 
files. You can also click the Select All button to select all files in the list.

• There are situations when the Cleanup function will list files that are not 
unused! 
- If you have moved or renamed files or folders (without updating the project files to 
use the new paths), there is no way for Nuendo to know that these files are used in a 
project. 
- If you perform the Cleanup function on a folder in which there are audio files belong-
ing to other projects (outside the folder), these files will be considered “unused”. 
- Also, make sure you don’t delete any files used in other applications, or files that you 
generally want to keep!

However, you can safely delete Image files since these can be recon-
structed by the program if necessary.

5. Delete any files you don’t want to keep, by selecting them and clicking 
Delete.

6. Close the dialog by clicking its close button.
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Exporting and importing tracks

You can export Nuendo tracks (of any type) for later import into other 
Nuendo projects. Everything associated with the tracks will be ex-
ported (mixer channel settings, automation subtracks, parts and 
events etc.) and a separate “media” folder will be created, containing 
copies of all referenced audio files.

Project specific settings such as tempo are not part of the exported 
track files.

Exporting tracks

1. Select the tracks that you wish to export.

2. Pull down the File menu and open the Export submenu. 

3. On the submenu, select “Selected Tracks...”.
A file dialog appears allowing you to select or create (and name) an empty destination 
folder for the exported tracks.

4. Click OK.

The tracks will be saved in the specified folder, and will contain two 
items; a XML file named after the enclosing folder and a subfolder 
named “Media” which will contain any associated audio or video files.

Importing tracks

The Import Track Archive function lets you import track exported from 
another Nuendo project.

• Note that the sample rate used in the project you import tracks to has 
to match the sample rate in the original project!
If not, audio files will play back at the wrong speed.

1. Pull down the File menu and open the Import submenu.

2. On the submenu, select “Track Archive...”.

3. In the file dialog that appears, select the XML file and click Open.
The “Copy files to Project Folder?” dialog appears just like when importing audio files. 

4. Click Yes to copy the files into your current project or No to leave 
them in their current location.
The tracks are imported, complete with all contents and settings.
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Exporting and importing AAF files

The Advanced Authoring Format (AAF) is a multimedia file format used 
to exchange digital media and metadata between different systems 
and applications across multiple platforms. Designed by the top media 
software companies, including Pinnacle, this format will help media 
creators by allowing them to exchange projects between applications 
without losing valuable metadata such as fades, automation and pro-
cessing information.

Exporting AAF files

1. Select “AAF...” from the Export submenu on the File menu.

The Export Options dialog for AAF files.

2. You can choose which tracks will be exported from your project by 
clicking in the export column for each track name in the list.
A check mark will appear next to each track that will be exported. You may also click 
the “Select All” button to select every track in the project for export.

3. If you wish to only export the portion of project that is between the left 
and right locators, check the box marked “From Left to Right Locator.”
If an event crosses over the left or right locator, it will be trimmed in the AAF file to the 
point of the locator. Only the portions of events that lie within the boundaries of the lo-
cators will be included in the exported file.
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4. If you want to create copies of all the media files, choose the “Copy 
Media” option.
By default, the copied audio files are placed in a sub-directory in the export destination 
folder. To specify a different location for the copied files, use the Media Destination 
Path text field.

5. If you want to copy only the portions of audio files that are used in the 
project, select the Consolidate Events option. 
You can also define handle lengths in milliseconds to include audio outside each event 
boundary for fine tuning later. If you do not have any handles when consolidating audio 
files, you will not be able to adjust fades or edit points when the project is imported in 
another application.

• Even when selecting neither of the above two options, you can still enter 
a media destination path.
All file references will be set to this path. You can create references to media destina-
tions that don’t exist on the system you are currently working with, making it easy to 
prepare files for use in projects on another system or in an networked environment.

6. In the Options section, you have the choice of exporting all data to 
one file or to create media references to files from within the AAF file.
Exporting only one file makes transfers simpler, but, at the time of writing of this man-
ual, certain applications cannot handle single AAF files. Check with each software 
manufacturer for up-to-date information regarding AAF support in other applications.

7. You can choose the Sample Size by using the pulldown menu. 
This defaults to keeping the same setting as the project.

8. You can choose to quantize events to frame boundaries by checking 
the last option.
Quantizing events to frame boundaries is sometimes necessary when exporting projects 
to video workstations that limit the accuracy of edits to the frame. Any events that begin 
or end not on a frame boundary can exhibit odd behavior or be moved when imported 
into a workstation of this type.

Importing AAF files

1. Select “AAF...” from the Import submenu on the File menu.

2. Once you have selected a valid AAF file, Nuendo will ask you if you 
wish to create a new project. Choosing Yes will import tracks into a 
new project.
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3. Select a directory or create one for the new project. 
If you choose not to create a new project, the imported tracks will be added to the cur-
rently active project.

4. In the dialog that appears, select the tracks you wish to import by click-
ing in the Import column next to each track.
You can also click the Select All button to import all tracks in the AAF file.

5. Click OK.
The import process will begin. Depending on the size of the imported project and if the 
files are embedded or referenced, the import process may take a while.

Exporting and importing AES31 files

The AES31 standard is an open file interchange format, developed by 
the Audio Engineering Society as a means of overcoming format in-
compatibility issues between different audio hardware- and software. 
It can be used for transferring projects via disk or network from one 
workstation to another, retaining time positions of events, fades, etc.

AES31 uses the widely used Microsoft FAT32 file system with Broad-
cast Wave as the default audio file format. This means that an AES31 
file can be transferred to and used with any digital audio workstation 
that supports AES31, regardless of the type of hardware and software 
used, as long as the workstation can read the FAT32 file system and 
Broadcast Wave files (or regular wave files).

Exporting AES31 files

1. Select “AES31...” from the Export submenu on the File menu.

2. Select a name and location for the new file and click Save.
The exported file will contain all Audio Track data, including audio file references. If any 
of the audio events in your project has real-time fades (as set up with the fade handles 
for the events), these will automatically be converted to fade audio files and stored in a 
fades folder next to the AES31 file.

The following will not be included in the resulting AES file:

• Any mixer settings or automation made in Nuendo. 
• MIDI Tracks.

The saved file will be an xml file (but with the extension “.adl”, for audio 
decision list) – this means you can open it in any text editor to check 
file references etc.
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Importing AES31 files

1. Select “AES31...” from the Import submenu on the File menu.

2. Navigate to the location of the AES31 file (extension “.adl”), select it 
and click Open.
You are now prompted to select or create a project folder for the new project.

3. After specifying the name and location of the project folder, the new 
project opens containing all the audio tracks and events stored in the 
AES31 file.

Exporting and importing OMF files

Open Media Framework Interchange (OMFI) is a platform independent 
file format intended for transfer of digital media between different ap-
plications. Nuendo can import and export OMF files (file extension 
“.omf”), allowing you to use Nuendo in conjunction with other audio 
and video applications.

Exporting OMF files

1. Pull down the File menu and open the Export submenu. 

2. On the submenu, select “OMF...”.
The OMF Export Setup dialog appears.

3. Use the track list to the left to select which tracks should be included 
in the exported file.
To select all tracks, click the “Select All” button. Normally, the whole project is included 
- to export the range between the locators only, activate “From Left to Right Locator”.

4. Select “1.0 File” or “2.0 File” depending on which OMFI version is 
supported by the application in which you plan to import the file.

5. Select whether you want to include all audio data in the OMF file 
(“Export All to One File”) or use references only (“Export Media File 
References”).
If you choose “Export All to One File”, the OMF file will be totally “self-contained”, but 
possibly very large. If you choose “Export Media File References”, the file will be small, 
but the referenced audio files must be available for the receiving application.
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6. If you selected the “2.0 File” option above you can choose whether to 
include the volume settings and fades for the events (as set up with 
the event volume and fade handles) as well as the clip names – to in-
clude these in the OMF file, activate “Export Clip Based Volume”, 
“Use Fade Curves” and/or “Export Clip Names” respectively.

7. Specify a sample size (resolution) and sample rate for the exported 
files (or use the current project settings).

8. If you activate “Quantize Events to Frames”, the event positions in the 
exported file will be moved to exact frames.

9. Click OK, and specify a name and location in the file dialog that 
appears.

The exported OMF file will contain (or make reference to) all audio files 
that are played in the project (including fade and edit files). It will not in-
clude unused audio files referenced in the Pool, or any MIDI data. Video 
files are not included, but Nuendo stores the start positions of Video 
Events in the OMF file, allowing you to manually import video files in the 
other OMF application (see below).

Importing OMF files

1. Pull down the File menu and open the Import submenu.

2. On the submenu, select “OMF...”.

3. In the file dialog that appears, locate the OMF file and click Open.
A project file dialog appears, allowing you to specify a folder for the new project.

4. Select an existing project folder or create a new one by typing its 
name in the dialog.

5. If the OMF file contains Video Event information, you are asked whether 
you want to create Markers at the start position of the Video Events.
This allows you to manually import the video files, using the Markers as position refer-
ences.

A new, untitled project is created, containing the Audio Events of the 
imported OMF file.
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Exporting and importing OpenTL files

OpenTL is a file exchange format originally developed for Tascam hard 
disk recording systems. OpenTL facilities also appear in a variety of 
DAWs, making Nuendo project transfer reliable and solid. For example, 
a common use of OpenTL is to convert hassle free, between Nuendo 
and Pro Tools. If you import or export an OpenTL file to/from Nuendo, 
the resulting project will contain all audio files, edits, and track names 
made in the Tascam device or DAW, with all events positioned sample 
accurately on the time line.

OpenTL implementation in Tascam® MMR-8, MMP-16 and MX-2424

All three Tascam devices work with either two types of disk volume 
formats: FAT32 (Windows standard) or HFS+ (MacOS standard). For 
proper Nuendo compatibility it is necessary that each and every MMR-
8/MMP-16 be running OS v5.03 and MX-2424 v3.12. A number of 
crucial OpenTL updates only appear in these machine operating sys-
tems, and only this setup can assure reliable Nuendo exchange.

Audio file formats are volume type dependent: for FAT32 this is BWF 
(*.wav) and for HFS+ this is SDII. OpenTL files can only be trans-
ferred within file systems of the same format which means that it is not 
possible to import an OpenTL project exported from Mac (HFS+) into 
a Windows system (FAT32) or vice versa, unless you use a conver-
sion utility (e.g. MM-EDL).

Nuendo for Windows supports OpenTL FAT32/BWF. Nuendo for 
Mac OS X supports OpenTL HFS+/SDII as well as FAT32/BWF. 
MMR-8, MMP-16, and MX-2424 support OpenTL projects sourcing 
or targeting Nuendo PC with up to 999 mono tracks.

Exporting OpenTL files

First, make sure all audio files (in the audio Pool) and tracks (in the 
Project window) in the project are in mono (split stereo tracks and 
stereo interleaved audio files to dual mono) and all 16-bit or all 24-bit. 
The OpenTL specification does not include support for 32-bit audio 
files. If the project pool contains 32-bit audio files, these will not be 
exported. Make sure all referenced audio files are located on the drive 
to which you want to export the OpenTL file.
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When exporting OpenTL files on PC, do not change the DF or NDF frame 
notation after you have set the project start time. Make sure that all au-
dio files in the project pool have the same sample rate, bit depth, and 
that all are set to Broadcast Wave file type.

1. Select “OpenTL...” from the Export submenu on the File menu.
In the dialog that appears, activate the “Copy Media” or the “Consolidate Events” op-
tion to guarantee that all audio is exported. Locate the target hotswap FAT32 disk, se-
lect the appropriate project folder and click Open.

2. Select a name and location for the new file and click Save.
The exported file will contain all audio track data, including file references, clip based 
volume automation, fade-in, fade-out, and crossfades. 

3. Now you can mount the carrier in the Tascam device and load the 
project.

The following will not be included in the resulting OpenTL EDL file: 

• Any real-time mixing, EQ, effects settings, breakpoint automation tracks
• MIDI tracks made in Nuendo

The following is a basic OpenTL specification description:

• Maximum number of mono tracks: 999
• Supported samplerates (Hz): 44056, 44100, 44144, 47952, 48000, 48048, 

42294, 42336, 45938, 45983, 46034, 46080, 50000, 50050, 88200, 
96000

• Bit depth: 16, 24
• Audio file types: BWF (Broadcast Wave format), WAVE (Standard Wave), 

SDII (Sound Designer II)
• Volume formats: FAT32, NTFS, HFS+
• Automation support: clip based volume, breakpoint volume and mute
• Fade support: fade in, fade out, and cross fade
• Framerates (Fps): 24/24, 23.976/24, 24.975/25, 25/25, 29.97/DF, 

29.97/NDF, 30/DF, 30/NDF 

Importing OpenTL files

1. Select “OpenTL...” from the Import submenu on the File menu.

2. Navigate to the location of the OpenTL file, select it and click Open.
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3. You are now prompted to select or create a project folder for the new 
project.
After specifying the name and location of the project folder, the new project opens 
containing all the audio files stored in the OpenTL file and their associated edits. Save 
the imported file as a Nuendo project. 

4. Open the Pool, and select “Prepare Archive…” from the Pool context 
menu. 
This will copy any necessary external audio files into the local Nuendo project directory. 

5. Select the Save option from the File menu. 
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Importing XSend projects from Liquid

For Liquid users, XSend provides a means to export a Liquid se-
quence directly to a Nuendo workstation either on the same machine, 
over a network or via portable media such as DVD-R.

The XSend options and features are available only if XSend is in-
stalled on your computer. You can either install XSend during the Nu-
endo installation process, or at a later point in time using the XSend 
installer supplied on the Nuendo program DVD. Also, make sure the 
XSend plug-in is activated in the Plug-in Information dialog.

Proceed as follows to import XSend files:

1. You must designate the XSend Incoming folder by selecting the 
XSend preferences from the Nuendo File menu.
A dialog will appear allowing you to browse your system to select a folder where ex-
ported Liquid projects will be stored.

2. Export the Liquid project to the Nuendo system.
This can be done directly over a network if the two systems are connected by one. No 
file sharing is needed. All file transfers are handled by XSend. Refer to the Liquid sys-
tem’s documentation for more information on how to do this. You may also export the 
sequence to portable media such as DVD-R or CD-R discs for transfer when no net-
work is available.

3. From the File menu’s Import submenu, choose “XSend...”
Navigate to the exported Liquid sequence which will be an .XSD file type.

4. You will be asked if you wish to create a new project.
Choose Yes if you want to import the XSend sequence into a blank project. If you 
choose No, the imported sequence will be appended to the currently active project. 
The new audio tracks will appear below the lowest track or channel in the project. In ei-
ther case, both audio and video files can be included in the XSend sequence, provid-
ing a convenient means to receive entire projects from Liquid users.
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Importing Premiere Generic EDL files

You can transfer audio files and their associated edits from the Adobe 
Premiere application to Nuendo. This is made possible by rendering a 
“Generic EDL” file from a session in Premiere, and importing the re-
sulting file. 

Proceed as follows:

1. Select “Premiere Generic EDL...” from the Import submenu on the File 
menu.

2. Navigate to the location of the Premiere Generic EDL file, select it and 
click Open.
You are now prompted to select a name and location for the new project folder that 
will be created.

3. After selecting, the new project opens containing all the audio files 
stored in the Premiere Generic EDL file and their associated edits.
Nuendo will also automatically extract any audio from video files if the audio is refer-
enced in the EDL file.

Exporting and importing MIDI files

Nuendo can import and export Standard MIDI Files, which makes it 
possible to transfer MIDI material to and from virtually any MIDI appli-
cation, on any platform. When you import and export MIDI files, you 
can also specify whether certain settings associated with the tracks 
should be included in the files (automation subtracks, volume and pan 
settings etc.).

Exporting MIDI files

To export your MIDI tracks as a Standard MIDI File, pull down the File 
menu and select “MIDI File...” from the Export submenu. A regular file 
dialog appears, allowing you to specify a location and name for the file.
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When you have specified a location and a name for the file, click 
“Save”. At this point, the Export Options dialog appears, allowing you 
to specify a number of options for the file – what should be included in 
the file, its type and its resolution (see below for descriptions of the 
options).

The Export Options dialog.

You will also find these settings in the Preferences dialog (MIDI-MIDI 
File page). If you set these up once and for all in the Preferences, you 
only need to click OK in the Export Options dialog to proceed.
The dialog contains the following options:

Option Description

Export Inspector 
Patch

If this is checked, the MIDI patch settings in the Inspector – Bank 
Select and Program Select (used for selecting sounds in the con-
nected MIDI instrument) are included as MIDI Bank Select and 
Program Change events in the MIDI file.

Export Inspector 
Volume/Pan

If this is checked, Volume and Pan settings made in the Inspector 
are included as MIDI Volume and Pan events in the MIDI file.

Export Automation If this is checked, recorded automation (see page 322) is con-
verted to MIDI controller events and included in the MIDI file. This 
also includes automation recorded with the MIDIControl plug-in. 
This is described in the “MIDI Effects” chapter in the separate PDF 
document “Working with MIDI”. 
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• The MIDI file will include the Tempo track.

• Inspector settings (other than patch, volume, pan and effects – see 
above) are not included in the MIDI file!
To include these, you need to convert the settings to “real” MIDI events and properties 
by using the Merge MIDI in Loop function for each track, see the “MIDI realtime param-
eters and effects” chapter in the separate PDF document “Working with MIDI”.

Export Inserts If this is checked and you are using any MIDI plug-ins as insert ef-
fects, the modifications to the original MIDI notes that occur as a 
result of the effect(s) will be included in the MIDI file. A MIDI delay, 
for example, will produce a number of repeats to a MIDI note by 
actually adding additional, “echoing” notes at rhythmic intervals – 
these notes will be included in the MIDI file if the option is activated.

Export Sends If this is checked and you are using any MIDI plug-ins as send ef-
fects, the modifications to the original MIDI notes that occur as a 
result of the effect(s) will be included in the MIDI file.

Export Marker If this is checked, any markers you have added (see page 173) will 
be included in the MIDI file as Standard MIDI File Marker events.

Export as Type 0 If this is checked, the MIDI file will be of Type 0 (all data on a single 
track, but on different MIDI channels). If you don’t check this op-
tion, the MIDI file will be of Type 1 (data on separate tracks). 
Which type to choose depends on what you want to do with the 
MIDI file (in which application or sequencer it should be used, etc.).

Export Resolution You can specify a MIDI resolution between 24 – 960 for the MIDI 
file. The resolution is the number of pulses, or ticks, per quarter 
note (PPQ) and determines the precision with which you will be 
able to view and edit the MIDI data. The higher the resolution, the 
higher the precision. The resolution should be chosen depending 
on the application or sequencer with which the MIDI file should be 
used though, since certain applications and sequencers may not 
be able to handle certain resolutions.

Option Description
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Importing MIDI Files

To import a MIDI file from disk, proceed as follows:

1. Select “MIDI File...” from the Import submenu on the File menu.

2. In the dialog that appears, select whether a new project should be 
created for the file or not.
If you select “No”, the MIDI file will be imported into the current project.

3. Locate and select the MIDI file in the file dialog that appears, and click 
Open.

4. If you chose to have a new project created, you are asked to specify a 
project folder for the new project.
Select an existing project folder or create a new one by selecting a location for it and 
typing its name in the dialog.

The MIDI file is imported. The result depends on the contents of the 
MIDI file and the Import Options settings in the Preferences dialog – 
MIDI-MIDI File page. The Import Options are as follows:

Option Description

Extract First Patch If this is checked, the first Program Change and Bank Select 
events for each track are converted to Inspector settings for 
the track.

Extract First Volume/Pan If this is checked, the first MIDI Volume and Pan events for 
each track are converted to Inspector settings for the track.

Import Controller as Au-
tomation track

If this is checked, MIDI controller events in the MIDI file will 
be converted to automation data for the MIDI tracks.

Import to Left Locator If this is checked, the imported MIDI file will be placed so that 
it starts at the position of the left locator – otherwise it will 
start at the beginning of the project. Note that if you choose 
to have a new project created automatically, the MIDI file will 
always start at the beginning of the project.

Import Marker If this is checked, Standard MIDI File Markers in the file will 
be imported and converted to Nuendo markers.

Import dropped File as 
single Part

If this is activated and you drag and drop a MIDI file into the 
project, the whole file will be placed on a single track.



NUENDO
File handling 29 – 659

As mentioned on page 657, the result also depends on what type of 
MIDI file it is – Type 0 or Type 1:

• If the MIDI file is of Type 0 (all data on a single track), only one MIDI track will 
be created.
This track will be set to MIDI Channel “Any”, allowing all MIDI events to play back on 
their original channels. You can use the Dissolve Part function on the MIDI menu to 
distribute the events onto different tracks with different MIDI Channels (see the “MIDI 
Processing” chapter in the separate PDF document “Working with MIDI”).

• If the MIDI file is of Type 1 (data on several tracks) a number of new MIDI 
tracks and parts will be created.

In both cases, the Tempo track is adjusted according to the Tempo 
track in the MIDI file.

It is also possible to import a MIDI file from disk by dragging and dropping 
it from the Windows Explorer or the Mac OS Finder into the Nuendo 
Project window. The Import Options apply if you use this method as well.

Ignore Mastertrack 
Events on Merge

If this is activated and you import a MIDI file into the current 
project, tempo track data in the MIDI file is ignored. The im-
ported MIDI file will play according to the current Tempo 
track in the project.

Option Description
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Importing Cubase VST files

As described on page 638, Nuendo can open Cubase SX/SL projects 
with the regular Open function. It is also possible to import files created 
in older versions of Cubase. There are three options for this on the File 
– Import submenu:

Import Cubase Song

This will open a Song file (Windows file extension “.all”) created in 
Cubase 5.0 or later and convert it to a Nuendo project. When import-
ing a Song, you will be asked to specify a folder for the new project, 
as usual.

• Cubase Songs can contain more than one Arrangement (containing in-
dependent part and event data). If this is the case, you will be asked 
which one of these Arrangements to import.
To import all Arrangements in a Cubase Song, simply repeat this for all Arrangements, 
and save each as a separate project.

The conversion has the following limitations:

Data Conversion result

MIDI output setting 
for MIDI tracks

If the output information stored in the original Song doesn’t 
match the current outputs, a “Pending Connections” dia-
log will appear, allowing you to remap each MIDI output in 
the Song to a new output.

MIDI track play parameters 
(Inspector settings)

Only the volume and transpose settings are included; the 
other parameters (velocity, compression, length and pan) 
are ignored.

MIDI part play parameters 
(Inspector settings)

All settings are included, except transpose.

Group tracks Removed.

Style tracks Removed.

Chord tracks Removed.

Drum tracks Converted to MIDI tracks with drum maps. MIDI output 
settings for individual drum sounds will be ignored.

Solo/Mute status of tracks Ignored.
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• It’s also possible to import Songs created in version 3.7x of Cubase for 
Windows.
However, this will only include the basic audio and MIDI data, ignoring most of the set-
tings.

MIDI “effect” devices, such 
as the arpeggiator and IPS

Removed.

Window layouts Ignored.

Key command settings Ignored.

Grooves Ignored.

MIDI Mixermaps Removed.

Dynamic events in audio 
parts (including M-points)

Ignored.

Automation The VST channel automation is included, but limited to 
volume, pan and EQ data. Plug-in automation and auto-
mation for DSP Factory settings are ignored.

Left/right locator positions 
and cycle status

Ignored.

Sync settings and status Ignored.

Master track hitpoints Removed.

VST Group channels Removed.

Multiple audio tracks routed 
to the same audio channel

Will be replaced by separate audio tracks (with separate 
channels in the mixer). This is because in Nuendo there is 
always one channel per track.

Solo/Mute status of VST 
channels

Ignored.

Data Conversion result
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Import Cubase Arrangement

As mentioned above, a Song in previous versions of Cubase could 
contain one or several Arrangements. These contained all the part and 
event data along with file references, but without mixer settings and 
similar, which were global to all Arrangements in the Song. Arrange-
ments could be saved as separate files, with the extension “.arr”.

When you import a Cubase Arrangement into Nuendo, it will be con-
verted to a project, just as when importing a Song. The same limita-
tions apply.

Import Cubase Part

Just as in Nuendo, previous Cubase versions used parts as containers 
for MIDI or audio events. These could be saved as separate files with 
the extension “.prt”. When you import a part file, the following happens:

• A new track is created, with the name of the part.
That is, the name of the part when it was saved in Cubase, not (necessarily) the file name.

• The part appears as a Nuendo part, at the left locator position.
• If the imported part was an audio part, the necessary clips and file references 

are added to the Pool.

Note that none of these file formats contain any actual audio data. Just 
as with Nuendo projects, the files only contain references to audio files. 
This means that you need access to the referenced audio files as well, 
to properly import Songs, Arrangements or Parts with audio.

Importing audio CD tracks

You can import audio from audio CDs, for use in Nuendo projects. 
This is done by selecting “Import Audio CD” from the Pool menu (or 
by selecting the “Audio CD…” option from the Import submenu on the 
File menu).

• If the project window is active, the imported audio CD track(s) will be 
inserted on the selected audio track, at the project cursor position.
It is also possible to import audio CD tracks into the Pool, which may be the preferred 
method if you want to import several CD tracks in one go.
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Selecting one of the Import Audio CD menu items brings up the fol-
lowing dialog:

• If you have more than one CD drive, you use the Drives pop-up menu 
to select the one holding the audio CD.

• The Speeds pop-up menu (Windows version only) lists all possible 
data transfer speeds for the selected CD drive.
While you normally want to use the fastest possible speed, you may have to select a 
slower speed for flawless audio extraction.
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• The main display in the dialog lists all audio tracks on the CD.
The columns have the following functionality:

• You can audition the selected audio CD track by clicking the Play 
button.
The track will be played back from the grab selection start (see below) to the track end 
(or until you click the button again). During playback, the button is labeled “Stop”.

• The arrow buttons next to the Play button allow you to audition the 
start and end of the grab selection only.
The left button will play a short snippet beginning at the start of the grab selection (see 
below), while the right button will play a snippet starting just before the end of the grab 
selection.

• If you want to import a section of an audio CD track only, you select 
the track in the list and specify the start and end of the grab selection 
by dragging the handles in the grab selection ruler.
Use the start and end audition buttons to fine tune the selection boundaries.

Column Description

Grab Activate the checkbox in this column for the track you want to grab (im-
port). To activate more than one checkbox (import more than one track), 
click and drag over the checkboxes (or press [Ctrl]/[Command] or [Shift] 
and click).

Track When you import an audio CD track, the file will be named according to 
the name in this column. You can rename a track by clicking in the Track 
column and typing a new name. You can also apply a name to all audio 
CD tracks (e.g. the name of the album, see below).

Length The length of the whole audio CD track, in minutes and seconds.

Size The file size of the whole audio CD track, in MegaBytes.

Grab Start You can grab a section of a track if you like. This indicates the start of the 
section to be grabbed in the track. By default, this is set to the start of the 
track (0.000) but you can adjust this on the grab selection ruler (see below).

Grab End Indicates the end of the section to be grabbed in the track. By default, this 
is set to the end of the track but you can adjust this on the grab selection 
ruler (see below).
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Note that you can import sections of several audio CD tracks by se-
lecting them in turn and adjusting the grab selection. The grab start 
and end settings for each track will appear in the list.

• If you wish, you can change the generic audio file name in the File 
Name field.
By default, the imported audio files will get this name with a track number added (typ-
ically Track 01, Track 02, and so on). However, if you have adjusted the track name for 
a specific audio CD track in the list, the corresponding audio file will use that name in-
stead.

• By default, imported audio CD tracks will be stored as Wave files 
(Windows) or AIFF files (Mac) in the Audio folder of the current 
project.
You can select another folder by clicking the Change Folder button.

• Clicking the Grab button will convert the selected audio CD tracks 
(the tracks for which the Grab checkbox is ticked) to audio files.
The grabbed files will be listed at the bottom of the dialog – click OK to actually import 
the files into the project and close the dialog, or click Cancel to discard the grabbed 
files.

Importing Audio from Video files

While you can automatically extract the audio when importing a video 
file (see page 623), it is also possible to import the audio from a video 
file without importing the video itself:

1. Pull down the File menu and select “Audio from Videofile” from the 
Import submenu.

2. In the file dialog that appears, locate and select the video file and click 
Open.
The audio in the selected video file is extracted and converted to a Wave file in the 
project’s Audio folder.

• A new Clip is created and added to the Pool. If the Project Window is 
active, an Event will be inserted on the selected Track at the project 
Cursor position.
This works just like when importing regular audio files.
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Importing ReCycle files

ReCycle, developed by Propellerhead Software, is a program designed 
especially for working with sampled loops. By “slicing” a loop and mak-
ing separate samples of each beat, ReCycle makes it possible to match 
the tempo of a loop and edit the loop as if it was built up of individual 
sounds. Nuendo can import two file types created by ReCycle: 

• REX files (export file format of the first versions of ReCycle, extension “.rex”).
• REX 2 files (file format of ReCycle 2.0 and later, extension “.rx2”).

Proceed as follows:

1. Select an audio track and move the project cursor to where you want 
the imported file to start.
You probably want to import REX files to tempo based audio tracks, since this will al-
low you to change the tempo later on (having the imported REX file automatically ad-
just).

2. Select “Audio File…” from the Import submenu on the File menu.

3. Select REX files or REX 2 files with the file type pop-up menu in the 
file dialog.

4. Locate and select the file and click Open.
The file is imported, and automatically adjusted to the current Nuendo tempo. 

Unlike a regular audio file, the imported REX file will consist of several 
events, one for each “slice” in the loop. The events will automatically 
be placed in an audio part on the selected track, and positioned so 
that the original internal timing of the loop is preserved.

5. If you now open the part in the Audio Part Editor, you can edit each 
slice separately by muting, moving and resizing events, adding effects 
and processing, etc.
You can also adjust the tempo and have the REX file automatically follow (provided 
that its track is tempo based).

• You can also achieve similar results by using Nuendo’s own loop slicing 
features.
See page 456.
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Importing compressed audio files

During the last years, various audio compression formats have be-
come very common. The major advantage of using such file formats is 
that the file size is significantly reduced, with very little degradation of 
sound quality. This allows for quick download, mass storage and easy 
transportation.

Nuendo can import (and export, see page 551) several common au-
dio compression formats. The procedure is the same as when import-
ing any non-compressed audio file, with one important thing to note:

If you import a compressed audio file, Nuendo will create a copy of the 
file and convert this to Wave format (Windows) or AIFF format (Mac OS 
X) before importing it (the original compressed file will not be used in 
the project). The Wave/AIFF file will be placed in the designated project 
Audio folder. Please be aware that the converted Wave/AIFF file will be 
several times larger than the original compressed file!

The following file types are supported:

MPEG audio files

MPEG, which stands for Moving Picture Experts Group, is the name 
of family of standards used for coding audio-visual information (e.g. 
movies, video, music) in a digital compressed format. 

Nuendo can read three types of audio MPEG files: MPEG Layer 1 (file 
extension *.mpeg), MPEG Layer 2 (*.mp2) and MPEG Layer 3 (*.mp3). 
Currently, mp3 is the most common of these formats, while the mp2 
format is mostly used in broadcast applications.

• Note that the file extension “.mpeg” can also be used by MPEG video files.
If you select an MPEG video file in the Import Audio dialog you will not be able to im-
port it.

Ogg Vorbis files

Ogg Vorbis is a relatively new format that is open and patent-free and 
offers very small audio files maintaining comparatively high audio qual-
ity. Ogg Vorbis files have the extension “.ogg”.
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Windows Media Audio files (Windows only)

Windows Media Audio is an audio format developed by Microsoft Inc. 
Due to advanced audio compression algorithms, Windows Media Au-
dio files can be made very small, maintaining good audio quality. The 
files have the extension “.wma”.

Options and Settings

Auto Save

If you activate the Auto Save checkbox in the Preferences dialog 
(General page), Nuendo will automatically save backup copies of all 
open projects with unsaved changes.

• You specify how often a backup copy should be created with the Auto 
Save Interval setting.

• Backup copies are named “Name.bak”, where “Name” is the name of 
the project. The files are saved in the project folder.

• Unsaved projects are also backed up in the same way.
Backup copies of unsaved projects will be named “#UntitledX.bak” where “X” is an in-
cremental number, to allow multiple backup copies in the same project folder.
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Startup Options

The “On Startup” pop-up menu in the Preferences dialog (General 
page) allows you to specify what should happen each time you launch 
Nuendo. The following options are available:

Option Description

Do Nothing Nuendo launches without opening a project.

Open Last Project The last saved project is opened on launch.

Open Default Project The default project is opened (see page 640).

Show Open Dialog The Open dialog appears on launch, allowing you to manu-
ally locate and open the desired project.

Show Template Dialog The Template dialog appears on launch, allowing you to cre-
ate a new project from one of the templates.

Show Open Options 
Dialog

The Open Document Options dialog appears on launch, see 
below. It allows you to make a different choice each time you 
launch Nuendo.
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Nuendo Open Document Options Dialog

The Nuendo projects you have used recently are displayed in the list. 
To open one of them, select it and click the “Open Selection” button. 
To open another project not listed there, click the “Open Other...” but-
ton. A file dialog appears that allows you to look for the desired file on 
your disk. Click the “New Project” button to create a new project us-
ing a template or not.

If you hold down [Ctrl]/[Command] while launching Nuendo this dia-
log will always be displayed, regardless of the startup option selected 
in the Preferences dialog (General page).



30
Customizing
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Background

The user can customize the appearance and functionality of Nuendo 
in various ways.

User configurable items described in this chapter are:

• Workspaces
By storing different window combinations as workspaces, you can quickly switch be-
tween different working modes – see page 673.

• Transport panel
The user can configure which Transport panel items are to be shown or hidden, and 
where they should be located – see page 676.

• Toolbars
In the project window and all editor windows, the user can configure which toolbar 
items are to be shown or hidden, and where they should be located – see page 678.

• Track list
The controls shown in the Track list can be set for each track type – see page 680.

• Configuration of main menu items
The user can hide items not needed on the main menus – see page 685.

• Preferences presets
You can save and recall preference settings as preference presets – see page 687.

• Appearance
The general look of the program can be adjusted – see page 690.

This chapter also contains a section describing where your prefer-
ences and settings are stored (see page 694), to help you transfer 
your customized settings to another computer.
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Workspaces

A configuration of Nuendo windows is called a “workspace”. A work-
space stores the size, position and content of all windows, allowing you 
to quickly switch between different working modes, from a menu or by 
using key commands. You may for example want as large a Project win-
dow as possible when you are editing, whereas you may want the mixer 
and effect windows open during mixdown. Workspaces are listed and 
managed on the Workspaces submenu on the Windows menu.

Editing the active workspace

There is always one workspace active, even if you haven’t saved any. 
To make changes to the active workspace, you simply set up the win-
dows as desired - including opening, closing, moving and sizing win-
dows, and adjusting zoom and track height. The changes are 
automatically stored for the active workspace.

• To keep a workspace from being accidentally changed, select “Lock 
Active Workspace” from the Workspaces submenu.
A locked workspace will keep its original window settings. You may of course change 
the current window layout on the screen but the next time you select the workspace 
again the originally stored layout will be recalled.

Creating a new workspace

1. Pull down the Window menu and open the Workspaces submenu.

2. Select “New Workspace”.
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3. In the dialog that appears, enter a name for the workspace.

4. Click OK.
The workspace is stored and will appear on the submenu. It will now be the active 
workspace.

5. Set up the windows you want to include in the new workspace.
This may include opening, moving and sizing windows, and adjusting zoom and track 
height.

Activating a workspace

1. Pull down the Window menu and open the Workspaces submenu.

2. Select the workspace from the list on the submenu.
The windows are closed, opened, moved and/or resized according to the stored work-
space.

• You can also activate any of nine workspaces using key commands.
This is set up under the Workspaces heading in the Key Commands dialog.

Organizing workspaces and presets

If you select “Organize...” from the Workspaces submenu, this dialog 
opens:
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The list to the left shows the workspaces in the active project, while 
the list to the right shows the workspace presets. While workspaces 
are stored with each project, workspace presets can be stored glo-
bally, allowing you to set up a number of workspaces for use in any 
project. Workspace presets store the position and size of the main 
windows only – project-specific windows are not included.

• In the Workspaces list to the left, you can rename workspaces (by 
double clicking and typing) and lock or unlock them.

• The arrow buttons between the two lists allow you to copy the se-
lected workspace to a workspace preset, or vice versa.

• The buttons below each list let you add, remove or activate work-
spaces or presets.
You can also activate a workspace or a preset by double clicking in its number column.

• Normally when you use key commands to activate workspaces, they 
relate to the order in the workspace list – the key command for “Work-
space 1” selects the first workspace on the list and so on. However, if 
you activate the Use IDs checkbox, you can enter a number (1-9) in 
the ID column for each workspace. 
This number will be used as reference when you are using key commands, so that the 
key command for “Workspace 1” recalls the workspace with ID 1.

• Workspace presets can be stored globally or for the project. By de-
fault the global presets are shown in the list to the right – to see the 
project presets, activate the Show Project Presets checkbox.

• If the Auto Instantiate Presets checkbox is activated when you create 
a new project or open a project, all global workspace presets are au-
tomatically converted to workspaces.

• To close the dialog, click the OK button or use [Esc].
Note that you can continue working in other windows with the Organize Workspaces 
dialog open.
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Customizing the Transport panel

You can customize the appearance of the Transport panel by deci-
ding which parts of it you wish to be visible, and where the parts 
should be located on the panel.

Setting which items are shown/hidden

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the Trans-
port panel area, a pop-up menu will appear. On this menu, you can di-
rectly check or uncheck elements of the Transport panel as desired.

You can also select different preset configurations from the lower half 
of the menu. To make all hidden items visible again, select “Show All”.

The Transport Setup dialog

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the Trans-
port panel area and select “Setup…” from the pop-up menu, a dialog 
appears. In this dialog you can also configure where the separate 
parts should be placed on the panel as well as saving/recalling differ-
ent configurations of the Transport panel.
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The dialog is divided into two columns. The left column displays the 
currently visible items on the Transport panel, and the right column 
displays the currently hidden items.

• You can change the current show/hide status by selecting items in 
one column and then use the arrow buttons in the middle of the dialog 
to move them to the opposite column.
Changes are applied directly.

• By selecting items in the “Visible Items” column and using the Move 
Up and Move Down buttons you can change the position of the se-
lected item(s) on the Transport panel.
Changes are applied directly. To undo all changes and revert back to the standard 
Transport panel layout, you can select “Default” from the pop-up menu accessed by 
right-clicking/[Ctrl]-clicking the Transport panel.

A “customized” Transport panel

• If you click the Save button (disk icon) in the Presets section, you can 
name the current configuration and to save it as a preset.
The saved setting appears in the Presets field.

• To remove a preset, select it and click the trash icon.

• Saved configurations are available for selection from the Presets pop-
up in the dialog, or directly from the pop-up menu brought up by right-
clicking or [Ctrl]-clicking the Transport panel.
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Customizing the toolbars

You can customize the appearance of the toolbars in the Project win-
dow and editor windows by deciding which sections should be visi-
ble, and where the sections should be located on the panel. The 
screenshots below illustrate customizing the Project window toolbar 
but you can use the same procedures for the toolbars in the Sample 
Editor, the MIDI editors and the Tempo Track Editor.

Setting which items are shown/hidden

If you right-click (Win) or [Ctrl]-click (Mac) anywhere within the tool-
bar area, a pop-up menu will appear. On this menu, you can directly 
check or uncheck elements of the toolbar as desired.

You can also select “Show All” (makes all hidden items visible) or 
“Default” (makes all hidden items visible – except those that are hid-
den by default – and moves them back to their standard locations).
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The Toolbar Setup dialog

If you select “Setup...” from the pop-up menu, a dialog appears. In this 
dialog you can decide which items should be visible, where the sepa-
rate items should be placed on the toolbar and save/recall different 
configurations of the toolbar.

The dialog is divided into two columns. The left column displays the 
currently visible items on the toolbar, and the right column displays the 
currently hidden items.

• You can change the current show/hide status by selecting items in 
one column and then use the arrow buttons in the middle of the dialog 
to move them to the opposite column.
Changes are applied directly.

• By selecting items in the “Visible Items” column and using the Move 
Up and Move Down buttons you can change the position of the se-
lected item(s) on the toolbar.
Changes are applied directly.

A “customized” toolbar
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• If you click the Save button (disk icon) in the Presets section, a text 
field appears, allowing you to name the current configuration and to 
save it as a preset.
The saved setting appears in the Presets field.

• To remove a preset, select it and click the trash icon.

• Saved configurations are available for selection from the Presets pop-
up in the dialog, or directly from the pop-up menu brought up by right-
clicking or [Ctrl]-clicking the toolbar.

Customizing track controls

You can configure (separately for each track type) what track controls 
should be shown in the Track list. You can also specify the location of 
controls and group controls so that they are always shown adjacent to 
each other. All this is done using the Track Controls Settings dialog.

Opening the Track Controls Settings dialog

There are two ways to open the dialog:

• By right-clicking (Win) or [Ctrl]-clicking (Mac) a track in the Track list, 
and selecting “Track Controls Settings” from the menu that appears.

or

• By clicking the arrow in the top left corner of the Track list and select-
ing “Track Controls Settings”.



NUENDO
Customizing 30 – 681

The dialog mainly consists of two lists, the left showing “Used Con-
trols” and the right “Available Controls”.

• The items in the Used Controls list are the controls currently shown in the 
Track list for the selected track type.

• The items in the Available Controls list (if any) are controls currently hidden in 
the Track list for the selected track type.

Setting the track type

The settings made in the Track Controls Settings dialog apply to the 
selected track type (Audio, MIDI, Group/FX Channel, Folder, Video). If 
you right-click (Win) or [Ctrl]-click (Mac) an audio track to open the 
dialog for example, the settings for audio tracks are automatically dis-
played. The selected track type is shown in the menu display in the 
top left corner of the dialog.

• To change the selected track type, click the arrow to the right in the 
menu display and select a track type from the pop-up menu that ap-
pears.
All settings made in the dialog will apply to all tracks (current and subsequent) of the 
selected type.

The track type pop-up
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Removing track controls

To remove track controls in the Track list, proceed as follows:

1. Make sure you have selected the desired track type (see above).

2. Select the control(s) you wish to hide in the Used Controls list.
You can use standard multiple selection methods (i.e. [Shift] and [Ctrl]/[Command].

3. Click the “Remove” button.
The control(s) are moved to the Available Controls list.

4. Click OK to remove the controls from the Track list.

• All controls can be removed except the Mute and Solo buttons.

Adding available track controls

To add available track controls to the Track list, proceed as follows:

1. Make sure you have selected the desired track type (see above).

2. Select the control(s) you wish to add in the Available Controls list and 
click the “Add” button.

3. Click OK to add the controls to the Track list.

Moving track controls

You can change the position or order of the track controls if you like:

1. Make sure you have selected the desired track type (see above).

2. Select the control(s) you wish to move in the Used Controls list.

3. Use the “Move Up” and “Move Down” buttons to reposition the se-
lected controls up or down in the Track list.

4. Click OK.
The controls are moved.
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Grouping track controls

If you resize the Track list, the position of the controls will change dy-
namically to accommodate as many controls as possible in the avail-
able space (given that Wrap Controls is activated – see below). By 
grouping several track controls you can ensure that they will always 
be positioned side by side in the Track list. To group controls, pro-
ceed as follows:

1. Make sure you have selected the desired track type (see above).

2. Select at least two controls you wish to group in the Used Controls list.

• You can only group controls that are adjacent to each other in the Used 
Controls list. To group controls that are currently not adjacent in the list, 
use the Move Up/Down buttons first.

3. Click Group.
A number is displayed in the Group column for the grouped controls. The first group 
created will have the number 1, the second 2 and so on.

4. Click OK.
The controls are now grouped.

About Wrap Controls

This is by default activated (checked). Wrap Controls is the function 
that allows the controls to be dynamically repositioned when resizing 
the Track list. That is, as many controls as can fit in any given space 
will be displayed depending on how you resize the Track list.

If you deactivate Wrap Controls, the positions of the controls will be 
fixed, regardless of the size of the Track list. In this mode, you may 
have to resize the tracks vertically (by dragging the dividers between 
them) to display all the controls.

About the Length column

The Length column in the Used Controls list allows you to set the 
maximum number of characters allowed in certain text fields (Name, 
Output). To change the setting, click on the number in the Length col-
umn and type in a new value.



NUENDO
30 – 684 Customizing

About Reset

There are two Reset buttons in the dialog:

• Clicking Reset will restore all default track controls settings for the se-
lected track type.

• Clicking Reset All will restore all default track controls settings for all 
track types.

Saving presets

You can save track control settings as presets for later recall:

1. Click on the Save icon beside the Presets name field.
A dialog appears allowing you to type in a name for the preset.

2. Click OK to save the settings as a preset.
Saved presets are available for selection from the Presets pop-up and from the pop-up 
at the top left corner of the Track list.

3. To remove a preset, select it in the Track Controls Settings dialog, 
and click the Delete icon beside the Presets name field.

• Nuendo comes with a number of track control settings presets available.
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Configuring the main menu items

Configuring the main menus is a feature intended for experienced Nuendo 
users. Don’t hide menus or menu items unless you are sure of the fact 
that you do not need them!

You can configure what items should be shown on the main menus 
and submenus, and even hide entire menus. By customizing the 
menus you can choose to hide items relating to program functions you 
never use, to customize the program according to your needs. For ex-
ample, if you never use the scoring features in Nuendo, you can hide 
the entire Scores menu from view.

1. Open the Preferences dialog and select the Configuration page.
The Configuration page contains two parent folders; “Main Menu”, which contains 
subfolders for all main menus, and “Command Categories” which contains subfolders 
for all Command categories. This section will only describe how to configure Main 
Menu items, not Command Categories (these are described on page 702).
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2. Click on the plus sign for a subfolder item, e.g. the File subfolder.
As you can see, all items and subfolders on the File menu are listed in the Name column.

• In the Menu column you can decide which File menu items to hide 
from view, simply by clicking in the column beside the corresponding 
menu item you wish to hide.
If you click the “On” in the Menu column for an item, it changes to “Off” and vice versa. 
All menu items set to “Off” will be hidden when you click Apply or OK.

• Certain essential menu items on the File and Edit menus cannot be 
hidden, such as Save, Open, Close, Undo/Redo etc.
For these items there is no entry in the Menu column.

• If you set a main menu folder (as opposed to a menu item) to Off in the 
Menu column, the entire menu will be hidden from view.
The exception to this is if the main menu folder contains non-removable menu items, in 
which case all hideable items on the menu will be set to Off, but the menu will still be 
visible.

• The Command column sets the key command On/Off status for the 
corresponding menu item.
If this is set to Off, any assigned key command for the item will be disabled (see page 
702 for more information).

• You can save menu configurations as preference presets, either sep-
arately or together with other Preferences dialog settings – see below.
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3. By using the above methods, you can customize all main menus to 
your liking.
To apply the changes without exiting the dialog click “Apply”. Click OK to apply the 
changes and exit the dialog.

• To restore all menu items to their default setting (which is visibility and 
key commands on for all menus and menu items), click the Defaults 
button.
Note that the Defaults button only restores the settings on the currently selected page 
(the Configuration page in this case) to their default settings. If you have changed set-
tings on another page of the Preferences dialog, these are not reset.

About preference presets

It is possible to save complete or partial preferences settings as pre-
sets. This lets you recall settings quickly and easily.

Saving a preference preset

When you have made your preferences settings, proceed as follows 
to save all settings as a preset:

1. If the dialog is not already open, select Preferences from the File 
menu (Win)/Nuendo menu (Mac).

2. Make sure that the “Store marked preferences only” box is not 
checked.
This is because this option is used for saving partial settings (see below), as opposed 
to complete settings.

3. Click the Store button in the lower left section of the Preferences 
dialog.
A dialog appears, allowing you to type in a name for the preset.

4. Click OK to save.
Your saved settings will now be available from the Preference Presets pop-up for your 
future projects.
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Loading a preference preset

To load a saved preference preset, proceed as follows:

1. Select Preferences from the File menu (Win)/Nuendo menu (Mac).

2. Select the saved preset from the Preference Presets pop-up.

3. Click OK to exit the Preferences dialog and apply the saved preset 
settings.

Saving partial preferences settings

It is also possible to save partial preferences settings. This is useful 
when you have made settings that perhaps only relate to a specific 
project or settings that you wish to apply only in certain situations for 
example. When you apply a saved partial preference preset you only 
change the specific saved settings, and all other Preferences dialog 
settings will be left unchanged.

When you have made your specific preferences settings, proceed as 
follows to save the partial settings as a preset:

1. Open the Preferences dialog.

2. Activate the “Store marked preferences only” checkbox.
When this is on, a new “Store” column appears in the Preferences page list.
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3. Click in the Store column for the Preferences items you wish to save.
Note that if you check a Preferences page that contains subpages these will automat-
ically also be checked. If this is not what you want, simply uncheck the subpages.

4. Click the Store button in the lower left section of the Preferences.
A dialog appears, allowing you to type in a name for the preset. It is a good idea to 
choose a descriptive name for a partial preference preset, preferably relating to the 
saved settings (for example “Configuration” or “Editing-Controls” etc.).

5. Click OK to save.
Your saved settings will now be available from the Preference Presets pop-up for your 
future projects.
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Appearance

In the Preferences dialog you will find a page called Appearance. It 
contains three subpages, on which you can adjust the look of the pro-
gram in the following way:

General

The three controls on the General subpage affect the appearance of 
the windows that surround the controls and workspaces in Nuendo. 

• Saturation determines how rich the background colors are, from grey 
to blue. 

• Contrast determines how bright or dark the background is in relation 
to controls and displays. 

• Brightness lightens or darkens the background.

Meters

The coloring of meters in Nuendo can be controlled in sophisticated 
ways. Multiple colors can help to visually indicate what levels are be-
ing reached, e. g. in a channel of the VST Mixer. To do this, the meter 
on the Appearances–Meters page has color handles that allow you to 
define what color the meter will have at a given signal level.

The Appearances–Meters page in the Preferences dialog.
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• The default setting has two color handles, one at the very top of the 
meter scale and one at the bottom. Each color handle has a unique 
color that gradually shifts as the meter moves toward the next color 
handle.
You can click on any color handle and move its position in the meter scale. If you hold 
down [Shift] while moving the handle with the mouse, it will move ten times slower for 
more precise positioning. You may also nudge the color handle’s position with the Arrow 
Up/Down keys. Holding Shift while nudging will move the color handle ten times faster.

• You can add color handles by [Alt]/[Option]-clicking anywhere along 
the side of the meter scale. [Ctrl]/[Command]-clicking on a handle re-
moves it from the meter scale.
By adding more color handles to the meter scale, you can define colors for more spe-
cific signal levels. Try adding two color handles very close to one another. You can 
make the meter color change more rapidly at a specific signal level this way.

• To change the color of a handle, you must first select it by clicking on it. 
You may also use the Tab key to select the next handle. (To select the 
previous handle, hold down [Shift] and press the Tab key.) Use the hue 
and brightness controls on the right side to alter the handle’s color.
The currently selected color handle is indicated by a black triangle on its left side.

Work Area

The work areas in Nuendo are those places where the actual data are 
displayed such as the project window event display. In these areas, 
there are items such as vertical and horizontal grid lines which can be 
altered in intensity by the controls found on this subpage.
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Applying track and event colors

You can use color scheming for easier overview of certain tracks and 
events in the Project window. Applying colors is divided into two ar-
eas; track and event colors.

• A track color is reflected and can be edited in the Inspector, Track list 
and in the corresponding channel in the Mixer. It is furthermore dis-
played in all parts and events for the track in the Event display.
Track colors can be switched on or off globally.

• Event colors are reflected in parts and events in the Event display and 
are independent from the track colors.
An applied event color “overrides” the track color, if both are used.

Track colors

• You activate track colors by clicking the color strip at the top of the 
Track list.

A small arrow appears to the right in the Track Name title bar.

Click here to bring up the color palette.
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• Clicking the arrow brings up the color palette where you can select a 
color and apply it to the selected track.
This palette or color set can be edited in the Event Color dialog.

The chosen track color is now reflected in the Inspector title bar, the 
field by the output activity meter in the Track list, in the Mixer and any 
parts or events on the selected track.

Colorizing parts and events

There is a Color tool (the paint bucket icon) on the Project window 
toolbar that can be used to colorize parts and events.

The Color tool.

Just below the Color tool there is a small strip. Click this to bring up 
the standard color palette. If you double-click this strip the Event 
Color dialog opens, where you can define new colors for the standard 
palette, add more colors etc.

• To colorize one or several selected events, select the Color tool, 
chose a color from the palette, and click on an event.
The color is applied to all selected events and overrides the track color (if used). 
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• If you press [Ctrl]/[Command] and click on an event with the Color 
tool, the color palette is displayed and you can choose the desired 
color for an event.

• If you press [Alt]/[Option], the Color tool cursor becomes a pipette, 
which can be used to select a color by clicking on a part/event.

• An alternative way to colorize parts and events is by selecting them, 
and then picking a color from the Color selector on the toolbar.

Where are the settings stored?

As you have seen, there are a large number of ways in which you can 
customize Nuendo. While some of the settings you make are stored in 
each project, others are stored in separate preference files.

If you need to transfer your projects to another computer (e.g. in an-
other studio), you can bring all your settings along by copying the de-
sired preference files and installing them on the other computer.

• It’s a good idea to make a backup copy of your preference files once 
you have set things up the way you want!
This way, if another Nuendo user wants to use his or her personal settings when work-
ing on your computer, you can restore your own preferences afterwards.

• Under Windows, preference files are stored in the folder “\Documents 
and Settings\<user name>\Application Data\Steinberg\Nuendo 3\”.
On the Start menu you will find a shortcut to this folder, for easy access.

• Under Mac OS X, the preference files are stored in the folder “Library/
Preferences/Nuendo 3/” under your “home” directory.
The full path would be: “/Users/<user name>/Library/Preferences/Nuendo 3/”.

The table below shows the location and name of each preference file.

Setting Stored in

Current edit modifier keys Edit Modifiers.xml

Current key commands Key Commands.xml

Current preferences Defaults.xml

Color setup saved in project
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Crossfade presets Presets\RAMPresets.xml

Drum maps saved in Project/Export as *.drm file

EQ presets Presets\RAMPresets.xml

Installed MIDI devices Midi Devices.bin

Key commands presets Presets\KeyCommands\<Preset Name>.xml

Logical Editor presets Presets\Logical Edit\<Preset Name>.xml

MIDI FX presets Presets\<Plugin Name>\<Plugin Name>.xml

Mixer view preset saved in project

Preferences configurations Configuration.xml

Preferences presets Presets\Configurations\<Preset Name>.xml

Quantize presets Presets\RAMPresets.xml

User templates templates\<Template Name>.npr

Toolbar presets Presets\RAMPresets.xml

Track controls presets Presets\RAMPresets.xml

Transport panel presets Presets\RAMPresets.xml

Usage profile log Usage Profile.xml

VST connections presets Presets\RAMPresets.xml

Workspaces saved in project

Workspaces presets (global) Window Layouts.xml

Zoom presets Presets\RAMPresets.xml

Setting Stored in
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Background

Introduction

Most of the main menus in Nuendo have key command shortcuts for 
certain items on the menus. In addition, there are numerous other 
Nuendo functions that can be performed via key commands. These 
are all default settings. If you want, you can customize existing key 
commands to your liking, and also add commands for menu items and 
functions currently not assigned any.

You can also assign tool modifier keys, i.e. keys that change the behavior 
of various tools when pressed. This is done in the Preferences dialog – 
see page 712.

How are key commands settings saved?

Every time you edit or add any key command assignment, this is stored 
as a global Nuendo preference – not as part of a project. Hence, if you 
edit or add a key command assignment, any subsequent projects that 
you create or open will use these modified settings. However, the de-
fault settings can at any time be restored by selecting “Reset All” in the 
Key Commands dialog.

In addition, you can save complete and partial key commands settings 
as a “key commands file”, which is stored separately and can be im-
ported into any project. This way you can quickly and easily recall cus-
tomized settings, when moving projects between different computers, 
for example. The settings are saved in a file on disk with the windows 
extension “.xml”.

See later in this chapter for details on how to save key commands 
settings.
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Setting up Key Commands

The following is a description of how you set up key commands and 
save them as presets for easy access.

Key commands settings are accessed and edited mainly in the Key 
Commands dialog, but there are also some settings that can be made 
in the Preferences dialog, and these are also addressed in this chapter.

Adding or modifying a key command

In the Key Commands dialog you will find all main menu items and a 
large number of other functions, arranged in a hierarchical way similar 
to that of the Windows Explorer and Mac OS Finder. The categories 
are represented by a number of folders, each containing various menu 
items and functions. When you open a category folder by clicking the 
plus-sign beside it, the items and functions it contains are displayed 
with the currently assigned key commands.
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To add a key command, proceed as follows:

1. Pull down the File menu and select “Key Commands…”.
The Key Commands dialog appears.

2. Use the list in the Commands column to navigate to the desired cate-
gory.

3. Click the plus-sign to open the category folder and display the items 
contained in it.
Note that you can also click the “global” plus- and minus-signs in the top left corner to 
open and close all category folders at once.

4. In the list, select the item to which you wish to assign a key command.
Already assigned key commands are shown in the Keys column as well as in the Keys 
section in the top right corner.

5. Alternatively, you can use the search function in the dialog to find the 
desired item.
For a description of how to use the search function, see page 703.

6. When you have found and selected the desired item, click in the 
“Type in Key” field and enter a new key command.
You can choose between any single key or a combination of one or several keys (Com-
mand, Option (Mac), Ctrl, Alt (Win), Shift) plus any key. Just press the keys you want to 
use.

If a selected item or function has a key com-
mand assigned already, it is displayed here...

...and here.
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7. If the key command you entered is already assigned to another item or 
function, this is displayed below the “Type in Key” field. 

In the case that a key command already is assigned to another function, you can either 
ignore this and proceed to assign the key command to the new function instead, or you 
can select another key command.

8. Click the Assign button above the field.
The new key command appears in the Keys List.

If the key command you enter is already assigned to another function, 
you will get a prompt asking if you want to reassign the command to the 
new function instead, or cancel the operation.

Note that you can have several different key commands for the same 
function. So adding a key command to a function that already has an-
other key command will not replace the key command previously de-
fined for the function. If you wish to remove an assigned key 
command, please see page 704.

9. Click OK to exit the dialog.
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Turning Key Commands off

Nuendo also gives you the option of turning key commands off, mean-
ing that even if a function has a key command assigned to it, you can 
disable the key command.

This is done in the Preferences dialog, in the following way:

1. Open the Preferences dialog from the File menu (under Mac OS X it 
is located on the Nuendo menu) and select the Configuration page.
As you can see, the Configuration page contains two main folders; “Main Menu” and 
“Command Categories”.

• The “Main Menu” folder contains a number of subfolders, which in turn each 
contains items found on the main menus in Nuendo.

• The “Command Categories” folder also contains a number of subfolders, 
each of which contains a number of program functions not available on any of 
the main menus.
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All the items and functions in the subfolders can have key commands 
assigned to them. The column to the right, labeled “Command”, allows 
you to set the On/Off status for the corresponding items. This indicates 
whether it should be possible to use assigned key commands for the 
items or not.

2. Click on the plus-sign beside one of the main folders to open it and 
list the subfolders it contains.

3. Open the desired subfolder by clicking its plus-sign, navigate to the 
item for which you want to disable the assigned key command, and 
select it.

4. Click in the “Command” column beside the item to set the status to 
“Off”.
Now it will not be possible to use any key command assigned to that menu item or 
function.

5. Repeat this for all items or functions for which you want to disable key 
commands.

• Note that if you set an entire subfolder to “Off” in this way, all the items 
or functions it contains will automatically be set to “Off” as well.
If this is not what you want, you can reset separate items in the subfolder to “On”.

6. When you’re done, click OK to close the Preferences dialog and apply 
the changes.

Searching for key commands

If you want to know which key command is assigned to a certain func-
tion in the program, you can use the Search function in the Key Com-
mands dialog:

1. Click in the search text field at the top left of the dialog and type in the 
function for which you want to know the key command.
This is a standard word search function, so you should type the command as it is 
spelled in the program. Partial words are OK; to search for e.g. all quantize related 
commands you could type “Quantize”, “Quant”, etc.

2. Click the Search button (the magnifying glass icon).
The search is conducted and the first matching command is selected and displayed in 
the commands list below. The keys column and the keys list show the assigned key 
commands, if any.
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3. To search for more commands containing the word(s) you entered, 
just press the Search button again.

4. When you’re done, click OK to close the dialog.

Removing a key command

To remove a key command, proceed as follows:

1. If the key commands dialog isn’t already open, pull down the File menu 
and select “Key Commands…”.

2. Use the list of categories and commands to select the item or function 
for which you wish to remove a key command.
The key command for the item is shown in the Keys list and the Keys column.

3. Select the key command in the Keys list and click the Remove button 
(the trash icon).
You will get a prompt asking if you want to remove the key command or cancel the 
operation.

4. Click OK to close the dialog.

Setting up macros

A macro is a combination of several functions or commands, to be 
performed in one go. For example, you could select all events on the 
selected audio track, remove DC offset, normalize the events and du-
plicate them, all with a single command.

Macros are set up in the Key Commands dialog as follows:

1. Click the Show Macros button.
The macro settings are shown in the lower part of the dialog. To hide these from view, 
click the button (now renamed to Hide Macros) again.

2. Click New Macro.
A new, unnamed macro appears in the Macros list. Name it by typing the desired name. 
You can rename a macro at any time by clicking it in the list and typing a new name.

3. Make sure the macro is selected, and then use the Categories and 
Commands in the upper half of the dialog to select the first command 
you want to include in the macro.
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4. Click Add Command.
The selected command appears in the list of Commands in the Macros section.

5. Repeat the procedure to add more commands to the macro.
Note that commands are added after the currently selected command in the list. This 
allows you to insert commands “in the middle” of an existing macro.

A macro with three commands.

• To remove a command from the macro, select it in the Macros list and 
click Delete.

• Similarly, to remove an entire macro, select it in the Macros list and 
click Delete.

After you’ve closed the Key Commands dialog, all macros you have 
created appear at the bottom of the Edit menu, available for instant 
selection.

You can also assign key commands to macros. All macros you have 
created appear in the upper section of the Key Commands dialog un-
der the Macros category – just select a macro and assign a key com-
mand as with any other function.
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Saving complete key commands settings

As previously mentioned, any changes made to the key commands 
(and macros) are automatically stored as a Nuendo preference. It is 
however also possible to store key commands settings separately. In 
this way, you can store any number of different key command settings, 
complete or partial, as presets for instant recall.

Proceed as follows:

1. Set up the key commands and macros to your liking.
When setting up key commands, remember to click “Assign” to make the changes.

2. Make sure that the “Store Selected Items Only” box is not checked.
This option is for saving partial key commands settings only (see below).

3. Click the Save button (the disk icon) by the Presets pop-up menu.
A dialog appears, allowing you to type in a name for the preset. 

4. Click OK to save the preset.
Your saved key commands settings will now be available in the Preset pop-up menu 
for your future projects.
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Saving partial key commands settings

It is also possible to save partial key commands settings. This is useful 
for example if you have made settings that only relate to a specific 
project or settings that you wish to apply only in certain situations. 
When you apply a saved partial preset you only change the specific 
saved settings, while all other key commands settings will be left un-
changed.

When you have set up the key commands and macros, proceed as 
follows to save the partial settings as a preset:

1. Activate the “Store Selected Items Only” check box.
When you check this box, a new “Store” column appears in the Commands list.

2. Click in the Store column for the key commands items you wish to save.
Note that if you check an entire category folder, as opposed to separate commands, all 
commands it contains will automatically also be checked. If this is not what you want, 
uncheck the commands you don’t want to include.

3. Click the Save button (the disk icon) next to the Presets pop-up menu.
A dialog appears, allowing you to type in a name for the Preset.

4. Click OK to save.
Your saved key commands settings will now be available from the Preset pop-up menu 
for your future projects.
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Loading saved key command settings

To load saved key command settings, proceed as follows:

• Note that this operation may replace existing key commands!
The key command settings you load will replace the current key command settings for 
the same functions (if any). If you have macros of the same name as those stored in the 
preset you load, these will be replaced too.
If you want to be able to revert to your current settings again, make sure to save them 
first, as described above!

1. Open the Key Commands dialog from the File menu.

2. Select the saved key commands preset you wish to open from the 
Presets pop-up.

3. Click OK to exit the Key Commands dialog and apply the saved preset 
settings.
The loaded key commands settings now replace the current key command settings.

Loading saved key commands settings from earlier versions of Nuendo

If you have used a previous version of Nuendo, you may have saved 
key commands settings from it that you’d like to use in Nuendo 3. This 
is possible by using the Import function, which lets you load and apply 
either saved key commands or macros:

1. Open the Key Commands dialog from the File menu.

2. Click the “Import” button (the folder icon) to the right of the Presets 
pop-up menu.
A standard browser dialog opens.

The Import button

3. In the browser dialog, use the “Files of type:” pop-up to specify if you 
want to import a Key Commands File (Windows file extension “.key”) 
or a Macro Commands File (extension “.mac”).
In Nuendo 3, Key Commands files include any macro settings and use the Windows 
extension “.xml”. So after you have imported an older file, you might want to save it as 
a preset (as described on page 706) to be able to access it from the Presets pop-up 
menu in the future.
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4. Navigate to the file you want to import and click “Open”.
The file is imported.

5. Click OK to exit the Key Commands dialog and apply the imported 
settings.
The settings in the loaded key commands or macros file now replace the current 
settings.

About the “Reset” and “Reset All” functions

These two buttons in the Key Commands dialog will both restore the 
default settings. The following rules apply:

• “Reset” restores the default key command setting for the function se-
lected in the Commands list.

• “Reset All” will restore the default key commands for all commands.

Note that the “Reset All” operation will cause any changes made to the 
default key commands to be lost! If you want to be able to revert to these 
settings again, make sure to save them first!

About the default key commands

As mentioned before, there are numerous default key commands. For 
an overview of these, please refer to the Getting Started book where 
they are listed for your convenience.

Using Alternative Key Sets

As an alternative to saving and loading key commands settings as pre-
viously described, you can set up and save “Alternative Key Sets”. This 
allows you to switch between different key commands settings “on the 
fly” while you are working in the program, instead of having to go into 
the Key Commands dialog to change them.

About the preset Alternative Key Sets

By default, Nuendo contains two different key sets:

• “Markers” is actually not an alternative key set, but rather, it is the default key 
set that you can switch back to at any time (see below).
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• “Shuttle” is a specialized, alternative key set containing key commands set-
tings for all of the Transport panel’s Shuttle controls.

You could edit and save these under the same names to replace them 
with your own settings should you so wish, but it is advised that you 
instead create additional key sets for your specific needs.

Saving an Alternative Key Set

Here’s how to create and save an Alternative Key Set:

1. Open the Key Commands dialog from the File menu.

2. Set up the key commands and macros the way you want them.

3. Decide whether you want to save complete or partial settings by acti-
vating/deactivating the “Store Selected Items Only” checkbox.

4. Click the Save button (the disk icon) in the Alternative Key Sets section.
A dialog appears, allowing you to type in a name for the Preset. 

5. Type in a name for the key set and click OK to save it.
The saved key set appears in the list of alternative key sets.

Editing an Alternative Key Set

To edit a saved key set, proceed as follows:

1. Select it in the list and click the “Open button” (the folder icon) in the 
Alternative Key Sets section.
The key set is now activated, and the key commands settings are changed accordingly.

2. Make the desired changes.

3. Click the Save button (the disk icon) in the Alternative Key Sets section.
The key set is saved with the updated settings.
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Removing a saved Alternative Key Set

• To remove a saved key set, select it in the list and click the “Remove” 
button (the trash icon) in the Alternative Key Sets section.
A dialog appears asking if you want to remove the key set or cancel the operation.

Switching between Alternative Key Sets

You switch between different key sets in the program by using the key 
command assigned to the function “Toggle Alternate Key Commands”, 
located in the “File” subfolder in the Key Commands dialog.

The key command for this function is by default [F5], but you can of 
course change this to any key command that suits you best. Refer to 
page 699 for instructions on how to change key commands.

• When you press the key command for the function, a small pop-up 
appears, indicating which key set is currently loaded.

• Each time you press the key command, you switch to the next avail-
able alternative key set.
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Setting up tool modifier keys

A tool modifier key is a key you can press to get an alternate function 
when using a tool. For example, clicking and dragging and event with 
the Arrow tool normally moves it – holding down a modifier key (by 
default [Alt]/[Option]) will copy it instead.

The default tool modifier keys are listed in the Getting Started book, 
but you can customize them if needed. This is done in the Preferences 
dialog:

1. Open the Preferences dialog from the File menu (on the Mac, this is 
located on the Nuendo menu) and select the Editing – Tool Modifiers 
page.

2. Select an option in the Categories list, and then locate the action for 
which you want to edit the modifier key.
For example, the “Copy” action mentioned above resides in the category “Drag & Drop”.

3. Select the action in the Action list.

4. Hold down the desired modifier key(s) and click the Assign button.
The current modifier key(s) for the action is replaced. If the modifier key(s) you pressed 
are already assigned to another tool, you will be asked whether you want to overwrite 
them. If you do, this will leave the other tool without any modifier key(s) assigned.

5. When you’re done, click OK to apply the changes and close the dialog.
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A
AAF files 646
ACID® loops 434
Activate project button 638
Active ASIO Ports for Data

only 607
Add Bus 19
Add Child Bus 20
Add Track 121
Adjust Fades to Range 187
AES31 files 648
AFL 22, 230
Aftertouch

Recording 83
AIFF files 554
Allow machine controlled cycle 592
Alternative Key Sets 709
Always Send Start Message 583
Angle Mode 312
Any (MIDI channel setting) 78
Apogee UV22 HR 270
APP

Introduction to 575
Setting up 580

Appearance 690
General 690
Meters 690

Applying effects 384
Archiving 497
ASIO 2.0 63
ASIO Direct Monitoring 63
ASIO Positioning Protocol

About 575
Setting up 580

Attenuate (Surround Panner) 317

Audio channels
Copying settings 245
Linking 254
Making settings for 237
Mixing down to file 550
Saving settings 256

Audio clips
About 360
Creating new versions 483
Deleting 484
Locating events 485
Managing in Pool 481
Opening in the Sample 

Editor 491
Audio effects

About 260
Applying 384
Automating 337
Batch Processing 388
Editing 288
External 284
For output busses 

(Master inserts) 269
Freezing 272
In surround configurations 319
Inserts 262
Loading 289
Naming 289
Organizing in subfolders 291
Post-fader inserts 262
Pre/Post fader sends 278
Presets 287
Recording with 72
Saving 289
Sends 276
Tempo sync 261
Using VST System Link 612
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Audio events
Blue handles 186
Editing in Browser 534
Editing in Sample Editor 400
Fade handles 186
Making selections in 410
Slicing 467
Volume handles 188

Audio files
Converting 498
Deleting permanently 485
Exporting 550
Format for recording 54
Formats 491
Import options 126
Importing into Pool 491
Importing into Project 

window 125
Locating missing 488
Reconstructing missing 489
Removing missing 489

Audio loops
Tempo matching 435

Audio parts
About 95
Creating by gluing events 135
Creating from events 128
Drawing 127
Editing in Audio Part 

Editor 422
Editing in Project Browser 533
Sliding contents 139

Audio pre-record 52
Audio Tempo Definition tool 435
Audio Warp

Real-time pitch shifting 451
Settings pop-up 448
Unstretch Audio 447

Audition bus 14, 21, 29, 230
Signal flow 31

Auditioning
Audio Part Editor 426
Project window 128
Sample Editor 407

Auto Edit (Button) 594
Auto Fades 204
Auto Monitoring modes 61
Auto Quantize 81
Auto Save 668
Auto Select Events under Cursor

Project window 131
Autolatch mode 335
Automation

About 322
Editing in Project Browser 538
Modes 335
Opening automation 

subtracks 326
Reduction Preference 347
Showing and hiding 326
Trimming/offsetting 

curves 336
Write/Read buttons 333

Automation events
About 339
Editing 340
Editing in Project Browser 344
Removing 343
Selecting 343

Automation follows Events 332
Automation Reduction Level 347
Automation Return Time 335
Automation subtracks

Assigning parameters to 328
Hiding and showing 331
Muting 332

Autoscroll 155
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B
Backup (.bak) files 668
Bars+Beats Linear

Tempo Track Editor 505
Batch Process 388
Beat Calculator 514
Bounce (Export Audio) 550
Bounce Selection

Pool 494
Project window 143
Sample Editor 413

Brightness 690
Broadcast Wave files

Exporting 559
Recording 54

Browser 530
Busses

About 15
Adding 19
Mixing down to file 550
Routing to and from 24
Viewing in the mixer 26

Bypass
Effect sends 279
Insert effects 264

C
Calculate (Hitpoints) 460
Channel (MIDI) 75
Channel Overview

EQ 244
Insert effects 265

Channel Settings
Audio tracks 237
Copying 245
MIDI tracks 253

Channel view sets 219
Chase 45
Child Bus 20

Chn setting 78
Cleanup 643
Click 90
Clips, see “Audio clips”
Close 639
Close Gaps 471
Color pop-up menu

Project window 122
Color tool 122
Colorize Event Background 118
Conform Files 499
Controllers

Recording 83
Convert Files 498
Convert to Real Copy 133
Count-in 90
Cpr files 638
Create Audio Images During 

Record 64
Create Events 

(Cycle Rec Mode) 67
Create Groove Quantize 468
Create Regions 

(Cycle Rec Mode) 68
Create slices 467
Crop 151
Crossfades

Creating 193
Editing in dialog 195
Presets 202
Removing 195
Simple Crossfade Editor 195

Csh files 497
Cubase VST files 660
Cursor, see “Project cursor”
Cut Time 150
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Cycle
About 40
About recording 52
Recording audio 66
Recording MIDI 81

Cycle markers
About 174
Adding in Marker window 175
Drawing 179
Editing 181
Making selections with 181
Navigating to 180
On Marker track 178

Cycle Record modes 81

D
DC Offset 378
Deactivate Punch In on Stop 88
Default Output Bus 21
Default project 640
Delay compensation

About 261
Delete

Audio files from disk 485
Events in Project window 143

Delete Overlaps
Audio 71, 145

Delete Time 150
Detect Silence 392
Device Panels 100, 236
Device Ports

Selecting for busses 19
Setting up 17

DirectX plug-ins 292
DirectX Video 617
Disable

Hitpoints 463
Inserts 264
Sends 279
Track 43

Display format 108
Dissolve Part

Audio 128
Dithering 269
Divide

Audio events 469
Track list 123

Drag Delay 131
Draw

Automation events 340
Hitpoints 464
In Sample Editor 417
Markers 179
Parts 127

Drop Out Frames 
(Sync option) 596

Drum mode (Time Stretch) 383
Duplicate

Events and parts 133
Track 122

E
Edit button

Audio channel strips 237
Audio track Inspector 99
MIDI channel strips 253

Edit Mode 626
Edits folder 360
Effect Return channels 282
Effects, see “Audio effects”
Elements (Sample Editor) 401
Enable

Record on Selected Track 49
Solo on Selected Track 142
Track 43

Envelope
Process 367
Real-time 206
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EQ
Bypassing 243
Presets 243
Setting 240

Eraser tool 143
Events

As Region 151
Color 122
Duplicating 133
Envelopes 206
From Regions 151
Grouping 140
Locking 140
Moving 131
Muting 142
Overlapping in audio part 425
Overlapping in Project 

window 132
Removing 143
Renaming 134
Renaming all on track 121
Resizing 136
Resizing with time stretch 138
Selecting 130
Sliding contents 139
Snap mode 154
Splitting 135

Events to Part 128
Events, see also “Audio events”
Exclusive Solo 229
Export

AAF 646
AES31 648
OMF 649
OpenTL file 651
Tempo track 511

Export as Type 0 657
Export Audio Mixdown 550
Export MIDI files 655
Export Options (MIDI files) 656

Export selected tracks 645
External FX 284
Extract Audio from Video 623, 665

F
Fade handles 186
Fade In/Out functions 189
Faders 225
Fades

Auto Fades 204
Creating 186
Editing in dialog 190
Presets 191
Processing 189
Removing 188

Fill Loop 134
Film 620

2-3 pull-down 620
Filter

MIDI 87
Project Browser 537

Find missing files 488
Find Selected in Pool 486
FireWire 622
Fixed tempo 502
Folder parts 169
Folder tracks

About 166
Moving tracks into 167
Muting and soloing 168

Frame offset 622
Frame rates 594
Framerate

Get From Video 618
Freeze

Edits 391
Real-time processing 452
Tracks 272
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FX channel tracks
About 273
Adding effects for 275
Mixing down to file 550
Routing sends to 276
Setting up 274
Soloing 283

G
Gain 368
Generic Remote Device 354
Glue Tube tool

Project window 135
Grid (Snap mode) 153
Grid Relative (Snap mode) 153
Groove Quantize

From audio 468
Group 140
Group channel tracks

About 94
Routing audio to 249
Using effects 271

Group channels
Mute Sources as well 250
Muting 250

H
Hitpoint Edit tool 463
Hitpoint Sensitivity 461
Hitpoints

Auditioning 460
Background 456
Calculating 460
Disabling 463
Editing manually 464
Locking 463

Horizontal Zooming Only 113

I
Import

AAF 646
AES31 648
Audio CD 493
Audio CD Tracks 662
Audio files 125
Audio from Video file 665
Cubase Arrangement 662
Cubase Part 662
Cubase Song 660
Medium in Pool 491
MIDI files 655
MPEG files 667
Ogg Vorbis files 667
OMF 649
OpenTL file 651
Premiere Generic EDL 655
REX 666
Tempo track 511
Video files 125
WMA files 668
XSend 654

Import Track Archive 645
Impulse Response file 363
Independent track loop

Audio Part Editor 427
Info line

Pool 477
Project window 106
Sample Editor 405

Inhibit Restart (Sync option) 596
Initialize Channel 247
Input (MIDI) 75
Input busses

About 15
Adding 19
Routing to channels 24
Viewing in the mixer 26



NUENDO
720 Index

Input channels 224
Input Gain

About 227
Setting record level 60

Input levels 59
Input mode 59, 248
Input Phase switch 228
Input/Output routing panel 

(Mixer) 213
Inputs (Audio) 17
Insert effects (Audio) 262
Insert into Project 486
Insert Silence

Project window 151
Sample Editor 412

Inspector
Audio tracks 101
Folder tracks 103
General controls 99
Handling 98

Intensity (Appearance) 690
Interpolate Audio Images 407

J
Jog wheel 42
Jump tempo curve mode 507

K
Keep Last

Audio cycle recording 66
MIDI cycle recording 82

Key commands
About 698
Alternative Key Sets 709
Default 709
Importing 708
Loading 708
Modifying 699
Removing 704

Resetting to default 709
Saving 706
Searching for 703
Turning off 702

L
Lanes

Audio Part Editor 424
Stacked Audio Recording 70
Stacked MIDI Recording 82

Latency
Monitoring 61
VST System Link 601

Left locator 40
Length Adjustment 86
Level faders 225
Level meters

Input mode 59, 248
Post-Fader mode 60, 248
Post-Panner mode 248
Settings 247

LFE amount (Surround) 315
Libraries 643
Line mode

Automation 342
Linear Record Mode

Audio 65
MIDI 80

Linear time base 124
Link Send Routing Panners to 

Channel Panners 281
Listen Mode 22, 30, 230
Locate when clicked in empty 

space 38
Locators 40
Lock 140
Lock Event Attributes 141
Lock Frames (Sync option) 596
Lock Hitpoints 463
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Loop
Audio Part Editor 427

Loop icon
Audio Part Editor 426
Pool 490
Sample Editor 407

M
M button 142
Machine control

About 576
Preferences 592
Setting up 585
Sony 9-Pin specifics 593

Machine position follows jog 592
Machine position follows mouse 

edits 592
Macros 704
Magnetic Cursor (Snap mode) 154
Magnifying Glass tool 113
Markers

About 174
Adding in Marker window 175
Drawing on Marker track 179
Editing in Project Browser 539
Editing on Marker track 179
ID-numbers 176
Key commands for 182
Marker track 178
Marker window 174
Moving 176
Removing 175
Snapping to 154

Menus
Customizing 685

Merge Clipboard 369
Merge Record Mode

Audio 65
MIDI 80

Merge Tempo From Tapping 516

Meters
Coloring of 690
Input mode 59, 248
Peak Hold Time 248
Post-Fader mode 60, 248
Post-Panner mode 248
Settings 247

Metric Bias 462
Metronome

Activating 90
Precount 90
Settings 91

MIDI channel
"Any" 78
Selecting for tracks 78

MIDI Channel Settings 253
MIDI Clock

About 572
Always Send “Start” 583
Transmitting 583

MIDI Controller Input to 
Automation Tracks 334

MIDI files 655
MIDI Filter 87
MIDI inputs

Renaming 76
Selecting for tracks 76

MIDI outputs
Renaming 76
Selecting for tracks 78

MIDI parts
About 95
Drawing 127
Editing in Project Browser 535
Sliding contents 139

MIDI Record Catch Range 86
MIDI reset 84
MIDI Thru 75
MIDI Timecode Follows Project 

Time 583
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MIDI tracks
Channel Settings window 253

Minimize Files 496
Mix (Cycle Record mode) 81
Mixconvert

Extended mixer view 236
Mixer

Common panel 223
Extended channel strips 213
Group channels 249
Hiding channel types 218
Input and output busses 224
Input/Output settings 213
Link/Unlink channels 254
Loading settings 257
Multiple mixer windows 210
Pan 232
Saving settings 256
Solo and Mute 229
Using Sends 276
View options 215
Volume 225

Mixer Selection Follows 
Project 238

Mixing down to an audio file 550
MMC

About 576
Setting up 585

Modifier keys 712
Monitor button

Audio tracks 62
MIDI tracks 75

Monitoring modes 61
Move Hitpoints 464
Move to Back/Front 132
Move to Cursor 131
Move to Origin 131
MP3 files

Exporting 560
Importing 667

MPEG files
Audio 667
Video 617

MPEX
Pitch Shift 374
Time Stretch 383

Multiple audio tracks 121
Musical Mode 434

Activating 435
Activating in Pool 438

Musical time base 124
Mute

Events in Project window 142
Mixer 229
Tracks 142
Using 229

Mute Pre-Send when Mute 279
Mute tool 142

N
N. Chan. Split/Interleaved 

(Export) 555
New Project 111
Noise Gate 370
Normal Record Mode

Audio 65
MIDI 80

Normal Sizing 136
Normalize

Audio process 371
Surround Panner 317

Npl files
Libraries 643
Pool files 497

NTSC 621
Nudge buttons

Project window toolbar 132
Nudge position buttons 42
Numeric keypad 37
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O
Offline Process History 386
Ogg Vorbis files

Exporting 561
Importing 667

OMF files 649
On Import Audio Files 126
On Processing Shared Clips 361
On Startup setting 669
Online (VST System Link) 605
Open 638
Open Document Options 

dialog 670
OpenTL files 651
Output (MIDI) 75
Output busses

About 15
Adding 19
Mixing down to file 550
Routing channels to 24
Surround configurations 303
Viewing in the mixer 26

Output channels 224
Outputs (Audio) 17
Overlapping events

Audio Part Editor 425
Project window 132

Overview 120
Overwrite (Cycle Record mode) 81
Overwrite mode (Automation) 336

P
Padlock symbol 140
PAL 622
Pan Law 234
Pan modes 233
Parabola mode

Automation 342
Part Data mode 119

Parts, see “Audio parts” or
“MIDI parts”

Paste at Origin 134
Paste Time

Selection ranges 150
Patch Editor (Surround) 319
Peak Hold Time 248
Pencil tool 127
Pending Connections 639
Performance meter 258
PFL 22, 230
Phase Reverse 372
Pitch Bend

Recording 83
Pitch Shift 372
Play icon

Audio Part Editor 426
Pool 490
Sample Editor 407

Play Order
Creating 160
Flattening 164

Play tool
Audio Part Editor 426
Project window 128

Plug-in delay compensation 261
Plug-in Information window

VST plug-ins 292
Plug-ins

Applying 384
Automating 337
Getting info 292
In surround configurations 319
Installing 290
Organizing 291
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Pool
About 474
Auditioning 490
Convert Files 498
Finding clips in 486
Handling audio clips 481
Import Medium 491
Importing Pool files 497
Locate missing files 488
Record folder 494
Status column icons 479

Position Mode 312
Post-Fader mode 60, 248
Post-Panner mode 248
Postroll 88
Pre fader sends 278
Pre/Post crossfade 362
Precount 90
Preferences

9-Pin 592
Presets 687
Transferring 694

Premiere Generic EDL files 655
Prepare Archive 497
Preroll 88
Process Tempo 512
Processing

About 361
Batch Process 388
Plug-ins 384
Settings and functions 362
Undoing 386

Project
Activating 638
Creating 111
Default 640
Opening 638
Saving 639
Saving templates 641

Project Browser 530

Project cursor
Autoscroll 155
Moving 38
Selecting events with 131
Snapping to 154

Project overview line 120
Project scrubbing 42
Project Setup dialog 111
Pull-down

2-3 pull-down 620
About 621

Pull-up
About 621

Punch In
Automatic 51
Manual 50

Punch Out 51

Q
Q-points 466
Quantize

Automatic during recording 81
Creating grooves from

audio 468
Quantize Audio 449
Quick Zoom 114
Quicktime 617

R
R button 333
Ramp tempo curve mode 507
Range Selection tool 146
Read button 333
Real Audio files 562
Real-time Export 552
Real-time mode (time stretch) 383
Real-time pitch shifting 451
Real-time processing

Freezing 452
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Reconstruct 489
Record Catch Range 86
Record enable 49

9-Pin Devices 593
Record file type 54
Record folder 58
Record format 55
Record mode (Linear)

Audio 65
MIDI 80

Recording in MIDI editors 86
Recording tempo changes 509
ReCycle files 666
Redo Zoom 117
Regions

Creating 414
Creating from events 151
Creating with Detect 

Silence 394
Editing 415
Exporting as audio files 494
Removing 416

Relative snapping 153
Remote control

Key commands 353
Setting up 350
Writing automation 352

Remove
Crossfades 195
DC Offset 378
Empty Tracks 122
Fades 188
Missing files 489
Parameter 343

Repeat
Events and parts 133

Replace Audio in Video File 624
Replace Record Mode

Audio 65
MIDI 80

Reset 84
Reset Mixer 247
Resolution 55
Resolving 573
Retrospective Record 85
Return To Start Position on 

Stop 43
Reverse 379
Revert 642
ReWire

About 630
Activating 632
Channels 634
Routing MIDI 635

REX files 666
Right locator 40
Routing

Audio to and from busses 24
Effect sends 277
Effect sends (Panning) 280
Inputs/outputs in effects 266

Ruler
About 108
Adding additional time 

scales 109
Ruler tracks 109

S
S button 142
Sample rate 112
Sample size 55
Save 639
Save New Version 641
Save Project to new folder 642
Scissors tool

Project window 135
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Scrubbing
Events in Project window 129
Events in Sample Editor 408
Project 42
Resizing events by 137
While setting snap point 409

Search key commands 703
Select Tool

Show Extra Info 107
Selecting

Events in Project window 130
Mixer channels 239

Send effects (Audio) 273
Send Shuttle Command instead of 

Fast Forward/Rewind 592
Send Still Command instead of 

Stop 592
Sensivity slider 461
Set Audio Event from Loop 469
Set Pool Record Folder 494
Set Record Folder 58
Set Tempo from Event 470
Set Timecode at Cursor 581
Shared copy 133
Shared VST plug-ins folder 291
Show Controllers 119
Show Data on Small Track 

Heights 118
Show Event Names 118
Show Event Volume Curves 

Always 186
Show Track Colors 122
Show Used Automation 339
Show Video Thumbnails 626
Shuffle (Snap mode) 154
Shuttle speed 41
Signal levels 59
Silence 379
Simple Crossfade Editor 195

Sine mode
Automation 342

Sizing Applies Time Stretch 138
Sizing Moves Contents 136
Slices

Auditioning 460
Creating 467
Disabling 463
Locking 463

SMPTE
Get From Video 618

Snap
Project window 152

Snap MIDI Parts to Bars 86
Snap point

Setting for clips in Pool 491
Setting in Project window 152
Setting in Sample Editor 408

Snap to Zero Crossing
Preference setting 155
Sample Editor 419

Snap Track Heights 115
Solo

Audio Part Editor 427
Folder tracks 168
Mixer 229
On Selected Track 142
Tracks 142

Solo Defeat 229, 283
Solo Record in MIDI Editors 86
Sony 9-Pin

Auto Edit button 594
Record enabling audio 

tracks 593
Setting up 588

Sony 9-pin
Preferences 592

Sound Designer II files 557



NUENDO
Index 727

Speaker tool
Audio Part Editor 426
Project window 128

Speakers (SurroundPanner) 313
Spectrum Analyzer 395
Split

Events 135
Range 151

Split at Cursor
Project window 135

Split Loop
Project window 135

Square mode
Automation 342

Stacked Cycle Recording
Audio 70
MIDI 82

Standard Mode 312
Start Record at Left Locator 50
Startup options 669
Static Value Line (Automation) 340
Stationary cursor 155
Statistics 398
Step Bar 39
Stereo Flip 380
Stereo Pan Law 234
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